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1
DR Series 系统简介
DR Series 系统说明文件包含的主题将介绍如何使用 Dell DR Series 系统执行数据存储操作以及管理存储和复制
容器。DR Series 系统主题将介绍并说明 DR Series 系统图形用户界面 (GUI)，您可使用此界面管理备份和复制操
作。通过一组全面的基于 GUI 的过程，您可使用支持的 Web 浏览器访问所有管理功能。如果存在不受 DR 
Series 系统 GUI 支持的任何重要管理任务或操作，本指南将提供并说明相应的命令行界面 (CLI) 命令。有关 DR 
Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR Series 系
统命令行参考指南）。

关于 DR Series 系统 GUI 说明文件

DR Series 系统说明文件描述了如何使用图形用户界面 (GUI) 及其菜单、选项卡和选项来执行广泛的数据存储操

作，并管理相关的存储和复制容器。

此说明文件面向管理员 终用户，其中介绍和提供了关于使用 DR Series 系统 GUI 元素轻松管理备份和重复数

据消除操作的过程。通过一组全面的基于 GUI 的过程，可以使用受支持的 Web 浏览器访问所有主要管理特性

和功能。

如果 DR Series 系统 GUI 不支持任何重要的管理任务或操作，则此说明文件将提供并描述相应的 DR Series 系统

命令行界面 (CLI) 命令。

注: 有关可用于 DR Series 系统的受支持 Web 浏览器的信息，请参阅 support.dell.com/manuals 上的 Dell DR 
Series System Interoperability Guide（Dell DR Series 系统互操作性指南）。

What's New In This Release
The following features have been added to the DR Series systems for this release:

Advanced 
Networking

Advanced networking feature allows you to modify the default bonded network configuration 
of your DR Series system. It allows you to create and manage multiple bonds on the same 
system to support your data, management and replication traffic. You must use the CLI to set 
up advanced networking. However, you can view and edit the NIC bonding configuration using 
the web user interface.

Rapid Data 
Storage Protocol

Rapid Data Storage (RDS) is developed by Dell Quest and provides a logical disk interface for 
use with network storage devices. RDS allows for better coordination and integration between 
DR Series system backup, restore, and optimized duplication operations with Dell Quest 
NetVault Backup (NVBU). You can back up, complete optimized replication, and restore data 
from DR Series systems using the Rapid Data Access protocol using the Dell Quest NetVault 
Backup DMA.

Daily Status 
Reporting

Daily status reporting feature allows you to configure daily system statistics for container 
status information on bytes ingested, deduplicated, and replicated.

Security 
Questions for 
Password Reset

Security questions for password reset allow you to add security questions to reset your DR 
Series system password.
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注: The maintenance mode User interface for the DR Series systems is updated in this release.

您可能需要的其他信息

警告: 请参阅系统随附的安全和管制信息。保修信息可能包含在此说明文件中，也可能作为单独的说明文

件提供。

• Dell DR Series System Owner's Manual（Dell DR Series 系统所有者手册）提供有关解决方案功能的信息，
介绍如何对系统进行故障排除以及如何安装或替换 DR Series 系统组件。本说明文件在 support.dell.com/
manuals 上提供。

• Dell DR Series System Command Line Reference Guide（Dell DR Series 系统命令行参考指南）提供有关使用 
DR Series 系统命令行界面 (CLI) 来管理 DR Series 系统数据备份和复制操作的信息。本说明文件在 
support.dell.com/manuals 上提供。

• Dell DR Series System Getting Started Guide（Dell DR Series 系统入门指南）提供设置 DR Series 系统的概
述并包括技术规格。本说明文件在 support.dell.com/manuals 上提供。

• Setting Up Your Dell DR4100 System（设置 Dell DR4100 系统）提供有关初始化 Dell DR4100 系统所需的网
络、初始设置和用户帐户设置的信息。本说明文件在 support.dell.com/manuals 上提供。

• Dell DR Series System Interoperability Guide（Dell DR Series 系统互操作性指南）提供有关可用于 DR Series 
系统的受支持硬件和软件的信息。本说明文件在 support.dell.com/manuals 上提供。

• Dell PowerVault MD1200 and MD1220 Storage Enclosures Hardware Owner's Manual（Dell PowerVault 
MD1200 和 MD1220 存储机柜硬件所有者手册）提供有关可用于 DR Series 系统的受支持外部数据存储扩
展架硬件（机柜）的信息。本说明文件在 support.dell.com/manuals 上提供。

• 系统随附的任何介质，用于配置和管理系统的说明文件和工具，包括与操作系统、系统管理软件、系
统更新软件以及随系统购买的系统组件相关的说明文件和工具。

注: 请经常访问 support.dell.com/manuals 以查看说明文件更新，并首先阅读这些说明文件更新，因为它们

通常会替代其他说明文件中的信息并包含说明文件的 新版本。

注: 请经常访问 support.dell.com/manuals 以查看发行说明，并首先阅读这些说明，因为它们包含与特定产

品版本已知问题相关的 新说明文件信息。

源代码获取途径

DR Series 系统软件的一部分可能包含开源软件，您可以按照在分发开源软件时所依据的特定许可证的条款和

条件使用该软件。

在特定开源软件许可证下，您还有权获得相应源文件。要了解更多信息或要查找各个程序的相应源文件，请访

问 opensource.dell.com 网站。
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2
Understanding the DR Series System
The DR Series system is a high-performance, disk-based backup and recovery appliance that is simple to deploy and 
manage, and offers unsurpassed Total Cost of Ownership benefits. Features such as innovative firmware and an all-
inclusive licensing model ensure optimal functionality and the assurance of no hidden costs for desired future features.

注: Unless otherwise noted, later references to "the system" or "DR Series system" are used interchangeably to 
represent the Dell DR Series system.

The DR Series system has a simple installation process with full, intuitive remote setup and management capabilities. It 
is available in the following drive capacities—2.7 Terabytes (TB), 5.4 TB, 9 TB, 18 TB, and 27 TB (the 27 TB drive capacity 
was added in Release 2.0), and is ideal for both small enterprise and remote office environments. The DR Series system 
and corresponding drive capacities are as follows:

• 300 Gigabyte (GB) drive capacity: 2.7 TB system (this system version does not support the addition of expansion 
shelf enclosures)

• 600 GB drive capacity: 5.4 TB system

• 1 TB drive capacity: 9 TB system

• 2 TB drive capacity: 18 TB system

• 3 TB drive capacity: 27 TB system

注: To better understand the drive capacity and the available physical capacity for the drive types available in the 
DR Series system, see Drive and Available Physical Capacities.

注: Release 2.0 also supports using an external data storage expansion shelf (also known as expansion 
enclosures). The DR Series system supports up to two expansion enclosures per system. An added expansion shelf 
enclosure must be equal to or greater than each DR Series system internal drive slot capacity (0–11). For more 
information about expansion enclosures, see Installing an Expansion Shelf License, DR Series System - Expansion 
Shelf Cabling, and Expansion Shelf Licenses.

Using Dell deduplication and compression algorithm technology, this system can achieve data reduction levels ranging 
from 10:1 to 50:1. This reduction in data results in less incremental storage needs and a smaller backup footprint. By 
removing redundant data, the system provides deduplication and compression that delivers:

• Fast, reliable backup and restore functionality

• Reduces media usage and power and cooling requirements

• Improves overall data protection and retention costs

The benefits of data deduplication can be extended across the enterprise—through the deduplicated replication 
function—to provide a complete backup solution for multi-site environments.

The shorter Recovery Time Objectives (RTO) and more attainable Recovery Point Objectives (RPO) can also be assured 
as critical backup data remains on disk and online longer. Capital and administrative costs are diminished at the same 
time as internal service level agreements (SLAs) are more easily met.

The DR Series system includes the following:

• Advanced data protection and disaster recovery

• Simple management interface (using the system GUI)
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• Wide variety of data backup installations and environments

The Dell DR Series system contains data backup and management software preinstalled on a Dell hardware appliance, 
which provides you with a robust disk-based data backup capability installed on a deduplication-enabled appliance.

The system supports two interface types, and the system software manages the storage containers using the following 
interfaces:

• A command line interface (CLI)

• A graphical user interface (GUI)

About the DR Series System
The Dell DR Series system is a solution designed to reduce your backup data footprint using a number of comprehensive 
backup and deduplication operations that optimize storage savings. Collectively, the DR Series system comes in two 
types:

• DR4000 system: this is preinstalled DR4000 system software on a Dell PowerEdge R510 appliance platform

• DR4100 system: this is preinstalled DR4000 system software on a Dell PowerEdge R720xd appliance platform

The DR Series system consists of the following components:

• Software — the system software supports record linkage and context-based lossless data compression 
methods.

• Hardware — there are two appliance types that support the DR Series:

– DR4000 system: includes twelve 3.5 inch SAS or Nearline SAS chassis drives that are hot-swappable, 
two power supplies for power redundancy, and two cabled 2.5-inch SAS drives for the operating 
system. The operating system is installed on two 2.5–inch internal drives that are in a RAID 1 
configuration in the DR4000 system.

– DR4100 system: includes twelve 3.5 inch SAS or Nearline SAS chassis drives that are hot-swappable, 
two power supplies for power redundancy, and includes two 2.5-inch drives that are hot-pluggable in 
the rear.

注: For slot locations for the twelve 3.5–inch drives in the DR Series system types, see DR Series System 
and Data Operations.

• Expansion shelf—the system appliance supports the addition of up to two external Dell PowerVault MD1200 
data storage expansion shelf enclosures. Adding an expansion shelf provides additional data storage for the DR 
Series system and also requires a license. Each added expansion shelf enclosure must be equal to or greater 
than each DR Series system internal drive slot capacity (0–11).

注: The 300 Gigabyte (GB) drive capacity (2.7TB) version of the DR Series system does not support the 
addition of expansion shelf enclosures.

For more information, see Expansion Shelf Licenses. For more general information about the supported storage 
enclosures, see “DR Series Expansion Shelf” in DR Series System and Data Operations, and 
support.dell.com/manuals.

驱动器容量和可用物理容量

表 1 定义了 DR4000 系统版本 1.0.1.2 及更高版本中的内部系统驱动器容量和可用物理容量（以十进制和二进制

值表示）。从版本 2.0 开始，DR Series 系统分为两类：

• DR4000 系统 - 采用已修改的 Dell R510 设备平台，预装 DR4000 系统软件。

• DR4100 系统 - 采用已修改的 Dell R720xd 设备平台，预装 DR4000 系统软件。
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内部驱动器容量

表 1 中列出的容量值表示已根据 DR4000/DR4100 系统版本中的相关开销调整的内部驱动器容量和可用物理容

量。

注: 在表 1 中，缩写 TB 和 GB 分别表示十进制的太字节和千兆字节，而缩写 TiB 则是二进制的太字节值。

作为数字信息存储单位，二进制太字节是字节的基于标准的二进制倍数。

表. 1: 内部驱动器容量和可用物理容量

DR Series 系统驱动器容量 可用的物理容量（十进制） 可用的物理容量（二进制）

3 TB（仅限 DR4100 系统） 26.79 TB 23.8 TiB

2 TB 17.9 TB 15.9 TiB

1 TB 8.89 TB 7.9 TiB

600 GB 5.29 TB 4.6 TiB

300 GB 2.47 TB 2.2 TiB

有关扩展架机柜支持的外部数据存储容量的更多常规信息，请参阅 DR Series System and Data Operations（DR 
Series 系统和数据操作）中的 DR Series Expansion Shelf（DR Series 扩展架）部分。

外部驱动器容量 

表 2 中列出的容量值表示在向 DR4000 或 DR4100 系统添加受支持的扩展架机柜后可用的外部驱动器中的附加存

储容量。使用扩展架机柜可添加容量为 1 太字节 (TB)、2 TB 或 3 TB 的附加数据存储。有关扩展架机柜的更多信

息，请参阅添加 DR Series 系统扩展架、安装扩展架许可和 DR Series 系统 - 扩展架布线。

表. 2: 外部驱动器容量和可用物理容量

DR Series 系统驱动器容量 可用的物理容量（十进制） 可用的物理容量（二进制）

1 TB 8.89 TB 7.9 TiB

2 TB 17.89 TB 15.9 TiB

3 TB 26.79 TB 23.8 TiB

Data Storage Terminology and Concepts
This topic presents several key data storage terms and concepts that help you to better understand the role that the DR 
Series system plays in meeting your data storage needs.
Data Deduplication and Compression: The DR Series system design draws upon a wide variety of data-reduction 
technologies that include the use of advanced deduplication algorithms, in addition to the use of generic and custom 
compression solutions that are effective across a large number of differing file types. The system uses a concept of 
content-awareness where it analyzes data to better learn and understand the structure of your files and data types.

Once this is learned, it uses this method to improve your data reduction ratios while reducing resource consumption on 
the host. The system uses block deduplication to address the increasing data growth, and this is well suited to providing 
the best results for routine and repeated data backups of structured data. Block-level deduplication works efficiently 
where there are multiple duplicate versions of the same file. This is because it looks at the actual sequence of the 
data–the 0s and 1s–that comprise the data.

Whenever a document is repeatedly backed up, the 0s and 1s stay the same because the file is simply being duplicated. 
The similarities between two files can be easily identified using block deduplication because the sequence of their 0s 
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and 1s remain exactly the same. In contrast to this, there are differences in online data. Online data has few exact 
duplicates. Instead, online data files include files that may contain a lot of similarities between each file. For example, a 
majority of files that contribute to increased data storage requirements come pre-compressed by their native 
applications, such as:

• Images and video (such as the JPEG, MPEG, TIFF, GIF, PNG formats)

• Compound documents (such as .zip files, email, HTML, web pages, and PDFs)

• Microsoft Office application documents (including PowerPoint, MS-Word, Excel, and SharePoint)

注: The DR Series system experiences a reduced savings rate when the data it ingests is already 
compression-enabled by the native data source. It is highly recommended that you disable data 
compression used by the data source, and especially for first-time backups. For optimal savings, the native 
data sources need to send data to the DR Series system in a raw state for ingestion.

Block deduplication is not as effective on existing compressed files due to the nature of file compression because its 0s 
and 1s change from the original format. Data deduplication is a specialized form of data compression that eliminates a 
lot of redundant data. The compression technique improves storage utilization, and it can be used in network data 
transfers to reduce the number of bytes that must be sent across a link. Using deduplication, unique chunks of data, or 
byte patterns, can be identified and stored during analysis. As the analysis continues, other chunks are compared to the 
stored copy and when a match occurs, the redundant chunk is replaced with a small reference that points to its stored 
chunk. This reduces the amount of data that must be stored or transferred, which contributes to network savings. 
Network savings are achieved by the process of replicating data that has already undergone deduplication.

By contrast, standard file compression tools identify short repeated substrings inside individual files, with the intent of 
storage-based data deduplication being to inspect large volumes of data and identify large amounts of data such as 
entire files or large sections of files that are identical. Once this has been done, this process allows for the system to 
store only one copy of the specific data. This copy will be additionally compressed using single-file compression 
techniques. For example, there may be cases where an email system may contain 100 or more emails where the same 1 
Megabyte (MB) file is sent as an attachment and the following shows how this is handled:

• Without data deduplication, each time that email system is backed up, all 100 instances of the same attachment 
are saved, which requires 100 MB of storage space.

• With data deduplication, only one instance of the attachment is actually stored (all subsequent instances are 
referenced back to the one saved copy), with the deduplication ratio being approximately 100 to 1). The unique 
chunks of data that represent the attachment are deduplicated at the block chunking level.

注: The DR Series system does not support deduplication of any encrypted data, so there will be no 
deduplication savings derived from ingesting encrypted data. The DR Series system cannot deduplicate 
data that has already been encrypted because it considers that data to be unique, and as a result, cannot 
deduplicate it.

In cases where self encrypting drives (SEDs) are used, when data is read by the backup application, it is decrypted by 
the SED or the encryption layer. This works in the same way as if you were opening an MS-Word document that was 
saved on a SED. This means that any data stored on a SED can be read and deduplicated. If you enable encryption in the 
backup software, you will lose deduplication savings because each time the data is encrypted, the DR Series system 
considers it to be unique.

Replication: Replication is the process by which the same key data is saved from multiple storage devices, with the goal 
of maintaining consistency between redundant resources in data storage environments. Data replication improves the 
level of fault-tolerance, which improves the reliability of maintaining saved data, and permits accessibility to the same 
stored data. The DR Series system uses an active form of replication that lets you configure a primary-backup scheme. 
During replication, the system processes data storage requests from a specified source to a specified destination (also 
known as a target) that acts as a replica of the original source data.
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注: Starting with Release 2.0, the DR Series system software includes version checking that limits replication only 
between other DR Series systems that run the same system software release version (DR Series systems running 
Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

注: It is important to distinguish the difference between data that has been processed by backup and data that has 
been processed by replication, since backup saves a copy of data that remains unchanged for a long period of 
time.

Targets with replica data are read-only, and are updated with new or unique data during scheduled or manual 
replications. The DR Series system can be considered to act as a form of the storage replication where the backed up 
and deduplicated data is replicated in real-time or via a scheduled window. In a replication relationship between two DR 
Series systems, this means that a relationship exists between a pair of systems, one acting as the source and the other 
as a target in the replication pair (for example, with acme-west and acme-east). When this type of replication 
relationship exists between distinct containers on two distinct DR Series systems, it can be considered bidirectional in 
the sense that:

• West1 container on the acme-west source system can replicate data to a separate East1 container on the 
acme-east target system.

• The East2 container on the target acme-east system can also replicate data back to the West2 container on the 
source acme-west system.

This form of replication involves separate containers on two distinct DR Series systems. Target containers in replication 
must always act as read-only, while source containers can act as read-write. Unlike NFS and CIFS containers, OST and 
RDS container replication is handled by the two supported Data Management Applications (DMAs) on media servers. 
For more information on OST, see Understanding OST. For more information on RDS, see Configuring and Using Rapid 
Data Storage.

注: OST and RDS containers are categorized as Rapid Data Access (RDA) containers in DR Series systems.

This release of the DR Series system supports the 32:1 replication of data, whereby up to 32 source DR Series systems 
can write data to different individual containers on a single, target DR Series system. This supports the use case where 
branch or regional offices can each write their own data to a separate, distinct container on a main corporate DR Series 
system.

注: Be aware that the storage capacity of the target DR Series system is directly affected by the number of source 
systems writing to its containers, and by the amount being written by each of the source systems.

If the source and target systems in a replication pair reside in different Active Directory (AD) domains, then the data that 
resides on the target DR Series system may not be accessible. When AD is used for authentication for DR Series 
systems, the AD information is saved with the file. This can serve to restrict user access to the data based on the type of 
AD permissions that are in place.

注: This same authentication information is replicated to the target DR Series system when you have replication 
configured. To prevent domain access issues, ensure that both the target and source systems reside in the same 
Active Directory domain.

Reverse Replication: The concept of reverse replication is not supported on DR Series systems. This is because replica 
containers are always in a R-O (read-only) mode on the DR Series system, thus making write operations a non-
supported operation. Under very specific conditions, it might be possible for replica containers to support a type of write 
operation whose sole function is to restore data from an archival target. For example, data could be replicated back to 
the remote site where a data management application (DMA), also known as backup software, is connected to allow 
this data to be restored directly.
This specific case applies only to configurations where data is backed up from a remote location to a local container, 
and then replicated over a WAN to a replica container that is backed up to tape backup. The data needs to be restored 
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from the tape backup to the original location; first, restore the data back to a DR Series system replica container, and 
then restore it back to the original source location of the data on the other side of the WAN link.

注: If you choose to use this alternate workaround method, you must set up a new data storage unit in the DMA 
and import the images before a restore to the original location can occur.

To support this effort to leverage deduplication across the WAN to allow this scenario, complete the following:

1. Make sure that the replication operation has completed (between source and target).

2. Delete current replication relationship, and re-create replication relationship (reversing the source and target 
roles).

3. Restore data to the original source container (now the target).

4. Make sure that the replication operation has completed.

5. Delete replication relationship and re-create replication relationship (restoring original source and target 
destinations).

Under this scenario, a fraction of the data to be recovered is sent across the WAN link. This could speed up a remote 
restore significantly. However, there are some downsides to this type of scenario:

• If step 1 is not followed correctly, any changes not fully replicated are lost.

• During steps 2 and 3, any data that is written to the original DR Series system source container may be lost.

• During step 4, if the data is not fully replicated back before the switch is made, it may be lost.

Alternatively, you still could support this effort by completing the following:

1. Create a new container on the target DR Series system.

2. Set up replication from this container back to the source DR Series system container.

3. Set up a new disk storage unit in the DMA and make sure that the DMA is aware of any new images.

4. Import the old images back into the DMA from the target DR Series system (the original source location).

5. Use a new disk storage unit in the DMA, and then restore the data back to the original client.

Data Deduplication and Compression

The DR Series system design uses various data-reduction technologies, including advanced deduplication algorithms, in 
addition to the generic and custom compression solutions that prove effective across many differing file types. Data 
deduplication and compression is addressed in the following areas:

• DR4000/DR4100 — The DR Series system backup and recovery appliances provide both efficient and high-
performance disk-based data protection to leverage the advanced deduplication and compression capabilities 
in the DR Series system software. Based on technology that is now part of the Dell Fluid Data Architecture, the 
DR Series systems provide a key component that performs backup, recovery, and data protection operations.

• Deduplication — This technology eliminates redundant copies of data and in the process it decreases disk 
capacity requirements and reduces the bandwidth needed for data transfer. Deduplication can be a major asset 
for companies that are dealing with increasing data volumes and require a means for optimizing their data 
protection.

• Compression — This technology reduces the size of data that is stored, protected, and transmitted. 
Compression helps companies improve their backup and recovery times while helping reduce infrastructure and 
network resource constraints.

In general, DR Series systems (DR4000 and DR4100) are disk-based data protection appliances that offer advanced 
deduplication and compression capabilities to reduce the time and cost associated with backing up and restoring data. 
Based on deduplication and compression technology, the DR Series systems eliminate the need to maintain multiple 
copies of the same data. This lets customers keep more data online longer and reduce the need for tape backup 
dependency.
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Using its deduplication and compression technology, DR Series systems can help achieve an expected data reduction 
ratio of 15:1. Achieving this reduction in data means that you need fewer incremental storage operations to run and it 
provides you with a smaller backup footprint. By removing redundant data, DR Series systems deliver fast reliable 
backup and restore functionality, reduce media usage and power and cooling requirements, and improve your overall 
data protection and retention costs.
You can extend the benefits of data deduplication across the enterprise as well–using the DR Series system 
deduplication replication function–to provide a complete backup solution for multi-site environments. With 32:1 
deduplicated replication, up to 32 nodes can be replicated simultaneously to separate, individual containers on one 
node. The DR Series systems use compression with replication to shrink the data that is needed to be moved across the 
wire to a container.
Replication can be scheduled based on your settings to occur during non-peak periods. The replication schedule you 
create can be set and prioritized to ingest data over replication data to ensure the most optimal back up windows based 
on your needs. The DR Series systems are Symantec OpenStorage Technology (OST) certified to provide tight 
integration with its NetBackup and Backup Exec DMA products to allow them to control when backup images are 
created, compressed, duplicated, and deleted, so that customers using these products can leverage the DR Series 
system appliance as a disk.
The DR Series systems also provide seamless integration with a number of data management applications (DMA), 
including Dell Quest NetVault Backup, CommVault replicated disk libraries, IBM Tivoli Storage Manager (TSM), EMC 
Networker, ARCserve, and Veeam backup software applications. Ideal for both small-sized and medium-sized 
companies as well as remote offices, the DR Series system provides data deduplication and compression support for 
four data capacity points: 35 Terabytes (TB), 70 TB, 130 TB, or 270 TB.

注: For a complete list of supported DMAs in the 2.1 release of the DR Series system, see the Dell DR Series 
System Interoperability Guide for details.

注: The DR Series system does not support deduplication of any encrypted data. So, there will be no deduplication 
savings derived from ingesting encrypted data. The DR Series system cannot deduplicate data that has already 
been encrypted because it considers that data to be unique, and as a result, it cannot deduplicate it.

Replication

Replication is the process by which the same key data is saved from multiple storage locations, with the goal being to 
maintain its consistency between redundant resources in data storage environments. Data replication improves the 
level of fault-tolerance, which improves the reliability of maintaining saved data, and permits accessibility to the same 
stored data. The DR Series system uses an active form of replication that lets you configure a primary-backup scheme. 
During replication, the system processes data storage requests from a specified source to a specified destination (also 
known as a target) that acts as a replica of the original source data.

注: Starting with Release 2.0, the DR Series system software includes version checking that limits replication only 
between other DR Series systems that run the same system software release version (DR Series systems running 
Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

注: It is important to distinguish the difference between data that has been processed by backup, and data that has 
been processed by replication. This is because backup saves a copy of data that generally remains unchanged for 
a long period of time.

Targets with replication data are read-only, and are updated with new or unique data during scheduled or manual 
replications. The DR Series system can be considered to act as a form of a storage replication process in which the 
backup and deduplication data is replicated in real-time or via a scheduled window in a network environment. In a 
replication relationship between two DR Series systems, this means that a relationship exists between a pair of systems. 
One system acts as the source and the other as a target in this replication pair (for example, acme-west and acme-east). 
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When this type of relationship exists between distinct containers on two distinct DR Series systems, it can be 
considered bidirectional in the sense that:

• The West1 container on the acme-west source system can replicate data to a separate East1 container on the 
acme-east target system.

• The East2 container on the target acme-east system can also replicate data back to the West2 container on the 
source acme-west system.

This form of replication involves separate containers on two distinct DR Series systems. Target containers in replication 
must always act as read-only, while sources containers can act as read-write. Unlike NFS and CIFS containers, OST and 
RDS container replication is handled by the two supported Data Management Applications (DMAs) on media servers. 
For more information on OST, see Understanding OST. For more information on RDS, see Configuring and Using Rapid 
Data Storage.

注: OST and RDS containers are categorized as Rapid Data Access (RDA) containers in DR Series systems.

The DR Series system supports the 32:1 replication of data, whereby up to 32 source DR Series systems can write data 
to different individual containers on a single, target DR Series system. This supports the use case where branch or 
regional offices can each write their own data to a separate, distinct container on a main corporate DR Series system.

注: Be aware that the storage capacity of the target DR Series system is directly affected by the number of source 
systems writing to its containers, and by the amount being written by each of the source systems.

However, if the source and target systems in a replication pair are in different Active Directory (AD) domains, then the 
data that resides on the target system may not be accessible. When AD is used to perform authentication for DR Series 
systems, the AD information is saved with the file. This can act to restrict user access to the data based on the type of 
AD permissions that are in place.

注: This same authentication information is replicated to the target DR Series system when you have replication 
configured. To prevent domain access issues, ensure that both the target and source systems reside in the same 
Active Directory domain.

反向复制

在 DR Series 系统上不支持反向复制的概念。这是因为 DR Series 系统上的副本容器始终处于 R-O（只读）模

式，这就使得写入操作成为不受支持的操作。

在极其特殊的条件下，副本容器有可能支持某种类型的写入操作，此写入操作的唯一功能就是从归档目标还原

数据。例如，可以将数据复制回远程站点，此站点上连接了数据管理应用程序 (DMA)（也称为备份软件），因

而可直接还原此数据。

这种特殊情形仅适用于以下配置：从远程位置向本地容器备份数据，然后通过 WAN 将数据复制到备份至磁带

的副本容器。数据需要从磁带备份还原至原始位置；首先，还原回 DR Series 系统副本容器，然后还原回 WAN 
链路另一端的原始数据源位置。

注: 如果您选择使用此备选解决方法，则必须在 DMA 中设置新的数据存储单元，并导入映像，然后才能还

原到原始位置。

要跨 WAN 利用此类重复数据消除，请完成以下操作：

1. 确保复制操作（源与目标之间）已经完成。

2. 删除当前的复制关系，然后重新创建复制关系（颠倒源角色与目标角色）。

3. 将数据还原到原始的源容器（现在的目标）。

4. 确保复制操作已经完成。

5. 删除复制关系，然后重新创建复制关系（还原原始源与目标目的地）。
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在此情形下，要恢复的一小部分数据将通过 WAN 链路发送。如此可显著加快远程还原的速度。但是，这种情

形也有一些弊端：

• 如果没有正确遵守步骤 1，则任何没有完全复制的更改都将丢失。

• 在步骤 2 和 3 期间，任何写入原始 DR Series 系统源容器的数据都可能会丢失。

• 在步骤 4 期间，如果在切换角色前没有将数据完全复制回去，则数据可能会丢失。

此外，还可以通过完成以下操作来支持此类过程：

1. 在目标 DR Series 系统上创建新容器。

2. 设置从此容器返向源 DR Series 系统容器的复制。

3. 在 DMA 中设置新的磁盘存储单元，并确保 DMA 可感知任何新映像。

4. 将旧映像从目标 DR Series 系统（原始的源位置）导入回 DMA。

5. 使用 DMA 中的新磁盘存储单元，然后将数据还原回原始客户端。

反向复制：备选方法

要支持通过备选方法来进行反向复制，请完成以下操作：

1. 在目标 DR Series 系统上创建新容器。

2. 设置从此容器返向源 DR Series 系统容器的复制。

3. 在 DMA 中设置新的磁盘存储单元，并确保 DMA 可感知任何新映像。

4. 将旧映像从目标 DR Series 系统（原始的源位置）导入回 DMA。

5. 使用 DMA 中的新磁盘存储单元，然后将数据还原回原始客户端。

Supported File System Protocols
The DR Series system supports the following file system protocols:

• Network File System (NFS)

• Common Internet File System (CIFS)

• Rapid Data Access (RDA)

– OpenStorage Technology (OST)

– Rapid Data Storage (RDS)

注: The DR Series system supports three container connection types: NFS, CIFS, and RDA. OST and RDS provide a 
logical disk interface that can be used with network storage devices to store data and support data storage 
operations.

For more information on OST, see Understanding OST, Creating an OST or RDS Connection Type Container, and Creating 
an NSF or CIFS Connection Type Container.

For more information on NFS and CIFS, see NFS, and CIFS. For more information on RDS, see Configuring and Using 
Rapid Data Storage.

NFS

网络文件系统 (NFS) 是一种文件系统协议，旨在成为文件服务器标准，其协议使用远程过程调用 (RPC) 计算机

通信方法。客户端可以通过网络访问文件，与访问本地存储的方式类似。
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NFS 是一个客户端-服务器应用程序，客户端可从中查看、存储和更新远程系统上的文件，就像在本地系统上

操作一样。系统或网络管理员可以装载全部或部分文件系统，装载的文件系统（或部分）可使用分配给每个文

件的权限进行访问。NFS 协议支持 Unix、Macintosh、OpenVMS 和 Microsoft Windows 操作系统。

CIFS

通用 Internet 文件系统 (CIFS) 远程文件访问协议是一种受 DR Series 系统支持的协议，也称为服务器消息块 

(SMB)。在运行 Microsoft Windows 操作系统的系统上，SMB 比网络文件系统 (NFS) 协议更常用。CIFS 允许程序

请求远程计算机上的文件或服务。

CIFS 还使用客户端-服务器编程模型，借此客户端可以请求访问文件或将消息传递给服务器上运行的程序。服

务器检查所有请求的操作并返回响应。CIFS 是一个公开（或开放）的 SMB 变量， 初由 Microsoft 开发和使

用。

注: DR Series 系统目前不支持服务器消息块 (SMB) 2.0 版。

注: 有关 CIFS 功能限制的详情，请参阅 support.dell.com/manuals 上的 Dell DR Series System Interoperability 
Guide（Dell DR Series 系统互操作性指南）。

CIFS ACL 支持

自 DR4000 系统版本 1.1 起，DR Series 系统软件支持将访问控制列表 (ACL) 用于 CIFS 和共享级别权限。根据定

义，ACL 只是可与任何网络资源相关联的权限列表。

每个 ACL 可以包含用于定义或说明各个用户或用户组的权限的访问控制条目 (ACE)。ACL 可以包含零个（表示

所有用户均具有访问权限）或若干用于定义每个用户或每个组的特定权限的 ACE。

注: 如果 ACE 列表为空（表示其中包含零个条目），则意味着所有访问请求都将得到批准。

ACL 描述可访问特定资源的实体。ACL 是 Windows 操作系统中内置的访问控制机制。DR Series 系统中的 ACL 支
持的不同之处在于它影响以下两种容器类型的方式：

• 新容器

• 现有容器

注: DR Series 系统支持使用 Microsoft Windows 管理工具为 CIFS 共享设置共享级别权限。通过共享级别权

限，可以控制对共享的访问。有关更多信息，请参阅配置共享级别安全性。

注: 任何属于 BUILTIN\Administrators 成员的用户均可编辑 CIFS 共享上的 ACL。本地 DR Series 系统管理员包

含在 BUILTIN\Administrators 组中。要向 BUILTIN\Administrators 组中添加附加的域组，可使用 Windows 客
户端上的计算机管理器工具以域管理员身份连接至 DR Series 系统，并根据需要添加任意组。通过此功

能，非域管理员用户可根据需要修改 ACL。

Access Control List Support in Containers

All containers created with the 1.1 release and later versions of the DR4000 system software (or pre–1.1 version system 
software that was upgraded to 1.1 or later), applies a default Access Control List (ACL) at the root of the container. This 
default ACL is the same as that which would be created by a Microsoft Windows 2003 Server. Therefore, these new 
containers with the default ACL support the following permission types:

注: Any user that is part of BUILTIN\Administrators can edit ACLs on CIFS shares. The local DR Series system 
administrator is included in the BUILTIN\Administrators group. To add additional domain groups to the BUILTIN
\Administrators group, you can use the Computer Manager tool on a Windows client to connect to the DR Series 
system as Domain administrator and add any groups you want. This capability allows users other than the Domain 
administrator to modify an ACL as needed.
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• BUILTIN\Administrators:

Allows Full access, object inherit, and container inherit.

Applies to This folder, subfolders, and files.

• CREATOR OWNER:

Allows Full access, inherit only, object inherit, and container inherit.

Applies to Subfolders and files only.

• EVERYONE:

Allows Traverse folders, execute files, list folders, read data, read attributes, and read 
extended attributes.

Applies to This folder only.

• NT AUTHORITY\SYSTEM:

Allows Full access, object inherit, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Create folders and append data, inherit-only, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Read and execute, and container inherit.

Applies to This folder, subfolders, and files.

• BUILTIN\Users:

Allows Create files and write data, object inherit, and container inherit.

Applies to Subfolders only.

注: If these permissions are unsuitable for your needs, you can modify the default ACL to suit your own 
requirement using the Windows ACL Editor (for example, using Properties → Security from Windows Explorer).

注: Beginning with the 1.1 release, the system does not understand the Owner Rights permission and sets the 
owner of new files/folders created by the Domain Administrators as DOM\Administrator rather than as BUILTIN
\Administrators.

现有容器（1.1 版之前）

从 1.1 版开始，DR Series 系统软件支持将访问控制列表 (ACL) 用于 CIFS 和共享级别权限。ACL 是可与任何资源

关联的权限列表。每个 ACL 可包含为单个用户或用户组定义或描述权限的访问控制条目 (ACE)。ACL 可包含零

个（所有访问权限）ACE，或按用户或组定义特定权限的多个 ACE。

对于在 1.1 版之前创建的任何现有容器，登录至指定 DR Series 系统的任何用户均可访问所有文件。在这些早于 

1.1 版的现有容器中，关联 ACL 仅支持以下权限：

• Everyone：

– 允许：完全访问

– 适用于：此文件夹、子文件夹和文件

• BUILTIN\Administrators：
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– 允许：完全访问、对象继承和容器继承

– 适用于：此文件夹、子文件夹和文件

不过，您还可根据需要向现有容器应用自己的 ACL。为此，请导航至指定容器的共享根目录，然后沿目录树应

用 ACL。请注意，完成此操作所需的时间取决于位于容器内的文件和文件夹的数量。

如果创建本地用户，这些用户将添加至 BUILTIN\Users。由于管理员帐户是 BUILTIN\Administrators 的成员，因

此如果您在容器上遇到任何有关 ACL 的问题（例如，应用的某个 ACL 将其自身或域管理员锁定），可以 

MACHINE\Administrator 身份通过客户端连接。

此时即可编辑 ACL（BUILTIN\Administrators 帐户拥有 TakeOwnership 权限）。请注意，较大 ACL 会占用容器上

的附加 Inode，如果容器中存在大量文件和文件夹，则会导致问题。较小 ACL（ 多 10 个 ACE）可位于 Inode 
的备用空间内，而较大 ACL 会占用附加 Inode。Inode 在 Linux（或与 Unix 相似的操作系统）上用作数据结构，

有关文件的所有信息（文件名和文件实际数据除外）都存储在此结构中。

注: Dell 建议管理员按照类似于为新容器设置默认权限的方式，向现有容器应用一组权限。不过，在向个

别用户授予满足其任何特定安全需求的访问权限时，需要仔细考虑。

Unix Permissions Guidelines

For a user to create, delete, or rename a file or a directory requires Write access to the parent directory that contains 
these files. Only the owner of a file (or the root user) can change permissions.

Permissions are based on the user IDs (UIDs) for the file Owner and group IDs (GIDs) for the primary group. Files have 
owner IDs and group owner IDs. To enable Unix access, the DR Series system supports three levels of users:

• Owner (of the file)

• Group (group in which the owner belongs)

• Other (other users with an account on the system)

Each of these three user types support the following access permissions:

• Read (read access that allows user to read files)

• Write (write access that allows user to create or write to a file)

• Execute (access that allows user to execute files or traverse directories in the filesystem)

注: A root user has all levels of permission access, and a user can be a member of a single group or of multiple 
groups (up to 32 groups are allowed in Unix).

Windows 权限准则

为了启用 Windows 访问权限，DR Series 系统支持访问控制列表 (ACL)，其中包含零个或多个访问控制条目 

(ACE)，以及可批准所有访问请求的空 ACE 列表。Windows 新技术文件系统 (NTFS) 将 ACL 用作安全描述符 (SD) 
过程的一部分，该过程需要此类文件系统对象（如文件和目录）的访问权限。ACL 支持以下两个级别的用户：

• Owners（所有者）

• 组

Owners（所有者）和 Groups（组）均具有安全 ID (SID)，SID 可定义和标识对象所有者或拥有对象的组。ACL 中
的 ACE 包含 SID，SID 是一种特定权限，可允许或拒绝访问，还能定义应用以下哪个继承设置：

• IO - 仅继承：不用于访问权限检查。

• OI - 对象继承：向新文件添加此 ACE。

• CI - 容器继承：向新目录添加此 ACE。
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Windows NTFS ACL 包括以下读取、写入、附加、执行和删除权限，支持用户执行以下操作：

• 同步访问权限

• 读取数据或列出目录

• 写入数据或添加文件

• 附加数据或添加文件夹

• 读取扩展属性 (EA)

• 写入 EA

• 执行文件或遍历文件夹

• 删除子文件夹或删除文件夹

• 删除文件

Owner（所有者）用户类型具有两个默认权限：

• 写入任意 ACL

• 读取控制

OpenStorage Technology (OST): DR Series System
OpenStorage Technology (OST) is developed by Symantec and provides a logical disk interface for use with network 
storage devices. The DR Series system appliance can use OST via plug-in software to integrate its data storage 
operations with a number of data management applications (DMAs).

OST allows for better coordination and integration between DR Series system backup, restore, and optimized duplication 
operations and the following supported DMA types:

• NetBackup

• Backup Exec

Integration is done via a Dell OST plug-in developed for the DR Series system, through which NetBackup and Backup 
Exec can control when the backup images are created, duplicated, and deleted. The major benefit of OST is that it 
allows the deduplication operations to happen on the client-side so that network traffic can be reduced.

OST via the Dell OST plug-in allows NetBackup and Backup Exec to take full advantage of such DR Series system 
features as data deduplication, replication, and energy efficiency. DR Series systems can access the OpenStorage API 
code through the plug-in, which can be installed on the media server platform choice you make (Windows or Linux). The 
OST protocol allows the supported backup applications to communicate directly with the DR Series system and 
determine whether a specific chunk of data already exists on the system. This process means that if the data already 
exists, only the pointers need to be updated on the DR Series system, and the duplicate chunk of data does not need to 
be transferred to the system. This process provides two benefits: it improves the overall backup speed, and also reduces 
the network load.

When OST is used with the DR Series system, it offers the following benefits:

• OST protocol provides faster and improved data transfers:

– Focused on backups with minimal overhead

– Accommodates larger data transfer sizes

– Provides throughput that is significantly better than CIFS or NFS

• OST and DMA integration:

– OpenStorage API enables the DMA-to-media server software communications

– DR Series system storage capabilities can be used without extensive changes to DMAs
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– Backup and replication operations are simplified by using built-in DMA policies

• DR Series System and OST:

– Control channel uses TCP port 10011

– Data channel uses TCP port 11000

– Optimized write operations enable client-side deduplication

• Replication operations between DR Series systems:

– No configuration required on source or target DR Series systems

– Replication is file-based, not container-based

– Triggered by DMA optimized duplication operation

– DR Series system transfers the data file (not the media server)

– After duplication, DR Series system notifies DMA to update its catalog (acknowledging the second 
backup)

– Supports different retention policies between source and replica

注: This capability to use OST, also known as DR Rapid Data Access within Dell, adds tighter integration with 
backup software applications, such as the two Symantec OpenStorage-enabled backup applications supported in 
this release: NetBackup and Backup Exec.

OpenStorage 技术 (OST) API

OpenStorage 技术 (OST) API 是应用程序编程接口，可使诸如 DR Series 系统等基于磁盘的设备在本机与两个支

持的 Symantec 数据管理应用程序 (DMA) NetBackup 和 Backup Exec 集成。例如，由于 DR Series 系统支持重复

数据消除和复制，OST API 可使这两个支持的 DMA 使用 DR Series 系统设备功能并将优化后的数据从一个存储

设备复制到另一存储设备。

OST API 支持将数据写入磁盘，以下示例对此进行了说明，其中 NetBackup (DMA) 使用 OST API 与 DR Series 系
统（数据备份和重复数据消除设备）交互：

• NetBackup 需要将文件存储至磁盘。为此，它通过 OST API 将需要备份的文件以及此文件的命名通知 DR 
Series 系统。

• DR Series 系统接受此文件并对其进行备份，然后将文件存储在其文件系统中。

• NetBackup 可对此特定存储文件执行以下三项后续操作之一：

– 使文件期满

– 从文件还原

– 拷贝或复制文件

• 如果使用 OST API 的 NetBackup 指示 DR Series 系统使存储文件到期，DR Series 系统会将存储文件从其
文件系统中删除。

• 与此类似，如果使用 OST API 的 NetBackup 要从存储文件还原，它将向 DR Series 系统指示要还原的文
件，DR Series 系统随后会将存储文件发送至 NetBackup 以进行还原。

注: OST 包含一项名为优化复制的功能。例如，在优化复制中，DMA (NetBackup) 指示设备 A 与设备 B 执
行优化复制。设备 A 和 B 通信并确定文件中需要从 A 复制到 B 的数据段，以确保设备 B 包含完整的重复

数据文件。操作成功后，DMA 即知道此数据文件存在两个副本，并可在设备 B 上像使用其中的任何其他

数据文件一样使用此文件。
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Software Components and Operational Guidelines

To better coordinate and integrate OpenStorage Technology (OST) with the DR Series system data storage operations, 
the following guidelines list the supported software, required components, optimal performance, and supported 
operations:

• OST Media Server Component:

– An OST server component resides on the DR Series system

– For Linux media server installations, use the Linux OST plug-in and the Red Hat Package Manager (RPM) 
installer

– For Windows media server installations, use the Windows OST plug-in and the Microsoft (MSI) installer

• Supported Windows-based OST plug-in releases:

注: The DR Series system supports both the 32–bit and 64–bit versions for NetBackup, and the 64–bit 
version for Backup Exec.

– Windows Server 2003

– Windows Server 2008

– Windows Server 2008 Release 2

• Supported Linux-based 64-bit OST plug-in releases:

– Red Hat Enterprise Linux, version 5.x
– Red Hat Enterprise Linux, version 6.x
– Red Hat Enterprise Linux, version 10 and 11

• Supported Symantec OpenStorage (OST) protocol:

– Symantec, version 9

– Symantec, version 10

• Supported Symantec DMAs:

– NetBackup: version 7.1 (Windows Server 2003, 32–bit), 7.1 (Windows Server 2008 R2, 64–bit), 7.5 
(Windows Server 2008, 32–bit), 7.5 (Windows Server 2008 R2, 64–bit), 7.1 (Red Hat Enterprise Linux 5.x, 
64–bit), and 7.5 (SUSE Linux Enterprise Server 11 SP2, 64–bit).

– Backup Exec: version 2010 Release 3 (Windows Server 2008 R2, 64–bit), and 2012 (Windows Server 
2008 R2, 64–bit).

注: The Dell DR Series system licensing is all-inclusive, so that no additional Dell licensing is 
required to use OST or the optimized duplication capability. The Dell OST plug-in that gets installed 
on a supported Linux or Windows media server platform is a free download from Dell. However, 
Symantec NetBackup requires that you purchase a Symantec OpenStorage Disk Option license. 
Similarly, Symantec Backup Exec requires that you purchase the Deduplication Option to enable 
the OST feature.

• Backup, restore, and optimized duplication operations need to be performed via the OST plug-in

• Optimal supported aggregated throughput rates:

– 3 Terabytes per hour (TB/hr) for passthrough write operations

– 4 TB/hr for optimized write operations

注: Passthrough writes are when data is sent from a media server to the DR Series system without 
applying any optimization to the data. By contrast, optimized writes are when data is sent from a 
media server to the DR Series system after optimization is applied to the data.

• Supported OST operations
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– Backup (Passthrough writes and Optimized writes)

– Restore

– Replication

注: To check for the latest supported OST software components and operating guidelines, see the Dell DR Series 
System Interoperability Guide. This document is available at support.dell.com/manuals.

Rapid Data Storage (RDS): DR Series System
Rapid Data Storage (RDS) is developed by Dell Quest and provides a logical disk interface for use with network storage 
devices. RDS allows for better coordination and integration between DR Series system backup, restore, and optimized 
duplication operations with Dell Quest NetVault Backup (NVBU).

The DR Series system and NVBU integration is done using the Rapid OFS (ROFS) plugin developed by Dell. The ROFS 
plugin allows NVBU control over backup image creation, deletion, and duplication. RDS allows deduplication and 
compression operations to happen on the client-side so that network traffic can be reduced.

The RDS protocol allows the supported backup applications to communicate directly with the DR Series system and 
determine whether a specific chunk of data already exists on the system. If the data already exists, only the pointers 
need to be updated on the DR Series system, and the duplicate chunk of data does not need to be transferred to the 
system. This process provides two benefits: it improves the overall backup speed, and also reduces the network load.

Rapid OFS (ROFS) API

注: Rapid OFS (ROFS) is an internal API used by RDS. The term ROFS is not used in the web user interface or CLI.

The Rapid OFS (ROFS) API is an application programming interface that allows disk-based devices like the DR Series 
system to natively integrate with the Dell Quest NetVault Backup. For example, because the DR Series system supports 
both data deduplication and replication, the ROFS API allows these supported DMAs to use the DR Series system 
appliance features and duplicate the optimized data from one storage appliance to another.

Unlike replication configured directly on the DR4x00 for CIFS and NFS, the ROFS API allows the Data Management 
Application (DMA) to be aware of the replication copy. The ROFS API allows the DMA to restore directly from any 
DR4x00 that are on the same subnet and can communicate with each other.

The ROFS API enables the writing of data to disk and allows NVBU (the DMA) to interact with the DR Series system (the 
data backup and deduplication device) using the ROFS API.

DR Series System and Data Operations
Data is stored and resides on the Dell DR Series system, a two-rack unit (RU) appliance, which comes preinstalled with 
the system software. Starting with the 2.0 release. the DR Series system comes in two types:

• DR4000 system: This consists of preinstalled DR4000 system software on a Dell PowerEdge R510 appliance 
platform.

• DR4100 system: This consists of preinstalled DR4000 system software on a Dell PowerEdge R720xd appliance 
platform.

The DR Series system consists of a total of 14 drives. Two of these drives are 2.5-inch drives that are configured as a 
Redundant Array of Independent Disks (RAID) 1 on the RAID Controller and this is considered to be volume 1. In the 
DR4000 system, these drives are internal, while in the DR4100 system, these drives are accessible from the rear. The 
data that is being backed up is stored on the 12 virtual disks that reside on the DR Series system appliance. This release 
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also supported additional storage in the form of external expansion shelf enclosures (see the DR Series Expansion Shelf 
section in this topic). The hot-swappable data drives that are attached to the RAID controller are configured as:

• 11 drives that operate as RAID 6, which act as virtual-disks for data storage (drives 1–11).

• The remaining drive (drive 0) acts as the dedicated hot-spare drive for RAID 6 for the system.

The DR Series system supports RAID 6, which allows the appliance to continue read and write requests to the RAID 
array virtual disks even in the event of up to two concurrent disk failures, providing protection to your mission-critical 
data. In this way, the system design supports double-data drive failure survivability.

If the system detects that one of the 11 virtual drives has failed, then the dedicated hot spare (drive slot 0) becomes an 
active member of the RAID group. Data is then automatically copied to the hot spare as it acts as the replacement for 
the failed drive. The dedicated hot spare remains inactive until it is called upon to replace a failed drive. This scenario is 
usually encountered when a faulty data drive is replaced. The hot spare can act as replacement for both internal 
mirrored drives and the RAID 6 drive arrays.

图 1: DR4000/DR4100 System Drive Slot Locations

Drive 0 (top) Drive 3 (top) Drive 6 (top) Drive 9 (top)

Drive 1 (middle) Drive 4 (middle) Drive 7 (middle) Drive 10 (middle)

Drive 2 (bottom) Drive 5 (bottom) Drive 8 (bottom) Drive 11 (bottom)

DR Series Expansion Shelf

Each DR Series system appliance supports the installation and connection of up to two Dell PowerVault MD1200 data 
storage expansion shelf enclosures. Each expansion shelf contains 12 physical disks in an enclosure, which provides 
additional data storage capacity for the basic DR Series system. The supported data storage expansion shelves can be 
added in 1 Terabyte (TB), 2 TB, or 3 TB hard drive capacities.

The physical disks in each expansion shelf are required to be Dell-certified Serial Attached SCSI (SAS) drives, and the 
physical drives in the expansion shelf uses slots 1–11 configured as RAID 6, with slot 0 being a global hot spare (GHS). 
When being configured, the first expansion shelf is identified as Enclosure 1 (in the case where two enclosures are 
added, these would be Enclosure 1 and Enclosure 2). Adding an expansion shelf to support the DR Series system 
requires a license. For more information, see Expansion Shelf Licenses. For more general information about the 
supported storage enclosures, see support.dell.com/manuals.

注: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition of 
expansion shelf enclosures.
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注: If you are running a DR4000 system with an installed release of system software prior to 2.1, and you intend to 
upgrade to release 2.1 system software and install an external expansion shelf (or shelves), Dell recommends that 
you observe the following best practice sequence of operations to avoid any issues:

• Upgrade the DR4000 system with the release 2.1 system software

• Power off the DR4000 system (required for 2.1 with Dell OpenManage 7.1)

• Connect the external expansion shelf (or shelves) with cabling to the DR4000 system

• Power on the external expansion shelf (or shelves)

• Power on the DR4000 system

注: If you install an expansion shelf enclosure to support a DR Series system, each shelf must use physical disks 
that have a capacity equal to or greater than each DR Series system internal drive slot capacity (0–11) that they 
are supporting.

图 2: DR4100 System Expansion Shelf (MD1200) Drive Slot Locations

Drive 0 (top) Drive 3 (top) Drive 6 (top) Drive 9 (top)

Drive 1 (middle) Drive 4 (middle) Drive 7 (middle) Drive 10 (middle)

Drive 2 (bottom) Drive 5 (bottom) Drive 8 (bottom) Drive 11 (bottom)

Understanding About Adding a DR Series Expansion Shelf

The 2.0 release of the DR Series system appliance allows you to connect up to two Dell PowerVault MD1200 data 
storage expansion shelf enclosures to provide additional data storage capacity beyond the capacity of the basic DR 
Series system. Supported data storage expansion shelves can be added in 1 Terabyte (TB), 2 TB, or 3 TB hard drive 
capacities. The process for adding an expansion shelf requires the following:

注: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition of 
expansion shelf enclosures.

• Physically adding or installing the expansion shelf (for more information, see Adding a DR Series System 
Expansion Shelf)

• Cabling the expansion shelf to the DR Series system (for more information, see DR Series System - Expansion 
Shelf Cabling)

• Installing the license for an expansion shelf (for more information, see Installing an Expansion Shelf License)

Supported Software and Hardware
For a complete list of the latest supported software and hardware for the DR Series system, Dell recommends that you 
see the Dell DR Series System Interoperability Guide at support.dell.com/manuals. For example, the Dell DR Series 
System Interoperability Guide lists the following supported hardware and software categories:
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• Hardware

– BIOS
– RAID controllers
– Hard drives (internal)
– Hard drives (external)
– USB flash drives
– Network interface controllers
– iDRAC Enterprise
– Marvell WAM controller

• Software

– Operating System
– Supported backup software
– Network file protocols and backup client operating systems
– Supported web browsers
– Supported system limits
– Supported OST software and components
– Supported RDS software and components

Terminal Emulation Applications

To access the DR Series system command line interface (CLI), the following terminal emulation applications can be 
used:

• FoxTerm
• Win32 console
• PuTTY
• Tera Term Pro

注: The listed terminal emulation applications are not the only ones that works with the DR Series system. This list 
is only intended to provide examples of terminal emulation applications that can be used.

DR Series — Expansion Shelf Cabling
Each DR Series system appliance is capable of supporting additional storage capacity and install and connect up to two 
Dell PowerVault MD1200 data storage expansion shelf enclosures. Each of the expansion shelf enclosures contains 12 
physical disks that provide additional data storage capacity for a basic DR Series system. The supported data storage 
expansion shelves can be added in 1 Terabyte (TB), 2TB, or 3TB hard drive capacities. figure 1and Figure 2display the 
recommended method for cabling between the DR4000/DR4100 PERC controller card to the appropriate connectors on 
the rear of the Dell PowerVault MD1200 expansion shelf enclosure.

注: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition of 
expansion shelf enclosures.

Make sure that the Dell PowerVault MD1200 front panel selector switch is set to its Unified mode (with the switch set to 
its “up” position, indicated by a single Volume icon). figure 1 shows the SAS In ports on the Enclosure Management 
Module (EMM) on the rear of the Dell MD1200. Figure 2 shows the recommended redundant path cabling configuration, 
which includes cable connections from both PERC H800 connectors on the DR4000 system (or the PERC H810 on a 
DR4100 system) to the two SAS In ports on the EMM rear chassis of the Dell PowerVault MD1200.

If you plan on installing the second of the two supported expansion shelf enclosures in Release 2.0, then the two SAS In 
ports on the rear chassis of the EMM on the second enclosure are daisy-chained to the two SAS Out ports on the EMM 
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rear chassis on the first enclosure. This is considered a redundant mode connection via the SAS In/Out connectors on 
the enclosures with the DR Series system appliance.

If you install a second enclosure and cable it as described here, make sure to set the enclosure mode switch on the 
MD1200 front chassis to the top (unified mode) positions. For more information, see Dell PowerVault MD1200 and 
MD1220 Storage Enclosures Hardware Owner's Manual at support.dell.com/manuals.

图 3: Dell PowerVault MD1200 Rear Chassis

图 4: Unified Mode Daisy-Chained Redundant Path Dell PowerVault MD1200 Enclosures
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图 5: SAS Port and Cable Connections (Dell PowerVault MD1200 EMM)

1. SAS cable
2. pull-tab

添加 DR Series 系统扩展架

使用 DR Series 系统配置扩展架机柜有三个关联任务，必须完成这三个任务才能使用此附加的数据存储容量：

• 安装将扩展架机柜连接至 DR Series 系统的所有电缆（有关信息，请参阅 DR Series 系统 - 扩展架布
线）。

• 使用 Storage（存储）页面添加并激活扩展架机柜（本主题将对此进行说明）。

• 为扩展架机柜安装 Dell 许可证（有关信息，请参阅安装扩展架许可）。

要将扩展架机柜添加至 DR Series 系统，请完成以下操作：

1. 在导航面板中单击 Storage（存储）。

此时将显示 Storage（存储）页面（此步骤假设您已连接所有扩展架机柜电缆）。

2. 在 Physical Storage（物理存储）窗格的 Physical Storage（物理存储）摘要表中，单击与要添加的机柜相对
应的 Configured（已配置）列中的 Add（添加）（显示的机柜状态为 Not Configured（未配置））。

此时将显示 Enclosure Addition（机柜添加）对话框，其中指示在机柜添加期间，对系统的所有输入输出将

停止，并提示您单击 OK（确定）继续或单击 Cancel（取消）停止此过程。

3. 单击 OK（确定）继续向 DR Series 系统添加机柜。

如果单击 Cancel（取消），添加过程将退出，并显示 Storage（存储）页面。

4. 如果单击 OK（确定），将显示 Enclosure Addition（机柜添加）对话框，指示此过程可能需要 10 分钟时间
才能完成。

此时将显示 System Status（系统状态）对话框，其中显示以下消息：The system is currently adding an 
enclosure. Please wait for this process to complete and the system to become operational.（系统当前正在添加

机柜。请等待此过程完成，然后才能使用系统）。

5. 要验证是否已添加机柜，请单击 Dashboard（仪表板）→ Health（运行状况）。

此时将显示 Health（运行状况）页面，每个正确连接并激活的扩展架机柜均具有相应的选项卡，其中显示

绿色状态勾号（例如，如果已安装两个机柜，将显示两个选项卡：Enclosure 1（机柜 1）和 Enclosure 2
（机柜 2））。
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注: 如果 Enclosure（机柜）选项卡未显示绿色状态勾号，则说明相应机柜存在问题（例如未正确连接

或激活）。

6. 添加扩展架机柜后，请确保安装扩展架许可证。

有关更多信息，请参阅安装扩展架许可证。
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3
Setting Up the DR Series System
Before you can interact with the DR Series system using one of its two supported methods: the web-based DR Series 
system graphical user interface (GUI) using a web browser or the command line interface (CLI) and a terminal emulator 
application (for example, PuTTY), you must first ensure that it is properly set up. For more information about properly 
setting up the DR Series system, see the following links. For more information on the DR Series system CLI commands, 
see the Dell DR Series System Command Line Reference Guide.
相关链接

Logging in Using a Web Interface
Interacting with the DR Series System
Logging in and Initializing the DR Series System
Networking Preparations for the DR Series System

Interacting With the DR Series System
You interact with the DR Series system using its web-based graphical user interface (GUI) through a browser-based 
connection. The DR Series system GUI provides a single, comprehensive data management interface that lets you 
create new data containers, modify or delete existing containers, and perform a number of data-related operations 
using its features and settings.

注: A second method for interacting with the DR Series system is by using its command-line interface (CLI) via a 
terminal emulator application (for example, PuTYY).

You can create and manage containers that are the repositories where you store your backup and deduplicated data. A 
data container is a shared file system that is imported using a client, and is accessible via NFS or CIFS filesystem 
protocols.

The DR Series system provides real-time summary tables, detail tables, and graphs that let you monitor the status of the 
data capacity, storage savings, and the throughput of the containers you are managing using its set of GUI features.

Networking Preparations for the DR Series System

Before you can start using the DR Series system, ensure that you have satisfied the following networking prerequisites:

• Network: An active network is available using Ethernet cables and connections.

注: If your DR Series system is equipped with a 1-GbE NIC, Dell recommends using CAT6 (or CAT6a) copper 
cabling. If your DR Series system is equipped with a 10-GbE NIC, Dell recommends using CAT6a copper 
cabling.

注: If your DR Series system is equipped with a 10-GbE enhanced small form-factor pluggable (SFP+) NIC, 
you must use Dell-supported SFP+ LC fiber-optic transceivers or twin-axial cabling.

• IP Addresses: You need to make sure to have IP addresses that you use for the DR Series system. The DR Series 
system ships with a default IP address and subnet mask address, which should only be used for an initial system 
configuration.

注: You need to have an IP address available to replace the default IP address if you choose the static 
mode of IP addressing, or select to use the DHCP mode of IP addressing.
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To perform an initial configuration, you need:

– An IP address for the system

– A subnet mask address

– A default gateway address

– A DNS suffix address

– A primary DNS server IP address

– (Optional) A secondary DNS server IP address

• NIC Connections: To configure NIC connection bonding remember that, by default, the DR Series system will 
configure its NIC interfaces together as a bonded team (and only one IP address is needed because the bonded 
NICs assume the primary interface address). NIC connection bonding can use either of these configurations:

– Adaptive load balancing (ALB), which is the default setting, does not require any special network switch 
support. Ensure that the data source system resides on the same subnet as the DR Series system. For 
more information, see Configuring Networking Settings.

– 802.3ad or dynamic link aggregation (using the IEEE 802.3ad standard). 802.3ad requires special switch 
configuration before using the system (contact your network administrator for an 802.3ad configuration).

注: To configure a 10-GbE NIC or 10-GbE SFP+ bonded configuration, connect only the 10-GbE/10-GbE SFP+ 
NICs. You can use the new Advanced Networking feature available on the command line interface to 
modify the default factory configuration.

• DNS: you need a DNS domain available, and you need to know the primary DNS server IP address (and a 
secondary DNS server IP address, if you choose to configure one).

• Replication ports: the replication service in the DR Series system requires that enabled fixed ports be configured 
to support replication operations that are to be performed across firewalls (TCP ports 9904, 9911, 9915, and 9916).
For more information about replication ports, see Managing Replication Operations, and for more information 
about system ports, see Supported Ports in a DR Series System.

注: For the latest details about supported hardware and software for the Dell DR Series system, see the 
Dell DR Series System Interoperability Guide at support.dell.com/manuals.

注: For information about ports needed for OST operations, see Understanding OST.

Connections for Initializing a DR Series System
There are two supported methods for connecting to the DR Series system for logging in and performing the initial system 
configuration via the DR Series system CLI:

• Local console connection: this is a local access connection made between a local workstation and the DR 
Series system (with one connection made to a USB keyboard port on the DR Series front/rear chassis, and a 
second connection made to the VGA monitor port on the DR Series system rear chassis. (See Figure 3 for 
locations in the DR Series System Rear Chassis Port Locations in the Local Console Connection.)

• iDRAC connection: this is a remote access connection made between an integrated Dell Remote Access 
Controller (iDRAC) and the dedicated management port on the DR Series system rear chassis. (See Figure 3 for 
locations in the DR Series System Rear Chassis Port Locations in the Local Console Connection.)
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初始化 DR Series 系统

第一次使用 DR Series 系统图形用户界面 (GUI) 之前，必须先正确初始化该系统。要初始化 DR Series 系统，请

完成以下操作：

1. 使用本地控制台 KVM（键盘视频监测器）连接或 iDRAC 连接登录 DR Series 系统 CLI。有关更多信息，请参
阅本地控制台连接或 iDRAC 连接。

2. 使用 Initial System Configuration Wizard（初始系统配置向导）配置系统的网络设置。有关更多信息，请参
阅登录并初始化 DR Series 系统。

Initial System Configuration Wizard（初始系统配置向导）可让您配置以下网络设置，以完成系统的第一次初始

化：

• IP addressing mode（IP 寻址模式）

• Subnet mask address（子网掩码地址）

• Default gateway address（默认网关地址）

• DNS suffix address（DNS 后 地址）

• Primary DNS server IP address（主要 DNS 服务器 IP 地址）

• （可选）Secondary DNS server IP address（次要 DNS 服务器 IP 地址）

• Host name for system（系统的主机名）

默认 IP 地址和子网掩码地址

本主题列出可用于 DR Series 系统初始化的以下默认地址值：

• IP 地址 - 10.77.88.99

• 子网掩码地址 - 255.0.0.0

有两个关键因素与默认地址值和初始化 DR Series 系统关联：

• 使用本地控制台

• 使用 DHCP 保留 MAC 地址

如果系统将位于的网络没有或不支持 DHCP，则 DR Series 系统可使用随附的默认 IP 地址 (10.77.88.99) 和子网掩

码地址 (255.0.0.0) 进行初始化。如果系统所在的网络没有或不支持为 DHCP 服务器中 NIC 的 MAC 地址保留 IP 地
址，则 DHCP 将在初始化期间分配未知（且您无法使用）的任意 IP 地址。

因此，如果网络不支持 DHCP 或您无法为 DHCP 网络接口卡 (NIC) 的特定 MAC 地址保留 IP 地址，Dell 建议您使

用本地控制台连接方法和 Initial System Configuration Wizard（初始系统配置向导）。

注: 在成功初始化和配置系统后，可修改该 IP 地址以使用静态 IP 地址或动态 IP 寻址 (DHCP)，并将子网掩

码地址修改为一个网络支持的地址。

注: 如果未在要安装到同一网络中的一个（或多个）DR Series 系统上运行 Initial System Configuration Wizard
（初始系统配置向导），该（或多个）系统可能会出现同一默认 IP 地址 (10.77.88.99)。此默认 IP 地址无法

由用户配置，如果存在多个系统，可能会导致其成为重复的 IP 地址。

初始化问题可能包括因网络断电而导致错误配置该网络中的 DHCP 服务器，或者从未运行 Initial System 
Configuration Wizard（初始系统配置向导）。

如果网络不接受默认子网掩码地址 (255.0.0.0)，可在 DR Series 系统和便携式计算机工作站之间建立连接。在此

情况下，请确保使用 SSH 连接，并使用默认 IP 地址运行 Initial System Configuration Wizard（初始系统配置向

导）。
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如果使用已知静态 IP 地址，可跳过运行 Initial System Configuration Wizard（初始系统配置向导），而直接使用 

DR Series 系统的用户界面配置 DR Series 系统。

要配置 DR Series 系统，请选择 System Configuration（系统配置） → Networking（网络） ，并根据需要配置网

络设置。有关更多信息，请参阅配置网络设置。

注: 有关登录和使用 Initial System Configuration Wizard（初始系统配置向导）的详情，请参阅配置网络设

置。

Local Console Connection

To configure a local console connection, you must make the following two rear chassis cable connections:

• VGA port and your video monitor

• USB port and your keyboard

To make local console cable connections for the DR4000 and DR4100 system appliances, complete the following:

1. (DR4000 system appliance) Locate the VGA monitor port and the USB ports on the back of your system. See Figure 3 
for the VGA and USB port locations and complete steps 1 to 4. For the DR4100 system appliance, skip to step 5.

2. Connect the video monitor to the VGA port on the back of your system (see item 1 in the DR4000 System Rear 
Chassis Port Locations table).

3. Connect the USB keyboard to one of the two USB ports on the back of your system (see item 3 in DR4000 System 
Rear Chassis Port Locations table).

4. You are now ready to perform initialization using the DR Series system CLI login process. For more information, see 
Logging in and Initializing the DR Series System.

图 6: DR4000 System Rear Chassis Port Locations

Item Indicator, Button, or Connector Icon Description

1 Video connector Connects a VGA display to the system.

2 iDRAC6 Enterprise port Dedicated management port for the iDRAC6 
Enterprise card.

3 USB connectors (2) Connects USB devices to the system. The ports are 
USB 2.0-compliant.

4 Ethernet connectors (2) Embedded 10/100/1000 NIC connectors.

5 Ethernet Connectors (2) on 
expansion card

1-GbE/10-GbE/10-GbE SFP+ Ethernet Port

To make local console cable connections for the DR4100 system appliance, complete the following:
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注: The DR4000 system supports up to four 1–GbE ports or up to two 10–GbE ports; for the 1–GbE ports, 
these are two internal LAN on Motherboard (LOM) ports referenced in item 4 above that reside on the 
motherboard, and two ports on an expansion card referenced in item 5 above. If the DR4000 system is using 
the two 10–GbE ports, these reside on an expansion card referenced in item 5 above.

5. (DR4100 system appliance) Locate the VGA monitor port and the USB ports on the back of your system. See Figure 3 
for the VGA and USB port locations and complete steps 5 to 8.

6. Connect the video monitor to the VGA port on the back of your system (see item 2 in the DR4100 System Rear 
Chassis Port Locations table).

7. Connect the USB keyboard to one of the two USB ports on the back of your system (see item 3 in the DR4100 
System Rear Chassis Port Locations table).

8. You are now ready to perform initialization using the DR Series system CLI login process. For more information, see 
Logging in and Initializing the DR Series System.

图 7: DR4100 System Rear Chassis Port Locations

Item Indicator, Button, or Connector Icon Description

1 iDRAC7 Enterprise port Dedicated management port for the iDRAC7 
Enterprise card (port is available only if an iDRAC7 
Enterprise license is installed on your system).

2 Video connector Connects a VGA display to the system.

3 USB connectors (2) Connects USB devices to the system. The ports are 
USB 2.0-compliant.

4 Ethernet connectors (4) Four integrated 10/100/1000 NIC connectors, or four 
integrated connectors that include:

– Two 10/100/1000 Mbps NIC connectors
– Two 100 Mbps/1 Gbps/10 Gbps SFP+/10-

GbE T connectors

5 PCIe expansion card slots (3) Connect up to three full-height PCI Express 
expansion cards

6 Hard drives (2) Provides two hot-swappable 2.5-inch hard drives

注: The DR4100 system supports up to six 1–GbE ports or up to two 10–GbE ports. For the 1–GbE ports, 
these are four internal LAN on Motherboard (LOM) ports referenced in item 4 above that reside on the 
network daughter card (NDC), and two additional ports on a PCI Express expansion card referenced in item 5 
above. If the DR4100 system is using the two 10–GbE ports, these ports reside on the NDC.
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iDRAC Connection

The iDRAC connection requires a network connection between the integrated Dell Remote Access Control (iDRAC) 
management port on the DR Series system and another computer running the iDRAC remote console session in a 
supported browser. The iDRAC provides remote console redirection, power control, and the out-of-band (OOB) system 
management functions for the DR Series system. iDRAC connections are configured using console redirection and the 
iDRAC6/7 web interface. The login values you can use for making iDRAC connections are:

• Default username: root

• Default password: calvin

• Default static IP address: 192.168.0.120

For information on how to configure the iDRAC, see the Dell RACADM Reference Guides at support.dell.com/manuals 
and Accessing iDRAC6/iDRAC7 Using RACADM.

When the Dell DR Series System splash screen is displayed, you are ready to begin initialization using the DR Series 
system CLI login process. For more information, see Logging in and Initializing the DR Series System.

Logging in and Initializing the DR Series System

Use the DR Series system CLI and the Initial System Configuration Wizard to log in to and initialize the system. After 
completing a local console or iDRAC connection, log in to the DR Series system CLI:

1. Launch a terminal emulator application (like PuTTY), and type the default IP address for the DR Series system (if 
you are not using iDRAC or local console).

2. At the login as: prompt, type administrator, and press <Enter>.

3. At the administrator@<system_name> password: prompt, type the default administrator password (St0r@ge!), and 
press <Enter>.
The Initial System Configuration Wizard window is displayed.

图 8: Initial System Configuration Wizard Window

4. To configure the network settings, type y (for yes), and press <Enter>.

5. To configure the use of the default IP address that ships with the system, choose to use static IP addressing.
To do this, at the DHCP prompt, type no (this selects static IP addressing), and press <Enter>.

注: When you select static IP addressing, you are prompted to type the static IP address (for example, you 
could use the default IP, 10.77.88.99) for the system, and press <Enter>. If your network supports the use of 
DHCP, type yes at the DHCP prompt, press <Enter>, and respond to any prompts.

6. To configure a subnet mask address, type the subnet mask address you want to use (for example, you could use 
the default subnet mask address, 255.0.0.0), and press <Enter>.
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7. To configure a default gateway address, type the default gateway address you want to use (for example, 
10.10.20.10), and press <Enter>.

8. To configure a DNS Suffix, type the DNS suffix you want to use (for example, storage.local), and press <Enter>.

9. To configure a primary DNS server IP address, type an IP address you want to use for the primary DNS server (for 
example, 10.10.10.10), and press <Enter>.

10. (Optional) To configure a secondary DNS server IP address, type y (for yes), and press <Enter>.
If you responded yes, type an IP address you want to use for the secondary DNS server (for example, 10.10.10.11), 
and press <Enter>.

11. To change the default host name (for example, the serial number of the DR Series hardware appliance), type y (for 
yes) and press <Enter>.
If you responded yes, type the host name you want to use, and press <Enter>. After you configure your host name 
response, the current system settings are displayed.

12. To accept these settings, type y (for yes), and press <Enter>.

13. If you want to change any of these settings, type n (for no), and press <Enter>. Modify the settings as needed, and 
press <Enter>.
When completed, a successful initialization message is displayed.

14. At the prompt, type exit and press <Enter> to end the DR Series system CLI session.

You are now ready to log in to the system using the DR Series system GUI.

注: Before you log into the system using the DR Series system GUI, make sure to register it in the local Domain 
Name System (DNS) for your network so that it is a DNS-resolvable entry.

注: At this point, you could modify the bonding mode to use 802.3ad, if this configuration is available in your 
network.

使用 RACADM 访问 iDRAC6/iDRAC7
您可以使用 RACADM 公用程序，通过基于 SSH 或 Telnet 的界面访问 iDRAC6/iDRAC7。RACADM（远程访问控制

器管理）是 Dell 开发的一个命令行公用程序，可让您安装和配置集成式 Dell Remote Access Controller (iDRAC) 接
口卡，以提供带外管理功能。

iDRAC 卡包含一个控制器，并拥有自己的处理器、内存、网络连接，以及系统总线访问权限。该卡可让系统或

网络管理员利用支持的 Web 浏览器或命令行界面，通过电源管理、虚拟介质访问和远程控制台功能来配置系

统，就如同使用本地控制台进行配置一样。

可用于建立 iDRAC 连接的登录值如下：

• 默认用户名：root

• 默认密码：calvin

• 默认静态 IP 地址：192.168.0.120

有关更多信息，请参阅 support.dell.com/manuals 上的 RACADM Reference Guides for iDRAC（针对 iDRAC 的 
RACADM 参考指南）、Integrated Dell Remote Access Controller 6 (iDRAC6) User Guide（集成式 Dell Remote Access 
Controller 6 (iDRAC6) 用户指南）或 Integrated Dell Remote Access Controller 7 (iDRAC7) User Guide（集成式 Dell 
Remote Access Controller 7 (iDRAC7) 用户指南）。

Logging in Using a Web Interface
To log in to the DR Series system using a browser-based connection, complete the following:
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注: This procedure describes the logging in process from a first-time perspective, starting with the Customer 
Registration and Notification page, the completion of the Initial System Configuration Wizard process, and the 
Initial Software Upgrade page.

1. In a supported web browser, type the IP address or hostname of the system in the browser Address bar, and press 
<Enter>.
The DR Series System Login page is displayed.

注: The DR Series System Login page may display a warning message if the web browser you are using does 
not properly support the DR Series system. If you are running a Microsoft Internet Explorer (IE) 8 or later web 
browser, make sure that you disable the Compatibility View. For more information about disabling the 
Compatibility View settings, see Disabling the Compatibility View Settings. For more information about the 
supported web browsers, see the Dell DR Series System Interoperability Guide, Release 2.0.0.0.

注: For best results when using IE web browsers in combination with supported Windows-based servers, 
ensure that Active Scripting (JavaScript) is enabled on the Windows client. This setting is often disabled by 
default on Windows-based servers. For more information on enabling Active Scripting, see Enabling Active 
Scripting in Windows IE Browsers.

注: If you want to reset your login password, click Reset Password on the DR Series System Login page. The 
Reset Password dialog is displayed.

The reset options displayed depend on the password reset option you configured earlier. For more information 
see, Modifying Password Reseting Options.

By default, the service tag option is displayed. In Service Tag, enter the service tag number ID for the system, 
and click Reset Password to reset the system password back to its default setting (or click Cancel to return to 
the DR Series System Login page).

2. In Password, type St0r@ge! and click Log in or press <Enter>.
The Customer Registration and Notification page is displayed. Before you can begin using the DR Series system 
graphical user interface (GUI), you need to properly register the system with Dell. In addition, this page also allows 
you to sign up for notifications about appliance alerts and system software updates. For more information, see 
Registering a DR Series System.

3. In the Settings pane of the Customer Registration and Notification page, complete the following:
a) In Contact Name, enter a system contact name.
b) In Relay Host, enter a hostname or IP address for the relay host.
c) In Email Address, enter an email address for the contact.
d) Select Notify me of DR4000 appliance alerts to be notified about system appliance alerts.
e) Select Notify me of DR4000 software updates to be notified about system software updates.
f) Select Don't show me this again to not display the Customer Registration and Notification page again.
g) Click Confirm to have the DR Series system accept your settings (or click Skip without configuring any settings) 

to proceed with initialization.

The Initial System Configuration Wizard page is displayed.

4. To start the initial system configuration process, click Yes.
The Initial Configuration — Change Administrator Password page is displayed.

注: If you click No, you will bypass the initial system configuration process, and the DR Series system 
Dashboard page is displayed. However, when you next log in to the DR Series system, you will be prompted to 
perform the initial system configuration process again with the Initial System Configuration Wizard page is 
displayed.

5. In the Settings pane of the Initial Configuration — Change Administrator Password page, complete the following:
a) In Current Password, enter the current administrator password.
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b) In New Password, enter the new administrator password.
c) In Retype New Password, enter the new administrator password again to confirm it.
d) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 

click Exit to close the Initial System Configuration Wizard).
The Initial Configuration — Networking page is displayed.

6. In the Settings pane of the Initial Configuration — Networking page, complete the following:
a) In Hostname, enter a hostname that meets the hostname naming convention: A-Z, a-z, 0–9, the dash special 

character (-), within a maximum 19 character limit.
b) In IP Address, select the Static or DHCP mode of IP addressing, and if planning to use a Secondary DNS, enter 

an IP address for the secondary domain name system.
c) In Bonding, select the Mode choice from the drop-down list (ALB or 802.3ad).

Dell recommends that you verify the system can accept your bonding selection type. The connection will be 
lost unless it is correctly configured. For more information, see Configuring Networking Settings.

d) In Bonding, enter the MTU value for the maximum transmission unit (the MTU accepts values between 512 and 
9000). For more information, see Configuring Networking Settings.

e) In Active Directory, enter a fully qualified domain name for the Active Directory Services (ADS) domain in 
Domain Name (FQDN), enter an organization name in Org Unit, enter a valid ADS username in Username, and 
enter a valid ADS password in Password.
For more information, see Configuring Active Directory Settings.

注: If an ADS domain has already been configured, you will not be allowed to change the values for the 
Hostname or IP Address settings.

f) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 
click Exit to close the Initial System Configuration Wizard).
The Initial Configuration — Date and Time page is displayed.

注: If the Microsoft Active Directory Services (ADS) domain has already been configured, the Initial 
Configuration — Date and Time page will not display.

7. In the Settings pane, select the Mode choice (NTP or Manual).
a) If you select NTP, accept or revise the NTP servers as desired (you are limited to only three NTP servers), and 

in Time Zone, select the desired time zone from the drop-down list.
b) If you select Manual, in Time Zone, select the desired time zone from the drop-down list, click the Calendar icon 

and select the desired day in the month, and adjust the Hour and Minute sliders to the desired time (or click 
Now to choose the current date and time), and click Done.

c) Click Next to continue with the initial configuration process (or click Back to return to the previous page, or 
click Exit to close the Initial System Configuration Wizard)

For more information, see Configuring System Date and Time Settings.

注: Dell recommends using NTP when the DR Series system is part of a workgroup and not part of an domain. 
When the DR Series system is joined to a domain, such as the Microsoft Active Directory Services (ADS) 
domain, NTP is disabled.

The Initial Configuration — Summary page is displayed.

8. The Initial Configuration — Summary page displays a summary of all of the initial configuration changes you have 
made. Click Finish to complete the Initial System Configuration Wizard (or click Back to return to a previous page to 
change a setting).
The Initial Software Upgrade page is displayed and prompts you to verify the current installed system software 
version.

9. Click Dashboard in the navigation panel,
The DR Series system main window consists of the following components:

– Navigation panel
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– System Status bar
– System Information pane
– Command bar

注: Located on the DR Series System Dashboard page command bar, you can display the Help system 
documentation by clicking Help, or logout of the system by clicking Log out.

注: When logged in, a Logout Confirmation dialog is displayed after 45 minutes of non-use. This dialog displays for 
30 seconds before the DR Series system performs a forced timeout. Click Continue to reset the 45-minute logout 
timer. If you do not click Continue before the 30-second interval elapses, the DR Series system logs you out. You 
must log in again to resume using the DR Series system features and GUI.

Before managing data using the system navigation panel options, you should understand the options and capabilities 
you can use. The navigation panel contains the following sections that let you manage your data:

• Dashboard
• Storage
• Schedules
• System Configuration
• Support

Registering a DR Series System

Before you can start using the DR Series system using its graphical user interface (GUI) for the first time, you must 
properly register the system with Dell by completing the Customer Registration and Notification page. In addition to 
registering your system, you can also sign up to be notified about appliance alerts and system software updates. The 
Customer Registration and Notification page is displayed when you initially log into a Release 2.0 DR Series system using 
a web interface connection, and it consists of the following text boxes and check boxes in the Settings pane:

• Contact Name
• Relay Host
• Email Address
• Notify me of DR4100 appliance alerts

注: If this check box is selected, you are notified of all warning and critical severity system alerts, which 
are the types that may require user action. For more information, see Displaying System Alerts.

• Notify me of DR4100 software updates

注: If this check box is selected, you are notified by Dell about any new system software upgrades or 
maintenance releases. For more information, see Software Upgrade Page and Options.

• Don't show me this again

注: DR4000 systems that run system software versions earlier than 2.1 that later upgrade to the 2.1 release see this 
screen display when logging into the DR Series system after the upgrade process.

To register a DR Series system:

1. In Contact Name, enter the name of the DR Series system contact.
2. In Relay Host, enter the hostname or IP address for the DR Series system email relay host.
3. In Email Address, enter an email address for the system contact.
4. To be notified about DR4000 appliance alerts, select the Notify me of DR4000 appliance alerts check box.
5. To be notified about DR4000 software updates, select the Notify me of DR4000 software updates check box.
6. To not display the Customer Registration and Notification page again, select the Don't show me this again check 

box.
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7. Click Confirm for the DR Series system to accept your values (or click Skip) to proceed to the Initial System 
Configuration Wizard page.

在 Windows IE 浏览器中启用活动脚本

要在 Microsoft Windows Internet Explorer (IE) Web 浏览器中启用 Active Scripting（活动脚本）(JavaScript)，请完

成以下操作：

注: 此过程介绍如何配置 Windows IE Web 浏览器以启用 Active Scripting（活动脚本）(JavaScript)。在基于 

Windows 的服务器上，此设置通常默认处于禁用状态

1. 启动 IE Web 浏览器，然后单击 Tools（工具）→ Internet Options（Internet 选项）。

此时将显示 Internet Options（Internet 选项）页面。

2. 单击 Security（安全）选项卡，然后单击 Custom level...（自定义级别...）。

此时将显示 Security Settings - Local Intranet Zone（安全设置 - 本地 Intranet 区域）页面。

3. 使用右侧的滚动条向下滚动 Settings（设置）选项，直到显示 Scripting（脚本）。

4. 在 Active scripting（活动脚本）中，单击 Enable（启用）。

5. 单击 OK（确定）为 Web 浏览器启用 JavaScript 和活动脚本功能。

此时将显示 Internet Options（Internet 选项）页面。

6. 单击 OK（确定）关闭 Internet Options（Internet 选项）页面。

禁用兼容性视图设置

对于用来登录 DR Series 系统以访问其图形用户界面 (GUI) 的 IE Web 浏览器，要禁用其 Compatibility View（兼容

性视图）设置，请完成以下操作：

注: 此过程描述了如何禁用 Compatibility View（兼容性视图）设置，以便确保用来访问 DR Series 系统的不

同 Microsoft Internet Explorer (IE) Web 浏览器版本之间不存在冲突。禁用兼容性视图设置时，需要在 

Compatibility View Settings（兼容性视图设置）页面中取消选中 Display all websites in Compatibility View（在

兼容性视图中显示所有网站）复选框选项，并且此页面的 Compatibility View（兼容性设置）列表中不得列

出与这些系统相关联的任何 DR Series 系统或域。

1. 启动 IE Web 浏览器，然后单击 Tools（工具）→ Compatibility View settings（兼容性视图设置）。

此时将显示 Compatibility View Settings（兼容性视图设置）页面。

2. 如果已选中 Display all websites in Compatibility View（在兼容性视图中显示所有网站）复选框选项，请将其
取消选中。

3. 如果 Compatibility View（兼容性视图）列表中列出任何 DR Series 系统，请选中此条目，然后单击 Remove
（移除）。

对列出的任何附加 DR Series 系统，重复执行此步骤。

4. 单击 Close（关闭）退出 Compatibility View Settings（兼容性视图设置）页面。

Dashboard（仪表板）页面和选项

默认情况下，系统会在用户登录后显示 Dashboard（仪表板）页面，其中显示与当前系统相关的以下信息：

• System Status（系统状态） 

– System State（系统状态）

– HW State（硬件状态）

– Number of Alerts（警报数）
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– Number of Events（事件数）

• Capacity（容量）

• Storage Savings（存储节省量）

• Throughput（吞吐量）

• System Information（系统信息）

注: 要刷新 Storage Savings（存储节省量）和 Throughput（吞吐量）中列出的值，请单击 。

注: 在 DR Series 系统导航面板中，Dashboard（仪表板）部分由以下菜单选项组成，选择这些菜单选项时

将显示相应的页面：

• Alerts（警报）

• Events（事件）

• Health（运行状况）

• Usage（使用情况）

• Statistics: Container（统计信息：容器）

• Statistics: Replication（统计信息：复制）

有关更多信息，请参阅以下内容：

• 了解 Dashboard（仪表板）选项

• 使用 Dashboard Alerts（仪表板警报）页面

• 使用 Dashboard Events（仪表板事件）选项

• 使用 Dashboard（仪表板）页面监测系统运行状况

• 使用仪表板显示系统事件

了解 Dashboard（仪表板）选项

DR Series 系统提供了一种机制，允许用户在登录后查看和访问有关系统的 新信息。导航面板（默认显示 

Dashboard（仪表板）页面）的 Dashboard（仪表板）部分会列出当前的系统状态，并提供以下菜单选项（选择

后会显示相应的页面）：

• Alerts（警报）

• Events（事件）

• Health（运行状况）

• Usage（使用情况）

• Statistics: Container（统计信息：容器）

• Statistics: Replication（统计信息：复制）

显示系统警报

要显示 Alerts（警报）页面，请单击 Dashboard（仪表板） → Alerts（警报） ，或单击 Dashboard（仪表板）页

面上的 Number of Alerts（警报数）链接。

Alerts（警报）页面中会显示当前时区（例如美国太平洋时区）、警报数和系统警报摘要表，该表会列出所有

系统警报，包括各条警报的索引号、时间戳和简短的描述消息。

未解决的严重事件将成为系统警报，待问题解决后，对应的警报将被清除。有关更多信息，请参阅监测系统警

报。
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Events（事件）

DR Series 系统提供了两种方式用于在 Events（事件）页面中显示当前的系统事件：

• 单击 Dashboard（仪表板）→ Events（事件）。

• 单击 Dashboard（仪表板）页面中的 Number of Events（事件数）链接。

Events（事件）页面提供了一个 Event Filter（事件筛选器）窗格，可根据所选事件严重性以及起始日期和结束

日期设置点设置特定搜索条件。设置搜索条件后，单击 Start Filter（开始筛选）即可显示与所设值相匹配的事

件。

匹配的事件显示在 Events（事件）摘要表中，其中列出了与所定义搜索条件相匹配的系统事件总数，并按照以

下属性定义每个匹配的系统事件：

• 索引号

• 事件严重性：严重、警告或信息

• 时间戳

• 消息（系统事件的简要描述）

在 Events（事件）页面中，根据以下内容为特定系统事件类型（或记录的所有系统事件）设置搜索条件：

• 在 Event Severity（事件严重性）中，从下拉列表选项中选择要搜索的事件严重性：ALL（全部）、
CRITICAL（严重）、WARNING（警告）和 INFO（信息）。

• 在 Message Contains（消息包含）中，输入要在事件消息文本中搜索的字词或字符串（DR Series 系统会
根据所输入的内容执行不区分大小写的匹配操作）。

• 在 Timestamp From（时间戳开始时间）中，在字段中输入起始时间或单击日历图标选择月份和天，使用 
Hour（小时）和 Minute（分钟）滑块输入起始时间，或单击 Now（现在）设置当前时间，然后单击 
Done（完成）。

• 对于 Timestamp To（时间戳结束时间），在字段中输入起始时间或单击日历图标选择月份和天，使用 
Hour（小时）和 Minute（分钟）滑块输入结束时间，或单击 Now（现在）设置当前时间，然后单击 
Done（完成）。

• 单击 Start Filter（开始筛选）显示与所选条件匹配的全部搜索结果，或单击 Reset（重置）将所有搜索设
置全部恢复为默认值。

所有严重系统事件都作为系统历史记录保留在事件列表中。有关更多信息，请参阅监测系统事件和使用事件筛

选器。

Health（运行状况）

您可以使用 Health（运行状况）页面显示和查看 DR Series 系统 DR4000 和 DR4100 的当前状态（请参阅图 1 和图 

2）。

要显示 Health（运行状况）页面，请单击 Dashboard（仪表板） → Health（运行状况） ，或单击 Dashboard
（仪表板）页面上的 HW State（硬件状态）链接。这两种方法都可显示此页面，其中会显示系统硬件（以及安

装的任何数据存储扩展架机柜）的当前状态。

当安装的受支持扩展架达到 大数量时，Health（运行状况）页面 多包含三个选项卡（例如：System（系

统）、Enclosure 1（机柜 1）和 Enclosure 2（机柜 2））。如果未安装扩展架，则将只显示一个选项卡（System
（系统））。
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Health（运行状况）页面：DR4000 系统

图 1 Health（运行状况）页面（DR4000 系统和组件）

Health（运行状况）页面：DR4100 系统

图 2 Health（运行状况）页面（DR4100 系统和组件）

默认情况下，将第一个显示 System（系统）选项卡，其中列出了其每个硬件组件的以下属性：

DR Series 系统组件

在 Health（运行状况）页面的 System（系统）选项卡中，下面的图像和 System Hardware Health（系统硬件运

行状况）表会显示系统组件的状态（有关具体位置，请参阅图 1 和图 2）。

• 机箱前视图（图像）- 显示 0-11 驱动器的位置和状态

• 机箱后视图（图像）- 显示电源设备位置和状态以及后面板连接器的位置

• 操作系统内部驱动器（图像）- 显示操作系统内部驱动器的状态
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• System Hardware Health（系统硬件运行状况）表 - 显示设备中所有主要硬件子组件的当前状态：

– Power Supplies（电源设备）- 状态、名称和位置

– Fans（风扇）- 状态、名称、速度和标识号

– Temperature（温度）- 状态、名称和温度

– Storage（存储）- 存储控制器、存储虚拟磁盘、存储物理磁盘、存储控制器电池和存储缓存

注: 存储控制器电池状态显示为 Ready（就绪）或 Charging（充电中），后者表示系统重新
引导之后、存储控制器电池充满电之前的状态。

– Voltage（电压）- 状态、名称、电压和探针名称

– NIC（网络接口卡）- 状态、名称、类型和速度

– CPU（中央处理器）- 状态和名称

– DIMM（双列直插内存模块）- 状态、名称和连接器名称

– NVRAM（非易失性随机访问存储器）- NVRAM（状态、名称、错误、温度、SSD 状态、SSD 运
行状况、SSD 固件版本、序列号和固件版本）；NVRAM 超级电容器（状态、名称、状态、电压
和 高设计电压）

注: 要显示机箱组件的当前状态、名称和状态，请将鼠标滚动至所需的组件上。

所有系统硬件组件均按照组件名称、状态和其他属性列示在 System Hardware Health（系统硬件运行状况）窗

格中。下表使用三种用于反映组件状态的颜色代码图标来标识组件的状态。

图标 说明

此颜色代码图标表示组件状态为正在以 佳状态操作。

此颜色代码图标表示组件状态为正在以警告状态操作（检测到非严重错误）。

此颜色代码图标表示组件状态为正在以错误或应当采取措施的状态操作（检测到严重错

误）。

要展开任何组件类别，以便显示各相关子组件的更多状态详情，请单击 System Hardware Health（系统硬件运

行状况）窗格中的 +（“加号”图标）。要收起任何已展开的组件类别，请单击 -（“减号”图标）。有关更

多信息，请参阅监测系统运行状况。

DR Series 系统机柜 

在 Health（运行状况）页面的 Enclosure（机柜）选项卡中，下面的图像和 System Hardware Health（系统硬件

运行状况）表会显示扩展架机柜组件的状态（有关具体位置，请参阅图 3）。

图 3 扩展架组件
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• 机箱前视图（图像）- 显示 1-11 驱动器的位置和状态；驱动器 0 是 RAID 6 的专用热备用驱动器

• 机箱后视图（图像）- 显示散热风扇的位置和状态以及后面板连接器的位置

• Service Tag（服务标签）- 列出所选扩展架的服务标签

• System Hardware Health（系统硬件运行状况）表 - 显示扩展架中所有主要硬件子组件的当前状态：

– Power Supplies（电源设备）- 状态、名称和位置

– Fans（风扇）- 状态、名称、速度和标识号

– Temperature（温度）- 状态、名称和温度

– Storage（存储）- 存储物理磁盘（状态、插槽、序列号、状态、GHS 状态、备用状态、智能警
报和大小）

– 机柜管理模块（状态、名称、标识符和 Nexus ID）

Usage（使用情况）

要显示 Usage（使用情况）页面，请单击 Dashboard（仪表板）→ Usage（使用情况）。Usage（使用情况）页

面包含一系列选项、下拉列表和选项卡，可用来筛选要查看的 DR Series 系统使用情况统计信息，包括：

• Latest Range（ 后范围）和 Display last...（显示 后...）- 这些选项根据选择的 Latest Range（ 后范
围）或 Time Range（时间范围）显示系统使用详情。

• System Usage（系统使用情况）选项卡 - 根据选择的 Latest Range（ 后范围）或 Time Range（时间范
围）选项显示系统使用情况，并用以下选项卡表示：CPU Load（CPU 负载）、System（系统）、
Memory（内存）、Active Processes（活动进程）、Protocols（协议）、Network（网络）、Disk（磁
盘）和 All（全部）。

注: 单击 All（全部）选项卡时，此操作会显示由所选范围和显示选项以及所配置的文件系统协议定义的系

统使用情况。要查看显示的所有使用情况类别，请使用页面右侧的滚动条。

Viewing the Latest Range

The Usage page lets you filter the system usage statistics you want to view. To view the Latest Range statistics, 
complete the following:

注: The Usage page also displays the Current Time Zone in use for the system.

1. Click the Latest Range option.

2. Select the desired Hours, Days, or Months duration in the Range pull-down list.

3. Enter the desired value in the Display last... drop-down list.
For the Hours duration, enter between 1 and 24 hours; for the Days duration, enter between 1 and 31 days; for the 
Months duration, enter between 1 and 12.

4. Click Apply.

5. To view a specific set of usage statistics, click one of the seven desired tabs, or click All to display the entire set of 
system usage statistical graphs.
The Usage page tabs include:

– CPU Load

– System

– Memory

– Active Processes

– Protocols

– Network

48



– Disk

– All

If you click All, the following set of statistics are displayed:

• CPU Load

• System Usage

• Memory Usage - Total

• Memory Usage - Real

• Active Processes - Total

• NFS Usage - Total

• CIFS Usage - Total

• OST Usage - Total

• RDS Usage - Total

• Network Usage

• Socket Usage

• Active Connections

• Disk Usage - Meta Data

• Disk Usage - Data Storage

• Meta Data - Storage Capacity

• Local Data - Storage Capacity

For information on viewing specific Time Range statistics on the Usage page, see Viewing a Specific Time Range.

Viewing a Specific Time Range

The Usage page lets you filter the system usage statistics you want to view. To view a specific Time Range, complete 
the following:

注: The Usage page also displays the Current Time Zone in use for the system.

1. In the Usage page, select the Time Range option.

2. Type the desired start date in Start Date (or click the calendar icon and make your date selection), or click Now to 
select the current time (or use the Hour and Minute sliders to set a desired time), and click Done.

3. Type the desired end date in End Date (or click the calendar icon and make your date selection), or select the Set 
“End Date” to current time to set the end date to the current day and time, or click Now to select the current 
time (or use the Hour and Minute sliders to set a desired time), click Done, and click Apply.
The Usage page tabs include:

– CPU Load

– System

– Memory

– Active Processes

– Protocols

– Network

– Disk

– All

If you click All, the following set of statistics are displayed:
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• CPU Load

• System Usage

• Memory Usage - Total

• Memory Usage - Real

• Active Processes - Total

• NFS Usage - Total

• CIFS Usage - Total

• OST Usage - Total

• RDS Usage - Total

• Network Usage

• Socket Usage - Total

• Active Connections

• Disk Usage - Meta Data

• Disk Usage - Data Storage

• Local Data Storage Capacity

For information on viewing the Latest Range statistics on the Usage page, see Viewing the Latest Range.

System Usage

This Usage page is where the DR Series system usage is displayed based on the Latest Time or Time Range values you 
selected. System usage statistics are grouped and represented by the following tabs:

• CPU Load

• System

• Memory

• Active Processes

• Protocols

• Network

• Disk

• All

注: If you click All, this displays system usage defined by the range and display options you select, and the file 
system protocols you have configured. To view all of the displayed usage categories, use the scroll bar on the 
right-hand side of the page.

The All tab displays the entire set of system status categories in graphic screen format (depending upon your file system 
protocol type):

• CPU Load

• System Usage

• Memory Usage - Total

• Memory Usage - Real

• Active Processes - Total

• NFS Usage - Total

• CIFS Usage - Total

• OST Usage - Total

• RDS Usage - Total
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• Network Usage

• Socket Usage - Total

• Active Connections

• Disk Usage - Meta Data

• Disk Usage - Data Storage

For more information, see Monitoring System Usage.

Statistics: Container Page

To display the Statistics: Container page, click Dashboard → Statistics: Container . This page lets you select from the 
Container Name drop-down list, and based on the container you select, displays a variety of statistics for the specified 
container:

注: The DR Series system polls for statistics every 30 seconds.

• Backup Data pane: displays the current number of active files ingested (based on time/minutes) and the current 
number of active bytes (mebibytes/MiB) ingested based on time in minutes. You can choose to click Zoom to 
view the backup data active files and active bytes statistics in other than the default mode of 1h (1–hour). The 
other selectable viewing options are 1d (1–day), 5d (5–day), 1m (1–month), and 1y (1–year).

• Throughput pane: displays the current number of Mebibytes/second (MiB/s) for read operations (based time/
minutes) and the current number of MiB/s for write operations (based on time/minutes). You can choose to click 
Zoom to view the throughput statistics in other than the default mode of 1h (1–hour). The other viewing options 
are 1d (1–day), 5d (5–day), 1m (1–month), and 1y (1–year) that you can select.

注: To refresh the values listed in the Backup Data and Throughput panes, click .

• Marker Type and Connection Type pane: displays the marker type associated with the selected container (for 
example CommVault, Networker, TSM (Tivoli Storage Manager), NetVault Backup, HP Data Protector, or 
ARCserve, and the Connection Type (NFS, CIFS, RDS, or OST).

• If the selected container includes an NFS connection type, there will be an NFS Connection Configuration pane 
that displays the following categories: NFS Access Path, Client Access, NFS Options, and Map Root To.

• If the selected container includes a CIFS connection type, there will be a CIFS Connection Configuration pane 
that displays the following categories: CIFS Share Path and Client Access.

• If the selected container includes an OST or RDS connection type, the OST or RDS login entry user is listed (for 
example, backup_user), and there are three tabs: Capacity, Duplication, and Client Statistics. The Capacity tab 
displays a Capacity pane with the following categories: Status, Capacity, Capacity Used, and Total Images. The 
Duplication tab displays a Duplication Statistics pane with the following Inbound and Outbound categories: 
Bytes Copied (logical), Bytes Transferred (actual), Network Bandwidth Savings, Current Count of Active Files, 
and Replication Errors. In addition, this tab also displays a Recent Number of Optimized Copies table, that lists 
the file name, peer IP, peer ID, logical bytes to send, replication rate, savings, and replicated at location. The 
Client Statistics tab displays a Client Statistics pane with the following categories: Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest Errors, 
Bytes Ingested, Bytes Transferred, and Network Savings.

• (Optional) Replication pane: displays the Replication Configuration and Replication Status panes. The 
Replication Configuration pane identifies whether the current container state (Enable or Disable), Role (source 
or target), Remote Container Name, Bandwidth, and the Encryption being used. The Replication Status pane 
identifies the Peer State, Replication State, Replication Average Transfer Rate, Replication Peak Transfer Rate, 
Network Average Transfer Rate, Network Peak Transfer Rate, Network Bytes Sent, Estimated Time to Sync (in 
days, hours, minutes, and seconds), Savings (in percentage), Last Insync Time (in timestamp format), and 
Schedule Status.

注: The Replication pane is only displayed in the Statistics: Container page if the selected container is configured 
for replication.
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Backup Data（备份数据）窗格

Statistics: Container（统计信息：容器）页面的 Backup Data（备份数据）窗格显示以下图形信息：

• 当前插入的活动文件数（基于以分钟表示的时间）

• 当前插入的活动字节数（二进制兆字节/MiB）（基于以分钟表示的时间）

对于 Active Files（活动文件数）和 Active Bytes（活动字节数）图形，均可选择以默认值 1 小时 (1h) 为增量单位

显示此信息，也可以选择 1 天 (1d)、5 天 (5d)、1 月 (1m) 和 1 年 (1y)。

注: 要刷新 Backup Data（备份数据）和 Throughput（吞吐量）窗格中列出的值，请单击 。

Throughput（吞吐量）窗格

Statistics: Container（统计信息：容器）页面中的 Throughput（吞吐量）窗格显示有关您在 Container Name（容

器名称）下拉列表中选择的任何现有容器的以下统计信息：

• 读操作当前的每秒二进制兆字节数 (MiB/s)（基于时间/分钟）

• 写操作的当前 MiB/s（基于时间/分钟）

注: 要刷新 Backup Data（备份数据）和 Throughput（吞吐量）窗格中列出的值，请单击 。

Replication（复制）窗格

Statistics: Container（统计信息：容器）页面的 Replication（复制）部分由两个窗格组成：Replication 
Configuration（复制配置）和 Replication Status（复制状态）。仅当任一完成复制配置的所选容器具有复制统计

信息时，此页面才会显示这部分信息。

Replication Configuration（复制配置）窗格

此窗格包含以下字段：

• Enable（启用）（例如，Yes（是）或 No（否））

• Role（角色）（例如，Source（源）或 Target（目标））

• Remote Container Name（远程容器名称）（例如，IP 地址或主机名）

• Bandwidth（带宽）（例如，Default（默认）、KiB/s、MiB/s 和 GiB/s）

• Encryption（加密）（例如，None（无）、AES 128-bit（AES 128 位）或 AES 256-bit（AES 256 位））

Replication Status（复制状态）窗格

此窗格包含以下字段：

• Peer State（对等状态）（例如，联机）

• Replication State（复制状态）（例如，同步）

• Replication Average Transfer Rate（复制平均传输速率）（例如，1005 KiB/s）

• Replication Peak Transfer Rate（复制峰值传输速率）（例如，2253 KiB/s）

• Network Average Transfer Rate（网络平均传输速率）（例如，2024 KiB/s）

• Network Peak Transfer Rate （网络峰值传输速率）（例如，2995 KiB/s）

• Network Bytes Sent（发送的网络字节数）（例如，69.79 KiB）

• Estimated Time to Sync（预计同步时间）（例如，14 天 32 小时 46 分钟 33 秒）

• Savings（节省量）（例如，27.99 %）

• Last INSYNC Time（上次同步时间）（例如，2012-11-04 16:45:53）
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• Schedule Status（计划状态）（例如，窗口区间外：2 天 1 小时 13 分钟 21 秒后开始）

注: 只有在对所选容器完成复制配置时，Statistics: Container（统计信息：容器）页面才会显示 Replication
（复制）窗格。

Connection Type Pane

The Connection Type pane is part of the Statistics: Container page, and the information displayed in this pane depends 
upon the connection type of the selected container:

• NFS containers — lists the following NFS connection configuration information:

– NFS Access Path

– Client Access

– NFS Options

– Map Root to

• CIFS containers — lists the following CIFS connection configuration information:

– CIFS Share Path

– Client Access

• OST or RDS containers — lists the following OST or RDS connection configuration information, grouped under 
the following tabs:

– Capacity tab — Status, Capacity, Capacity Used, and Total Images.

– Duplication tab — the Duplication Statistics pane displays both Inbound and Outbound categories with 
the following statistic types: Bytes Copies-logical, Bytes Transferred-actual, Network Bandwidth 
Savings-in percentage, Current Count of Active Files, and Replication Errors. The Recent Number of 
Optimized Copies pane displays a summary table that lists each entry by the following: File Name, Peer 
IP, Peer ID, Logical Bytes to Send, Replication Rate, Savings, and Replicated at categories.

– Client Statistics tab — contains the Client Statistics pane, which displays Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest 
Errors, Bytes Ingested, Bytes Transferred, and Network Savings (in percentage) statistics.

For more information, see Monitoring Container Statistics.

Duplication Statistics

The Duplication Statistics pane displays duplication statistics (which are also known as file copy statistics) for OST or 
RDS connection type containers. To view these duplication statistics, navigate to the Statistics: Container page, select 
an OST or RDS connection type container in the Container Name list, and select the Duplication tab. The Duplication 
Statistics pane displays the following statistics types:

• Inbound:

– Bytes Copied (logical): displayed in bytes

– Bytes Transferred (actual): displayed in bytes

– Network Bandwidth Savings: (displayed by percentage)

– Current Count of Active Files: displayed in numbers of files

– Replication Errors: displayed in numbers of errors

• Outbound:

– Bytes Copied (logical): displayed in bytes

– Bytes Transferred (actual): displayed in bytes

– Network Bandwidth Savings: (displayed by percentage)
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– Current Count of Active Files: displayed in numbers of files

– Replication Errors: displayed in numbers of errors

Recent Number of Optimized Copies

When an OST or RDS container is selected in the Statistics: Container page, you can display the Recent Number of 
Optimized Copies summary table in the Connection Type: OST or Connection Type: RDS pane. This pane, its tabs, and the 
summary table are displayed only when the Duplication tab is selected and an OST or RDS connection type container is 
selected in the Container Name pull-down list.

Recent Number of Optimized Copies Summary Table
This summary table contains the following information about the optimized copies:

• File Name

• Peer IP

• Peer ID

• Logical Bytes to Send

• Replication Rate

• Savings (in percentage)

• Replicated at (in yyyy-mm-dd hh:mm:ss format)

Client Statistics

You can display client statistics in the Statistics: Container page that correspond to any container that is configured as 
an OST or RDS connection type. To display client statistics, click the name of the OST or RDS container in the Container 
Name list, and click the Client Statistics tab in the Connection Type: OST or Connection Type: RDS pane. This action 
displays the following Client Statistics types for the selected OST or RDS container:

• Images Ingested

• Images Complete

• Images Incomplete

• Images Restored

• Bytes Restored

• Image Restore Errors

• Image Ingest Errors

• Bytes Ingested

• Bytes Transferred

• Network Savings (in percentage)

For more information, see Monitoring Container Statistics.

Statistics: Replication（统计信息：复制）页面

要显示 Statistics: Replication（统计信息：复制）页面，请单击 Dashboard（仪表板）→ Statistics: Replication
（统计信息：复制）。在此页面中，您可查看和监测所选复制容器或对等 DR Series 系统的统计信息，此页面

包含两个主窗格：

• Replication Filter（复制筛选器）- 您可使用 Container Filter（容器筛选器）选择所有、一个或多个复制容
器或者一个或多个对等系统，并配置要显示在 Replication Statistics（复制统计信息）摘要表中的各种统
计信息类型。可从 10 个 Headers（标题）复选框中选择，以筛选搜索中使用的复制静态信息类型：Peer 
Status（对等状态）、Replication Status（复制状态）、Time To Sync（同步时间）、Progress %（进度百
分比）、Replication Throughput（复制吞吐量）、Network Throughput（网络吞吐量）、Network Savings
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（网络节省量）、Last Time In Sync（上次同步时间）、Peer Container（对等容器）和 Peer System（对
等系统）。

• Replication Statistics（复制统计信息）- 包含一个摘要表，其中显示 Replication Filter（复制筛选器）窗
格中对于所选容器或对等系统的复制统计信息的筛选结果。此摘要表基于所选复选框显示统计信息类
别。

注: 从 2.0 版开始，DR Series 系统软件包含了版本检查功能，它限制只能与运行相同系统软件版本的其他 

DR Series 系统进行复制（运行 2.0.x 版软件的 DR Series 系统只能与运行相同版本系统软件的其他 DR Series 
系统进行复制）。例如，2.0.x 版的系统不能与 2.1 或 3.0 版的系统进行复制，但可以与运行 2.0.0.1 或 2.0.0.2 
版的系统进行复制。

有关更多信息，请参阅监测复制统计信息、显示复制统计信息和显示 Statistics: Replication（统计信息：复制）

页面。

容器筛选器

Statistics: Replication（统计信息：复制）页面的 Replication Filter（复制筛选器）窗格中包含以下组件：

• Container Filter（容器筛选器）：

– All（全部）：选择此选项可让您选择系统中的所有复制容器

– Name（名称）：选择此选项，将会显示一个下拉列表，让您从中选择复制容器

– Peer System（对等系统）：选择此选项，将会显示一个列表框，让您选择对等 DR Series 系统

• Headers（标题）：选择以下复选框，可让您筛选特定的复制统计信息类型

– Peer Status（对等状态）

– Replication Status（复制状态）

– Time to Sync（同步时间）

– Progress %（进度百分比）

– Replication Throughput（复制吞吐量）

– Network Throughput（网络吞吐量）

– Network Savings（网络节省量）

– Last Time in Sync（上次同步）

– Peer Container（对等容器）

– Peer System（对等系统）

注: DR Series 系统每 30 秒轮询一次统计信息。

配置 Replication Filter（复制筛选器）设置后，单击 Apply Filter（应用筛选）以在 Replication Filter（复制筛选

器）摘要表中显示筛选出来的一组复制统计信息。Replication filter（复制筛选器）摘要表会列出与所选复选框

相对应的复制统计信息（默认情况下，会选择 Peer Status（对等状态）、Replication Status（复制状态）、

Network Throughput（网络吞吐量）、Network Savings（网络节省量）和 Progress Percentage（进度百分比）复

选框，并在表格中显示相应的信息）。要重置复选框选择，请单击 Reset（重置）。

注: 如果选择的统计信息类型超过五个，请使用水平滚动条来滚动显示统计信息的附加列。

有关更多信息，请参阅监测复制统计信息。

Storage（存储）页面和选项

要显示 Storage（存储）页面，请单击 Dashboard（仪表板） → Storage（存储） 。此页面在以下窗格中显示与

系统相关的存储信息：
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注: DR Series 系统每 30 秒轮询并更新一次统计信息。

• Storage Summary（存储摘要）：

– Number of Containers（容器数）

– Number of Containers Replicated（已复制的容器数）

– Total Number of Files in All Containers（所有容器中的文件总数）

– Compression Level（压缩级别）

• Capacity（容量）：

– 已用和可用的系统物理容量（以百分比和二进制千兆字节 (GiB) 或二进制太字节 (TiB) 为单位）

• Storage Savings（存储节省量）：

– 以百分比为单位并基于时间（以分钟为单位）的总节省量（重复数据消除和压缩）图表；可显
示 1 小时 (1h)、1 天 (1d)、5 天 (5d)、1 个月 (1m) 和 1 年 (1y) 的统计信息；默认设置为 1 小时。

• Throughput（吞吐量）：

– 以二进制兆字节数/秒 (MiB/s) 为单位并基于时间（以分钟为单位）的读取和写入率图表；可显
示 1 小时 (1h)、1 天 (1d)、5 天 (5d)、1 个月 (1m) 和 1 年 (1y) 的统计信息；默认设置为 1 小时。

• Physical Storage（物理存储）：

– Type：内部或外部存储（外部存储为扩展架机柜）

– Raw Size（以千兆字节或太字节为单位列出的存储容量）

– % Used（表示已用容量的百分比）

– Service Tag（标签为唯一的 7 位 Dell ID）

– Configured（列出的状态为 Yes（是）、No（否）、Add（添加）或 Detect（检测））

– State（存储状态为 Ready（就绪）、Reading（正在读取）、Initializing（正在初始化）、
Rebuilding（正在重建）或 Not Detected（未检测到））

注: 要刷新 Storage Savings（存储节省量）和 Throughput（吞吐量）中列出的值，请单击 。要刷新扩

展架机柜，请在 Physical Storage（物理存储）摘要表的 Configured（已配置）列下单击 Detect（检测）

（将显示 Enclosure Detect（机柜检测）对话框，其中包含以下消息：If the enclosure is undetected, please 
wait five minutes and try again. If the enclosure still remains undetected after an attempt, keep the enclosure 
powered On and reboot the appliance（如果未检测到机柜，请等待五分钟并重试。如果尝试后仍未检测到

机柜，请使机柜电源保持打开并重新引导设备））。

有关 DR Series 系统容器操作的更多信息，请参阅管理容器操作。

了解 Storage（存储）选项

DR Series 系统提供存储机制，用于存储系统已插入到可轻松访问的存储容器中的备份数据与重复数据消除数

据。DR Series 系统图形用户界面 (GUI) 可通过其系统存储过程简化存储此类数据的过程。导航面板中的 Storage
（存储）部分提供以下菜单选项，选择选项后，将显示相应页面：

• Containers（容器）

• Replication（复制）

• Compression Level（压缩级别）

• Clients（客户端）
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Containers

To display the Containers page, click Storage→ Containers. This page displays the total number of containers (Number 
of Containers) and the container path (Container Path: /containers). This page lets you perform the following tasks using 
its options: Create, Edit, Delete, and Display Statistics. These options let you do the following:

• Create new containers

• Edit existing containers

• Delete existing containers

• Display container, connection, and replication statistics

The Containers page also displays a Containers summary table that displays the following types of container-related 
information:

• Containers — lists containers by name

• Files — lists the number of files in each container

• File type — lists the connection type per container:

– Network File System (NFS)

– Common Internet File System (CIFS)

– Rapid Data Access (RDA)

• Replication status — lists the current replication state per container:

– Not Configured

– Stopped

– Disconnected

– Trying to Connect

– Online

– N/A

– Marked for Deletion

注: For newly created OST or RDS containers, the Replication status displays N/A. When replication data has been 
deleted from an existing OST or RDS container, the Replication status also displays N/A. For existing containers 
that are in the process of deleting a large amount of data, the Replication status displays Marked for Deletion to 
indicate that the data deletion process has not yet completed.

注: Use Select to identify the container on which you want to perform an action. For example, click Select, and 
click Display Statistics to display the Statistics: Container page for the container you selected.

Replication（复制）页面

要显示 Replication（复制）页面，请单击 Storage（存储）→ Replication（复制）。Replication（复制）页面会

显示源复制的数量、本地和远程容器的名称、对等状态以及每个容器的所选带宽。通过 Replication（复制）页

面可执行以下任务：

• 创建新复制关系（源和目标对）并选择要使用的加密类型

• 编辑或删除现有复制关系

• 开始或停止复制对之间的复制

• 为复制过程设置带宽（或速度限制）
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• 显示现有复制关系的统计信息

Replication（复制）页面包含一个 Replication（复制）摘要表，其中会列出与复制相关的以下信息：

• Local Container Name（本地容器名称）- 本地容器的名称（IP 地址或主机名）

• Role（角色）- 复制过程中的源或目标

• Remote Container Name（远程容器名称）- 远程容器的名称（IP 地址或主机名）

• Peer State（对等状态）- Online（联机）、Offline（脱机）、Paused（暂停）或 Disconnected（断开连
接）

注: 开始后，Peer State（对等状态）会显示所选容器的状态为 Online（联机）。停止后，Peer State
（对等状态） 初显示为 Paused（暂停），继而更改为 Offline（脱机）。

• Bandwidth（带宽）- 设置包括二进制千字节/秒 (KiB/s)、二进制兆字节/秒 (MiB/s)、二进制千兆字节/秒 
(GiB/s) 或默认值（无限带宽设置）

注: 单击 Select（选择）可标识要对其执行操作的复制关系。例如，单击 Select（选择）→ Display 
Statistics（显示统计信息）可显示所选容器的 Statistics: Replication（统计信息：复制）页面。有关
更多信息，请参阅 Statistics: Replication（统计信息：复制）页面。

Compression Level（压缩级别）

要显示 Compression Level（压缩级别）页面，请单击 Storage（存储） → Compression Level（压缩级别） 。在

此页面中，对于要通过 DR Series 系统执行备份和重复数据消除的所有传入数据，可设置或编辑要用于这些数

据的数据压缩级别。请根据您的需要，使用以下选项之一选择压缩级别设置：

• Fast（快速）- 备份时间较短，节省的空间较少（此为默认设置）。

• Best（ 佳）- 节省的空间 多，备份时间较长。

有关更多信息，请参阅配置压缩级别设置。

Clients

To display the Clients page, click Storage → Clients. This page displays the total number of clients that are connected to 
the DR Series system, which can be a combination of NFS, CIFS, RDS, and OST clients, and this total is listed above the 
three Client tabs (NFS, CIFS, and RDA tabs).

In addition, depending upon the tab type you select, the number of clients for each connection type is displayed. For 
example, in the Clients page, if the RDA tab is selected, this displays the number of current OST or RDA clients that 
correspond to this type (OpenStorage Technology or Rapid Data Storage clients) that are connected to the system, and 
provides the following information client-related information:

• Number of RDA Clients — lists number of OST and RDS clients

• Name — lists each client by name

• Type — lists the type of RDA clients

• Plug-In — lists the plug-in type installed on each client

• Backup Software — lists the backup software used with each client

• Idle Time — lists the idle time (non-activity) for each client

• Connection — lists the number of connections for each client

• Mode — lists the current mode type for each client

To perform one of the possible actions on a client, click Select to identify the client, and then click the desired option (for 
example, the RDA tab provides three options: Update Client, Edit Password, or Download Plug-In. For more information 
about using this page and its tabs, see Clients Page (Using the NFS or CIFS Tab) or Clients Page (Using the RDA Tab).
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Clients Page (Using the NFS or CIFS Tab)

To display the Clients page, click Storage→ Clients. This page displays the total number of clients that are connected to 
the DR Series system, and this number reflects all of the clients based listed under the Clients tabs (NFS, CIFS, and RDA). 
Using this page and the NFS or CIFS tab lets you perform the following tasks for NFS or CIFS clients (for information 
about RDA clients, see Clients Page (Using the RDA Tab). The Clients page displays a summary of the NFS (or CIFS) 
clients, and lists the following types of NFS and CIFS client-related information:

• Number of NFS (or CIFS) Clients — lists number of NFS (or CIFS) clients

• Name — lists each client by name

• Idle Time — lists idle time (nonactivity) for each client

• Connection Time — lists connection time for each client

Clients Page (Using the RDA Tab)

To display the Clients page, click Storage→ Clients. This page displays the total number of clients that are connected to 
the DR Series system, and this number reflects all of the clients based listed under the Clients tab (NFS, CIFS, and RDA). 
Using this page and the RDA tab lets you perform the following tasks for RDS or OST clients:

• Update a client (you are limited to modifying the mode type)

• Edit a client password

• Download a client plug-in

注: The RDA plug-in is installed by default if you are running the latest version of Dell Quest NetVault 
Backup (NVBU). You must download and install the RDA plug-in for NVBU only if there is a plug-in version 
mismatch between the DR Series system software and NVBU.

This page displays an RDS or OST Clients Summary table that lists the following types of RDs or OST client-related 
information:

• Name — lists client by name

• Type — lists client type

• Plug-In — lists plug-in type that is installed on the client

• Backup Software — lists backup software used with this client

• Idle Time — lists the idle time for this client

• Connection — lists the number of connections for this client

• Mode — lists the mode types that can be set for this client:

– Auto

– Passthrough

– Dedupe (deduplication)

注: If an OST or RDS client has four or more CPU cores, it is considered to be dedupe-capable. However, 
the OST or RDS client operating mode depends upon how it is configured in the DR Series system (Dedupe 
is the default RDA client mode). If the administrator did not configure an OST or RDS client to operate in a 
specific mode and it is dedupe-capable, it will run in the Dedupe mode. If an OST or RDS client is not 
dedupe-capable (meaning the OST or RDS client has less than four CPU cores), and the administrator sets 
it to run in the Dedupe mode, it will only run in the Passthrough mode. If an OST or RDS client is set to run 
in Auto mode, the OST or RDS client will run in the mode setting determined by the media server. The 
following table shows the relationship between the configured OST or RDS client mode types and the 
supported client mode based on client architecture type and corresponding number of CPU cores.
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表. 3: Supported OST or RDS Client Modes and Settings

OST or RDS Client 
Mode Settings

32–Bit OST or RDS 
Client (4 or more 
CPU cores)

64–Bit OST or RDS 
Client (4 or more 
CPU cores)

32–Bit OST or RDS 
Client (Less than 4 
CPU cores)

64–Bit OST or RDS 
Client (Less than 4 
CPU cores)

Auto Passthrough Dedupe Passthrough Passthrough

Dedupe Not Supported Supported Not Supported Not Supported

Passthrough Supported Supported Supported Supported

注: Click Select to identify the OST or RDS client on which you want to perform an action. For example, click Select 
→ Download Plug-In to display the Download Plug-Ins page for the client you selected. Select the plug-in for the 
relevant client and protocol.

About the Schedules Page and Options
To display the Schedules page, click Dashboard → Schedules . This page displays any existing Replication or Cleaner 
operations that have been set up for the DR Series system. If no times are listed, this indicates there are no scheduled 
Replication or Cleaner operations. The Replication and Cleaner operations will automatically run whenever the DR 
Series system detects a window of inactivity when there are no other major system operations running.

注: Replication schedules can only be set on individual replication-enabled source containers.

The Schedules page lets you create a new schedule for running Replication or Cleaner operations, or you can modify an 
existing schedule for either of these operations. For more information about scheduling Replication or Cleaner 
operations, see Creating a Cleaner Schedule and Creating a Replication Schedule.

注: Cleaner operations are system processes that reclaim disk space from containers where files were deleted. 
When no Cleaner schedule is set, the Cleaner process will run as needed.

The Schedules page displays the following:

• System Time Zone: using the following format (US/Pacific, Tue May 1 10:33:45 2012)

• Scheduled Replication operations: with day of the week (Sunday through Saturday), start time, and stop time

• Scheduled Cleaner operations: with day of the week (Sunday through Saturday), start time, and stop time

注: Schedules only control the source container in scheduled Replication operations; the target container is 
passive in these operations.

设置复制计划

要通过 Schedules（计划）页面设置复制计划，请完成以下操作：

注: 只能在单个启用复制的源容器上设置复制计划。

注: 从 2.0 版开始，DR Series 系统软件包含了版本检查功能，它限制只能与运行相同系统软件版本的其他 

DR Series 系统进行复制（运行 2.0.x 版软件的 DR Series 系统只能与运行相同版本系统软件的其他 DR Series 
系统进行复制）。例如，2.0.x 版的系统不能与 2.1 或 3.0 版的系统进行复制，但可以与运行 2.0.0.1 或 2.0.0.2 
版的系统进行复制。

1. 单击选项栏上的 Replication（复制），此时将显示 Replication Schedule（复制计划）页面。

另一种显示 Replication Schedule（复制计划）页面的方法是，单击 Schedules（计划）→ Replication 
Schedule（复制计划）。

2. 在 Container（容器）的下拉列表中，选择一个已启用复制的源容器。
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3. 单击 Schedule（计划）以显示 Set Replication Schedule（设置复制计划）窗口，然后为一周中每个要计划
复制的日期输入 Start Time（开始时间）和 Stop Time（停止时间）（使用小时和分钟下拉列表）。

有关复制计划的更多信息，请参阅创建复制计划。

注: 如果 Create（创建）或 Edit Schedule（编辑计划）信息处于禁用状态（显示为灰色），这意味着

不存在已启用复制的源容器，无法为其创建复制计划。您必须先创建可以复制的源容器。有关更多

信息，请参阅创建复制关系。

设置清理器计划

要在 Schedules（计划）页面上设置清理器计划，请完成以下操作：

注: 有关设置新清理器计划或修改现有清理器计划的更多信息，请参阅创建清理器计划。

1. 在导航面板中单击 Schedules（计划）→ Cleaner Schedule（清理器计划），或在 Schedules（计划）页面
上单击 Cleaner（清理器）以显示 Cleaner Schedule（清理器计划）页面。

2. 如果没有清理器计划，请单击 Schedule（计划）以显示 Set Cleaner Schedule（设置清理器计划）窗口，并
对一周中要计划的每个日期输入开始时间和停止时间（使用 Hour（小时）和 Minute（分钟）下拉列
表）。

如果存在要修改的现有清理器计划，请单击 Edit Schedule（编辑计划）并进行更改。

About the System Configuration Page and Options
To display the System Configuration page, click Dashboard → System Configuration . The System Configuration page 
displays the current DR Series system configuration information in the following panes:

• Networking

• Active Directory

• Local Workgroup Users

• Email Alerts

• Password

• Admin Contact Info

• Email Relay Host

• Date and Time

注: Each pane title in the System Configuration page serves as a link. To display the corresponding page that 
provides more detailed information and the related options you can use, click the pane title link. For example, to 
display the Date and Time page, click the Date and Time pane title link.

The System Configuration page provides three options that let you:

• Edit the current system password

• Shut down the system

• Reboot the system

The System Configuration page provides the means for managing configuration settings for the Networking, Active 
Directory, Local Workgroup Users, Email Alerts, Admin Contact Info, Email Relay Host, and Date and Time pages in the 
system.
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注: For example, to manage the date and time configuration settings, click Date and Time to display the Date and 
Time page. You can then add or edit the following date and settings: Mode, Time Zone, and Date and Time. If the 
DR Series system is part of a workgroup and not joined to a Microsoft Active Directory Services (ADS) domain, you 
will also be able to add or edit the Network Time Protocol (NTP) servers associated with the system. However, 
when the DR Series system is joined to a domain, the NTP Servers setting on the Date and Time page is disabled 
and is not displayed.

注: Dell recommends using NTP servers when the DR Series system will be running as part of a workgroup and not 
joined to a domain. The use of NTP servers as a reference time source is disabled when the DR Series system is 
joined to a domain.

System Configuration Page and Options

To display the System Configuration page, click Dashboard → System Configuration . This page displays the following 
pane title-enabled links that allow you to display more detailed system configuration information for the following 
categories:

• Networking

• Active Directory

• Local Workgroup Users

• Email Alerts

• Password

• Admin Contact Info

• Email Relay Host

• Date and Time

Networking
The Networking pane displays the currently configured Mode, Hostname, IP Address, Bonding, Domain Suffix, and 
Primary DNS settings for the DR Series system. The Networking pane title acts as a link to the Networking page:

• This page lists the Hostname, IP Address, DNS, Bonding, and installed NICs. The Networking page provides Edit 
Hostname, Edit IP Address, Edit DNS, Edit Bonding, and Edit MTU options.

• This page also displays the interfaces showing bonds and other Ethernet connections.

Active Directory
The Active Directory pane displays the current status of the Domain Name for the DR Series system (not configured or 
listing the configured domain name). The Active Directory pane title acts as a link to the Active Directory page:

• This page contains a Settings and a CIFS Container Share Path pane. The Settings pane lists the configuration 
status, and lists the FQDN domain name (Fully Qualified Domain Name) of the Microsoft Active Directory 
Services (ADS) domain. The CIFS Container Share Path pane lists the current CIFS container share path 
locations. The Active Directory page provides the Join and Leave options.

Local Workgroup Users
The Local Workgroup Users pane displays the current configured local workgroup users (CIFS) for the DR Series 
system. The Local Workgroup Users pane title acts as a link to the Local Workgroup Users (CIFS) page:

• This page lists the configured local CIFS users by user name that belongs to the local workgroup in the DR 
Series system. The Local Workgroup Users (CIFS) page provides the Create, Edit, and Delete options (by which 
you manage the users that belong to this local workgroup. To edit or delete an existing local workgroup user, 
click Select to identify the local user you wish to modify or delete.
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Email Alerts
The Email Alerts pane displays the current number of email notification recipients configured for the DR Series system. 
The Email Alerts pane title acts as a link to the Email Alerts page:

• This page lists all currently configured recipient email addresses. The Email Alerts page provides Add, Edit, 
Delete, and Send Test Message options. To create an email recipient, click Add to display the Add Recipient 
Email Address dialog, in Email Address enter a valid email address for your email system, and click Submit. To 
edit or delete an existing email recipient, click Select to identify the email recipient in which you wish to modify, 
delete, or send a test message.

Admin Contact Info
The Admin Contact Info pane displays the current information associated with the administrator configured for the DR 
Series system. The current information is contained in the Contact Information and Notification panes. The Contact 
Information pan includes the Contact Information, Company Name, Email, Work Phone, and Comments categories. The 
Notification pane displays the status of the DR Series system appliance alerts and system software updates (disabled or 
enabled). The Admin Contact Info pane title acts as a link to the Administrator Contact Information page:

• This page contains contact information for the DR Series system administrator and is sent with all system alert 
email messages. The Administrator Contact Information page provides the Add Contact Information option 
(which after you configure it, this option changes to Edit Contact Information). Click the Edit Contact Information 
option to display the Edit Administrator Contact Information dialog where you can enter information or select a 
check box:

– Administrator Name

– Company Name

– Email

– Work Phone

– Comments

– Notify me of DR4000 appliance alerts

– Notify me of DR4000 software updates

Password
The Password Management pane displays the current Reset Password Option set for the system. The Reset Password 
Option can be:

• Service Tag Only

• Service Tag and Administrator Email

注: To select the option Service Tag and Administrator Email, you must first configure the e-mail relay host 
and administrator contact e-mail.

In the Password Management pane you can edit the current password and edit the password reset options.

Email Relay Host
The Email Relay Host pane displays the current email relay host configured for the DR Series system. The Email Relay 
Host pane title acts as a link to the Email Relay Host page:

• This page lists the configured email relay host by its IP address or hostname that is responsible for email in the 
DR Series system. The Email Relay Host page provides the Add Relay Host option (which after you configure it, 
this option changes to Edit Relay Host).
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Date and Time
The Date and Time pane displays the current Mode configured for the DR Series system (Manual or NTP), the current 
Time Zone, and the current Date and Time (in mm/dd/yy hh:mm:ss format, for example: 12/11/12 14:58:22 PST). The Date 
and Time pane title acts as a link to the Date and Time page:

• This page contains a Settings pane that lists the Mode used. The system uses Network Time Protocol (NTP) 
servers if the system is part of a workgroup and not joined to an Active Directory Services (ADS) domain. If the 
system is joined to an ADS domain, then the NTP servers setting is disabled and the system uses the ADS 
domain time. The Settings pane also displays the current Time Zone, and current Date and Time. The Date and 
Time page provides the Edit option for changing the date and time settings.

注: Dell recommends using the Network Time Protocol (NTP) servers when the DR Series system is part of a 
workgroup and not part of a domain. The NTP time mode is disabled when the DR Series system is joined to an 
Active Directory Services (ADS) domain. Any attempt to enable the NTP time mode when you are joined to an ADS 
domain displays an error message indicating this is not possible.

Understanding the System Configuration Page Options

The System Configuration page contains three key system options:

• Password Management

• Shutdown

• Reboot

Edit Password
Edit Password—click this option to display the Edit Password dialog, where you can change the login password for the 
DR Series system

注: To change CIFS login credentials, you can use the DR Series system CLI command, authenticate –set –user . 
For details, see the Dell DR Series System Command Line Reference Guide.

注: Editing your existing login password is different than resetting your login password. Click Edit Password in the 
System Configuration page to edit your login password to reflect any value that meets the system password 
requirements (for more information, see Modifying the System Password. Click Reset Password in the Login page 
to reset your login password to the system default value, which requires you to provide the service tag for your 
system. For more information, see Resetting the Default System Password.

Shutdown
Shutdown—click this option to display the Shutdown System dialog, where you can shut down the DR Series system.

小心: Shutdown powers Off the appliance on which the system software is installed. Once in a powered Off state, 
you can power it On at its physical location or using an iDRAC configuration to the system.

Reboot
Reboot—click this option to display the Reboot System dialog, where you can reboot the DR Series system.

Support（支持）页面和选项

单击 Dashboard（仪表板）→ Support（支持）可显示 Support（支持）页面。Support（支持）页面会在 Support 
Information（支持信息）窗格中显示当前与支持相关的信息：
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注: 所显示的以太网列表（MAC 和速度）的具体数量取决于系统中安装的以太网端口数量和类型。例如，

DR4000 系统 多可支持四个 1 GbE 端口或两个 10 GbE 端口，而 DR4100 系统则 多可支持六个 1 GbE 端口

（四个位于网络子卡上的内部 1 GbE 端口，两个位于 PCI Express 扩展卡上的 1 GbE 端口）或两个 10 GbE 端
口。以下示例显示的是四个端口（eth0 到 eth3）。

• Product Name（产品名称）

• Software Version（软件版本）

• Service Tag（服务标签）

• Last Diagnostic Run（上次诊断运行时间）

• BIOS Version（BIOS 版本）

• MAC Address（MAC 地址）

• iDRAC IP Address（iDRAC IP 地址）

• eth0 MAC

• eth0 Speed（eth0 速度） 

• eth1 MAC

• eth1 Speed（eth1 速度）

• eth2 MAC

• eth2 Speed（eth2 速度）

• eth3 MAC

• eth3 Speed（eth3 速度）

此外，此页面还提供对 DR Series 系统附加存储进行支持、升级和许可的选项：Diagnostics（诊断）、Software 
Upgrade（软件升级）和 License（许可证）。有关更多信息，请参阅了解 Support（支持）页面选项。

了解 Support（支持）页面选项

导航面板中显示的 Support（支持）页面中提供了三个重要选项：Diagnostics（诊断）、Software Upgrade（软

件升级）和 License（许可证）。这三个选项可让您执行以下任务：

• 生成、下载或删除诊断日志文件

• 将 DR Series 系统软件升级到更高的版本

• 为添加的任何数据存储扩展架安装许可证文件

Diagnostics（诊断）

Diagnostics（诊断）：单击此选项可显示 Diagnostics（诊断）页面，其中会依照文件名、大小、时间、诊断日

志捆绑包生成的日期、创建诊断日志捆绑包的原因及其状态，系统列出各个诊断数。Diagnostics（诊断）页面

中提供 Generate（生成）、Download（下载）和 Delete（删除）选项。

诊断日志文件捆绑包由 Dell 支持部门用于诊断用户报告的系统状态，或者在 DR Series 系统操作出现问题时用

于检测。

注: 单击 Select（选择）以标识您要对其执行操作的诊断日志文件。例如，单击 Select（选择）→ 

Download（下载）以显示您选择下载的诊断日志文件的 File Download（文件下载）对话框。

注: 诊断捆绑包可用两种模式生成：管理员生成和自动生成。在自动生成模式中，一旦检测到进程或服务

失败，DR Series 系统便开始在后台收集系统相关的信息。收集完成后，DR Series 系统会产生系统事件。

如果在管理员未提出请求的情况下频繁生成诊断捆绑包，您可能需要联系 Dell 支持部门寻求帮助。

有关 Diagnostics（诊断）页面和 Diagnostics（诊断）服务的更多信息，请参阅 Diagnostics（诊断）页面和选

项，以及关于 Diagnostics（诊断）服务。
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Software Upgrade（软件升级）

Software Upgrade（软件升级）：单击此选项可显示 Software Upgrade（软件升级）页面，其中包含两个窗格：

Upgrade File Location（升级文件位置）和 Software Information（软件信息）。Software Upgrade（软件升级）页

面可让您导航寻找软件升级文件。找到该文件后，单击 Start Upgrade（开始升级）可开始执行升级过程，或查

看 DR Series 系统的当前版本和升级历史。Start Upgrade（开始升级）页面提供 Reboot（重新引导）选项。

注: 准备为 DR Series 系统执行软件升级时，必须下载软件升级文件，并将其保存在可从运行 DR Series 系
统 GUI 的系统上本地访问的位置。

有关系统软件升级的更多信息，请参阅 Software Upgrade（软件升级）页面和选项。

许可证

许可证：单击此选项可显示 License（许可证）页面，其中包含两个窗格：License File Location（许可证文件位

置）和 Number of Installed Licenses（已安装的许可证数目）。在 License（许可证）页面中，您可以为已安装

的数据存储扩展架寻找相应的许可证文件。

在 License File Location（许可证文件位置）窗格中，输入所下载的扩展架许可证文件在本地磁盘（或已知网络

位置）上的存放位置（通常为 /store/license），或单击 Browse...（浏览...）导航至许可证文件 (license.xml) 所在

的其他目录/文件夹路径位置。找到该文件后，单击 Install License（安装许可证），为已安装的数据存储扩展

架安装并验证许可证文件。

安装并验证许可证文件后，License（许可证）页面会显示 License file has been successfully installed（许可证文

件已安装成功）对话框，并且 Number of Installed Licenses（已安装的许可证数目）摘要表会更新，以包含您刚

才安装的新许可证文件。Number of Installed Licenses（已安装的许可证数目）窗格中包含一个摘要表，其中按 

ID、说明、授权 ID 和当前状态列出并标识已安装的每个许可证。

有关受支持的数据存储扩展架或扩展架所需的许可证的更多信息，请参阅扩展架许可证和安装扩展架。

Expansion Shelf Licenses
This topic introduces the license required for adding external data storage in the form of Dell MD1200 storage arrays 
that are referred to as expansion shelf enclosures. Expansion shelf enclosures allow you to add supplemental data 
storage capacity to support DR Series system operations. The DR Series system supports up to maximum of two 
enclosures per system, and any expansion shelf enclosure that is added must be equal to or greater than each DR 
Series system internal drive slot capacity (0–11). Expansion shelf enclosures can be added to the internal data storage 
to create up to 9, 18, or 27 Terabyte (TB) hard drive capacities, and expansion shelf enclosures can be added in 1 TB, 2 
TB, or 3 TB capacities. Licenses define the expansion shelf enclosure size in a license = size format (for example, shelf = 
18TB), and licenses are added on a per-shelf basis.
表. 4: Expansion Shelf Capacities in the DR Series System

System/Expansion Shelf Enclosure Size Maximum Data Storage Capacity Options

600 Gigabyte (GB) expansion shelf
• 9 TB
• 18 TB
• 27 TB

1 TB expansion shelf
• 9 TB
• 18 TB
• 27 TB

2 TB expansion shelf
• 18 TB
• 27 TB

3 TB expansion
• 27 TB
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Licenses
Adding an expansion shelf enclosure requires that you order a license for each enclosure from a Dell Account 
representative at the time that you order the DR Series system. You can also order this at a later date when you want to 
add additional external storage to your base DR Series system. To obtain the license, you can download it from the 
support.dell.com/ website using your service tag or use an email link from your Dell Account representative.

If you already have a Dell MD1200 storage array, the order process supports licensing for existing hardware that you 
want to add to a base DR Series system. Each license supports one expansion shelf enclosure, and the system supports 
up to two enclosures using the DR Series system service tag. Because the licenses are tied to the system service tag, if 
the internal drives are moved to another system chassis, this would require a new license. For more information about 
the expansion shelf enclosures, see “DR Series Expansion Shelf” in DR Series System and Data Operations.

注: The 300 Gigabyte (GB) drive capacity (2.7 TB) version of the DR Series system does not support the addition of 
expansion shelf enclosures to add external storage to the base system.

安装扩展架许可证

确保已找到扩展架的许可证，然后再尝试进行安装和验证。

要为 DR Series 系统扩展架安装许可证，请完成以下操作：

注: 驱动器容量为 300 千兆字节 (GB)（共 2.7 TB）的 DR Series 系统版本不支持添加扩展架机柜。

1. 在导航面板中，选择 Support（支持）→ License（许可证）（或双击 License（许可证））。

将显示 License（许可证）页面，其中显示 License File Location（许可证文件位置）窗格和 Number of 
Installed Licenses（已安装的许可证数目）窗格。

2. 在 License File Location（许可证文件位置）窗格中，输入许可证文件所在的路径（通常为 /store/
license），或单击 Browse...（浏览...）导航至许可证文件的位置。

3. 单击 Install License（安装许可证），按照提示完成所有操作。

成功后，将显示 License has been successfully installed（许可证已安装成功）对话框，而新的许可证将显示

在 Number of Installed Licenses（已安装的许可证数目）窗格中。Number of Installed Licenses（已安装的许

可证数目）窗格中会列出已安装许可证的总数目，并会按 ID、简短说明、授权 ID（许可证标签）和许可

证状态定义已安装的各许可证。
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4
Configuring the DR Series System Settings
This topic introduces the concept that before you can run any DR Series system operations, you first need to understand 
the following key tasks:

• How to initialize the system

• How to shut down or reboot the system

• How to manage the system password

Initializing the DR Series system requires that you configure and manage a number of very important system settings.

注: Dell recommends that you use the Initial System Configuration Wizard to configure your DR Series system. 
Changing some of the system settings using the DR Series system GUI (such as bonding, MTU, hostname, IP 
address, and DNS) can cause issues that may affect your DR Series system GUI access.

For more information about initializing the system, see Initializing the DR Series System.

For more information about shutting down or rebooting the system, see Shutting Down the DR Series System and 
Rebooting the DR Series System.

For more information about managing the system password, see Managing the DR Series System Password.

Configuring Networking Settings
You can configure the networking settings that were configured using the Initial System Configuration Wizard process 
for the DR Series system in the following tabs:

注: For the Ethernet port settings on the NICs, this example only shows Eth0 and Eth1 (depending upon your system 
configuration, you could have NICs configured with Ethernet port settings in the Eth0–Eth5 range). The DR4000 
system supports up to four 1–GbE ports or up to two 10–GbE ports, while the DR4100 system supports up to six 
1–GbE or up to two 10–GbE ports. For more information, see Local Console Connection.

• Hostname

– Hostname (FQDN)

– iDRAC IP Address

• DNS 

– Domain Suffix

– Primary DNS

– Secondary DNS

• Interfaces

– Device

– Mode

– MAC Address

– MTU (maximum transmission unit)

– Bonding Option
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– Slave Interfaces

• Eth0

– MAC

– Maximum Speed

– Speed

– Duplex

• Eth1

– MAC

– Maximum Speed

– Speed

– Duplex

To configure new networking settings (or to change from those set using the Initial System Configuration Wizard), 
complete the following:

1. Select System Configuration → Networking.
The Networking page is displayed. Select settings for hostname, IP Address, DNS, Bonding, or to view the Ethernet 
port settings (Eth0-Eth3) for the DR Series system.

– To configure hostname, skip to step 2.

– To configure IP addressing, skip to step 5.

– To configure DNS, skip to step 10.
2. To change the current Hostname, select the Hostname tab and click Edit Hostname on the options bar.

The Edit Hostname dialog is displayed.

3. Type a hostname in Hostname that meets the following supported character types and length:

– Alphabetic—allows A-Z, a-z, or a combination of upper and lower case alphabetic characters.

– Numeric—allows numerals zero (0) through 9.

– Special characters—allows only the dash (-) character.

– Length limit—hostnames cannot exceed the maximum length of 19 characters.
4. Click Submit to set the new hostname for your system.

5. To change the current IP address settings for the selecte NIC bond or Ehternet port, select the Interfaces tab and 
click Edit Interfaces on the options bar.
The Edit Interface — <bond or Ethernet port number> dialog is displayed.

6. Under IP Address, in Mode, select Static (to set static IP addressing for your system), or select DHCP (to set 
dynamic IP addressing for your system).

注: To select the DHCP mode of IP addressing, select DHCP, and click Submit. The remaining substeps in this 
step only need to be completed if you selected the Static mode of IP addressing for the DR Series system.

a) In New IP Address, type an IP address that represents the new IP address for your system.
b) In Netmask, type an netmask address value that represents your system (the system IP address and netmask 

identify the network to which your system belongs).
c) In Gateway, type an IP address for the gateway associated with your system.

7. Under MTU, in MTU, enter the value you want to set as the maximum.

注: Ensure that the value that you enter in MTU is the same for the clients, Ethernet Switch, and the appliance. 
The connection between the clients, the Ethernet switches, and the appliance will break if the MTU number is 
not the same on all the components.

70



注: In computer networking, jumbo frames are Ethernet frames with more than 1500 bytes of payload (but in 
some cases, jumbo frames can carry up to 9000 bytes of payload). Many Gigabit Ethernet switches and 
Gigabit Ethernet network interface cards support jumbo frames. Some Fast Ethernet switches and Fast 
Ethernet network interface cards also support jumbo frames.

Some computer manufacturers use 9000 bytes as the conventional limit for jumbo frame sizes. To support jumbo 
frames used in an Internet Protocol subnetwork, both the host DR Series system (initiator or source) and the target 
DR Series system have to be configured for 9000 MTU.

Consequently, interfaces using a standard frame size and those using the jumbo frame size should not be in the 
same subnet. To reduce the chance of interoperability issues, network interface cards capable of supporting jumbo 
frames require specific configurations to use jumbo frames.

To verify that the destination system can support a specific frame size, use the DR Series system CLI command 
network --ping --destination <IP address> --size <number of bytes>.

For more information, contact Dell Support for assistance (for details, see Contacting Dell).

注: Make sure that if you are using any Dell network switches that you take full advantage of the latest switch 
firmware upgrades and application notes. The application notes provide procedures that assist you in 
performing switch firmware upgrades and saving configuration files (for complete details, see 
support.dell.com/ and navigate to Drivers and Downloads for your system type).

注: When setting or changing the MTU value, make sure that you verify that the Ethernet network switch is 
capable of supporting an MTU size that is equal to or larger than the value you are setting. Any mismatch in 
MTU values between the clients, Ethernet network switch, and the DR Series system appliance will make it 
inoperable.

Dell suggests that you observe standard best practices when deploying jumbo frames in networks, and 
recommends using jumbo frames with the DR Series system because this frame size typically provides the best 
performance. However, for networks that do not support jumbo frames, the DR Series system also supports using 
the standard frame size.

8. Under Bonding, from the Bonding configuration list, select the appropriate bonding configuration.

注: You may lose the connection to the system if you change the bonding configuration. Change the bonding 
configuration only if the system accepts the new bonding type.

– TLB — configures transmit load balancing.

– ALB—configures adaptive load balancing (ALB), which is the default setting.

注: ALB load balancing does not balance the load properly when your backup servers are on a remote 
subnet. This is because ALB uses the address resolution protocol (ARP) and ARP updates are subnet-
specific. Because this is the case, ARP broadcasts and updates are not sent across the router. 
Instead, all traffic is sent to the first interface in the bond. To resolve this ARP-specific issue, make 
sure that your data source systems reside on the same subnet as the DR Series system.

– 802.3ad—configures dynamic link aggregation using the IEEE 802.ad standard.

小心: If you change the existing bonding setting, the connection to the DR Series system may be lost 
unless you are sure that the system can accept this bonding type.

9. Click Submit to have the DR Series system accept the new values (or click Cancel to display the Networking page).
The Updated IP Address dialog is displayed when the selection is successful (if you change the static IP address 
manually, you need to use this IP address in the browser when you log back into the DR Series system).

10. To configure DNS settings for your system, select the DNS tab and click Edit DNS on the options bar.
The Edit DNS dialog is displayed.

11. In Domain Suffix, type a domain suffix to use.
For example, acme.local. This is a required field.
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12. In Primary DNS, type an IP address that represents the primary DNS server for your system; this is a required field.

13. For Secondary DNS, type an IP address that represents the secondary DNS server for your system; this is an 
optional field.

14. Click Submit to have the DR Series system accept the new values (or click Cancel to display the Networking page).
The Updated DNS dialog is displayed when the selection is successful.

Networking Page and Ethernet Port Values

The Networking page displays the currently configured multiple Ethernet ports for the DR Series system in a series of 
panes. For 1–Gigabit Ethernet (GbE) ports in the DR4000 system this could be Eth0, Eth1, Eth2, and Eth3, and in the 
DR4100 system this could be Eth0, Eth1, Eth2, Eth3, Eth4, and Eth5. For 10-GbE/10-GbE SFP+ NICs, this means that the two 
ports are bonded together into a single interface. For example, the DR Series system port configuration is as follows:

• In a 1-GbE NIC configuration: the DR4000 system supports up to four 1–GbE ports, which consists of up to two 
internal LAN on Motherboard (LOM) ports and two ports on an expansion card that are bonded together. The 
DR4100 system supports up to six 1–GbE ports, which consists of up to four internal LOM ports on the network 
daughter card (NDC) and two ports on a PCI Express expansion card.

• In a 10-GbE or 10-GbE SFP+NIC configuration: the DR4000 system supports up to two 10–GbE or 10–GbE SFP+ 
ports on an expansion card that are bonded together. The DR4100 system supports up to two 10-GbE or 10-GbE 
SFP+ ports that reside on the NDC that are bonded together.

注: For more information on advanced networking options see the Command Line Interface Guide available at 
dell.com/support/manuals.

The ports for bonded NICs display: MAC address, port speed in megabtyes per second (MB/s), maximum speed, and 
duplex setting. The following example shows Ethernet port values for the four ports in a 1-GbE NIC bonded configuration 
on a DR4000 system:

Eth0:

• MAC: 00:30:59:9A:00:96

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth1:

• MAC: 00:30:59:9A:00:97

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth2:

• MAC: 00:30:59:9A:00:98

• Speed: 1000Mb/s

• Max Speed: 1000baseT/Full

• Duplex: Full

Eth3:

• MAC: 00:30:59:9A:00:99

• Speed: 1000Mb/s
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• Max Speed: 1000baseT/Full

• Duplex: Full

管理 DR Series 系统密码

可以通过两种方法管理登录 DR Series 系统时所使用的登录密码：

• 使用 System Configuration（系统配置）页面中的 Edit Password（编辑密码）选项修改现有登录密码。有
关更多信息，请参阅修改系统密码。

• 使用 DR Series System Login（DR Series 系统登录）页面中的 Reset Password（重置密码）选项将登录密
码重置为默认值。有关更多信息，请参阅重置默认系统密码。

Modifying the System Password

To configure a new password or to modify an existing password for logging in to the DR Series system, complete the 
following:

1. To change the system password, do one of the following:.

– In the navigation panel, select System Configuration, the System Configuration page is displayed. Click 
Password Management.

– In the navigation panel, select System Configuration → Password, the Password Management page is 
displayed.

2. Click Edit Password.
The Edit Password dialog is displayed.

3. In Current password, type the current password for the system.

4. In New password, type the new system password.

5. In Confirm password, retype the new password to confirm this as the new password replacing the existing system 
password.

6. Click Change Password (or click Cancel to display the System Configuration page).
If successful, a Password change was successful dialog is displayed.

Resetting the Default System Password

To reset the system to use the default password (St0r@ge! ) for logging in, complete the following:

1. In the Login window, click Reset Password.
The Reset Password dialog is displayed.

If the password reset option is set to Service Tag, proceed to step 2.

If the password reset option is set to Service Tag and Administrator Email, proceed to step 4.

2. In Service Tag, type the Service Tag associated with your system, and click Reset Password.

注: If you are unsure of the Service Tag associated with your DR Series system, it can be found on the 
Support page (click Support in the navigation panel to display the Support Information pane, which displays 
the Service Tag).

The Login window is displayed, and a Password has been reset dialog is displayed.

3. To log in using the default password, type St0r@ge! , and click Login.

注: After you have reset the login password to its default and logged in to the DR Series system, Dell 
recommends for security reasons that you create a new unique login password.
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4. In Service Tag, type the Service Tag associated with your system.

注: If you are unsure of the Service Tag associated with your DR Series system, it can be found on the 
Support page (click Support in the navigation panel to display the Support Information pane, which displays 
the Service Tag).

5. In Administrator Email enter the email address of the administrator of this system.
The Administrator Email that you enter must match the administrator email address configured in the DR Series 
system. If you have set security questions, the security questions are displayed.

6. Enter the answers to the configured security questions in Answer 1 and Answer 2.

7. Click Send Now.
An email with a unique code, used to reset the password, is sent only to the configured administrator email 
address. The code is valid for only 15 minutes. The password rest code expires after 15 minutes and cannot be 
used. You must repeat the password reset procedure to regenerate the code again.

关闭 DR Series 系统

如果需要，可以通过在 System Configuration（系统配置）页面中选择 Shutdown（关闭）来关闭 DR Series 系
统。但在尝试关闭该系统之前，应充分了解此操作对系统操作的影响。

小心: 关闭 DR Series 系统软件所安装在的设备的电源。电源关闭后，只能在物理位置将电源重新打开，否

则必须为 DR Series 系统使用 iDRAC 连接。

要关闭 DR Series 系统，请完成以下操作：

1. 在导航面板中，选择 System Configuration（系统配置）。

此时将显示 System Configuration（系统配置）页面。

2. 在 System Configuration（系统配置）页面选项栏上单击 Shutdown（关闭）。

此时将显示 Shutdown confirmation（关闭确认）对话框。

3. 单击 Shutdown System（关闭系统）以继续关闭系统（或单击 Cancel（取消）返回 System Configuration
（系统配置）页面）。

重新引导 DR Series 系统

如果需要，可以选择 System Configuration（系统配置）页面中的 Reboot（重新引导）选项来重新引导 DR Series 
系统。要重新引导系统，请执行以下操作：

1. 在导航面板中，选择 System Configuration（系统配置）。

此时将显示 System Configuration（系统配置）页面。

2. 单击 System Configuration（系统配置）页面选项栏上的 Reboot（重新引导）。

此时将显示 Reboot System（重新引导系统）确认对话框。

3. 单击 Reboot System（重新引导系统）继续重新引导系统（或单击 Cancel（取消）返回 System Configuration
（系统配置）页面）。

重新引导完毕后（完成系统重新引导过程 长可能需要 10 分钟），将显示 System has successfully 
rebooted（系统已成功重新引导）对话框。

配置压缩级别设置

对于要通过 DR Series 系统执行备份和重复数据消除的所有传入数据，可配置要用于这些数据的数据压缩。
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注: 此为系统的全局压缩级别设置。更改压缩级别设置后，所做更改将仅影响新传入的数据（使用新设置

写入）。系统中的所有现有数据仍保持使用其插入时的设置（这些数据未使用新的压缩级别设置重新写

入）。

压缩级别设置可在 Compression Level（压缩级别）页面进行配置，方法是选择以下选项：

• Fast（快速）-（默认设置），选择此选项时，系统执行备份的速度将比选择 Best（ 佳）时更快。不
过，使用此设置会导致空间节省量相应减少。

• Best（ 佳）- 选择此选项时，系统备份获得的总体空间节省量 大。不过，使用此设置会导致备份过
程完成时间相应较长。

要为系统配置 Compression Level（压缩级别）设置，请完成以下操作：

1. 选择 Storage（存储） → Compression Level（压缩级别） 。
此时将显示 Compression Level（压缩级别）页面。

2. 要配置 Compression Level（压缩级别）设置，请单击选项栏上的 Edit（编辑）。

此时将显示 Compression Level Settings（压缩级别设置）对话框。

3. 在 Compression Level（压缩级别）列表中，选择要用于所有传入数据的压缩级别类型：Fast（快速）或 
Best（ 佳）。

4. 单击 Set Compression Level（设置压缩级别）以使用此设置配置系统（或单击 Cancel（取消）以显示 
Compression Level（压缩级别）页面）。

选择成功时，将显示 Updated Compression（已更新压缩）对话框。

注: 为系统配置的压缩级别设置为全局设置。更改压缩级别设置后，所做更改将仅影响新传入的数据

（使用新设置写入）。系统中的所有现有数据仍保持使用其之前插入时的设置（这些数据未使用新

的压缩级别设置重新写入）。系统将对新传入的数据执行校验和，因此更改压缩级别不会对系统的

存储容量产生任何负面影响。

配置 Active Directory 设置

要指示 DR Series 系统加入或退出包含 Microsoft Active Directory 服务 (ADS) 的域，需配置 Active Directory 设
置。要加入 ADS 域，请完成以下程序中的步骤 1-4 （要退出 ADS 域，请跳至步骤 5）。将 DR Series 系统加入 

ADS 域时，将禁用网络时间协议 (NTP) 服务，转而使用基于域的时间服务。

要针对使用 ADS 的域配置 DR Series 系统，请完成以下操作：

1. 选择 System Configuration（系统配置） → Active Directory。
此时将显示 Active Directory 页面。

注: 如果尚未配置 ADS 设置，Active Directory 页面的 Settings（设置）窗格中将显示一条信息性消息。

2. 单击选项栏上的 Join（加入）。

此时将显示 Active Directory Configuration（Active Directory 配置）对话框。

3. 在 Active Directory Configuration（Active Directory 配置）对话框中输入以下值：

– 在 Domain Name (FQDN)（域名 (FQDN)）中键入 ADS 的完全限定域名，例如 AD12.acme.com。（此
为必填字段。）

注: 支持的域名长度限于 64 个字符，并且只能包含 A-Z、a-z、0-9 和三个特殊字符（短划线 
(-)、句点 (.) 与下划线 (_)）的组合。

– 在 Username（用户名）中，键入符合 ADS 用户名准则的有效用户名。（此为必填字段。）

注: 支持的用户名长度限于 64 个字符，并且只能包含 A-Z、a-z、0-9 和三个特殊字符（短划线 
(-)、句点 (.) 与下划线 (_)）的组合。

– 在 Password（密码）中，键入符合 ADS 密码准则的有效密码。（此为必填字段。）
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– 在 Org Unit（组织单位）中，键入符合 ADS 组织名称准则的有效组织名称。（此为必填字段。）

4. 单击 Join Domain（加入域）以使用这些 ADS 设置来配置您的系统（或单击 Cancel（取消）以显示 Active 
Directory 页面）。

如果成功，将显示 Successfully Configured（配置成功）对话框。

注: 如果配置 CIFS 容器共享路径，这些路径将显示在 Active Directory 页面的 CIFS Container Share Path
（CIFS 容器共享路径）窗格中。

5. 要退出 ADS 域，请在 Active Directory 页面中单击 Leave（退出）。

此时将显示 Active Directory Configuration（Active Directory 配置）对话框。

6. 要退出已配置的 ADS 域，需输入以下信息：

a) 在 Username（用户名）中，输入 ADS 域的有效用户名。

b) 在 Password（密码）中，输入 ADS 域的有效密码。

7. 单击 Leave Domain（退出域）以指示 DR Series 系统退出 ADS 域（或单击 Cancel（取消）以显示 Active 
Directory 页面）。

如果成功，将显示 Successfully Configured（配置成功）对话框。

配置本地工作组用户设置

需要配置设置以创建由经过 CIFS 身份验证的用户组成的本地工作组。通过此功能，可创建本地工作组（Local 
Workgroup Users（本地工作组用户）），从中可以添加新用户、编辑现有用户或删除用户。

要配置 DR Series 系统以创建本地工作组用户，请完成以下操作：

1. 选择 System Configuration（系统配置） → Local Workgroup Users（本地工作组用户） 。
此时将显示 Local Workgroup Users (CIFS)（本地工作组用户 (CIFS)）页面。

2. 要在此本地用户工作组中创建新的 CIFS 用户，请单击选项栏上的 Create（创建）。

此时将显示 Create a local workgroup user for CIFS authentication（创建用于 CIFS 身份验证的本地工作组用

户）对话框。

a) 在 User Name（用户名）中，为此用户输入有效的用户名。

b) 在 Password（密码）中，为此用户输入有效的密码。

c) 单击 Add CIFS User（添加 CIFS 用户）以在系统的本地工作组用户中创建新用户（或单击 Cancel（取
消）以返回 Local Workgroup Users (CIFS)（本地工作组用户 (CIFS)）页面）。

如果成功，将显示 Added CIFS user（已添加 CIFS 用户）确认对话框。

3. 要编辑此本地用户工作组中的现有 CIFS 用户，请单击 Select（选择）以在 Local Workgroup Users（本地工
作组用户）摘要表中标识要修改的用户，然后单击选项栏中的 Edit（编辑）。

此时将显示 Edit a local workgroup user for CIFS authentication（编辑用于 CIFS 身份验证的本地工作组用户）

对话框。

a) 在 Password（密码）中，为此用户输入不同的有效密码。

此用户的 User Name（用户名）无法修改，只能修改 Password（密码）。如果希望用户使用不同的 

User Name（用户名），必须删除此用户，然后创建使用所需 User Name（用户名）的新用户。

b) 单击 Edit CIFS User（编辑 CIFS 用户）以修改系统本地工作组用户中现有用户的密码（或单击 Cancel
（取消）以返回 Local Workgroup Users (CIFS)（本地工作组用户 (CIFS)）页面）。

4. 要从本地用户工作组中删除现有 CIFS 用户，请单击 Select（选择）以在 Local Workgroup Users（本地工作
组用户）摘要表中标识要删除的用户，然后单击选项栏中的 Delete（删除）。

此时将显示 Delete user（删除用户）确认对话框。

a) 单击 OK（确定）以从 Local Workgroup Users（本地工作组用户）摘要表中删除所选用户（或单击 
Cancel（取消）以返回 Local Workgroup Users (CIFS)（本地工作组用户 (CIFS)）页面）。

如果成功，将显示 Deleted CIFS user（已删除 CIFS 用户）确认对话框。
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配置电子邮件警报设置

可以创建和管理要向其发送 DR Series 系统电子邮件警报的用户的收件人电子邮件地址。Email Alerts（电子邮

件警报）页面包含多个选项，可用于添加新收件人电子邮件地址，编辑或删除现有收件人电子邮件地址，以及

向 Recipient Email Address（收件人电子邮件地址）窗格中所列的收件人电子邮件地址发送测试消息。

注: Email Alerts（电子邮件警报）页面包含管理收件人电子邮件地址和测试发送消息功能所需的全部选

项。

添加收件人电子邮件地址

要配置并添加新的收件人电子邮件地址，请完成以下操作：

1. 选择 System Configuration（系统配置） → Email Alerts（电子邮件警报） 。
此时将显示 Email Alerts（电子邮件警报）页面。

2. 单击选项栏上的 Add（添加）。

此时将显示 Add Recipient Email Address（添加收件人电子邮件地址）对话框。

3. 在 Email Address（电子邮件地址）中，使用您电子邮件系统支持的地址格式键入有效电子邮件地址。

4. 单击 Submit（提交）以配置此收件人电子邮件地址（或单击 Cancel（取消）以显示 Email Alerts（电子邮件
警报）页面）。

此时将显示 Email Alerts（电子邮件警报）页面，操作成功时，将显示 Added email recipient（已添加电子邮

件收件人）对话框。

5. 要创建附加收件人电子邮件地址，请重复步骤 2 到 4。

注: 有关发送电子邮件警报消息以测试一个或多个电子邮件收件人的信息，请参阅发送测试消息。

Editing or Deleting a Recipient Email Address

To edit or delete an existing recipient email address:

1. Select System Configuration→ Email Alerts.
The Email Alerts page is displayed.

注: To edit or delete an existing recipient email address, you must first click Select in the Recipient Email 
Address pane to indicate the address that you want to edit or delete. To edit an existing email address, 
proceed to step 2, or to delete an existing email address, skip to step 4. For more information about adding 
email recipients, see Adding a Recipient Email Address.

2. To edit an existing recipient email address, click Select to indicate the recipient email address entry that you want 
to change, and click Edit on the options bar.
The Edit Recipient Email Address dialog is displayed.

3. Modify the existing email address you selected as needed, and click Submit.
The Email Alerts page is displayed, and a Successfully updated email recipient dialog is displayed when 
successful. To edit additional recipient email addresses, repeat steps 2 and 3.

4. To delete an existing recipient email address, click Select to indicate the recipient email address entry that you 
want to delete, and click Delete on the options bar.
The Delete Confirmation dialog is displayed.

5. Click OK to delete the selected email recipient address (or click Cancel to display the Email Alerts page).
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The Email Alerts page is displayed, and a Deleted email recipient dialog is displayed when successful. To delete 
additional recipient email addresses, repeat steps 4 and 5.

发送测试消息

利用 DR Series 系统可向所有已配置的收件人电子邮件地址发送测试消息。通过此过程，您可以管理系统警报

邮件的发送，随后验证所有已配置的电子邮件收件人是否均已收到这些消息。

注: 如果需要电子邮件中继主机，请确保完成相关配置。有关电子邮件中继主机的更多信息，请参阅添加

电子邮件中继主机。

1. 选择 System Configuration（系统配置）→ Email Alerts（电子邮件警报）。

此时将显示 Email Alerts（电子邮件警报）页面。

2. 单击选项栏上的 Send Test Message（发送测试消息）。

此时将显示 Send Test Email （发送测试电子邮件）确认对话框。

3. 单击 OK（确定）（或单击 Cancel（取消）以显示 Email Alerts（电子邮件警报）页面）。

此时将显示 Email Alerts（电子邮件警报）页面，操作成功时，将显示 Successfully sent email（已成功发送

电子邮件）对话框。

4. 验证是否所有目标收件人电子邮件地址都已收到测试电子邮件。

配置管理员联系信息

您可以配置管理员联系信息，从而标识以管理员身份主动管理或负责 DR Series 系统的人员。为此，请在 

Administrator Contact Information（管理员联系信息）页面中使用 Edit Contact Information（编辑联系信息）选项

输入联系信息。

在导航面板的 Dashboard（仪表板）页面中，单击 System Configuration（系统配置）→ Admin Contact Info（管

理员联系信息）以显示 Administrator Contact Information（管理员联系信息）页面。

有关管理员联系信息的更多信息，请参阅编辑管理员联系信息和添加管理员联系信息。

以下信息类别显示在 Administrator Contact Information（管理员联系信息）页面的 Contact Information（联系信

息）和 Notification（通知）窗格中，这些信息将随所有系统警报电子邮件发送：

• Contact Information（联系信息）

– Administrator Name（管理员名称）

– Company Name（公司名称）

– Email（电子邮件）

– Work Phone（工作电话）

– Comments（注释）

• Notification（通知）

– Notify me of DR4000 appliance alerts（通知我 DR4000 设备警报）复选框的状态（启用或禁用）

– Notify me of DR4000 software updates（通知我 DR4000 软件更新）复选框的状态（启用或禁用）

添加管理员联系信息

要配置系统管理员的联系信息，请完成以下操作：

1. 选择 System Configuration（系统配置） → Admin Contact Info（管理员联系信息） 。
此时将显示 Administrator Contact Information（管理员联系信息）页面。

2. 单击选项栏上的 Add Contact Information（添加联系信息）。
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此时将显示 Add Administrator Contact Information（添加管理员联系信息）对话框。

3. 在 Administrator Name（管理员名称）中，键入该设备的管理员的名称。

4. 在 Company Name（公司名称）中，键入与管理员关联的公司名称。

5. 在 Email（电子邮件）中，键入管理员的电子邮件地址（使用您电子邮件系统支持的电子邮件地址格
式）。

6. 在 Work Phone（工作电话）中，键入与管理员关联的电话号码。

7. 在 Comments（注释）中，键入某些信息或添加注释以用于唯一标识此管理员。

8. 单击 Notify me of DR 4000 appliance alerts（通知我 DR4000 设备警报）复选框以获得有关系统设备警报的通
知。

9. 单击 Notify me of DR 4000 software updates（通知我 DR4000 软件更新）复选框以获得有关系统软件更新的通
知。

10. 单击 Submit（提交）（或单击 Cancel（取消）以显示 Administrator Contact Information（管理员联系信息）
页面）。

此时将显示 Administrator Contact Information（管理员联系信息）页面，若成功则会显示 Updated 
administrator contact information（已更新管理员联系信息）对话框。

编辑管理员联系信息

要编辑现有系统管理员的联系信息，请完成以下操作：

1. 选择 System Configuration（系统配置）→ Admin Contact Info（管理员联系信息）。

此时将显示 Administrator Contact Information（管理员联系信息）页面。

2. 单击选项栏上的 Edit Contact Info（编辑联系信息）。

此时将显示 Edit Administrator Contact Information（编辑管理员联系信息）对话框。

3. 在相应信息字段中，根据需要修改管理员联系信息。

4. 选中 Notify me of DR Series appliance alerts（通知我 DR Series 设备警报）复选框以选择此选项（如果已选
中此选项，也可单击以取消选中）。

5. 选中 Notify me of DR Series software updates（通知我 DR Series 软件更新）复选框以选择此选项（如果已选
中此选项，也可单击以取消选中）。

6. 单击 Submit（提交）（或单击 Cancel（取消）以显示 Administrator Contact Information（管理员联系信息）
页面）。

此时将显示 Administrator Contact Information（管理员联系信息）页面，若成功则会显示 Updated 
administrator contact information（已更新管理员联系信息）对话框。

Managing Passwords
You can edit the system password and system password reset configuration on this page.

Modifying the System Password

To configure a new password or to modify an existing password for logging in to the DR Series system, complete the 
following:

1. To change the system password, do one of the following:.

– In the navigation panel, select System Configuration, the System Configuration page is displayed. Click 
Password Management.
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– In the navigation panel, select System Configuration → Password, the Password Management page is 
displayed.

2. Click Edit Password.
The Edit Password dialog is displayed.

3. In Current password, type the current password for the system.

4. In New password, type the new system password.

5. In Confirm password, retype the new password to confirm this as the new password replacing the existing system 
password.

6. Click Change Password (or click Cancel to display the System Configuration page).
If successful, a Password change was successful dialog is displayed.

Modifying Password Reset Options

To modify the password reset options:

1. Select System Configuration → Password.
The Password Management page is displayed.

2. Click Edit Password Reset Options.
The Edit Password Reset Options dialog is displayed.

3. To use service tag only, select Service Tag Only and click Submit.

注: To select the option Service Tag and Administrator Email, you must first configure the e-mail relay host 
and administrator contact e-mail.

4. To use the service tag and administrator e-mail, select Service Tag and Administrator Email.
The optional security questions area is displayed.

5. To set the optional security questions, under Optional Security Question 1 and Optional Security Question 2 in 
Question enter the security question.

6. In Answer , enter the answer to your security question.

注: Save the answer in a secure location, you will need these answers to reset the DR Series system 
password.

7. Click Submit.

配置电子邮件中继主机

如果需要，可以将外部电子邮件中继主机配置为向 DR Series 系统提供服务（如果网络电子邮件系统需要一个

中继主机）。电子邮件中继主机通常是外部邮件服务器，可将任何电子邮件警报从 DR Series 系统中继到指定

的每个收件人电子邮件地址。

要在 Email Relay Host（电子邮件中继主机）页面上执行此操作，请单击 Add Relay Host（添加中继主机）定义

新的电子邮件中继主机（或者，要编辑现有电子邮件中继主机，请单击选项栏上的 Edit Relay Host（编辑中继

主机））。有关编辑现有电子邮件中继主机的更多信息，请参阅编辑电子邮件中继主机。

添加电子邮件中继主机

要为 DR Series 系统配置新的电子邮件中继主机，请完成以下操作：

注: 要编辑现有电子邮件中继主机，请参阅编辑电子邮件中继主机。

1. 选择 System Configuration（系统配置） → Email Relay Host（电子邮件中继主机） 。
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此时将显示 Email Relay Host（电子邮件中继主机）页面。

2. 单击选项栏上的 Add Relay Host（添加中继主机）。

此时将显示 Add Relay Host（添加中继主机）对话框。

3. 在 Relay Host（中继主机）中，键入将用作 DR Series 系统电子邮件中继主机的外部邮件服务器的主机名或 
IP 地址。

4. 单击 Submit（提交）（或单击 Cancel（取消）以显示 Email Alerts（电子邮件警报）页面）。

此时将显示 Email Relay Host（电子邮件中继主机）页面，若成功则会显示 Updated external email server 
information（已更新外部电子邮件服务器信息）对话框。

5. 发送一条测试消息以验证电子邮件中继主机是否工作正常。

有关更多信息，请参阅发送测试消息。

6. 验证是否所有目标收件人电子邮件地址都已收到测试电子邮件。

编辑电子邮件中继主机

要编辑 DR Series 系统的现有电子邮件中继主机，请完成以下操作：

1. 选择 System Configuration（系统配置）→ Email Relay Host（电子邮件中继主机）。

此时将显示 Email Relay Host（电子邮件中继主机）页面。

2. 单击选项栏上的 Edit Relay Host（编辑中继主机）。

此时将显示 Edit Relay Host（编辑中继主机）对话框。

3. 在 Relay Host（中继主机）中，根据需要修改外部邮件服务器的电子邮件中继主机名或 IP 地址。

4. 单击 Submit（提交）（或单击 Cancel（取消）以显示 Email Alerts（电子邮件警报）页面）。

此时将显示 Email Relay Host（电子邮件中继主机）页面，若成功则会显示 Updated external email server 
information（已更新外部电子邮件服务器信息）对话框。

配置系统日期和时间设置

如果需要配置或管理系统使用的日期和时间设置，以使其与在域中运行的其他 DR Series 系统或客户端同步，

请导航至 Date and Time（日期和时间）页面并单击 Edit（编辑）。Date and Time（日期和时间）页面将显示包

含以下日期和时间相关设置的 Settings（设置）窗格（默认情况下，系统在初始系统启动时使用以下日期和时

间设置作为默认值）：

• Mode（模式）- 从两种类型中选择：Manual（手动）和 Network Time Protocol (NTP)（网络时间协议 
(NTP)）。

注: 如果 DR Series 系统为工作组成员而非域成员，Dell 建议您使用 NTP。当 DR Series 系统加入域
（例如 Microsoft Active Directory 服务 (ADS) 域）时，NTP 将处于禁用状态，DR Series 系统将使用
域时间。

• Time Zone（时区）- 在 NTP 模式中，可从基于格林威治标准时间的时区选项列表中进行选择，例如 
GMT-8:00, Pacific Time (US and Canada)（GMT-8:00 太平洋时间（美国和加拿大））。

• NTP Servers（NTP 服务器）- 在 NTP 模式中，可从 NTP 服务器的 Internet 池（ 多可定义三个 NTP 服务
器）中进行选择。如果 Settings（设置）窗格未显示此设置，请验证 Mode（模式）是否指示 DR Series 
系统已加入 Active Directory 服务 (ADS) 域。如果 DR Series 系统已加入域，将禁用 NTP。

• Set Date and Time（设置日期和时间）- 在 Manual（手动）模式中，单击日历图标并配置日期和时间
（使用 24 小时制时间格式选择月份、日期和时间）。使用日历上的控件选择月份和日期，使用滑块控
件选择小时和分钟。要设置当前时间，请单击 Now（现在）。设置完日期和时间值后，单击 Done（完
成）（此时将显示时间，例如 12/12/12 14:05:45）。配置所有日期和时间设置后，单击 Submit（提交）使 
DR Series 系统接受新值。

注: 系统同步对于正确执行数据存档和复制服务操作至关重要。
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通过使用 NTP 模式，系统时钟将保持同步，从而确保您的系统拥有可靠的时间戳。这对于工作组中成功交换

文件、协调和验证网络日志以及请求资源访问权限非常重要。

注: 如果系统为工作组成员，Dell 建议您使用 NTP 模式以确保更好地执行复制服务操作。您可以使用 Date 
and Time（日期和时间）页面中的 Edit（编辑）选项设置或修改 DR Series 系统的现有日期和时间设置。不

过，如果已加入域，NTP 服务将处于禁用状态，此时将使用域时间管理模式，而无法启用 NTP。

Editing System Date and Time Settings

To modify the default time and date settings for your DR Series system, complete the following:

1. Select System Configuration → Date and Time.
The Date and Time page is displayed.

2. Click Edit on the options bar.
The Edit Date and Time dialog is displayed.

注: If the DR Series system is joined to a Microsoft Active Directory Services (ADS) domain, the Edit option 
will be disabled (grayed out) and the Mode, Time Zone, or Date and Time values cannot be changed in the 
Settings pane. This is because whenever a DR Series system is joined to a domain, the Network Time Protocol 
(NTP) is disabled and the DR Series system uses the domain-based time service. NTP is used in the Mode 
setting when the DR Series system is part of a workgroup and not joined to a domain. To be able to modify or 
edit any of the Settings pane values when the DR Series system is joined to an ADS domain, you would first 
need to leave the ADS domain before you could modify any of the date and time settings. For more 
information, see Configuring Active Directory Settings.

3. In Mode, select either Manual or NTP.
If you select Manual, continue on with the tasks in step 3.

If you select NTP, skip to step 4.

a) Select Manual.
The Edit Date and Time dialog is displayed.

b) Click the Time Zone drop-down list and choose the desired time zone.
c) Click the Calendar icon (adjacent to Set Date and Time), and select the desired day in the month (the system 

prevents the selection of unsupported days).
d) Adjust the Hour and Minute sliders to the desired time (or click Now to set the date and time to be the current 

date and time in hours and minutes).
a) Click Done.

The Edit Date and Time dialog is displayed with your new settings.

4. Select NTP.
The Edit Date and Time dialog is displayed.

– Click the Time Zone drop-down list and select the desired time.
– Edit or revise the NTP servers as desired (you are limited to selecting only three NTP servers).

5. Click Submit (or click Cancel).
The Date and Time page is displayed, and an Enabled NTP service dialog is displayed when successful (and this 
was your selected mode).

Creating Containers
After initialization, the DR Series system contains a single default container named backup. Containers function like a 
shared file system, which can be assigned a connection type of None (to be defined later), NFS/CIFS, or RDA (includes 
both OST and RDS clients). Containers can then be accessed using NFS, CIFS, or RDA.
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If needed, you can also create additional system containers for storing your data. For more information about creating a 
storage container or specific connection type containers, see Creating Storage Containers, Creating an NSF or CIFS 
Connection Type Container, or Creating an OST or RDS Connection Type Container.

Configuring Share-Level Security
The DR Series system supports setting up share-level permissions for CIFS shares using the standard Microsoft 
Windows administrative tool, Computer Management. Computer Management is a component that is built into the 
Microsoft Windows 7, Vista, and XP operating systems.

注: Any user that is part of BUILTIN\Administrators can edit ACLs on CIFS shares. The local DR Series system 
administrator is included in the BUILTIN\Administrators group. To add additional domain groups to the BUILTIN
\Administrators group, you can use the Computer Manager tool on a Windows client to connect to the DR Series 
system as Domain administrator and add any groups you want. This capability allows users other than the Domain 
administrator to modify an ACL as needed.

This administrative tool lets you control access to shares and also configure read-only or read-write access to user 
groups or individual users within the Active Directory Service (ADS) when joined to an ADS domain.

To implement share-level security on a DR Series system that has been joined to an ADS domain, make sure that you 
have mapped a drive on the DR Series system using an account with DOMAIN\Administrator credentials (or by using an 
account that is equivalent to a domain administrator). For more information about joining to an ADS domain, see 
Configuring Active Directory Settings.

注: If you do not use an account with sufficient privileges, you will not be able to see the shares or you may 
experience other problems.

1. Click Start → Control Panel → Administrative Tools → Computer Management.
The Computer Management page is displayed.

2. Click Action → Connect to another computer... .
The Select Computer dialog is displayed.

3. Click Another computer, type the hostname or IP address for this DR Series system, and click OK.
The Computer Management page is displayed with the designated DR Series system listed in the left pane.

4. Click System Tools, and click Shared folders.
The Shares, Sessions, and Open Files folders are displayed in the main pane of the Computer Management page.

5. Click Shares to display a list of the shares managed by the DR Series system.
6. Right-click on the share of interest, and select Properties.

The specified share Properties page is displayed.

7. Click the Share Permissions tab in the specified share Properties page.
The Share Permissions view in the Properties page is displayed.

8. To remove existing access permissions to the share, or add additional groups or user that can access the share, 
complete the following:

– To add access for a new group or user, click Add... to display the Select Users or Groups dialog.

– Click Object Types..., choose the object types you want to select (Built-in security principals, Groups, or 
Users), and click OK.

– Click Locations... and define the root location from which to begin your search, and click OK.

– In the Enter the object names to select list box, enter any object name(s) you want to find.

注: You can search for multiple objects by separating each name with a semicolon, and by using one 
of the following syntax examples: DisplayName, ObjectName, UserName, 
ObjectName@DomainName, or DomainName\ObjectName.
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– Click Check Names to locate all matching or similar object names that are listed in the Enter the object 
names to select list box, by using the object types and directory locations you selected.

9. Click OK to add the object to the Group or user names list box.
10. In the Permissions pane for the selected object, select the Allow or Deny check box to configure the following 

permissions:

– Full Control

– Change

– Read
11. Click OK to save the selected share permission settings associated with the selected object.
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5
Managing DR Series Storage Operations

Managing Container Operations
This topic introduces the concept of using the DR Series system to manage all of your data storage and replication 
operations. Data storage operations can include tasks such as creating new containers, managing or deleting existing 
containers, moving data into containers, and displaying current container statistics. Replication operations can include 
such tasks as creating new replication relationships, managing or deleting existing replication relationships, starting 
and stopping replication, setting a replication bandwidth limit per host, displaying current replication statistics, and 
setting a replication schedule.

Creating Storage Containers

By default, the DR Series system provides a container named backup for your use after you complete the basic system 
configuration and initialization process. You can also create additional containers to store your data as needed.

注: The DR Series system does not support creating container names that begin with a 0 (zero). In addition, many of 
the DR Series system GUI and CLI operations will not work when a container name begins with a 0.

Containers function like a shared file system that can be accessed using the following connection types:

• NFS/CIFS

• NFS

• CIFS

• RDA (Rapid Data Access)

– OST (OpenStorage Technology)

– RDS (Rapid Data Storage)

• None (an unassigned connection type)

Choosing the None or unassigned connection type lets you create containers that can be configured later as needed. To 
modify a container configured with a None connection type, select the container, click Edit, and start configuring it as 
desired.

Creating an NFS or CIFS Connection Type Container

To create an NFS or a CIFS connection type container, complete the following:

1. Select Storage → Containers.
The Containers page is displayed, which includes a Containers summary table listing all existing containers.

2. Click Create.
The Create New Container dialog is displayed.

3. In Container Name, type the name of the container.
Container names cannot exceed 32 characters in length, and can be composed of any combination of the following 
characters:
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注: The DR Series system does not support the use of the following special characters in container names: /, 
#, or @.

– A-Z (uppercase letters)

– a-z (lowercase letters)

– 0-9 (numbers)

– dash (-) or underscore (_) special characters

4. In Marker Type, select from the following choices: None, Auto, CommVault, Networker, TSM, or ARCserve.
If you select the Auto marker type, this will enable all marker types to be detected. As a best practice, if you have 
only one type of DMA with traffic directed to a container, it is best to select the corresponding marker type (for 
example, CommVault). Conversely, as a best practice, if you have traffic from a DMA that is not one of the 
supported marker types, it is best to disable marker detection for the container by selecting the None marker type.

5. In Connection Type, select NFS/CIFS.
This displays the following in the NFS and CIFS panes:

– NFS access path: <system name>/containers/<container name>

– CIFS share path: <system name>\<container name>

注: To create an NFS connection type, skip to step 6. To create a CIFS connection type, skip to step 10.

6. To select an NFS connection type, click Enable NFS in the NFS pane.
The Client Access, NFS Options, and Map root to panes are displayed, and is where you configure this container to 
use NFS to backup Unix or Linux clients.

7. In the Client Access pane, define a specific NFS client (or all clients) that can access the NFS container or manage 
clients who can access this container:

– To allow open access for all clients to the NFS container you create, select Open Access (all clients have 
access). When you select this setting, this action removes the Add client (IP or FQDN Hostname) and 
Clients text boxes. Select this check box only if you want to enable access for all clients to this NFS 
container.

– To define a specific client that can access the NFS container you create, type the IP address (or its FQDN 
hostname) in the Add clients (IP or FQDN Hostname) text box, and click Add. The “added” client appears 
in the Clients list box.

– To delete an existing client from the NFS Clients list box, select the IP address (or FQDN hostname) of the 
client you want to delete, and click Remove. The “deleted” client disappears from the list box.

8. In the NFS Options pane, define which NFS options to use for the client, by selecting from the NFS Options choices: 
rw (allows read-write access), ro (allows read-only access), or insecure (allows for replies being made to requests 
before the changes in the request are committed to disk).

注: The DR Series system always commits writes to NVRAM first before committing any changes to disk.

9. In the Map root to pane, select the user level you want mapped to this container from one of the following options 
from the drop-down list and skip to step 12.

– nobody represents a user on the system without root access permissions

– root represents a remote user with root access to read, write, and access files on the system

– administrator represents the system administrator

注: The DR Series system administrator that manages the system has a different set of privileges than does 
the CIFS administrator user. Only the DR Series system administrator can change the password for the CIFS 
administrator user. To change the password that allows access for the CIFS administrator user, use the 
authenticate --set --user administrator commands. For more information, see the Dell DR Series System 
Command Line Reference Guide.
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10. To select a CIFS connection type, click Enable CIFS in the CIFS pane.
The Client Access pane is displayed, which allows you to configure this container to use CIFS to backup Microsoft 
(MS) Windows clients.

11. In the Client Access pane, define a specific CIFS client (or all clients) that can access the CIFS container or 
manage clients who can access this container:

– To allow open access for all clients to the CIFS container you created, select Open Access (all clients have 
access). When you select this setting, this action removes the Add clients (IP or FQDN Hostname) and 
Clients text boxes. Select this check box only if you want to enable access for all clients to this CIFS 
container.

– Type the IP address (or its FQDN hostname) in the Add clients (IP or FQDN Hostname) text box, and click 
Add. The “added” client appears in the Clients list box.

– To delete an existing client from the Clients list box, click to select the IP address (or FQDN hostname) of 
the client you want to delete, and click Remove. The “deleted” client disappears from the list box.

12. Click Create a New Container (or click Cancel to display the Containers page).
The Containers page is displayed, along with a Successfully Added dialog. The list of containers in the Containers 
summary table is now updated with your new container.

Creating an OST or RDS Connection Type Container

To create an OST or RDS connection type container:

1. Select Storage → Containers.
The Containers page displays all existing containers.

2. Click Create.
The Create New Container dialog is displayed.

3. In Container Name, type the name of the container.
Container names cannot exceed 32 characters in length, and can be composed of any combination of the following 
characters:

– A-Z (uppercase letters)

– a-z (lowercase letters)

– 0-9 (numbers)

– dash (-) or underscore (_) special characters

注: The DR Series system does not support the use of the following special characters in container names: /, 
#, or @.

4. In Marker Type, select Auto.
Selecting Auto marker type enables all marker types to be detected. As a best practice, if you have only one type of 
DMA with traffic directed to a container, it is best to select the corresponding marker type (for example, 
CommVault). As a best practice, if you have traffic from a DMA that is not one of the supported marker types, it is 
best to disable marker detection for the container by selecting the None marker type.

5. In Connection Type, select RDA .
The RDA pane is displayed.

6. In RDA type, select either OST or RDS.

7. In Capacity, select one of the following options allowed per container:

注: If you select RDS, by default, Unlimited is selected. Under Capacity the Size field is inactive.

– Unlimited: this defines the allowed amount of incoming raw data per container (based on the physical 
capacity of the container).
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– Size: this defines a set limit in Gibibytes (GiB) for incoming raw data allowed per container.

8. Click Create a New Container (or click Cancel to display the Containers page).
After creating the new container, the Containers page is displayed and includes a Successfully Added dialog. The 
list of containers in the Containers summary table is updated with your new container (and its new status is 
reflected as N/A in the Replication column of this table).

创建未分配的连接类型容器

要在 DR Series 系统中创建未分配的容器而不定义连接类型（None（无）），请完成以下操作：

注: DR Series 系统支持您创建容器而不为其配置特定连接类型。以后您准备配置未分配的容器时，可以在 

Containers（容器）摘要表中将其选中，单击 Edit（编辑），然后将其配置为想要的连接类型。

1. 选择 Storage（存储） → Containers（容器） 。
此时将显示 Containers（容器）页面，其中包含所有现有容器。

2. 单击 Create（创建）。

此时将显示 Create New Container（创建新容器）对话框。

3. 在 Container Name（容器名称）中，键入容器的名称。

容器名称长度不能超过 32 个字符，可由以下字符任意组合而成：

注: DR Series 系统不支持在容器名称中使用以下特殊字符：/、# 或 @。

– A-Z（大写字母）

– a-z（小写字母）

– 0-9（数字）

– 短横线 (-) 或下划线 (_) 特殊字符

4. 在 Marker Type（标记类型）中，从以下选项中选择：None（无）、Auto（自动）、CommVault、
Networker、TSM 或 ARCserv。
如果选择 Auto（自动）标记类型，将可检测到所有标记类型。如果只有一种类型的 DMA，且流量指向某

个容器，则 佳做法是选择对应的标记类型（例如 CommVault）。反之，如果发出流量的 DMA 不属于所

支持的任何标记类型，则 佳做法是选择 None（无）标记类型以禁用容器的标记检测。

5. 要创建容器而不分配连接类型，请选择 None（无）来创建容器，以后再进行配置，或禁用该容器的任何
特定标记类型。

6. 单击 Create a New Container（创建新容器）（或单击 Cancel（取消）显示 Container Summary（容器摘要）
页面）。

创建新容器后，将会显示 Containers（容器）页面，其中会显示 Successfully Added（已成功添加）对话

框。Containers（容器）摘要表中的容器列表会更新以包括新的未分配容器。

Editing Container Settings

To modify any of the settings for an existing container, complete the following:

1. Select Storage→ Containers.
The Containers page is displayed, and lists all current containers.

2. Click Select to identify the container in the list that you want to modify, and click Edit.
The Edit Container dialog is displayed.

3. Modify the marker type options for the selected container as needed (containers support None, Auto, CommVault, 
Networker, TSM (Tivoli Storage Manager), or ARCserve.
If you select the Auto marker type, this will enable all marker types to be detected. As a best practice, if you have 
only one type of DMA with traffic directed to a container, it is best to select the corresponding marker type (for 
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example, CommVault). Conversely, as a best practice, if you have traffic from a DMA that is not one of the 
supported marker types, it is best to disable marker detection for the container by selecting the None marker type.

4. Modify the connection type options for the selected container as needed (containers support None, NFS/CIFS, and 
RDA).

– If you want to modify an existing NFS/CIFS, NFS, or CIFS connection type container settings, see the NFS/
CIFS, NFS-only, and CIFS-only options available in Creating an NSF or CIFS Connection Type Container, and 
make the corresponding changes.

– If you want to modify the existing OST or RDS connection type container settings, see the options available 
in Creating an OST or RDS Connection Type Container , and make the corresponding changes.

– If you want to modify the existing unassigned (None) connection type container settings, see the options 
available in Creating An Unassigned Connection Type Container, and make the corresponding changes.

注: If you select Open Access in the Client Access pane, the Add clients (IP or FQDN Hostname) and Clients 
panes are hidden and you cannot create or modify these options.

注: The DR Series system always commits writes to NVRAM first before committing any changes to disk.

注: The DR Series system administrator that manages the DR Series system has a different set of privileges 
than the CIFS administrator user. Only the DR Series system administrator can change the password for the 
CIFS administrator user. To change the password that allows access for the CIFS administrator user, use the 
DR Series system CLI authenticate --set --user administrator command. For more information, see the Dell DR 
Series System Command Line Reference Guide at dell.com/support/manuals.

5. Once the container type settings have been modified, click Modify this Container (or click Cancel to display the 
Containers page).
The Successfully updated container dialog is displayed. The list of containers in the Containers summary table is 
updated with the newly modified container.

删除容器

删除容器之前，Dell 建议首先认真考虑是否需要保留容器中的数据。要删除包含数据的现有容器，请完成以下

操作：

小心: 在删除任何包含经过重复数据消除的数据的 DR Series 容器之前，Dell 建议采取几个步骤以使用另一

种长期保留方法来保留此数据。容器一旦删除，将无法恢复经过重复数据消除的数据。DR Series 系统的

当前版本和更高版本允许在一项操作中删除任何指定容器及其全部内容。

1. 选择 Storage（存储） → Containers（容器） 。
此时将显示 Containers（容器）页面，并列出所有当前容器。

2. 单击 Select（选择）以标识要删除的容器，然后单击 Delete（删除）。

此时将显示 Delete Confirmation（删除确认）对话框，提示您已选择删除的特定容器的名称。

3. 在 Delete Confirmation（删除确认）对话框中单击 OK（确定）（或单击 Cancel（取消）以显示 Containers
（容器）页面）。

此时将显示 Successfully removed container（已成功删除容器）对话框。Containers（容器）摘要表将更新

且不再显示已删除的容器。

Moving Data Into a Container

To move data into an existing DR Series system container, complete the following:

1. Click Start → Windows Explorer → Network .
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The Network page is displayed, which lists all current computers.

2. In the browser Address bar, click Network to select your DR Series hostname or IP address.
The Network page is displayed, which lists all current storage and replication containers.

注: However, if your DR Series system is not listed, you can enter its hostname or IP Address preceded by 
"https://" and followed by the container name in the Address bar to access it (for example in this format, 
https://10.10.20.20/container-1). The DR Series system only supports the Hypertext Transfer Protocol Secure 
(HTTPS) form of IP addressing.

3. Move data from the source location to the destination container using your regular DMA or backup application 
process.

注: If any file ingested by the DR Series system by a DMA or backup application is renamed or deleted without 
using the DMA or backup application’s process, the corresponding catalog must be updated accordingly. 
Failure to do so may prevent the DMA or backup application from being able to access the data.

4. Verify that the data recently moved now resides in the destination container (or click Dashboard → Statistics: 
Container, select the destination container in the Container Name drop-down list, and view the following 
information panes for recent container activity:

– Backup Data

– Throughput

– Connection Type

– Replication

Displaying Container Statistics

To display the current statistics for an existing container that stores your data, complete the following:

注: An alternate method to display statistics for any current container is to select that container by name in the 
Container Name drop-down list in the Statistics: Container page (Dashboard Statistics: Container).

1. Select Storage → Containers.
The Containers page is displayed, and the Containers summary table lists all of the current containers in the 
system.

2. Click Select to identify the container to display, and click Display Statistics in the options bar.
The Statistics: Container page is displayed which shows the current backup data (number of active files and active 
bytes ingested in the Backup Data pane), and read and write throughput (in the Throughput pane). The system polls 
for and updates the displayed statistics every 30 seconds.

注: To display statistics for another container, select that container by name in the Container Name drop-
down list.

This page also displays the marker type and connection type for the selected container, and the displayed statistics 
depends upon the connection type container. For more information, see Statistics: Container Page, Connection 
Type Pane, and Monitoring Container Statistics.

In addition, you can also display the set of system statistics by using the DR Series system CLI stats --system 
command to show the following categories of system statistics:

– Capacity Used (system capacity used in Gibibytes or GiBs)

– Capacity Free (system capacity free in GiBs)

– Read Throughput (read throughput rate in Mebibytes or MiB/s)

– Write Throughput (write throughput rate in MiB/s)

– Current Files (current number of files in system)
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– Current Bytes (current number of ingested bytes in system)

– Post Dedupe Bytes (number of bytes after deduplication)

– Post Compression Bytes (number of bytes after compression)

– Compression Status (current compression status)

– Cleaner Status (current space reclamation process status)

– Total Inodes (total number of data structures)

– Dedupe Savings (deduplication storage savings by percentage)

– Compression Savings (compression storage savings by percentage)

– Total Savings (total storage savings by percentage)

使用 CLI 显示 DR Series 系统统计信息

检查当前 DR Series 系统统计信息的另一种方法是：使用 DR Series 系统 CLI stats --system 命令显示以下类别的

系统统计信息：

• Capacity Used（使用的系统容量，单位为二进制千兆字节 (GiB)）

• Capacity Free（可用的系统容量，单位为 GiB）

• Read Throughput（读吞吐率，单位为二进制兆字节/秒 (MiB/s)）

• Write Throughput（写吞吐率，单位为 MiB/s）

• Current Files（系统中当前文件的数量）

• Current Bytes（系统中当前插入的字节数量）

• Post Dedupe Bytes（消除重复数据后的字节数量）

• Post Compression Bytes（压缩后的字节数量）

• Compression Status（当前压缩状态）

• Cleaner Status（当前空间回收进程的状态）

• Total Inodes（数据结构总数）

• Dedupe Savings（通过重复数据消除节省的存储量，以百分比表示）

• Compression Savings（通过压缩节省的存储量，以百分比表示）

• Total Savings（节省的总存储量，以百分比表示）

有关 DR Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR 
Series 系统命令行参考指南）。

使用 CLI 显示特定于容器的统计信息

可使用 DR Series 系统 CLI stats --container --name <container name> 命令显示一系列特定于容器的统计信息，包

括以下统计信息类别：

• Container Name（容器的名称）

• Container ID（与容器关联的 ID）

• Total Inodes（容器中的数据结构总数）

• Read Throughput（容器的读吞吐率，单位为二进制兆字节/秒 (MiB/s)）

• Write Throughput（容器的写吞吐率，单位为 MiB/s）

• Current Files（容器中的当前文件数）

• Current Bytes（容器中当前插入的字节数）

• Cleaner Status（所选容器的当前空间回收进程状态）

有关 DR Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR 
Series 系统命令行参考指南）。
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Managing Replication Operations
If you plan on performing replication operations across a firewall, the DR Series system replication service requires that 
the following fixed TCP ports be configured to support replication operations:

注: To allow replication storage information to be viewed by a corresponding data management agent (DMA), the 
target DR Series system needs to reside in the same domain as the source DR Series system in the replication 
relationship.

• port 9904
• port 9911
• port 9915
• port 9916

注: If there are no existing containers, replication relationships, or any scheduled replication operations, the only 
Replication-related option that is enabled is Create. The Edit, Delete, Stop, Start, Bandwidth, and Display Statistics 
options are disabled (grayed out).

In the 2.0 release, DR Series systems support 32:1 replication of data. This means that multiple source DR Series systems 
(up to 32) can write data to different individual containers on a single, target DR Series system.

注: Starting with release 2.0, the DR Series system software includes version checking that limits replication only 
between other DR Series systems that run the same system software release version (DR Series systems running 
Release 2.0.x software can only replicate with other DR Series systems that run the same release system 
software). For example, Release 2.0.x systems will not be able to replicate with Release 2.1 or Release 3.0 systems, 
but can replicate with systems running Release 2.0.0.1 or 2.0.0.2.

注: You need to be aware that the storage capacity of the target DR Series system is directly affected by the 
number of source systems writing to its containers, and also by the amount being written by each of these source 
systems.

创建复制关系

要创建新的复制关系，请完成以下操作：

1. 选择 Storage（存储） → Replication（复制） 。
此时将显示 Replication（复制）页面，其中按以下类别列出了所有当前复制条目：

– Local Container Name（本地容器名称）

– Role（目标或源）

– Remote Container Name（远程容器名称）

– Peer State（联机或脱机）

– Bandwidth（复制带宽限制）

注: Bandwidth（带宽）为复制带宽限制，可将其设置为二进制千字节/秒 (KiB/s)、二进制兆字节/秒 

(MiB/s)、二进制千兆字节/秒 (GiB/s) 或无限带宽（默认）。

2. 单击选项栏中的 Create（创建）。

此时将显示 Create Replication（创建复制）页面。

3. 在 Step 1: Select a local container（步骤 1：选择一个本地容器）中，从可用容器列表中选择一个本地容
器。

4. 在 Step 2: Select Encryption（步骤 2：选择加密）中，选择以下加密选项之一：None（无）、128-bit（128 
位）或 256-bit（256 位）。
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5. 在 Step 3: Select a role（步骤 3：选择一个角色）中，选择 Source（源）或 Target（目标）。

6. 在 Step 4: Remote container settings（步骤 4：远程容器设置）中，选择以下两个选项之一：

– Create container on remote system（在远程系统上创建容器）。如果选择此选项，请参阅在远程系
统上创建容器（复制），其中介绍了在远程系统上创建容器的过程。

– Map to container on remote system（映射到远程系统上的容器）。如果选择此选项，请参阅映射到
远程系统上的容器（复制），其中介绍了映射到远程系统上的容器的过程。

7. 在步骤 4 中输入所需信息：Username（用户名）、Password（密码）、Peer System（对等系统）和 Peer 
Container Name（对等容器名称）字段。

有关更多信息，请参阅在远程系统上创建容器（复制）或映射到远程系统上的容器（复制），具体取决于

所选选项。

8. 单击 Create Replication（创建复制）（或单击 Cancel（取消）以显示 Replication（复制）页面）。

如果成功，将显示 Successfully added replication（已成功添加复制）对话框。

Creating a Container on a Remote System (Replication)

This topic describes the process for creating a replication relationship with a container on a remote system using the 
Replication page. For more information, see Creating Replication Relationships. The following procedure assumes you 
have completed the Step 1, Step 2, and Step 3 tasks for creating replication relationships, and you are selecting the 
Create container on a remote system option in Step: 4 Remote container settings.

To create a replication relationship with a container on a remote system, complete the following tasks:

注: Exercise care when configuring the direction of replication for source and target containers. For example, 
target containers can have their contents deleted if they contain existing data.

1. In Username, type a valid user name for the peer system (for example, administrator).
2. In Password, type a valid password for the peer system (for example, St0r@ge!).
3. In Peer System, type the IP address that represents this peer system (for example, 10.10.10.10).
4. In Peer Container Name, type a name for the new container (for example, StorageReplica2), or choose from an 

existing container on the peer system.
5. Click Create Replication (or click Cancel to display the Replication page).

The Successfully added replication dialog is displayed when successful.

映射至远程系统上的容器（复制）

本主题介绍使用 Replication（复制）页面映射至远程系统上的容器，从而创建新复制关系的过程。有关更多信

息，请参阅创建复制关系。以下过程假设已完成创建复制关系中的步骤 1、步骤 2 和步骤 3 任务，并且将在 

Step 4: Remote container settings（步骤 4：远程容器设置）中选择 Map to container on a remote system（映射至

远程系统上的容器）选项。

要通过映射至远程系统上的容器来创建复制关系，请完成以下任务：

注: 配置源容器和目标容器的复制方向时要小心。例如，目标容器包含现有数据时，其内容可能会被删

除。

1. 单击 Map to container on remote system（映射至远程系统上的容器）。

2. 在 Username（用户名）中，键入对等系统的有效用户名（例如，administrator）。

3. 在 Password（密码）中，键入对等系统的有效密码（例如，St0r@ge!）。

4. 在 Peer System（对等系统）中，键入代表对等系统的 IP 地址（例如，10.10.10.10）。

5. 在 Remote Container（远程容器）中，单击 Retrieve Container(s)（检索容器）以在列表框中显示远程容器。

6. 在 Retrieve Container(s)（检索容器）列表框中，选择所需的远程容器。

7. 单击 Create Replication（创建复制）（或单击 Cancel（取消）以显示 Replication（复制）页面）。

如果成功，将显示 Successfully added replication（已成功添加复制）对话框。
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编辑复制关系

要修改现有复制关系的设置，请完成以下操作：

注: 配置源容器和目标容器的复制方向时要小心。例如，目标容器包含现有数据时，其内容可能会被删

除。

1. 选择 Storage（存储）→ Replication（复制）。

此时将显示 Replication（复制）页面。

2. 单击 Select（选择）以标识要修改的复制关系，然后单击选项栏中的 Edit（编辑）。

此时将显示 Edit Replication（编辑复制）对话框。

3. 根据需要，在 Step 2: Select Encryption（步骤 2：选择加密）中修改以下任意值：

– 无

– 128 位
– 256-bit（256 位）

4. 根据需要，在 Step 4: Remote container settings（步骤 4：远程容器设置）中修改以下任意值：

– 用户名

– 密码

– Peer System（对等系统）

注: 由于无法修改复制关系的现有已定义角色（源或目标），因此，如有必要，必须删除现有复制关

系，然后重新创建具有所需的特定源和目标角色的新关系。

5. 单击 Save Replication（保存复制）（或单击 Cancel（取消）以显示 Replication（复制）页面）。

如果成功，将显示 Successfully updated replication（已成功更新复制）对话框。

删除复制关系

要删除现有复制关系，请完成以下操作：

1. 选择 Storage（存储） → Replication（复制） 。
此时将显示 Replication（复制）页面。

2. 单击 Select（选择）以标识要删除的关系，然后单击选项栏中的 Delete（删除）。

此时将显示 Delete replication（删除复制）对话框。

3. 在 Delete replication（删除复制）对话框中单击 OK（确定）（或单击 Cancel（取消）显示 Replication（复
制）页面）。

成功时，会显示 Successfully deleted replication（已成功删除复制）对话框。

开始和停止复制

要开始或停止现有复制关系中的复制，请完成以下操作：

注: 有关设置复制计划的更多信息，请参阅创建复制计划。

1. 选择 Storage（存储） → Replication（复制） 。
此时将显示 Replication（复制）页面。

2. 单击 Select（选择）以标识要停止（请参阅步骤 3）或开始（请参阅步骤 4）复制过程的复制关系。

3. 要停止计划的复制过程，请单击 Stop（停止），然后单击 OK（确定）以停止复制（或单击 Cancel（取
消）以显示 Replication（复制）页面）。
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此时将显示 Successfully stopped replication（已成功停止复制）对话框。

4. 要开始计划的复制过程，请单击 Start（开始），然后单击 OK（确定）以开始复制（或单击 Cancel（取
消）以显示 Replication（复制）页面）。

此时将显示 Successfully started replication（已成功开始复制）对话框。

设置复制带宽

要设置 DR Series 系统上的复制带宽速率，请完成以下操作：

1. 选择 Storage（存储）→ Replication（复制）。

此时将显示 Replication（复制）页面。

2. 单击 Select（选择）以标识要设置复制带宽速率的复制关系，然后单击 Bandwidth（带宽）。

此时将显示 Replication Bandwidth Throttling（复制带宽限制）对话框。

3. 从 Peer System（对等系统）下拉列表中选择对等系统的 IP 地址。

4. 在 Set bandwidth throttling speed（设置带宽限制速度）中，从以下选项中选择要设置的复制带宽限制：

– 单击 KBps（千字节/秒），然后在 Rate（速率）框中键入一个以 KBps 为单位的速率值。

– 单击 MBps（兆字节/秒），然后在 Rate（速率）框中键入一个以 MBps 为单位的速率值。

– 单击 GBps（千兆字节/秒），然后在 Rate（速率）框中键入一个以 GBps 为单位的速率值。

– 单击 Default (not limited)（默认（无限制））以选择无限制复制带宽速率。

注: 您可以配置的 小允许复制带宽设置是 192 KBps。

5. 单击 Set Bandwidth（设置带宽）（或单击 Cancel（取消）显示 Replication（复制）页面）。

如果成功，将显示 Successfully set replication bandwidth（已成功设置复制带宽）对话框。

显示复制统计信息

要显示现有复制关系的统计信息，请完成以下操作：

1. 选择 Storage（存储） → Replication（复制） 。
此时将显示 Replication（复制）页面。

2. 单击 Select（选择）以标识要显示其复制统计信息的复制关系，然后单击 Display Statistics（显示统计信
息）以显示 Statistics: Replication（统计信息：复制）页面，其中包含：

– Replication Filter（复制筛选器）- 通过此窗格中的 Container Filter（容器筛选器）部分，可以选择一
个或多个复制容器、所有复制容器、一个或多个对等 DR Series 系统。通过 Headers（标头）部
分，可以从十个统计信息类型复选框中任意选择要在 Replication Statistics（复制统计信息）摘要表
中显示的统计信息类型（默认情况下，已选中五个复选框：Peer Status（对等状态）、Replication 
Status（复制状态）、Network Throughput（网络吞吐量）、Network Savings（网络节省量）和 
Progress %（进度百分比））。

– Replication Statistics Summary（复制统计信息摘要）- 此窗格显示基于在 Replication Filter（复制筛
选器）窗格中所选的复选框以及在相应表列中列出的容器或对等系统选择而筛选的统计信息结
果。根据所选的复选框的数量，可能需要使用水平滚动条来显示所有统计信息列。

3. 在 Replication Filter（复制筛选器）窗格中，选择要显示其复制统计信息的以下任意容器筛选器选项：

– 单击 All（全部）- 可显示系统上当前已配置的所有容器的复制统计信息。

– 单击 Name（名称），并在 Name（名称）下拉列表中选择单个容器 - 可显示单个容器的复制统计
信息。要显示多个容器，请在 Name（名称）下拉列表中单击 Ctrl 并选择要包括的任何附加容器。

– 单击 Peer System（对等系统），然后选择 Peer System（对等系统）列表框中的单个对等 DR Series 
系统 - 可显示单个对等系统的复制统计信息。要显示多个对等系统，请在 Peer System（对等系
统）列表框中单击 Ctrl 并选择要包括的任何附加对等系统。
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4. 在 Replication Filter（复制筛选器）窗格中，从以下 Headers（标头）复选框中选择要在 Replication 
Statistics（复制统计信息）摘要表中筛选和显示的所选容器的标头：

注: 对于运行不同 DR Series 系统软件版本的源系统（例如，一个系统运行 1.0.1.2 软件而另一个系统运

行 1.1.1.0 软件），由于在源设备上使用的系统软件版本不同，因此其 Containers: Statistics（容器：统

计信息）和 Statistics: Replication（统计信息：复制）页面中显示的复制统计信息将存在一些细小的差

异。

– Peer Status（对等状态）- 表示当前对等状态（Insync（同步中）、Paused（暂停）或 Replicating
（正在复制））。

– Replication Status（复制状态）- 表示当前复制状态（Offline（脱机）、Online（联机）、
Disconnected（已断开连接）、Trying to Connect（正在尝试连接）或 Stopped（已停止））。

– Time to Sync（同步时间）- 表示系统同步所需的时间（以天/小时/分钟/秒为单位）。

– Progress (%)（进度百分比）- 以百分比形式表示当前复制进度。

– Replication Throughput（复制吞吐量）- 以百分比 (%) 形式表示当前复制吞吐量。

– Network Throughput（网络吞吐量）- 以百分比形式表示当前网络吞吐量。

– Network Savings（网络节省量）- 以百分比形式表示当前通过复制实现的网络节省量。

– Last Time in Sync（ 后一次同步）- 表示 后一次进行系统同步的时间。

– Peer Container（对等容器）- 表示复制关系中的对等容器。

– Peer System（对等系统）- 表示复制关系中的对等系统的 IP 地址。

有关更多信息，请参阅显示 Statistics: Replication（统计信息：复制）页面。

Creating a Replication Schedule

Replication schedules can only be set on individual replication-enabled source containers. To create a Replication 
schedule on a replication-enabled source container, complete the following:

注: If there is no Replication schedule set, but there is pending data that can be replicated, replication will run 
when it detects the following: 1) there are no active data ingests, and 2) five minutes of system idle time have 
elapsed since the last data file ingest completed.

注: The Replication Schedule page displays the current DR Series system time zone and current timestamp (using 
this format: US/Pacific, Tue Oct 28 14:53:02 2012).

To schedule Replication operations on your system, complete the following:

1. Select Schedules → Replication Schedule.
The Replication Schedule page is displayed.

2. Click to select the replication-enabled source container in the Container drop-down list.
The Replication schedule table is displayed with columns that identify the week day, start time, and stop time.

3. Click Schedule to create a new schedule (or click Edit Schedule to modify an existing Replication schedule).
The Set Replication Schedule page is displayed.

4. Select (or modify) the Start Time and Stop Time setpoint values using the Hour and Minutes pull-down lists to 
create a Replication schedule. For an example, see Daily Replication Schedule Example and Weekly Replication 
Schedule Example.

注: You must set a corresponding Stop Time for every Start Time in each Replication schedule you set. The DR 
Series system will not support any Replication schedule that does not contain a Start Time/Stop Time pair of 
setpoints (daily or weekly).

5. Click Set Schedule for the system to accept your Replication schedule (or click Cancel to display the Replication 
Schedule page).
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注: To reset all of the values in the current Replication schedule, click Reset in the Set Replication Schedule 
dialog. To selectively modify values in the current schedule, make your changes to the corresponding hours 
and minutes pull-down lists for the Start Time and Stop Time you wish to modify, and click Set Schedule.

Dell recommends that you do not schedule the running of any Replication operations during the same time period 
when Cleaner or ingest operations will be running. Failure to follow this practice will affect the time required to 
complete the system operations and/or impact your DR Series system performance.

Daily Replication Schedule Example

The daily Replication schedule example in this topic illustrates the process for setting up a replication schedule that 
uses a 24-hour clock (the time keeping convention where time of day is defined on a 24–hour basis). You set or view a 
Replication schedule in the Replication Schedule page. For more information, see Creating a Replication Schedule.

注: Replication schedules can only be set on individual replication-enabled source containers.

To set a daily replication schedule that starts at 16:00 hours (which is 4:00 PM in a 12–hour clock format) and stops at 
23:00 hours (which is 11:00 PM in a 12–hour clock format) on Mondays, click Edit Schedule (if modifying an existing 
schedule) or Schedule (if creating a new schedule):

• Select 16 in the hours pull-down list and 00 in the minutes pull-down list to set a Start Time of 16:00 on Monday.

• Select 23 in the hours pull-down list and 00 in the minutes pull-down list to set a Stop Time of 23:00 for Monday.

• Set the Start Time and Stop Time setpoints for any remaining days of the week on which you want to schedule 
replication.

注: You must set a corresponding Stop Time for every Start Time in each Replication schedule you set. The DR 
Series system will not support any Replication schedule that does not contain a Start Time/Stop Time pair of 
setpoints (daily or weekly).

Weekly Replication Schedule Example

The following example shows how to set up a weekly Replication schedule with a start time at 01:00 am on Saturday and 
a stop time at 01:00 am on Sunday. The DR Series system uses the 24-hour clock convention for its time keeping in which 
each day is divided into twenty-four 1-hour segments.

注: Replication schedules can only be set on individual replication-enabled source containers that you select from 
the Container drop-down list.

• Select 01 in the hours pull-down list and 00 in the minutes pull-down list to set a Start Time of 01:00 for Saturday.

• Select 01 in the hours pull-down list and 00 in the minutes pull-down list to set a Stop Time of 01:00 for Sunday

注: You need to click Set Schedule for the DR Series system to accept your Replication schedule.

For more information on Replication schedules, see Creating a Replication Schedule.
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6
监测 DR Series 系统
本主题介绍如何使用导航面板中的 Dashboard（仪表板）页面选项监测 DR Series 系统操作的当前状态。

Dashboard（仪表板）页面显示当前系统状态类别摘要（System State（系统状态）、HW State（硬件状态）、

Number of Alerts（警报数量）和 Number of Events（事件数量）。此外，此页面还显示 Capacity（容量）、

Storage Savings（存储节省量）和 Throughput（吞吐量）），并包括 System Information（系统信息）窗格。还

有指向其他系统页面（Health（运行状况）、Alerts（警报）和 Events（事件）页面）的链接，使用这些链接可

显示 DR Series 系统的当前系统运行状况（按其组件的状态划分）、当前系统警报和当前系统事件。

Monitoring Operations Using the Dashboard Page
The Dashboard page contains system status indicators for the current state of the DR Series system (System State), 
current hardware state (HW State), current number of system alerts (Number of Alerts), and current number of system 
events (Number of Events). The Dashboard page also contains data graphs that display:

• Capacity—used space and free space available in percentage and total (in Gibibytes or Tebibytes)

• Storage Savings—total savings in percentage based on time (in minutes), which can be displayed in 1h (1–
hour, which is the default), 1d (1–day), 5d (5–day), 1m (1–month), or 1y (1–year) durations.

• Throughput—for reads and writes in volume based on time (in minutes), which can be displayed in 1h (1–hour, 
which is the default), 1d (1–day), 5d (5–day), 1m (1–month), or 1y (1–year) durations.

The Dashboard page also displays a System Information pane that lists key information about this DR Series system 
(such as product name, system name, software version, and a number of other key categories). For details about the 
System Information pane, see System Information Pane.

System Status（系统状态）栏

Dashboard（仪表板）页面包含带有以下图标的 System Status（系统状态）窗格，这些图标可指示当前系统状

态并提供指向更多 DR Series 系统状态信息的链接：

• System State（系统状态）

• HW State（硬件状态）（带有指向 Health（运行状况）页面的链接）

• Number of Alerts（警报数）（带有指向 Alerts（警报）页面的链接）

• Number of Events（事件数）（带有指向 Events（事件）页面的链接）

有关以下 System Status（系统状态）窗格图标的更多详情：

• System State（系统状态），请参阅监测系统使用情况。

• HW State（硬件状态），请参阅监测系统运行状况。

• Number of Alerts（警报数），请参阅监测系统警报。

• Number of Events（事件数），请参阅监测系统事件。
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位置 Status（状态）图标 说明

System Status（系统状

态）栏

表示 佳状态。

System Status（系统状

态）栏

表示警告状态（检测到非严重错误）。

System Status（系统状

态）栏

表示应当采取措施的状态（检测到严重错误）。

注: 要显示有关当前 HW State（硬件状态）的特定信息，请单击该链接以显示 Health（运行状况）页面。

Health（运行状况）页面显示 DR Series 系统硬件和扩展架机柜（如果已安装）的当前状态：前后机箱视

图，呈现了硬盘驱动器、电源设备、散热风扇和连接位置。DR Series 系统的 System Hardware Health（系

统硬件运行状况）窗格显示了电源设备、散热风扇、温度、存储、电压、网络接口卡 (NIC)、CPU、DIMM 
和 NVRAM 的状态。外部扩展架机柜的 System Hardware Health（系统硬件运行状况）窗格显示了电源设

备、散热风扇、温度、存储和机柜管理模块 (EMM) 的状态。

注: 要显示有关当前 Number of Alerts（警报数）的更多信息，请单击该链接以显示 Alerts（警报）页面。

Alerts（警报）页面显示了警报总数，并按索引号、时间戳和消息（简要说明警报状态）列出每个系统警

报。

注: 要显示有关当前 Number of Events（事件数）的更多信息，请单击该链接以显示 Events（事件）页面。

Events（事件）页面显示了事件总数，并按索引号、严重性（严重、警告和信息类）、时间戳和消息（简

要说明事件状态）列出每个系统事件。

DR Series 系统和 Capacity（容量）窗格、Storage Savings（存储节省量）窗格、
Throughput（吞吐量）窗格

Dashboard（仪表板）页面中包含三个中心窗格，其中显示的数据图表将说明有关容量、存储节省量和吞吐量

的当前 DR Series 系统状态：

• Capacity（容量）- 以百分比为单位显示已用和可用物理存储容量，并以二进制千兆字节和二进制太字
节（GiB 和 TiB）为单位显示容量。

• Storage Savings（存储节省量）- 以百分比为单位显示一段时间（以分钟为单位）内的总节省量（结合
重复数据消除和压缩）。

• Throughput（吞吐量）- 以二进制兆字节/秒 (MiB/s) 为单位显示一段时间（以分钟为单位）内读操作和写
操作的吞吐量。

注: 对于 Storage Savings（存储节省量）和 Throughput（吞吐量）数据图表，可选择显示 1h（1 小时，默认

设置）、1d（1 天）、5d（5 天）、1m（1 个月）和 1y（1 年）期间内的当前值。

System Information（系统信息）窗格

System Information（系统信息）窗格位于 Dashboard（仪表板）页面的下部，显示了以下类别的当前系统信

息：

• Product Name（产品名称） 

• System Name（系统名称）

• Software Version（软件版本）

• Current Date/Time（当前日期/时间）

• Current Time Zone（当前时区）
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• Cleaner Status（清理器状态）

• Total Savings（总节省量）（百分比）

• Total Number of Files in All Containers（所有容器中的文件总数）

• Number of Containers（容器数）

• Number of Containers Replicated（已复制的容器数）

• Active Bytes（活动字节数）（优化前的总字节数）

注: 要显示有关 DR Series 系统 GUI 中特定要素的附加信息，请单击相应的问号 (?) 图标。

监测系统警报

您可以使用导航面板、Dashboard（仪表板）页面及其选项监测 DR Series 系统警报并显示系统的当前状态：

• 使用 Dashboard（仪表板）页面，可通过 Number of Alerts（警报数）链接访问 Alerts（警报）页面。

• 可从导航面板中使用 Dashboard（仪表板）→ Alerts（警报）访问 Alerts（警报）页面。

• Alerts（警报）页面将列出系统警报数、当前时区，并提供按索引号定义的警报摘要表、系统警报时间
戳和描述警报的简短消息。有关更多信息，请参阅显示系统警报。

使用 Dashboard Alerts（仪表板警报）页面

要使用 Dashboard（仪表板）页面显示当前系统警报数，请完成以下操作：

注: 当您已经在 Dashboard（仪表板）页面上，并且希望快速显示有关系统警报的更多信息时，此方法很

方便。

1. 单击 Dashboard（仪表板）页面上的 Number of Alerts（警报数）。

System Status（系统状态）栏中的 Number of Alerts（警报数）提供了一个链接（可指示警报数，在此案例

中为 2 个警报，这些警报列在 Number of Alerts: 2（警报数：2）链接中）。

2. 单击 Number of Alerts（警报数）链接（在本例中为 2）。

随即会显示 Alerts（警报）页面。

3. 查看 System Alerts（系统警报）摘要表中的系统警报列表，它们由索引号、时间戳和说明该警报的简要消
息标识。

有关更多信息，请参阅 Dashboard（仪表板）页面和选项以及显示系统警报。

查看系统警报

要使用 DR Series 导航面板显示系统警报的当前数量，请完成以下操作：

1. 在导航面板中单击 Dashboard（仪表板）→ Alerts（警报）。

此时将显示 Alerts（警报）页面，其中在 System Alerts（系统警报）摘要表中列出了系统警报的数量，并

提供了当前时区（例如 US/Pacific（美国/太平洋））。

2. 查看 System Alerts（系统警报）摘要表中列出的系统警报，每个警报由以下项标识：

– 索引号（例如：1、2...）。

– 时间戳（采用 yyyy-mm-dd hh:mm:ss 格式；例如 2012-10-30 10:24:53）。

– 消息（警报的简要说明，例如 Network Interface Controller Embedded (LOM) Port 2 disconnected. 
Connect it to a network and/or check your network switches or routers for network connectivity issues
（嵌入式网络接口控制器 (LOM) 端口 2 已断开连接。请将其连接到网络和/或检查网络交换机或路
由器以解决网络连接问题））。
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监测系统事件

可以监测 DR Series 系统事件，并使用 Events（事件）页面中的 Event Filter（事件筛选器）窗格筛选要显示的事

件。此页面可以显示 All（全部）系统事件，您也可以将事件限制为仅属于以下类型之一：Info（信息）（信息

性）、Warning（警告）或 Critical（严重）事件。

通过 Events（事件）页面，可以搜索系统事件和基于符合搜索条件的系统事件监测 DR Series 系统的当前状

态。有关使用 Event Filter（事件筛选器）窗格的更多信息，请参阅使用事件筛选器。

要监测系统，请使用下列任一方法显示 Events（事件）页面：

• 在 Dashboard（仪表板）页面中，单击 Events（事件）页面中的 Number of Events（事件数）链接。

• 在导航面板中，单击 Dashboard（仪表板） → Events（事件） 以显示 Events（事件）页面。

使用仪表板显示系统事件

要使用 Dashboard（仪表板）页面显示当前系统事件数（Number of Events（事件数）），请完成以下操作：

注: 当您已经在 Dashboard（仪表板）页面上，并希望显示当前系统事件时，此方法很方便。

1. 在 Dashboard（仪表板）页面上，单击 System Status（系统状态）栏中的 Number of Events（事件数）链接
（例如 Number of Events: 2（事件数：2））。

此时将显示 Events（事件）页面，其中列出了当前事件的总数、Event Filter（事件筛选器）、Events（事

件）摘要表和当前时区。

2. 在 Event Filter（事件筛选器）窗格中，可以选择通过使用 Event Severity（事件严重性）下拉列表以及设置 
Timestamp From（时间戳开始时间）和 Timestamp To（时间戳结束时间）开始和结束设置点来筛选事件。

3. 在 Event Severity（事件严重性）下拉列表中，选择要筛选并显示的事件的严重性级别（All（全部）、
Critical（严重）、Warning（警告）或 Info（信息））。

4. 在 Message Contains（消息包含）中，在 Message（消息）文本字段中输入要搜索的词或词串，DR Series 
系统将对您输入的内容执行不区分大小写的匹配（不支持任何其他搜索选项）。匹配项显示在 Events（事
件）摘要表中。

5. 在 Timestamp From（时间戳开始时间）中，在字段中单击或单击日历图标以显示当前月份和日期。

– 在当前月计划中单击并选择一天（或使用月份标题中的左箭头和右箭头分别选择前面或后面的月
份）。

– 使用 Hour（小时）和 Minute（分钟）滑块以小时和分钟设置所需时间，或单击 Now（现在）使用
当前时间。

– 配置完毕后，单击 Done（完成）。

6. 在 Timestamp To（时间戳结束时间）中，在字段中单击或单击日历图标以显示当前月份和日期。

– 在当前月计划中单击并选择一天（或使用月份标题中的左箭头和右箭头分别选择前面或后面的月
份）。

– 使用 Hour（小时）和 Minute（分钟）滑块以小时和分钟设置所需时间，或单击 Now（现在）使用
当前时间。

– 配置完毕后，单击 Done（完成）。

7. 单击 Start Filter（开始筛选）以基于所选设置在 Events（事件）摘要表中显示系统事件。

Events（事件）摘要表基于 Index（索引）、Severity（严重性）、Timestamp（时间戳）和 Message（消

息）（事件的简要说明）显示系统事件。要导航和显示 Events（事件）摘要表中的结果，请完成以下操

作：

– 设置每页要显示的事件数：单击该表右下角的 Events per page（每页事件数），然后选择每页要显
示 25 或 50 个事件。
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– 使用滚动条显示每一整页的系统事件。

– 要显示其他系统事件页面，请单击 prev（上一页）或 next（下一页），在特定页码上单击，或在 
Goto page（转至页码）中输入页码并单击 Go（转至）以显示该页系统事件。

8. 要清除当前筛选器设置，请单击 Reset（重置），然后按照步骤 3 至步骤 6 中说明的过程设置新筛选器
值。

有关在 Events（事件）页面上使用事件筛选器的更多信息，请参阅使用事件筛选器。

使用 Dashboard Events（仪表板事件）选项

要使用 DR Series 导航面板显示系统事件的当前数量，请完成以下操作：

1. 在导航面板中单击 Dashboard（仪表板）→ Events（事件）。

此时将显示 Events（事件）页面，其中在 System Events（系统事件）摘要表中列出了系统事件的数量，并

提供了当前时区（例如 US/Pacific（美国/太平洋））。

2. 查看 System Events（系统事件）摘要表中的当前系统事件列表，此列表按索引号、严重程度、时间戳和事
件消息简要说明分组。

3. 使用 Event Filter（事件筛选器）可搜索与所选条件（事件严重程度、消息内容、时间戳开始和时间戳结束
范围）匹配的事件。

有关使用 Event Filter（事件筛选器）的更多信息，请参阅使用事件筛选器和使用仪表板显示系统事件。

使用事件筛选器

Events（事件）页面包含 Event Filter（事件筛选器）窗格，通过该窗格可以筛选想要在 Events（事件）摘要表

中显示的系统事件的类型。事件筛选通过选择严重性级别和使用时间戳完成。在 Event Severity（事件严重性）

下拉列表中选择严重性级别，然后通过在 Timestamp from（时间戳开始时间）和 Timestamp to（时间戳结束时

间）中选择特定的开始设置点和结束设置点来细化搜索。

要筛选想要在 Events（事件）摘要表中显示的系统事件，请完成以下操作：

1. 单击 Dashboard（仪表板）→ Events（事件）（或通过 Number of Events（事件数）链接访问 Events（事
件）页面）。

此时将显示 Events（事件）页面，其中列出了当前事件数和为系统设置的当前时区。

2. 在 Event Filter（事件筛选器）窗格中，从 Event Severity（事件严重性）下拉列表中选择想要的显示严重
性。

系统事件严重性级别包括：

– All（全部）- 显示全部四种系统事件（All（全部）、Critical（严重）、Warning（警告）和 Info（信
息））

– Critical（严重）- 仅显示严重事件（用红色显示）

– Warning（警告）- 仅显示警告事件（用黄色显示）

– Info（信息）- 仅显示信息性事件

3. 在 Message Contains（消息包含）中，在 Message（消息）文本字段中输入要搜索的词或词串，DR Series 
系统将对您输入的内容执行不区分大小写的匹配（不支持任何其他搜索选项）。匹配项显示在 Events（事
件）摘要表中。

4. 单击 Calendar（日历）图标（位于 Timestamp From（时间戳开始时间）旁边）以配置开始设置点。

要配置开始设置点，请完成以下操作：

– 在当前月份中选择所需的一天，或单击月份标题栏中的左箭头或右箭头选择前面或后面的月份。

– 将 Hour（小时）和 Minute（分钟）滑块调到所需的时间（或单击 Now（现在）将日期和时间设置
为当前日期和时间（小时和分钟））。

– 单击 Done（完成）。
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5. 单击 Calendar（日历）图标（位于 Timestamp To（时间戳结束时间）旁边）以配置结束设置点。

要配置结束设置点，请完成以下操作：

– 在当前月份中选择所需的一天，或单击月份标题栏中的左箭头或右箭头选择前面或后面的月份。

– 将 Hour（小时）和 Minute（分钟）滑块调到所需的时间（或单击 Now（现在）将日期和时间设置
为当前日期和时间（小时和分钟））。

– 单击 Done（完成）。

6. 单击 Start Filter（开始筛选）（或单击 Reset（重置）以将所有值恢复为默认值）。

基于筛选器选项的搜索结果会显示在 Events（事件）摘要表中。

有关使用 Events（事件）摘要表的更多信息，请参阅使用仪表板显示系统事件。

监测系统运行状况

在 DR Series 系统中，使用以下两种方法之一监测和显示系统硬件状况的当前状态：

• 使用 Dashboard（仪表板）→ Health（运行状况），可以从导航面板访问 Health（运行状况）页面。

• 在 Dashboard（仪表板）页面中，可以通过 HW State（硬件状况）链接访问 Health（运行状况）页面。

有关 Health（运行状况）页面的更多信息，请参阅运行状况。

使用 Dashboard（仪表板）页面监测系统运行状况

要使用 Dashboard（仪表板）页面显示和监测当前 DR Series 系统硬件的状态，请完成以下操作：

1. 在导航面板中单击 Dashboard（仪表板）。

此时将显示 Dashboard（仪表板）页面，并在 System Status（系统状态）栏中提供一个 HW State（硬件状

态）链接（例如 HW State: optimal（硬件状态： 佳））。（单击 Dashboard（仪表板）→ Health（运行状

况），也可访问 Health（运行状况）页面。）

2. 单击 HW State（硬件状态）链接（在本例中为 optimal（ 佳）），可显示 Health（运行状况）页面。

Health（运行状况）页面了提供 System（系统）选项卡，此选项卡默认显示在此页面上。如果已安装机

柜，系统还将包括 Enclosure（机柜）选项卡（此版本支持 多安装两个扩展架）。System（系统）选项

卡显示机箱的前视图和后视图，前视图显示磁盘驱动器位置 (0-11) 和操作系统内部驱动器 (12-13)，后视图

显示风扇、系统连接器和电源设备。如果已安装并单击机柜，则 Enclosure（机柜）选项卡显示机柜机箱

的前视图和后视图，前视图显示物理磁盘位置 (0-11)，后视图显示机柜连接器、风扇和可插拔驱动器位

置。此外，还显示扩展架的服务标签。System（系统）和 Enclosure（机柜）选项卡均会显示 System 
Hardware Health（系统硬件运行状况）摘要表，此表分别列出了 DR Series 系统或其扩展架中的所有主要

组件的当前状态。

注: 当您已经在 Dashboard（仪表板）页面上，并且想要显示有关当前系统状态的更多信息时，此方

法很方便。

DR Series 系统 - 系统硬件运行状况组件

– 电源设备

– 风扇

– 温度

– 存储

– 电压

– NIC

– CPU
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– DIMM

– NVRAM

机柜 - 系统硬件运行状况组件

– 电源设备

– 风扇

– 温度

– 存储

– 机柜管理模块 (EMM)

使用 Dashboard Health（仪表板运行状况）选项

要使用导航面板以显示已安装的 DR Series 系统组件（或任何扩展架机柜）的当前系统状态，请完成以下操

作：

1. 单击 Dashboard（仪表板）→ Health（运行状况）。

此时将显示 Health（运行状况）页面。

2. 将鼠标悬停在 Health（运行状况）页面上的机箱前后面板视图上，以显示包含状态、名称以及 DR Series 
系统磁盘驱动器和操作系统驱动器（DR4000 和 DR4100 系统）状态的对话框。

使用相同的过程显示包含电源设备和扩展架机柜后面板连接器的状态及名称的类似对话框。

3. 查看所有 DR Series 系统或扩展架组件（取决于所选的选项卡是 System（系统）还是 Enclosure（机柜））
的 System Hardware Health（系统硬件运行状况）摘要表中的状态。

要显示附加信息，请单击以展开相应摘要表中的每个组件。

注: Health（运行状况）页面提供了 DR Series 机箱前后视图（显示 DR4000 系统的机箱驱动器 (0-11)、
电源设备（PS1 和 PS2）以及操作系统内部驱动器（12 和 13））的状态（在 DR4100 系统中，操作系

统驱动器位于机箱背面）。此外，所有其他主要 DR Series 系统组件均列在 System Hardware Health
（系统硬件运行状况）表中（电源设备、风扇、温度、存储、电压、NIC（网络接口卡）、CPU、
DIMM（双列直插式内存模块）和 NVRAM）。对于安装的每个扩展架（Enclosure 1（机柜 1）或 

Enclosure 2（机柜 2）），Health（运行状况）页面提供扩展架机箱前后视图（显示机箱驱动器 

(0-11)）的状态，并列出服务标签。机柜的 System Hardware Health（系统硬件运行状况）表列出了电

源设备、风扇、温度、存储和机柜管理模块 (EMM)。

有关系统组件和 Health（运行状况）页面的更多信息，请参阅运行状况、监测系统运行状况和使用 Dashboard
（仪表板）页面监测系统运行状况。

Understanding DR Series System NICs And Ports

The DR Series system supports the use of the following types of NICs:

• 1-Gigabit Ethernet (GbE) two-port (10-Base T); Dell recommends using CAT6a copper cabling

• 10-GbE two-port (100-Base T); Dell recommends using CAT6a copper cabling

• 10-GbE SFP+ two-port using LC fiber-optic transceivers or twin-axial cabling

The 1-GbE, 10-GbE, and 10-GbE SFP+ NICs configurations bond multiple Ethernet ports into a single interface by default:

• For the 1-GbE ports, this means that the four ports in the DR4000 system (or the six ports in the DR4100 system) 
are bonded together to form one interface connection.

• For the 10-GbE and 10-GbE SFP+ ports, this means that to operate at maximum speed, only the two high-speed 
Ethernet ports are bonded together to form one interface connection.
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The DR Series system supports configuring the NICs to use either of the two following supported bonding 
configurations:

• ALB—adaptive load balancing (ALB) is the default; this configuration does not require special switch support, 
but it does require the data source machine to be on the same subnet as the DR Series system. The ALB is 
mediated by the Address Resolution Protocol (ARP).

• 802.3ad—also known as Link Aggregation Control Protocol (LACP) is used for copper-wired Ethernet 
applications; this configuration does require special switch management (the requirement being that it be 
managed from the switch).

For more information, see Configuring Networking Settings.

ALB and the 802.3ad are link aggregation methods that aggregate or combine multiple network connections in parallel to 
increase throughput beyond what a single connection could support.

Link aggregation for Ethernet connections also provides redundancy, in case one of the links fails. The DR Series system 
also comes with a Serial-Attached SCSI (SAS) card for future enhancements.

The DR Series system ships equipped with the 1-GbE, I-GbE, or 10-GbE SFP+ NIC. To visually differentiate between the 
NIC types, observe the markings on the NICs installed in the rear chassis of the DR Series system:

• 1-GbE NIC is labeled as GRN=10 ORN=100 YEL=1000

• 10-GbE NIC is labeled as 10G=GRN 1G=YLW

注: There are three key requirements to meet if you choose to use the 10-GbE NIC configuration: 1) use only CAT6a 
copper cabling, 2) you must have two switch ports capable of supporting 10-GbE NICs, and 3) you do not connect 
the 1-GbE ports.

注: There are three key requirements to meet if you choose to use the 10-GbE SFP+ NIC configuration: 1) use only 
Dell-supported SFP+ transceivers, 2) you must have two switch ports capable of supporting 10-GbE SFP+ NICs (and 
LC fiber-optic or twin-axial cabling), and 3) you do not connect the 1-GbE ports.

To verify the types of NICs that are installed in your system, click System Configuration → Networking to display the NIC 
information. For more information, see Configuring Networking Settings. In addition, you can also use the DR Series 
system CLI network --show command to display other NIC-related information.

监测系统使用情况

要显示当前 DR Series 系统的使用情况，请单击 Dashboard（仪表板）→ Usage（使用情况）以显示 Usage（使

用情况）页面。通过此页面可监测系统状态，当前显示的系统使用情况状态基于有效的 Latest Range（ 后范

围）或 Time Range（时间范围）。这些设置可定义 Usage（使用情况）页面上以下选项卡类别的输出：

• CPU Load（CPU 负载）

• System（系统）

• Memory（内存）

• Active Processes（活动进程）

• Protocols（协议）

• Network（网络）

• Disk（磁盘）

• All（全部）
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注: 单击 All（全部）之后，此选项卡显示以下 DR Series 系统状态类别：CPU Load（CPU 负载）、System 
Usage（系统使用情况）、Memory Usage - Total（内存使用情况 - 总量）、Memory Usage - Real（内存使用

情况 - 真实）、Active Processes - Total（活动进程 - 总量）、NFS Usage - Total（NFS 使用情况 - 总量）、

CIFS Usage - Total（CIFS 使用情况 - 总量）、Network Usage（网络使用情况）、Socket Usage - Total（套接

口使用情况 - 总量）、Active Connections（活动连接）、Disk Usage - Meta Data（磁盘使用情况 - 元数据）

和 Disk Usage - Data Storage（磁盘使用情况 - 数据存储）。

Displaying Current System Usage

To display the current usage for a DR Series system, complete the following:

1. Click Dashboard → Usage.
The Usage page is displayed.

2. View the current system usage based on the current Latest Range or Time Range values in effect (the default is the 
last 1-hour period). By default, the CPU Load is always the first tab that displays when the Usage page is selected.
The tabs you can display in the Usage page include: CPU Load, System, Memory, Active Processes, Protocols, 
Network, Disk, and All. For more information, see System Usage.

3. Click any of the system usage tabs to display the current status for that tab category (or click All to display all of the 
system usage tab results).
For example, click Protocols to display the current results for the NFS Usage - Total, CIFS Usage - Total, RDS Usage 
- Total, and OST Usage - Total for the system.

设置 Latest Range（ 后范围）值

要设置 Latest Range（ 后范围）值并显示基于此设置的系统状态结果，请完成以下操作：

1. 单击 Dashboard（仪表板）→ Usage（使用情况）。

此时将显示 Usage（使用情况）页面。

2. 单击 Latest Range（ 后范围）。

3. 在 Range（范围）下拉列表中选择想要的持续时间段（Hours（小时）、Days（日）或 Months（月））。

默认情况下，Hours（小时）是下拉列表中显示的第一个持续时间选项。

4. 在与所选 Range（范围）持续时间段相匹配的 Display last...（显示 近...）下拉列表中选择一个值。

例如，Hours（小时）（显示的默认显示时间段）会列出 1-24 之间的选项。如果选择 Days（日），则列出

的选项介于 1-31 之间，如果选择 Months（月），则列出的选项介于 1-12 之间。

5. 单击应用。

6. 单击与要基于所选设置查看的使用情况类型对应的选项卡（或单击 All（全部）显示基于所选设置的所有
系统结果）。

有关更多信息，请参阅使用情况和显示当前系统使用情况。

设置 Time Range（时间范围）值 

要设置 Time Range（时间范围）值并显示基于这些设置的系统状态结果，请完成以下操作：

1. 单击 Dashboard（仪表板） → Usage（使用情况） 。
此时将显示 Usage（使用情况）页面。

2. 单击 Time Range（时间范围）。

3. 在 Start Date（开始日期）中，单击 Start Date（开始日期）字段（或 Calendar（日历）图标）以显示当前
月份。
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要选择之前的月份，请单击月份标题栏中的左箭头以在当前年度（或之前年度）中选择所需月份。

4. 要在所选月份中选择 Start Date（开始日期），有两种选择：

– 在所选月份中选择特定的一天（仅显示可用天数）。未来天数不可用（显示为灰色）。

– 单击 Now（现在）可选择当前日期和时间（以 Hours（小时）和 Minutes（分钟）表示）（或使用 
Hour（小时）和 Minute（分钟）滑块来选择所需的时间值）。

5. 单击 Done（完成）以显示 Start Date（开始日期）中的日期和时间设置。

您设置的日期和时间设置以 mm/dd/yyyy hh:mm AM/PM 格式显示。

6. 在 End Date（结束日期）中，执行与设置 Start Date（开始日期）相同的过程以指定结束日期（或选择 Set 
“End Date” to current time（将“结束日期”设置为当前时间））。

7. 单击应用。

8. 单击与要使用设置选项监测的使用情况类型相对应的选项卡（或单击 All（全部）以显示基于您的设置选
项的所有系统使用情况选项卡结果）。

9. 查看基于所选条件的 DR Series 系统使用情况结果。

有关 Usage（使用情况）页面的更多信息，请参阅使用情况和显示当前系统使用情况。

监测容器统计信息

单击 Dashboard（仪表板）→ Statistics: Container（统计信息：容器）可监测在 Container Name:（容器名称：）

下拉列表中所选容器的统计信息，其当前统计信息显示在以下窗格中：

• Backup Data（备份数据）

• Throughput（吞吐量）

• Marker Type（标记类型）

• Connection Type（连接类型）

• Replication（复制）

有关更多信息，请参阅 Backup Data（备份数据）窗格、Throughput（吞吐量）窗格、Connection Type（连接类

型）窗格、Replication（复制）窗格、Statistics: Container（统计信息：容器）页面和编辑容器设置。

Displaying the Statistics: Container Page

To display container statistics for a selected container, complete the following:

1. Click Dashboard→ Statistics: Container.
The Statistics: Container page is displayed.

2. In the Container Name: drop-down list, select the container you want to monitor.

注: When you select a container, all statistics displayed on the Statistics: Container page represent specific 
information about the backup data, throughput, replication, marker type, and connection type for the selected 
container. The displayed statistics will vary depending upon the connection type used by the specified 
container.

3. View the current statistics in the Backup Data and Throughput panes.
The Backup Data pane displays the number of active files ingested based on time (in minutes), and the number of 
active bytes ingested based on time (in minutes). The Throughput pane displays the number of read data in 
Mebibytes/per second (MiB/s) based on time (in minutes), and the number of write data in MiB/s based on time (in 
minutes).

注: The Current Time Zone for the DR Series system is displayed below the Backup Data pane (for example, 
System Time Zone: US/Pacific).
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4. In the Backup Data and Throughput panes, click Zoom to select which duration period you want to display:

– 1h (1-hour is the default duration displayed)
– 1d (1-day)
– 5-d (five-day)
– 1m (1-month)
– 1y (1-year)

注: To refresh the values listed in the Backup Data and Throughput panes, click .

5. The Marker Type pane displays the marker type associated with the container (supported marker types include 
None, Auto, CommVault, Networker, TSM (Tivoli Storage Manager), or ARCserve.
If the Auto marker type is selected, this means all marker types will be detected. If you have a specific marker type 
selected (for example, CommVault), this means you have specified traffic to the container from that DMA type. If 
marker detection for the container is disabled, this means the None marker type is selected.

6. In the Connection Type pane, view information about the configured connection type for the selected container 
which can be NFS, CIFS, NFS/CIFS, RDS, or OST (the following example shows an NFS/CIFS container):

– NFS Connection Configuration pane—NFS access path, Client Access, NFS Options, and Map root to.
– CIFS Connection Configuration pane—CIFS share path and Client Access.
– If the container is an RDA connection type container, the Connection Type OST pane or Connection Type 

RDS — displays three tabs: Capacity, Duplication, and Client Statistics. The Capacity tab displays a 
Capacity pane with Status, Capacity, Capacity Used, and Total Images. The Duplication tab displays a 
Duplication Statistics pane with Inbound and Outbound statistics in the following categories: Bytes Copied 
(logical), Bytes Transferred (actual), Network Bandwidth Settings, Current Count of Active Files, and 
Replication Errors. The Client Statistics tab displays a Client Statistics pane with Images Ingested, Images 
Complete, Images Incomplete, Images Restored, Bytes Restored, Image Restore Errors, Image Ingest 
Errors, Bytes Ingested, Bytes Transferred, and Network Savings.

7. In the Replication pane (for NFS/CIFS connection types), view the replication information for the selected container 
in the following two panels:

– Replication Configuration—Enable, Role, Remote Container Name, Bandwidth, and encryption.
– Replication Status—Peer State, Replication State, Replication Average Transfer Rate, Replication Peak 

Transfer Rate, Network Average Transfer Rate, Network Peak Transfer Rate, Estimated Time to Sync (in 
days, hours, minutes, and seconds), Savings (in percentage), Last INSYNC Time (yyyy-mm-dd hh:mm:ss), 
and Schedule Status (next starting time in days, hours, minutes, and seconds).

监测复制统计信息

单击 Dashboard（仪表板）→ Statistics: Replication（统计信息：复制）可显示和监测 Replication Filter（复制筛

选器）窗格中所选的一个（或多个）容器和一个（或多个）对等 DR Series 系统的复制统计信息。根据配置的

设置，可监测和显示以下方面的复制统计信息：

• 所有容器

• 一个或多个特定容器

• 一个或多个对等 DR Series 系统

Replication Filter（复制筛选器）窗格包含 10 个标题复选框，选中这些复选框后，将显示 Container Filter（容器

筛选器）中所选容器或其他对等 DR Series 系统的复制统计信息。

选择容器、对等系统和复制统计信息类别后，单击 Apply Filter（应用筛选器）可基于所选的搜索条件显示复制

统计信息结果。

使用 Statistics: Replication（统计信息：复制）页面可选择性筛选并显示所有容器、一个或多个特定容器或者一

个或多个其他对等 DR Series 系统的特定类型的相关复制统计信息。
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有关复制统计信息的更多信息，请参阅显示复制统计信息、容器筛选器和显示 Statistics: Replication（统计信

息：复制）页面。

Displaying the Statistics: Replication Page

To display system replication container statistics for a selected container or another DR Series system, complete the 
following:

1. Click Dashboard→ Statistics: Replication.
The Statistics: Replication page is displayed.

2. To select a container or another peer DR Series system, choose the appropriate Container Filter option.

– Click All to choose all of the replication containers.

– Click Name, press Ctrl, and select the containers in the list box to select one or more containers in the list 
that you want to display.

– Click Peer System, press Ctrl, and select the peer systems in the list box to select one or more peer DR 
Series systems in the list that you want to display.

注: Only one of the Container Filter options can be active at any one time (they are mutually exclusive).

3. Select the Header check box(es) for the replication statistics categories for which you want to filter and display in 
the Replication Statistics summary table:

– Peer Status

– Replication Status

– Time to Sync

– Progress % (percentage)

– Replication Throughput

– Network Throughput

– Network Savings

– Last Sync in Time

– Peer Container

– Peer Status

注: The following five types of replication statistics are enabled by default: Peer Status, Replication Status, 
Network Throughput, Network Savings, and Progress %. If you choose more than five types of statistics 
(when you select additional check boxes), a horizontal scroll bar appears at the bottom of the Replication 
Statistics table. Use this scroll bar to display the columns of additional statistics that may not display within 
the main window.

4. Click Apply Filter to display the replication statistics types you selected to filter for your container or other peer DR 
Series system choices.
The Replication Statistics summary table displays the replication statistics types you selected in the Replication 
Filter pane.

To reset the default settings in the Replication Filter pane, click Reset.

To update the Replication Filter table after making a change, click Apply Filter to display an updated set of 
replication statistics.

注: Use the horizontal and vertical scroll bars to navigate through the columns of replication statistics 
displayed in the Replication Statistics summary table.

110



注: You can set up nightly replication statistics notification mails using the alerts --email --
daily_report yes command. For more information, see the Dell DR Series Systems Command Line Interface 
Guide at dell.com/support/manuals.

使用 CLI 显示复制统计信息

除了使用 DR Series 系统 GUI 显示复制统计信息外，还可以使用 DR Series 系统 CLI stats --replication --name 
<container name> 命令显示特定复制容器的统计信息，以查看以下复制容器统计信息类别：

• Container Name（复制容器的名称）

• Replication Source Container（用于标识数据源的名称）

• Replication Source System（数据源的 IP 地址或主机名）

• Peer Status（复制对等的当前状态；例如，暂停）

• Replication State（复制关系的当前状态；例如，同步中）

• Schedule Status（计划的当前状态，单位为天、小时、分钟、秒）

• Replication Average Throughput（复制平均吞吐率，单位为二进制千字节/秒 (KiB/s)）

• Replication Maximum Throughput（复制 大吞吐率，单位为 KiB/s）

• Network Average Throughput（网络平均吞吐率，单位为 KiB/s）

• Network Maximum Throughput（网络 大吞吐率，单位为 KiB/s）

• Network Bytes Sent（发送的网络字节总数，单位为二进制兆字节 (MiB)）

• Dedupe Network Savings（通过重复数据消除实现的网络节省总量，采用百分比形式）

• Compression Network Savings（通过压缩实现的网络节省总量，采用百分比形式）

• Last INSYNC Time（上次同步操作的日期，格式为 yyyy-mm-dd hh:mm:ss）

• Estimated time to sync（距离下次同步操作的时间，单位为天、小时、分钟和秒）

此外，系统还将按文件显示数据复制历史，并提供复制时间戳和其他与文件相关的信息。

有关 DR Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR 
Series 系统命令行参考指南）。
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7
使用 DR Series 系统支持选项
可使用 Support（支持）页面及其 Diagnostics（诊断）、Software Upgrade（软件升级）和 License（许可）选项

维护 DR Series 系统的状态。要访问这些选项，请使用 DR Series 系统导航面板（例如，单击 Support（支持）

→ Diagnostics（诊断）以显示 Diagnostics（诊断）页面）或使用 Support（支持）页面上的 Diagnostics（诊

断）、Software Upgrade（软件升级）或 License（许可）链接。

Support Information Pane
The Support page displays the Support Information pane, which provides the following information about the DR Series 
system:

• Product Name—DR Series system product name
• Software Version—DR Series system software version installed
• Service Tag—DR Series system appliance bar code label
• Last Diagnostic Run—timestamp of latest diagnostics log file (for example, Tue Nov 6 12:39:44 2012)
• BIOS Version—current version of installed BIOS
• MAC Address—current address in standard two-digit hexadecimal grouping format
• iDRAC IP Address—current IP address of iDRAC (if applicable)
• Ethernet Ports—displays information about bonded ports only (if the 10-GbE NICs are installed, it only displays 

information about the two supported 10–GbE ports):

– Eth0 MAC address and port speed
– Eth1 MAC address and port speed
– Eth2 MAC address and port speed in
– Eth3 MAC address and port speed in

注: This example shows four Ethernet ports bonded (such as if a DR4000 system with 1–GbE ports as a 
single interface). For more information on possible port configurations, see the system chassis 
descriptions in Local Console Connection.

注: The Support Information pane contains important information that may be needed if you contact Dell Support 
for any technical assistance.

注: For additional system information, click Dashboard in the navigation panel to display its System Information 
pane, which lists Product Name, System Name, Software Version, Current Date/Time, Current Time Zone, Cleaner 
Status, Total Savings (in percentage), Total Number of Files in All Containers, Number of Containers, Number of 
Containers Replicated, and Active Bytes.

Diagnostics（诊断）页面和选项

使用 Diagnostics（诊断）页面上的选项可生成捕捉系统当前状态的新诊断日志文件（Generate（生成））、将

诊断日志文件下载至本地系统（Download（下载））或删除现有诊断日志文件（Delete（删除））。

注: 有关诊断日志文件、日志文件目录和诊断服务的更多信息，请参阅关于诊断服务。
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DR Series 诊断日志文件是一个捆绑包，包含记录 新系统设置的各种文件类型，并将其保存为压缩的 .lzip 文
件格式。Diagnostics（诊断）页面通过以下属性标识每个诊断日志文件：

• File name（文件名）- 格式为 <hostname>_<date>_<time>.lzip，如本例所示：acme-
sys-19_2012-10-12_13-51-40.lzip

注: 诊断日志文件名被限制为 128 个字符。

• Size（大小）- 单位为兆字节（例如 58.6 MB）。

• Time（时间）- 日志文件的创建时间戳（例如 Fri Oct 12 13:51:40 2012）。

• Reason for generation（生成原因）- 说明生成日志文件的原因（例如，[admin-generated]：管理员生
成）。

注: 诊断原因说明被限制为 512 个字符，并且只能使用 DR Series 系统 CLI 添加说明。

• Status（状态）- 指示日志文件的状态（例如 Completed（已完成））。

显示 Diagnostics（诊断）页面的方法有两种：

• 使用 Support（支持）页面（通过 Diagnostics（诊断）链接访问 Diagnostics（诊断）页面）。

• 使用 Support（支持） → Diagnostics（诊断） （从导航面板访问 Diagnostics（诊断）页面）。

如果有多页诊断日志文件，可使用 Diagnostics（诊断）摘要表下部的控件导航至另一页面：

• 单击 prev（上一页）或 next（下一页）可向后或向前移动一页。

• 双击列出的页码（在 Goto（转至）页面旁边）。

• 在 Goto（转至）页面中输入页码，然后单击 Go（前往）。

• 使用 Diagnostics（诊断）摘要表右侧的滚动条可查看所能显示的所有诊断日志文件。

注: 在 Diagnostics（诊断）摘要表中还可以设置每页要显示的条目数。在 View per page（每页查看量）下

拉列表中，单击 25 或 50 以选择需要显示的条目数量。

Generating a Diagnostics Log File 

A DR Series diagnostics log file is a bundle that contains a variety of file types that record the latest system settings, and 
saves them in a compressed .lzip file format. The Diagnostics page identifies each diagnostics log file by the following 
attribute types:

• File name

• Size

• Time

• Reason for generation

• Status

注: When you generate a diagnostics log file bundle, it contains all of the DR Series system information that may be 
needed when contacting Dell Support for technical assistance.

The diagnostics log file bundle collects the same type of hardware, storage, and operating system information collected 
by the Dell System E-Support Tool (DSET) from the Dell DR Series system hardware.

The diagnostics log file bundle is identical to one created using the DR Series system CLI diagnostics --collect --dset 
command. System diagnostics information can assist Dell Support when troubleshooting or evaluating your DR Series 
system.
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To generate a diagnostics log file bundle for your system, complete the following:

1. Select Support → Diagnostics in the navigation panel.
The Diagnostics page is displayed, and this page lists all current diagnostics log files.

2. Click Generate.
A New log file is scheduled dialog is displayed.

3. To verify that a new diagnostics log file is being generated, check the status of the diagnostics log file by selecting 
Support → Diagnostics.
The Diagnostics page is displayed, and a status showing In-progress indicates that a new diagnostics log file is 
being generated.

Once completed, the new diagnostics log file resides at the top of the File Name column in the table. To verify, check its 
timestamp (using its date and time), to ensure this is the latest diagnostics file created.

注: When you generate a diagnostics log file bundle, it contains all of the DR Series system information that may be 
needed when contacting Dell Support for technical assistance. This also includes all the previous auto-generated 
diagnostics log files, which are then deleted from the DR Series system.

The diagnostics log file bundle collects the same type of hardware, storage, and operating system information collected 
by the Dell System E-Support Tool (DSET) from the Dell DR Series system appliance hardware:

• To collect a DSET log file, use the DR Series system CLI command, diagnostics --collect --dset.

• To collect the comprehensive DR Series system diagnostics log file bundle (which also includes DSET 
information), use the DR Series system CLI command, diagnostics --collect.

下载诊断日志文件

要显示 Diagnostics（诊断）页面并打开或下载现有诊断日志文件，请完成以下操作：

1. 在导航面板中单击 Support（支持）→ Diagnostics（诊断）。

此时将显示 Diagnostics（诊断）页面，其中将列出系统允许的所有当前诊断日志文件。

2. 单击 Select（选择）以标识要下载的诊断日志文件，然后单击 Download（下载）（或单击诊断日志文件名
链接）。

此时将显示 File Download（文件下载）对话框。

注: 正在生成新诊断日志文件（并且其 Status（状态）显示为 In-progress（进行中））时，诊断日志

文件名链接处于非活动状态，而如果尝试选择此文件，Download（下载）选项会被禁用。

3. 根据以下情况将文件下载至所需位置：

a) 如果从基于 Linux 的系统访问 DR Series 系统 GUI：请单击 Save File（保存文件）并导航至不同文件夹位
置，定义新文件名（或保留现有文件名），然后单击 Save（保存）将诊断日志文件保存至指定的文件
夹位置。

b) 如果从基于 Windows 的系统访问 DR Series 系统 GUI：请单击 Save（保存）（或 Save As（另存
为）），导航至 Downloads（下载）文件夹并检索此诊断日志文件。

删除诊断日志文件

要从 Diagnostics（诊断）页面上的 Diagnostics（诊断）摘要表中删除现有诊断日志文件，请完成以下操作：

1. 选择 Support（支持） → Diagnostics（诊断） 。
此时会显示 Diagnostics（诊断）页面。

2. 单击 Select（选择）以选择要删除的诊断文件，然后单击 Delete（删除）。

此时将显示 Delete Confirmation（删除确认）对话框。
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3. 单击 OK（确定）以删除所选的诊断日志文件（或单击 Cancel（取消）以显示 Diagnostics（诊断）页
面）。

成功时，会显示 Log file was removed successfully（已成功移除日志文件）对话框。

DR Series System Software Upgrade
When you initiate a DR Series system software upgrade, the navigation panel displays only the Support page and the 
Software Upgrade options.

The administrator that initiated the software upgrade (considered the initiator administrator) will see a System 
Information pane that displays an alert that reads IMPORTANT: Please do not navigate out of this 
screen until the upgrade is finished, and displays the upgrade status as Upgrade in 
Progress... Please wait.... The Current Version and Upgrade History versions of the DR Series system 
software are listed in the Software Info pane.

All other administrators that may be logged into DR Series system (with the exception of the initiator administrator who 
started the software upgrade), will only see a dialog that displays Status: The system is being 
upgraded. Wait for it to become operational.

There are only three possible outcomes during a DR Series system software upgrade operation:

• The upgrade operation completed successfully—no reboot is required.

• The upgrade operation completed successfully—but a reboot is required (click Reboot in the Software Upgrade 
page).

• The upgrade operation failed.

Software Upgrade（软件升级）页面和选项

使用 Software Upgrade（软件升级）页面验证 Software Information（软件信息）窗格中 DR Series 系统软件的当

前安装版本。可使用两种方法显示 Software Upgrade（软件升级）页面：

• 使用 Support（支持）页面，单击 Software Upgrade（软件升级）。

• 使用导航面板，选择 Support（支持） → Software Upgrade（软件升级） 。

这两种方法均可显示 Software Upgrade（软件升级）页面，在此页面上可使用其中的选项验证当前安装版本，

检查以前安装的软件版本的升级历史，验证 iDRAC IP 地址（如果正在使用），启动升级过程或重新引导 DR 
Series 系统。

注: 在 DR Series 系统软件升级期间，升级状态“starting”（正在启动）几乎在整个软件升级过程中一直显

示。直至 DR Series 系统升级状态更改为“almost done”（几乎完成），系统升级过程才彻底完成。

Verifying the Current Software Version 

To verify the currently installed version of the DR Series system software, complete the following:

注: You can verify the version of the installed DR Series system software in the Dashboard page (in the System 
Information pane), the Support page (in the Support Information pane), and the Software Upgrade page (in the 
Software Information pane).

The following procedure documents the process from the Software Upgrade page.

1. In the navigation panel, select Support and click Software Upgrade (or select Support→ Software Upgrade).
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The Software Upgrade page is displayed.

2. Verify the currently installed DR Series system software version listed as Current Version in the Software 
Information pane (all previously installed versions are listed under Upgrade History, showing the version number 
and timestamp when installed).

Upgrading the DR Series System Software

To upgrade the DR Series system software, complete the following:

注: The DR Series system only supports the copying of upgrade images and diagnostics files to and from the 
system using WinSCP. The DR Series system does not support the copying or deleting of any other file types using 
WinSCP. To use WinSCP to copy DR Series software upgrade and diagnostics log files, ensure that the File 
Protocol mode is set to SCP (Secure Copy) mode.

注: You can use other SCP tools with the DR Series system, but you cannot use these other SCP tools to copy other 
types of files to or from the DR Series system.

1. Using the browser, go to support.dell.com, navigate to the DR4000 product page, and enter your service tag.

2. In the Dell DR Series Drivers & Downloads page, click Find Drivers & Downloads.
The Drivers & Downloads page displays a listing of downloadable firmware, utilities, applications, and drivers for 
the DR Series system.

3. Locate the IDM section of the Drivers & Downloads page, which includes the Dell-Utility (DR Series Upgrade File) in 
the format, DR4x00-x.x.x.x-xxxxx.tar.gz, and showing its release date and version.

4. Click Download File, click For Single File Download via Browser, and click Download Now.
The File Download dialog is displayed.

5. Click Save to download the latest system software upgrade file to the DR Series system that is running the browser 
session started by the DR Series administrator.

6. Using the DR Series system GUI, select Support, and click the Software Upgrade link (or select Support → 
Software Upgrade).
The Software Upgrade page is displayed.

7. Type the path of the software upgrade file in the Select the upgrade file from local disk (or click Browse..., and 
navigate to the location where you downloaded the system software upgrade file).

8. Select the software upgrade file, and click Open.

9. Click Start Upgrade.
When you initiate a DR Series system software upgrade, the navigation panel displays only the Support page and 
the Software Upgrade option.

The administrator that initiated the software upgrade (known as the initiator administrator) sees a System 
Information pane that displays an alert and upgrade status, and the Current Version and Upgrade History versions 
of the DR Series system software listed in the Software Info pane.

All other administrators that may be logged into DR Series system (excluding the initiator administrator), only.

There are only three possible outcomes during a DR Series system software upgrade operation:

– Upgrade has completed successfully—no reboot is required.

– Upgrade has completed successfully—but a reboot is required (click Reboot in the Software Upgrade 
page).

– Upgrade has failed.
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注: If the DR Series system software upgrade operation fails, you can reboot the system and attempt another 
software upgrade operation using the DR Series system GUI. If this is unsuccessful, you can use the DR 
Series system CLI system --show command to view the current System State status. DR Series system 
software upgrades can also be performed using the DR Series system CLI. For details, see the Dell DR Series 
System Command Line Reference Guide at dell.com/support/manuals/. If both the DR Series system GUI and 
CLI attempts are unsuccessful, contact Dell Support for assistance.

Restore Manager (RM)
The Dell Restore Manager (RM) utility can be used to restore the DR Series system software. RM can be used when a 
non-recoverable hardware or software failure prevents the DR Series system from functioning correctly.

RM can also be used to reset the system back to its initial factory settings when moving it from a test environment to a 
production environment. RM supports the following two modes:

• Recover Appliance—in Recover Appliance mode, RM reinstalls the operating system and attempts to recover 
the prior system configuration and the data residing in the containers.

注: To use the Recover Appliance mode, you must use an RM build that is compatible with the DR Series 
system software version that was running before the OS reset was attempted.

• Factory Reset—in a Factory Reset mode, RM reinstalls the operating system and resets the system 
configuration back to the original factory state. It is important to note that when doing a factory reset, all of the 
containers and the data in the containers gets deleted.

小心: Using the Factory Reset mode deletes all of the DR Series system data. The Factory Reset mode must only be 
used when the container data is no longer needed.

Downloading the Restore Manager

The Dell Restore Manager (RM) utility runs from a USB boot key that contains the RM image, which must first be 
downloaded from the Dell Support site.

1. Using a supported web browser, navigate to support.dell.com.

2. Enter the DR4100 system Service Tag to be directed to the DR Series system download page (or choose a product 
category).

3. Navigate to the Drivers & Downloads page.

4. In the Category drop-down list, select IDM.

5. If required, expand the IDM category to list the available IDM download files.

6. Locate, select, and download the DR4100 Restore Manager file (listed in the following RM filename format, "DR4000-
UM-x.x.x.xxxxx.tag.gz").

创建 Restore Manager USB 闪存盘

要创建 Restore Manager (RM) USB 闪存盘，必须先从 Dell 支持站点下载 RM 映像 (.img) 文件，然后将此文件传输

到 USB 闪存盘。USB 闪存盘的大小必须至少为 4 GB（千兆字节）或更大。当 Windows USB 映像工具满足以下

条件时，可使用它们传输 RM 映像：

• 支持使用 .img 文件格式

• 支持使用直接的数据块到数据块的设备复制，以确保 USB 闪存盘是可引导的
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要将 RM 映像传输至 Linux 或 Unix 系统上的 USB 闪存盘，请执行以下操作：

1. 将下载的 RM 映像文件复制到 Linux 或 Unix 系统。

2. 将 USB 闪存盘插入到 Linux 或 Unix 系统上可用的 USB 端口。

记住操作系统报告的设备名称（例如 /dev/sdc4）。

3. 此时不要在本地将 USB 设备装载到文件系统。

4. 使用 dd 命令将 RM 映像复制到 USB 闪存盘：

dd if=<path to .img file> of=<usb device> bs=4096k

例如：

dd if=/root/DR4100-UM-04.49.01.00.00.34555.img of=/dev/sdc4 bs=4096

运行 Restore Manager (RM)

要运行 Dell Restore Manager (RM) 公用程序，请使用在创建 RM USB 闪存盘中创建的 RM USB 闪存盘引导 DR 
Series 系统。

1. 将 RM USB 闪存盘插入系统上可用的 USB 端口。

还可以使用 iDRAC 的虚拟介质选项远程加载 RM USB 闪存盘。有关更多信息，请参阅 Integrated Dell 
Remote Access Controller 6 (iDRAC6) User Guide（集成式 Dell Remote Access Controller 6 (iDRAC6) 用户指南）

中的 Configuring and Using Virtual Media（配置和使用虚拟介质），网址为 support.dell.com/support/edocs/
software/smdrac3/。

2. 使用 RM USB 闪存盘引导 DR Series 系统。

3. 显示开机自检 (POST) 屏幕时，按 F11 加载 Boot Manager。

4. 在 Boot Manager 内，导航到系统硬盘驱动器 (C:)，选择 USB 闪存盘作为根设备，然后按 <Enter>。

5. 几分钟后，Restore Manager 将加载并显示其主屏幕。

6. 选择所需的 Restore（还原）模式（Recover Appliance（恢复设备）或 Factory Reset（重置为出厂设
置））。

7. 输入确认字符串，然后按 <Enter> 继续。

小心: Factory Reset（重置为出厂设置）模式将删除所有 DR Series 数据。只有不再需要容器数据时，

才能使用 Factory Reset（重置为出厂设置）模式。

注: Restore Manager 完成任务后，只有管理员帐户保持启用状态。要重新启用根帐户或服务帐户，请

参阅 Dell DR Series System Command Line Reference Guide（Dell DR Series 系统命令行参考指南）中的 

DR Series 系统 CLI 命令 user --enable --user。

注: 如果在运行 Restore Manager 之前预先将 DR Series 系统加入任何 Active Directory 服务 (ADS) 域，

则运行结束后，需要手动重新加入所需的 ADS 域。有关加入 ADS 域的信息，请参阅配置 Active 
Directory 设置。

Resetting the Boot LUN Setting in PERC H700 BIOS After Running RM

In the event that both of the 2.5-inch 300 GB 10K RPM 6 GB/s SAS internal drives (OS) in RAID1 are replaced, you must 
run the Dell Restore Manager (RM) utility to recover the DR Series system OS drives.

Following the RM recovery process, the boot logical unit number (LUN) has to be reset to VD0 RAID1. The DR Series 
system unsuccessfully attempts to boot from RAID6 instead of RAID1.
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To resolve this issue, reset the Dell PERC H700 BIOS to revise the proper boot order setting to configure the proper boot 
LUN to be RAID1. To reset the proper LUN boot order, complete the following steps:

1. Start Restore Manager.

2. Select Option 1 → Recover My Appliance.
The OS Virtual Disk is created: Warning Code 2002 dialog is displayed.

3. Click Proceed.
The Operating System installation was successful dialog is displayed.

4. Click Reboot, and during reboot, press Ctrl+R to enter the PERC BIOS.
The PERC BIOS Configuration Utility page is displayed.

5. Select Controller 0: PERC H700 in the list.

6. Press Ctrl+N twice to select the Ctrl Mgmt (Controller Management) tab.

7. Select Ctrl Mgmt, click Select bootable VD, and select VD 0 as the VD0 RAID1.

8. Click Apply, and reboot the DR Series system.
The RM Recover My Appliance mode process will then complete.

卸下或更换硬件

要正确卸下或更换任意 DR Series 系统硬件，必须遵守并使用关闭和启动过程的 佳做法。有关全套卸下和更

换过程及其分步说明，请参阅 Dell DR Series System Owner’s Manual（Dell DR Series 系统所有者手册）。

有关 佳做法的更多信息，请参阅 DR Series 系统：正确关闭和启动和关闭 DR Series 系统。

DR Series 系统：正确关闭和启动

在 DR Series 系统中尝试卸下或更换任何硬件组件之前，请确保遵循以下 佳做法正确关闭和启动系统：

1. 通过在 System Configuration（系统配置）页面中选择 Shutdown（关闭）来关闭 DR Series 系统。

有关更多信息，请参阅关闭 DR Series 系统。可用于关闭系统的另一种方法是 DR Series 系统 CLI 命令 

system --shutdown。

2. 等待 DR Series 系统彻底完成其关闭过程。

关闭过程完成后，电源设备状态指示灯将熄灭。

3. 从电源插座中拔下 DR Series 系统电源线插头。

4. 请再等一段时间（ 多 10 分钟），并/或验证系统机箱后面板上的所有绿色和琥珀色 NVRAM LED 都熄灭。

注: 如果没有让 NVRAM 超级电容器有足够的时间来放电，则 DR Series 系统随后启动时，NVRAM 状态

将报告 DATA LOSS（数据丢失）。

5. 打开插闩释放锁，向后将 DR Series 系统护盖滑离，以接触到设备内部组件。

要接触到 DR Series 系统的内部，请卸下护盖。有关更多信息，请参阅 Dell DR Series System Owner’s 
Manual（Dell DR Series 系统所有者手册）中的过程。

6. 根据需要卸下和更换系统硬件组件。

7. 装回护盖，将系统电源线重新连接到电源插座。

8. 按开机指示灯/电源按钮开启 DR Series 系统。

DR Series 系统 NVRAM

NVRAM 是 DR Series 系统中的现场可换单元 (FRU)。为 NVRAM 双数据速率 (DDR) 内存供电的超级电容器必须在

电源中断期间能够将其内容移动到固态驱动器 (SSD)。
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此数据传输过程需要能维持系统运行 3 分钟的电量（一般而言，此过程大约只需要一分钟）。如果在数据备份

到 SSD 时出现问题，系统后续重新引导时会检测到。出现以下情况时，NVRAM 可能会发生备份故障：

• NVRAM 在电源中断期间备份数据失败

• 超级电容器没有维持足够的电量将 DDR 内容备份到 SSD。

• NVRAM/SSD 遇到行尾 (EOL) 错误或另一个错误。

如果出现以上任意一种情况，NVRAM 需要执行故障恢复或更换。

注: Dell 建议使用以下任一 DR Series 系统 CLI 命令，在更换 NVRAM 之前采用以下支持的方法将 NVRAM 中
的 DR Series 系统数据刷新到 RAID6 中：system --shutdown 或 system --reboot。

注: 如果需要卸下或更换 DR Series 系统中的 NVRAM，请参阅关闭 DR Series 系统和 NVRAM 现场更换。

NVRAM 备份故障恢复

更换 DR Series 系统机箱内 PCIe x4（或 x8）插槽中的 NVRAM 卡后，可通过完成以下任务从 NVRAM 备份故障中

恢复：

小心: 启动 DR Series 系统后必须至少等待 20 分钟，才能使用 DR Series 系统 CLI 命令：maintenance --
hardware --reinit_nvram。在启动后等待的这 20 分钟时间里，NVRAM 卡、超级电容器校准和所有固态驱动

器 (SSD) 进程可全部完成，这是 DR Series 系统正常运行所必需的。

在 Maintenance（维护）模式下，DR Series 系统将确定、检测和修复数据丢失问题。在系统重新引导的过程

中，它将确保 NVRAM 上不保留有价值的数据。

1. 输入以下 DR Series 系统 CLI 命令：maintenance --hardware --reinit_nvram。

这将通过再次初始化 NVRAM，从而格式化 SSD，并清除所有备份和还原日志。

2. 验证 DR Series 系统是否已进入其维护模式。

有关更换 NVRAM 的更多信息，请参阅 NVRAM 现场更换和 DR Series 系统：正确关闭和启动。

NVRAM 现场更换

每当现场更换 DR Series 系统 NVRAM 时，都必须遵守以下 佳做法中的过程：

小心: 启动 DR Series 系统后必须至少等待 20 分钟，才能使用 DR Series 系统 CLI 命令：maintenance --
hardware --reinit_nvram。在启动后等待的这段时间里，NVRAM 卡、超级电容器校准和 SSD 进程可全部完

成，这是 DR Series 系统正常运行所必需的。

注: 有关更多信息，请参阅 DR Series 系统：正确关闭和启动。

1. 验证 DR Series 系统软件是否检测到 NVRAM 新接入系统。

2. 输入以下 DR Series 系统 CLI 命令：maintenance --hardware --reinit_nvram。

此命令可初始化 NVRAM，创建新分区，并更新 DR Series 系统软件在内部使用的信息。

3. 验证 DR Series 系统是否已进入其维护模式。

正确初始化后，DR Series 系统将自动进入维护模式。文件系统检查器会检查每个数据块映射和数据存

储，以确定 NVRAM 故障期间丢失了多少数据。

121



122



8
配置和使用 OST
本主题介绍主要的 OpenStorage 技术 (OST) 任务，并提供其他 OST 相关主题的链接，这些主题包含说明如何执
行以下任务的过程：

• 配置 DR Series 系统以配合 OST 和支持的 DMA 使用；有关更多信息，请参阅使用 Backup Exec GUI 配置 
DR Series 系统和使用 NetBackup 配置 DR Series 系统信息

• 使用 DR Series 系统 GUI 配置逻辑存储单元 (LSU)；有关更多信息，请参阅配置 LSU

• 将 Dell OST 插件安装到支持的媒体服务器（Linux 或 Windows）；有关更多信息，请参阅安装适用于 
Linux 的 OST 插件或安装适用于 Windows 的 OST 插件

• 使用支持的 Symantec DMA（NetBackup 和 Backup Exec）执行备份和还原操作；有关更多信息，请参阅

– 使用 NetBackup 从 DR Series 系统备份数据

– 使用 NetBackup 从 DR Series 系统还原数据

– 使用 NetBackup 在 DR Series 系统之间复制备份映像

– 使用 Backup Exec 在 DR Series 系统上创建备份

– 使用 Backup Exec 从 DR Series 系统还原数据

– 使用 Backup Exec 优化 DR Series 系统之间的复制

注: 这项使用 OST 的功能又称为 Dell 内的 DR 快速数据访问，它更紧密地实现了与备份软件应用程序（例
如此版本中支持的两个启用 Symantec OpenStorage 的备份应用程序：NetBackup 和 Backup Exec）的集
成。

了解 OST
OpenStorage 技术 (OST) 提供可与网络存储设备配合使用的逻辑磁盘接口，而 DR Series 系统设备需要插件软件
才能将其数据存储操作与以下支持的数据管理应用程序 (DMA) 集成：

• NetBackup

• Backup Exec

DR Series 系统使用 Dell OpenStorage 插件与这些支持的 DMA 集成。NetBackup 和 Backup Exec 均可通过此插件

控制备份映像的创建、复制和删除时间。DMA 可通过此插件充分利用重要的 DR Series 系统功能，例如复制和

重复数据消除。

DR Series 系统通过 Dell OST 插件访问 OpenStorage API 代码。此插件可安装在所选的受支持媒体服务器平台

（Windows 或 Linux）上。当 OST 与 DR Series 系统配合使用时，可提供以下好处：

• OST 协议有助于更快、更好地传输数据：

– 致力于以 小的开销进行备份

– 容许传输更大规模的数据

– 提供显著优于 CIFS 或 NFS 的吞吐量

• OST 和 DMA 集成：

– OpenStorage API 可实现 DMA 与媒体服务器软件间的通信

– 无需大量更改 DMA 即可使用 DR Series 系统存储功能
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– 通过使用内置的 DMA 策略来简化备份和复制操作

• DR Series 系统和 OST 端口与写操作：

– 控制通道使用 TCP 端口 10011

– 数据通道使用 TCP 端口 11000

– 优化写操作支持在客户端侧执行重复数据消除

• DR Series 系统之间的复制操作：

– 源或目标 DR Series 系统上不需要配置

– 复制是基于文件的，而非基于容器

– 复制由 DMA 优化的复制操作触发

– DR Series 系统传输数据文件（而非媒体服务器）

– 复制完成后，DR Series 系统会通知 DMA 更新其目录（确认第二次备份）

– 支持源和副本之间采用不同的保留策略

– 复制是在 DMA 本身中设置，而非在 DR Series 系统中设置

OpenStorage 技术 (OST) API
OpenStorage 技术 (OST) API 是应用程序编程接口，可使诸如 DR Series 系统等基于磁盘的设备在本机与两个支

持的 Symantec 数据管理应用程序 (DMA) NetBackup 和 Backup Exec 集成。例如，由于 DR Series 系统支持重复

数据消除和复制，OST API 可使这两个支持的 DMA 使用 DR Series 系统设备功能并将优化后的数据从一个存储

设备复制到另一存储设备。

OST API 支持将数据写入磁盘，以下示例对此进行了说明，其中 NetBackup (DMA) 使用 OST API 与 DR Series 系
统（数据备份和重复数据消除设备）交互：

• NetBackup 需要将文件存储至磁盘。为此，它通过 OST API 将需要备份的文件以及此文件的命名通知 DR 
Series 系统。

• DR Series 系统接受此文件并对其进行备份，然后将文件存储在其文件系统中。

• NetBackup 可对此特定存储文件执行以下三项后续操作之一：

– 使文件期满

– 从文件还原

– 拷贝或复制文件

• 如果使用 OST API 的 NetBackup 指示 DR Series 系统使存储文件到期，DR Series 系统会将存储文件从其
文件系统中删除。

• 与此类似，如果使用 OST API 的 NetBackup 要从存储文件还原，它将向 DR Series 系统指示要还原的文
件，DR Series 系统随后会将存储文件发送至 NetBackup 以进行还原。

注: OST 包含一项名为优化复制的功能。例如，在优化复制中，DMA (NetBackup) 指示设备 A 与设备 B 执
行优化复制。设备 A 和 B 通信并确定文件中需要从 A 复制到 B 的数据段，以确保设备 B 包含完整的重复

数据文件。操作成功后，DMA 即知道此数据文件存在两个副本，并可在设备 B 上像使用其中的任何其他

数据文件一样使用此文件。

OST 准则

为获得 佳结果，请遵守以下准则，以便在 DR Series 系统中以 佳性能执行支持的 OpenStorage 技术 (OST) 操
作：

• 备份、还原和优化的重复数据消除操作需要通过 Dell OST 插件执行

注: 客户端系统上需要安装 Dell OST 插件才能支持客户端侧的重复数据消除。
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• 支持的 佳聚合吞吐率：

– 对于传送写操作，吞吐率为每小时 3 太字节 (TB/hr)

– 对于优化写操作，吞吐率为 4 TB/hr

注: 传送写操作是指直接将数据从媒体服务器发送给 DR Series 系统而不对数据应用任何优化，而
优化写操作则是指先对数据应用优化，再从媒体服务器向 DR Series 系统发送数据。

• 备份：

– 传送写操作

– 优化写操作

• 还原

• 复制

OST Terminology
This topic introduces and briefly defines some basic OpenStorage Technology (OST) terminology used throughout the 
DR Series system documentation.

Term Description

BE Symantec DMA, Backup Exec (BE).

DMA/DPA Data Management Application (also known as Data Protection 
Application), which are terms for the role played by the Symantec 
NetBackup or Backup Exec applications.

LSU Logical Storage Unit, which from the DR Series system perspective, 
represents any container created for data storage. LSU is a common 
storage term while container is a common term in DR Series systems 
that represents a location for storing data.

media server This is the host running the DMA media server (NetBackup and Backup 
Exec), and is where the OST plug-in is installed. The OST plug-in can 
also be installed on a NetBackup client.

NBU Symantec DMA, NetBackup (NBU).

OST The OpenStorage Technology from Symantec, which allows storage 
devices to deliver backup and recovery solutions with NetBackup. OST 
uses the OpenStorage API and a plug-in installed on either a Linux or a 
Windows-based media server platform.

Supported OST Software and Components
This topic provides a brief listing of some of the supported OST software and components that can be used with the DR 
Series system.

注: For the latest list of supported DMAs and OST plug-ins, see the Dell DR Series System Interoperability Guide, at 
support.dell.com/manuals.

表. 5: Supported OST Software and Components

Software or Component Description

OST Server Components
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Media Server Component resides on the DR Series system

• Linux installations • Uses a Linux OST plug-in and the Red Hat Package 
Manager (RPM) installer

• Windows installations • Uses a Windows OST plug-in and the Microsoft installer 
(MSI)

OST Plug-In Component

Windows-based 64–bit Supported releases:

• Windows Server 2003
• Windows Server 2008
• Windows Server 2008, Release 2

Linux-based 64–bit Supported releases:

• Red Hat Enterprise Linux, version 5.x
• Red Hat Enterprise Linux, version 6.x
• SUSE Linux Enterprise Server, version 10 and 11

OST Protocol

Symantec OpenStorage Supported releases:

• Symantec, versions 9 and 10

Supported DMAs

Symantec (Linux and Windows 64–bit versions) Supported releases:

• NetBackup

– Versions 6.5, 7.1, and 7.5 (Windows Server 2003, 
32–bit)

– Version 7.5 (Windows Server 2008, 32–bit)
– Version 7.5 (Windows Server 2008 R2, 64–bit)
– Version 7.1 (Red Hat Enterprise Linux 5.x)
– Version 7.5 (SUSE Linux Enterprise Server 11 SP2, 

64–bit)
• Backup Exec

– Version 2010 R3 (Windows Server 2008 R2, 64–bit)
– Version 2012 (Windows Server 2008 R2, 64–bit)

注: The Dell DR Series system licensing is all-inclusive, so that no additional Dell licensing is required to use OST 
or the optimized duplication capability. The Dell OST plug-in that gets installed on a supported Linux or Windows 
media server platform is a free download from Dell. However, Symantec NetBackup requires that you purchase a 
Symantec OpenStorage Disk Option license. Similarly, Symantec Backup Exec requires that you purchase the 
Deduplication Option to enable the OST feature.
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OST Required Configurations
This topic introduces three possible required configurations to enable OpenStorage Technology (OST) operations: DR 
Series system and a DMA-based media server or client (for example, OST operations that support a NetBackup-media 
server, a Backup Exec-media server, or a Backup Exec-client).

佳做法：OST 和 DR Series 系统

本主题介绍对 DR Series 系统使用 OpenStorage 技术 (OST) 操作的一些 佳做法建议。

• OST 和非 OST 容器可存在于同一 DR Series 系统上。DR Series 系统支持同一设备上拥有 OST 和非 OST 容
器。然而，这可能导致容量报告错误，因为两个容器类型共享相同的底层存储。

• OST 复制和非 OST 复制在同一 DR Series 系统上。非 OST 复制需要进行配置，并按容器进行复制。然
而，这种类型的复制不会复制 OST 容器。OST 复制是基于文件的，由 DMA 触发。

• 请勿将容器连接类型从 NFS/CIFS 更改为 OST。必须先删除非 OST 容器，然后才能将此容器创建为同名 
OST 容器。

设置客户端侧的优化

客户端侧的优化过程可节省备份操作的执行时间，并降低网络上的数据传输开销。

可使用 DR Series 系统 CLI 命令 ost --update_client --name --mode 开启或关闭客户端侧的优化（又称为客户端侧

的重复数据消除）。有关 DR Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line 
Reference Guide（Dell DR Series 系统命令行参考指南），网址为 support.dell.com/manuals。

Configuring an LSU
You can configure a logical storage unit (LSU) as an OpenStorage Technology (OST) connection type container for data 
storage by using the DR Series system GUI. To configure an LSU as an OST connection type container, log in to the DR 
Series system and complete the following:

1. Navigate to the Containers page (in the Dashboard navigation panel).

2. Click Create to create a new container.
The Create New Container dialog is displayed.

3. In Container Name, enter a name for the container.

4. In Marker Type, select the None marker type.
For OST operations, only the NetBackup and Backup Exec media servers are supported.

5. In Connection Type, set the container type to OST.
The OST pane is displayed, and this is where you can set the capacity for the OST connection type container.

6. In Capacity, select either the Unlimited or Size options to set the capacity for the OST connection type container.
If you select Size, make sure to define the desired size in Gibibytes (GiB).

7. Click Create a New Container (or click Cancel to display the Containers page).

注: For general information about creating DR Series system containers, see Creating Containers, and for creating 
an OST connection type container, see Creating an OST or RDS Connection Type Container.
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注: The capacity option in this command example sets the quota on the LSU. This is the maximum number of bytes 
(ignoring optimization) that can be written to an LSU and it is listed in the gigabytes (GB). If the capacity option is 
not specified (or if 0 is specified for the capacity), then the LSU will not have a quota. If this is the case, then this 
means that the amount of data that can be written to the LSU is limited only by the amount of free space on the 
disk.

Installing the Dell OST Plug-In
Before you can start the installation process for the Dell OST plug-in, you need to understand its role. The Dell OST plug-
in must be installed on to the media server type you choose (this DR Series system release supports Linux and 
Windows). The Dell OST plug-in software enables integration between DR Series system data storage operations and 
the supported data management applications (DMAs).

Understanding the Dell OST Plug-In (Linux)

The Dell OST plug-in must be installed on the designated Linux-based media server running the support Linux server 
operating system software in the following directory, /usr/openv/lib/ost-plug-ins. The Dell OST plug-in is installed using a 
self-extracting installer that installs the OST plug-in and all its related components. The installer supports the following 
modes, with the default being Help (-h):

注: If no option is selected, the Help mode is displayed by default.

• Help (-h)

• Install (-install)

• Upgrade (-upgrade)

• Uninstall (-uninstall)

• Force (-force)

$> ./Dellostplugin-x86_64-38105.bin -help
Dell plug-in installer/uninstaller
usage: Dellostplugin-x86_64-38105.bin [ -h ] [ -install ] [ -uninstall ]
-h             : Displays help
-install       : Installs the plug-in
-upgrade            : Upgrades the plug-in
-uninstall     : Uninstalls the plug-in
-force                    : Forces the installation of the plug-in

You can download the Dell OST Plug-In Installer in two ways:

• Using the Dell website:

– Navigate to support.dell.com/ and locate the Drivers and Downloads location

– Locate the Dell OST plug-in for Linux and download this to your system.

• Using the DR Series system GUI:

– Click Storage → Clients

– Click the OST tab in the Clients page, and click Download Plug-In

– Select the appropriate plug-in in the Download Plug-Ins page, and click Download

Once downloaded, run the Dell OST Plug-In Installer to install the plug-in on your designated Linux-based media server. 
For specifics, see Installing the OST Plug-In for NetBackup on Linux.

注: The Dell OST plug-in needs to be installed on client systems to support client-side deduplication.
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Understanding the Dell OST Plug-In (Windows)

This Dell OST plug-in must be installed in the following directory on the designated Windows-based media server 
running the supported Microsoft Windows server operating system software: $INSTALL_PATH\VERITAS\Netbackup\bin
\ost-plug-ins for NetBackup installations, and $INSTALL_PATH\Symantec\Backup Exec\bin\ for Backup Exec 
installations. Once downloaded, you can use SETUP to install the Dell OST plug-in. For specifics, see Installing the OST 
Plug-In for Backup Exec on Windows or Installing the OST Plug-In for NetBackup on Windows.

注: The Dell OST plug-in needs to be installed on client systems to support client-side deduplication.

Installing the OST Plug-In for Backup Exec on Windows

This topic describes how to install the Dell OpenStorage Transport (OST) plug-in within a Microsoft Windows 
environment for performing DR Series system operations via the plug-in.

Make sure that you meet all of the following prerequisites before installing the OST plug-in:

注: The Dell OST plug-in must be installed on client systems to support client-side deduplication.

1. The Backup Exec installation must be running on one of the supported Windows media server platforms.

2. The Windows OST installer must be present. If not, download the Windows installer (DellOSTPlug-in.msi), which is 
available at support.dell.com/drivers, to a network directory location you can access.

Version 2.0.0 of the OST plug-in supports the following versions of Backup Exec: Backup Exec 2010 (Release 3), Backup 
Exec 2012, Backup Exec 12.5. Version 2.0.0 of the OST plug-in supports the following Windows-based media servers: 
Windows 2003, Windows 2008, and Windows 2008 (Release 2).

注: For the latest information on supported versions, see the Dell DR Series System Interoperability Guide, 
available at support.dell.com/manuals.

To install the Dell OST plug-in, complete the following:

1. Launch the Backup Exec Administrator console, select Tools, and Backup Exec Services....
The Backup Exec Services Manager page is displayed.

2. Select the server on which you want to install the Dell OST plug-in, and select Stop all services.
The Restarting Backup Exec Services page is displayed, which lists the current status of services for the selected 
server.

3. Click OK.
4. Launch the Dell Storage Plug-In for Symantec OST Setup Wizard (and accept all default values).
5. In the Welcome page, click Next to continue.

The End-User License Agreement page is displayed.

6. Click I accept the terms in the License Agreement, and click Next.
7. In the Destination Folder page, accept the default destination location, and click Next.
8. In the Ready to Install Dell Storage Plug-In for Symantec OST page, click Install.

When the plug-in has been installed, the Completed the Dell Storage Plug-In for Symantec OST Setup Wizard page 
is displayed.

9. Click Finish to exit the wizard.

Installing the OST Plug-In for NetBackup on Windows

This topic describes how to install the Dell OST plug-in on a media server running the supported Microsoft Windows 
server operating system software (and using the NetBackup DMA).
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Ensure that you have downloaded the Dell OST plug-in installer into the correct directory on the designated media 
server. The OST plug-in installer is saved as DellOSTPlugin64.msi, or DellOSTPlugin.msi (DellOSTPlugin64.msi is for 64-
bit operating systems and DellOSTPlugin.msi is for 32-bit operating systems). Ensure that the correct plug-in is 
downloaded to support your 64-bit or 32-bit systems.

注: The Dell OST plug-in must be installed on client systems to support client-side deduplication.

1. Stop the NetBackup services if they are running, by using the following command:
Verify if a previous version is already installed. If it is, uninstall it. If SETUP performs this check, there is no need to 
do it manually.
$INSTALL_PATH\VERITAS\NetBackup\bin\bpdown.exe

2. Run SETUP to install the OST plug-in.

3. Check that the plug-in is installed by using the following NetBackup command on the Windows media server:
$INSTALL_PATH\VERITAS\NetBackup\bin\admincmd\bpstsinfo.exe -pi

This NetBackup command lists the Dell OST plug-in details along with other plug-in details, as shown in the 
following example:

– Plug-In Name: libstspiDellMT.dll

– Prefix: DELL

– Label: OST Plug-in that interfaces with the DR Series system

– Build Version: 9

– Build Version Minor: 1

– Operating Version: 9

– Vendor Version: Dell OST plug-in 10.1

4. Start the NetBackup services by using the following command:
$INSTALL_PATH\VERITAS\NetBackup\bin\bpup.exe

注: To more information about uninstalling the Dell OST plug-in, see Uninstalling the Dell OST Plug-In for 
Windows.

卸载 Windows 上的 Dell OST 插件

如果需要卸载基于 Windows 的媒体服务器上的 Dell OST 插件，请使用以下卸载过程：

通过标准 Microsoft Windows 卸载过程卸载基于 Windows 的媒体服务器上的 Dell OST 插件。

注: Dell 建议保留媒体服务器上的 Dell OST 插件安装程序，以便在需要重新安装此 Dell OST 插件时使用。

以下过程例举了在安装有 Dell OST 插件的基于 Windows 的媒体服务器上卸载此插件的过程。

1. 单击 Start（开始），然后单击 Control Panel（控制面板）。

此时将显示 Control Panel（控制面板）页面。

2. 在 Programs and Features（程序和功能）下，单击 Uninstall a program（卸载程序）。

此时将显示 Uninstall or change a program（卸载或更改程序）页面。

3. 在列出的已安装程序中找到 Dell OST 插件，单击鼠标右键并选择 Uninstall（卸载）。

此时将显示 Programs and Features（程序和功能）确认对话框。

4. 单击 Yes（是）卸载 Dell OST 插件。

130



为 Linux 上的 NetBackup 安装 OST 插件

本主题说明如何在运行支持的 Red Hat Enterprise Linux 或 SUSE Linux 服务器操作系统软件（使用 NetBackup 
DMA）的媒体服务器上安装 Dell OST 插件。

确保已将 Dell OST 插件安装程序下载至指定媒体服务器上的正确目录。OST 插件安装程序保存为 Dellostplugin-
x86_64-xxxxx.bin.gz，其中 xxxxx 表示其内部版本号。

注: 客户端系统上需要安装 Dell OST 插件才能支持客户端侧的重复数据消除。

1. 使用以下命令解压 OST 插件安装程序文件：

$> /bin/gunzip Dellostplugin-x86_64-xxxxx.bin.gz
2. 使用以下命令配置 OST 插件安装程序上的可执行位：

$> /bin/chmod a+x Dellostplugin-x86_64-xxxxx.bin
3. 使用 -install 选项停止 NetBackup nbrmms 服务。

如果尝试安装 OST 插件时，NetBackup nbrmms 服务正在运行，则 OST 插件安装程序将返回错误。

4. 使用 -install 选项运行 OST 插件安装程序，并使用以下命令安装此插件：

$> ./Dellostplugin-x86_64-xxxxx.bin -install

注: 安装 Dell OST 插件之前，必须停止 NetBackup nbrmms 进程。另外还需要使用 Dell OST 插件安装程

序卸载此插件。用户不能配置 Dell OST 插件的安装位置。

5. OST 插件安装程序停止运行后，系统提示返回，请在 Linux 媒体服务器上使用以下 NetBackup 命令检查输
出，以验证插件是否正确加载。

$> /usr/openv/netbackup/bin/admincmd/bpstsinfo -plugininfo

此 NetBackup 命令将列出 Dell OST 插件详情，如下所示：

– Plug-In Name: libstspiDellMT.so

– Prefix: DELL

– Label: Dell OpenStorage (OST) Plug-in

– Build Version: 10

– Build Version Minor: 1

– Operating Version: 10

– Vendor Version: (EAR-2.0.0) Build: 41640
6. 将 OST 插件安装程序保留在媒体服务器上，以便在需要卸载此插件时使用。

有关卸载 Dell OST 插件的信息，请参阅卸载 Linux 上的 Dell OST 插件。

卸载 Linux 上的 Dell OST 插件

如果需要卸载基于 Linux 的媒体服务器上的 Dell OST 插件，请使用以下卸载过程：

1. 使用 -uninstall 选项停止 NetBackup nbrmms 服务。

如果尝试卸载 OST 插件时，NetBackup nbrmms 服务正在运行，则 OST 插件安装程序将返回错误。

2. 使用 -uninstall 选项通过以下命令运行 OST 插件安装程序可卸载此插件：

$> ./Dellostplugin-x86_64-xxxxx.bin -uninstall

注: 卸载 OST 插件之前必须停止 NetBackup nbrmms 服务（另外还需要使用 Dell OST 插件安装程序卸载

此插件）。

3. 在 Linux 媒体服务器上使用以下 NetBackup 命令检查插件是否卸载：

$> /usr/openv/netbackup/bin/admincmd/bpstsinfo -plugininfo
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注: 如果 -pluginfo 命令返回任何 Dell OST 插件详情，则表示插件尚未卸载。

4. 将 OST 插件安装程序保留在媒体服务器上，以便在需要卸载此插件时使用。

使用 NetBackup 配置 DR Series 系统信息

本主题介绍使用 NetBackup 媒体服务器命令行界面 (CLI) 命令和图形用户界面 (GUI) 菜单、选项卡及选项配置 DR 
Series 系统信息的概念。通过 NetBackup CLI 命令和 GUI 菜单、选项卡及选项可配置 Linux 或 Windows 媒体服务
器。在 DR Series System Administrator Guide（DR Series 系统管理员指南）说明文件中，可找到阐述使用 
NetBackup CLI 的操作的特定主题，例如向打算与 DR Series 系统配合使用的每个 Linux 和 Windows 媒体服务器
上的 NetBackup 中添加 DR Series 系统名称，使用 NetBackup GUI 将其配置为通过 OST 与 DR Series 系统合作，
使用 NetBackup GUI 从 DR Series 系统上的逻辑存储单元 (LSU) 中配置磁盘池，以及使用 NetBackup GUI 利用 DR 
Series 系统上的磁盘池创建存储单元。
相关链接

为 DR Series 系统配置 NetBackup
使用 NetBackup 图形用户界面 (GUI) 将其配置为通过 OST 与 DR Series 系统合作。无论在 Linux 还是 
Windows 平台上，此过程实际上是相同类型的操作。

使用 Backup Exec GUI 配置 DR Series 系统
Backup Exec 仅支持使用自己的图形用户界面 (GUI) 配置 DR Series 系统。不支持通过 Backup Exec 命
令行界面 (CLI) 使用 Backup Exec 2010 版本。

使用 NetBackup CLI 添加 DR Series 系统名称 (Windows)
本主题说明如何使用 NetBackup CLI 向计划与 DR Series 系统配合使用的每个基于 Windows 的媒体服
务器中添加 DR Series 系统名称。

使用 NetBackup CLI 添加 DR Series 系统名称 (Linux)
This topic describes how to use the NetBackup CLI to add the DR Series system name to each Linux-based 
media server you plan to use with the DR Series system.

Using NetBackup CLI to Add DR Series System Name (Linux)

This topic describes how to use the NetBackup CLI to add the DR Series system name to each Linux-based media server 
you plan to use with the DR Series system.

1. Add the DR Series system name to NetBackup by using the following command:
/usr/openv/netbackup/bin/admincmd/nbdevconfig -creatests 
-storage_server servername -stype DELL -media_server mediaservername 

2. Log in to and authenticate with DR Series system by using the following command (for details, see Configuring an 
LSU).
/usr/openv/volmgr/bin/tpconfig -add -storage_server servername -stype DELL -
sts_user_id backup_user -password password

注: On the DR Series system, only one user account exists, and the user ID for that account is backup_user. 
You can only change the password for this account; you cannot create a new account nor can the existing 
account be deleted.
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使用 NetBackup CLI 添加 DR Series 系统名称 (Windows)

本主题说明如何使用 NetBackup CLI 向计划与 DR Series 系统配合使用的每个基于 Windows 的媒体服务器中添加 
DR Series 系统名称。

1. 使用以下命令将 DR Series 系统名称添加到 NetBackup：
$INSTALL_PATH\VERITAS\NetBackup\bin\admincmd\nbdevconfig -creatests -
storage_server servername -stype DELL -media_server mediaservername

2. 使用以下命令登录 DR Series 系统并添加用于身份验证的有效凭据（有关详情，请参阅配置 LSU）。

$INSTALL_PATH\VERITAS\Volmgr\bin\tpconfig -add -storage_server servername -
stype DELL -sts_user_id backup_user -password password

为 DR Series 系统配置 NetBackup

使用 NetBackup 图形用户界面 (GUI) 将其配置为通过 OST 与 DR Series 系统合作。无论在 Linux 还是 Windows 平
台上，此过程实际上是相同类型的操作。

登录 NetBackup 并完成以下操作：

1. 在 NetBackup Administrator（NetBackup 管理员）控制台的主窗口中，单击 Configure Disk Storage Servers
（配置磁盘存储服务器）以启动 Storage Server Configuration Wizard（存储服务器配置向导）。

此时将显示 Storage Server Configuration Wizard（存储服务器配置向导）页面，在其中可添加存储服务器。

2. 单击 OpenStorage 以选择要在此窗口中配置的磁盘存储类型，然后单击 Next（下一步）。

此时将显示 Add Storage Server（添加存储服务器）页面。

3. 输入以下值以配置存储服务器：

– 在 Storage server type（存储服务器类型）中，输入 DELL。

– 在 Storage server name（存储服务器名称）中，输入 DR Series 系统的名称。

– 在 Select media server（选择媒体服务器）下拉列表中，选择所需的媒体服务器（要在上面配置 
OST 的服务器）。

– 输入在 DR Series 系统中进行身份验证所需的凭据值：

* 用户名

* 密码

* 确认密码

输入的凭据应该与 DR Series 系统所要求的凭据相同。有关更多信息，请参阅配置 LSU。

4. 单击下一步。

此时将显示 Storage Server Configuration Summary（存储服务器配置摘要）页面，其中列出了所配置的值。

5. 单击下一步。

所配置的存储服务器和对应的凭据显示在 Storage Server Creation Status（存储服务器创建状态）页面中。

6. 单击 Next（下一步），然后单击 Finish（完成）关闭 Storage Server Configuration Wizard（存储服务器配置
向导）。

此时将显示 Storage server servername successfully created（存储服务器 servername 已成功创建）页面。

NetBackup 现已配置为与 DR Series 系统配合使用。
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Creating Disk Pools From LSUs

Use the NetBackup graphical user interface (GUI) to configure disk pools from logical storage units (LSUs) on the DR 
Series system.

Log in to NetBackup, and complete the following:

1. In the main window of the NetBackup Administrator console, click Configure Disk Pools to launch the Disk Pool 
Configuration Wizard.
The Disk Pool Configuration Wizard page is displayed, which is where you define media servers for use in a disk 
pool.

2. In the Welcome to the Disk Pool Configuration Wizard page, click Next.
The Disk Pool page is displayed.

3. In Type, select OpenStorage (DELL), and click Next.
The Select Storage Server page is displayed, and contains a list of available storage servers.

4. In the Storage server list, select a server, and click Next.
The Disk Pool Properties page is displayed.

5. Select the LSUs (volumes) to include from the list, and click Next.
The Disk Pool Properties page is displayed.

6. Enter a Disk pool name, and click Next.
The Summary page for the Disk Pool Configuration Wizard is displayed.

7. Verify the disk pool configuration in the Summary page, and click Next to configure the disk pool you created.
The Performing required task page is displayed, with the status being: Configuration completed successfully. You 
have several options available at this point:

– Clear the Create a storage unit for the disk pool.

– Click Finish and close the Disk Pool Configuration Wizard.

– Click Next to create the storage unit with this disk pool.

注: If you create the storage unit using the Disk Pool Configuration Wizard, you can skip the step where you 
create storage units using a disk pool.

8. Click Next to continue with creating a storage unit using this wizard.

9. Enter a Storage unit name, and click Next.
The Successfully Completed Disk Pool Configuration page is displayed.

10. Click Finish.

To display the disk pool you created, click Devices → Disk Pools in the left navigation pane in the NetBackup 
Administrator console.

使用磁盘池创建存储单元

使用 NetBackup GUI 利用 DR Series 系统上的磁盘池创建存储单元。

登录 NetBackup 并完成以下任务：

1. 在 NetBackup Administrator（NetBackup 管理员）控制台的主窗口中，单击左侧导航窗格中的 Storage（存
储），然后选择 Storage Units（存储单元）。

2. 在 NetBackup Administrator（NetBackup 管理员）控制台的主窗口中，单击鼠标右键，从下拉列表中选择 
New Storage Unit（新存储单元）。
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3. 在 New Storage Unit（新存储单元）页面中，在 Storage unit name（存储单元名称）中输入名称，在 Disk 
pool（磁盘池）下拉列表中选择所创建的 OST 磁盘池。

4. 单击 OK（确定）创建新存储单元。

Backing Up Data From a DR Series System (NetBackup)
This topic describes how to use NetBackup to back up data from a DR Series system.

Before backing up data, you first need to configure a policy that creates a backup on the OpenStorage Technology (OST) 
logical storage unit (LSU). This type of policy is similar to what is done for network-attached storage (NAS) shares, 
except that when defining policy attributes, you need to select the LSU that contains the OST disk pool.

To back up data from a DR Series system using a policy, complete the following:

1. Log into the NetBackup Administrator console.

2. Click NetBackup Management in the left navigation pane, and select Policies.

3. In the All Policies main window, right-click OST, and select Change Policy from the drop-down list.
The Change Policy page is displayed.

4. In the Change Policy page, click the Attributes tab, and select the settings for the policy you want to create.

5. Click OK to create the policy, which displays under OST in the main window.

6. Right-click the policy, and select Manual Backup from the drop-down list.
The Manual Backup page is displayed.

7. In the Manual Backup page, enter the name of the media server in Server, and click OK.

To monitor the status of any backup operation, click Activity Monitor in the left navigation pane of the NetBackup 
Administrator console, and select the backup job you are interested in to view details about the operation.

Restoring Data From a DR Series System Using NetBackup

This topic describes how to use NetBackup to restore data from a DR Series system. The process for restoring data from 
OpenStorage Technology (OST) logical storage units (LSUs) is similar to how restores are performed from any backup 
device.

To restore data from a DR Series system, complete the following:

1. Log into the NetBackup Administrator console.

2. Click Backup, Archive, and Restore in the left navigation pane.

3. In the Restore main window, click the Restore Files tab.

4. Select the data that you want to restore, and click OK.

To monitor the status of any restore operation, click Activity Monitor in the left navigation pane of the NetBackup 
Administrator console, and select the restore job you are interested in to view details about the operation.

Duplicating Backup Images Between DR Series Systems Using NetBackup

Using NetBackup with the DR Series system, you can duplicate backup images from a disk pool on one DR Series 
system to a target disk pool (or a storage unit derived from it) that could be on the same DR Series system or on a 
different DR Series system.

To duplicate backup images between DR Series systems using NetBackup, complete the following:

1. Log into NetBackup Administrator console.

2. Click NetBackup Management in the left navigation pane, and select Catalog.
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3. In the Catalog main window, select Duplicate from the Action drop-down list, and click Search Now.
The Search Results pane is displayed, which lists images from which you can choose to duplicate.

4. Right-click to select the image in the Search Results pane that you would like to duplicate, and select Duplicate in 
the drop-down list.
The Setup Duplication Variables page is displayed.

5. In the Setup Duplication Variables page, select the LSU that is the target DR Series system in the Storage unit drop-
down list, and click OK.

6. To monitor the status of any duplicate image operation, perform the following:
a) Click Activity Monitor in the left navigation pane of the NetBackup Administrator console.
b) Select the data duplication job in which you are interested.
c) View the operation details.

Using Backup Exec With a DR Series System (Windows)
This topic introduces the Dell OpenStorage Technology (OST) plug-in and describes its installation prerequisites for 
Backup Exec within a Microsoft Windows environment. Once installed, Backup Exec can perform DR Series system 
operations via the OST plug-in.

OST Plug-In and Supported Versions

This topic introduces the version 1.0 of the OST plug-in that supports the following versions of Backup Exec:

• Backup Exec 2010, Release 3

• Backup Exec 2012

Version 1.0 of the OST plug-in supports the following versions of the Windows media server:

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008, R2

注: For the latest information, see the Dell DR Series System Interoperability Guide, available at support.dell.com/
manuals.

Installation Prerequisites for the OST Plug-In for Backup Exec

This topic introduces the installation prerequisites for installing the OST plug-in for Backup Exec on Windows media 
servers. Ensure that you meet the following prerequisites prior to installing the Dell OST plug-in:

1. The Backup Exec installation must be running on one of the supported Windows platforms.

2. Dell recommends that the DR Series system appliance have an OST container created and configured. For details, 
see Configuring an LSU.

3. The Windows OST installer must be present. If not, download the Windows installer (DellOSTPlug-in.msi), which is 
available at support.dell.com/support/drivers, to a network directory location you can access.

4. The Dell OST plug-in needs to installed in the following directory on the designated Windows-based media server 
running the supported Microsoft Windows operating system software ($INSTALL_PATH\VERITAS\NetBackup\bin
\ost-plugins) for NetBackup installations.
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使用 Backup Exec GUI 配置 DR Series 系统

Backup Exec 仅支持使用自己的图形用户界面 (GUI) 配置 DR Series 系统。不支持通过 Backup Exec 命令行界面 
(CLI) 使用 Backup Exec 2010 版本。

要使用 Backup Exec GUI 配置 DR Series 系统，请完成以下操作：

1. 启动 Backup Exec Administrator（Backup Exec 管理员）控制台，依次选择 Tools（工具）和 Backup Exec 
Services...（Backup Exec 服务...）。

2. 选择要在 Backup Exec Services Manager（Backup Exec 服务管理器）页面中配置的服务器，然后选择 Start 
all services（启动所有服务）。

3. 验证所有服务已启动后，单击 OK（确定）。

4. 在 Connect to Media Server（连接至媒体服务器）页面中，登录媒体服务器，输入 User name（用户名）和 
Password（密码），然后单击 OK（确定）。

5. 在 Backup Exec Administrator（Backup Exec 管理员）页面中，单击 Network（网络），然后单击 Logon 
Accounts（登录帐户）。

此时将显示 Logon Account Management（登录帐户管理）页面。

6. 单击 New（新建）创建新的登录帐户。

此时将显示 Add Logon Credentials（添加登录凭据）页面。

7. 在 Account Credentials（帐户凭据）窗格中，输入针对 DR Series 系统的帐户凭据 User name（用户名）和 
Password（密码），然后单击 OK（确定）（例如，默认用户名为 backup_user）。

8. 在 Backup Exec Administrator（Backup Exec 管理员）页面中，单击 Devices（设备）选项卡，然后在列出为
根节点的本地系统名称上单击鼠标右键。

此时将显示设备相关选项的下拉列表。

9. 在下拉列表中选择 Add OpenStorage（添加 OpenStorage）。

此时将显示 Add OpenStorage Device（添加 OpenStorage 设备）页面。

10. 使用以下信息配置 Add OpenStorage Device（添加 OpenStorage 设备）页面，然后单击 OK（确定）：

– Server（服务器）- 输入 DR Series 系统的主机名或 IP 地址。

– Logon account（登录帐户）- 从下拉列表中选择具有 DR Series 系统访问凭据的帐户。

– Server type（服务器类型）- 从下拉列表中选择插件类型（DELL OST 插件）。

– Logical storage unit（逻辑存储单元）- 输入要使用的 LSU（DR Series 系统容器）名称。

11. 单击 Yes（是），以响应关于将新设备设置为新作业默认目标的提示。

12. 关闭 Add OpenStorage Device（添加 OpenStorage 设备）页面。

此时将显示 Restart Services（重新启动服务）确认对话框（此对话框建议不要在当前运行任何作业时重新

启动服务）。

13. 单击 Restart Now（立即重新启动）以重新启动 Backup Exec 服务。

使用 Backup Exec 在 DR Series 系统上创建备份

本主题说明如何使用 Backup Exec 在 DR Series 系统上创建备份。

要使用 Backup Exec 在 DR Series 系统上创建备份，请完成以下操作：

注: 以下过程记录了使用 Backup Exec 2010 完成此操作的过程。使用 Backup Exec 2012 时的过程有所不同。

有关具体详情和过程，请根据您使用的特定 DMA 产品和版本参阅 Symantec 提供的产品特定说明文件。

1. 启动 Backup Exec Administrator（Backup Exec 管理员）控制台，然后选择 Job Setup（作业设置）选项卡。

2. 单击左侧导航窗格中的 Backup Tasks（备份任务），然后选择 New job（新建作业）。

此时将显示 Backup Job Properties（备份作业属性）页面。
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3. 在 Backup Job Properties（备份作业属性）页面的左侧导航窗格中，选择 Source（源），然后选择 
Selections（选择项）。

此时将显示 Selections（选择项）页面。

4. 在 Selections（选择项）页面的中心窗格中选择系统或节点名称，然后单击与要备份的文件对应的复选
框。

5. 在 Backup Job Properties（备份作业属性）页面的左侧导航窗格中，选择 Destination（目标），然后选择 
Device and Media（设备和介质）。

此时将显示 Device and Media（设备和介质）页面。

6. 在 Device and Media（设备和介质）页面的 Device（设备）窗格中，选择下拉列表中的 DELL OST 设备，然
后单击 Run Now（立即运行）启动备份作业。

7. 单击 Job Monitor（作业监测器）选项卡查看创建的备份作业的进度。

Optimizing Duplication Between DR Series Systems Using Backup Exec

The Backup Exec DMA can work with the DR Series system to replicate backups between two DR Series systems that 
are part of a defined source and target replication pair. This process uses the deduplication and replication features of 
the DR Series system via the OpenStorage Technology (OST).

Using OST, backed up data is catalogued which makes its available from the designated media server so that a 
seamless restore can be performed from either the target or source DR Series system. This is considered an integrated 
replication, where the OST appliance does the replication. It is considered to be “optimized” because the data flows 
from the local appliance directly to the remote appliance in a deduplicated format, and it does not travel through the 
media server.

When the data is in a deduplicated format (in an optimized form), only new or unique data is copied between the two DR 
Series systems. Because the duplication job is initiated by Backup Exec, there are two entries in its catalog: one entry is 
for the source file, while the other entry is for the target file. The backup administrator can restore backup data from 
either appliance in case of data loss or disaster.

To optimize duplication between DR Series systems, create an additional OST device that points to the target DR Series 
system, and complete the following:

1. Launch the Backup Exec Administrator console, select the Devices tab, and right-click the target DR Series system.

2. Select Add OpenStorage in the drop-down list.
The Add OpenStorage Device page is displayed

3. Configure the Add OpenStorage Device page with the following information:

– Server—enter the host name or IP address of the DR Series system.

– Logon account—select the account from the drop-down list (or click ... and browse to the account 
location), which has credentials for accessing the DR Series system.

– Server type—select the type of server from the drop-down list (DELL).

– Logical storage unit—enter the name of the logical storage unit (LSU), also known as a DR Series system 
container, to use.

4. Click Yes in response to the prompt if you want to make the new device the default destination for new jobs.

5. Close the Add OpenStorage Device page.

6. Click the Job Setup tab.

7. In the left navigation pane, select Backup Tasks, and click New job to duplicate backup sets.
The New Job to Duplicate Backup Sets page is displayed.

8. Select Duplicate existing backup sets, and click OK.

9. Click the View by Resource tab in the Selections page, and select the dataset you want copied.

10. In the left navigation pane, select Destination, and select Device and Media.
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11. In Device, select the destination device from the drop-down list (that was created in this procedure), and click Run 
Now to start the replication operation between the two DR Series systems.

12. Click the Job Monitor tab to view the progress of the replication operation you created.

Restoring Data from a DR Series System Using Backup Exec

This topic describes how to use Backup Exec to restore data from a DR Series system.

To restore data from a DR Series system using Backup Exec, complete the following:

1. Launch the Backup Exec Administrator console, and select the Job Setup tab.
2. In the left navigation pane, select Restore Tasks, and click New job.

The Restore Job Properties page is displayed.

3. Click the View by Resource tab in the Selections pane, and select the dataset to be restored.
4. Click Run Now to start the restore job.
5. Click the Job Monitor tab to view the progress of the restore job operation you created.

Understanding the OST CLI Commands
The OpenStorage Transport (OST) --mode component supported in the DR Series system command line interface (CLI) 
command supports three values, which represent optimized writes done via: deduplication (--mode dedupe), 
passthrough (--mode passthrough), and auto (--mode auto). These OST commands are used in the following format: ost 
--update_client --name --mode.

注: If an OST client has four or more CPU cores, it is considered to be dedupe-capable. However, the OST client 
operating mode depends upon how it is configured in the DR Series system (Dedupe is the default OST client 
mode). If the administrator did not configure an OST client to operate in a specific mode and it is dedupe-capable, 
it will run in the Dedupe mode. If an OST client is not dedupe-capable (meaning the OST client has less than four 
CPU cores), and the administrator sets it to run in the Dedupe mode, it will only run in the Passthrough mode. If an 
OST client is set to run in Auto mode, the OST client will run in the mode setting determined by the media server. 
The following table shows the relationship between the configured OST client mode types and the supported client 
mode based on client architecture type and corresponding number of CPU cores.

表. 6: Supported OST Client Modes and Settings

OST Client Mode 
Settings

32–Bit OST Client (4 
or more CPU cores)

64–Bit Client (4 or 
more CPU cores)

32–Bit OST Client 
(Less than 4 CPU 
cores)

64–Bit OST Client 
(Less than 4 CPU 
cores)

Auto Passthrough Dedupe Passthrough Passthrough

Dedupe Not Supported Supported Not Supported Not Supported

Passthrough Supported Supported Supported Supported

Supported DR Series System CLI Commands for OST

The following are the supported DR Series system CLI commands for OST operations:
administrator@acme100 > ost
Usage:
   ost --show [--config]
              [--file_history] [--name <name>]
              [--clients]
              [--limits]
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   ost --setpassword
   ost --delete_client --name <OST Client Hostname>

   ost --update_client --name <OST Client Hostname>
       --mode <auto|passthrough|dedupe>

   ost --limit --speed <<num><kbps|mbps|gbps> | default>
       --target <ip address | hostname>

   ost --help

ost <command> <command-arguments>
<command> can be one of:
   --show            Displays command specific information.
   --setpassword     Updates the OST user password.
   --delete_client   Deletes the OST client.
   --update_client   Updates attributes of the OST client.
   --limit           Limits bandwidth consumed by ost.

For command-specific help, please type ost --help <command>
For example:
     ost --help show

注: The --files in the ost --show --file_history command represents replicated files that were processed via the 
DMA optimized duplication operation. This command displays only up to the last 10 such files. The --name in the 
ost --show --name command represents the OST container name.

注: For more information about OST-related DR Series system CLI commands, see the Dell DR Series System 
Command Line Reference Guide.

Understanding OST Plug-In Diagnostic Logs
There are currently two supported types of OST plug-ins for which you can collect diagnostic logs: NetBackup and 
Backup Exec.

注: The directory location, C:\ProgramData, is considered to be a hidden directory on Windows-based systems. 
However, you can copy and paste C:\ProgramData\Dell\DR\log\ into your Internet Explorer Address bar or you can 
enter this into the Windows command prompt window (Start→ All Programs→ Accessories→ Command Prompt).

For more information about OST, OST plug-ins and logs, see Understanding OST, Installing a Dell OST Plug-In, Rotating 
OST Plug-In Logs for Linux, and Rotating OST Plug-In Logs for Windows.

轮转 Windows 的 OST 插件日志

默认情况下，Windows 日志轮转大小设置为 10 兆字节 (MB)。一旦日志文件达到此大小，OpenStorage Transport 
(OST) 插件会自动将现有日志文件 libstspiDell.log 重命名为 libstspiDell.log.old，然后创建新日志。

修改日志轮转大小
要修改日志轮转大小，可编辑以下注册表项值：

HKLM\Software\Dell\OST\LogRotationSize

修改此值之后，新轮转大小值将立即生效（这表示不必重新启动备份过程）。
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使用 Linux 公用程序收集诊断信息

可以使用名为 Dell_diags 的 Linux 公用程序来收集纯 Linux 客户端的诊断信息。此 Linux 公用程序由 OST 插件安
装程序安装在 /opt/Dell 目录。此工具可收集以下类型的信息：

• var/log/libstspiDell.log.*

• usr/openv/netbackup/logs

• usr/openv/logs/nbemm/

• usr/openv/logs/nbrmms/

Dell_diags 诊断文件会被写入以下位置：/var/log/diags_client location。

以下示例显示了收集 OST 诊断日志的过程（所显示的 root 用户帐户代表位于媒体服务器上的用户，不应与 DR 
Series 系统上的 root 用户帐户混淆）：

root@oca3400-74 ~]# ./Dell_diags -collect Collecting diagnostics...Done 
Diagnostics location: /var/log/diags_client//oca3400-74_2012-02-27_23-02-13.tgz

OST 插件中的日志级别默认设置为 Error（错误），可由用户进行配置，并且可通过 DR Series 系统 CLI 或 GUI 
修改。

轮转 Linux 的 OST 插件日志

如果将 OST 插件日志级别设置为 Debug（调试），可导致插件日志的大小快速增长。预防日志大小出现任何问
题的 佳做法是使用基于 Linux 的系统中通常提供的 logrotate 公用程序轮转 OST 插件日志。

要配置日志轮转，请完成以下操作：

1. 在 /etc/logrotate.d/ 下创建一个文件，命名为“ost”，然后添加以下条目：

/var/log/libstspiDell.log { rotate 10 size 10M copytruncate }

2. 在 /etc/cron.hourly/ 下创建一个文件，命名为“ost_logrotate.cron”，然后添加以下条目：

#!/bin/bash /usr/sbin/logrotate /etc/logrotate.d/ost

logrotate 公用程序每小时运行一次，每当日志文件的大小超过 10 兆字节 (MB) 时，就会轮转日志。此过程自动

执行，是 OST 插件安装的组成部分。

收集媒体服务器信息的准则

除了基于历史和故障排除目的可收集的 DR Series 系统诊断日志文件捆绑包和核心文件，如果已运行任何 
OpenStorage 技术 (OST) 操作，则 Dell 建议另外收集一些与媒体服务器相关的重要文件。本主题介绍位于 Linux 
和 Windows 平台上的一些重要媒体服务器文件。

Linux 媒体服务器上的 NetBackup

对于运行在 Linux 媒体服务器上的 NetBackup，Dell 建议收集以下文件：

• 来自媒体服务器的 OST 插件配置文件和日志文件

– 位置：/var/log/libstspiDell.log.*

• 来自媒体服务器的 NetBackup 备份作业日志和命令日志：

– 位置：NetBackup 日志文件位于 /usr/openv/netbackup/logs/ 下。对于 NetBackup 中的每个进程，
日志目录中都有一个对应的子目录。Dell 关注与以下进程相关的日志：bptm、bpdm、bprd、
bpcd、bpbrm。
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– 请注意，默认情况下，这五个目录可能不存在，因此仅当媒体服务器上存在这些日志时才能进
行收集。如果已创建这些日志文件，则其位置如下所示：/usr/openv/netbackup/logs/bptm、/usr/
openv/netbackup/logs/bpdm、/usr/openv/netbackup/logs/bpcd、/usr/openv/netbackup/logs/bprd 
和 /usr/openv/netbackup/logs/bpbrm。

– Dell 建议从以下目录收集日志：/usr/openv/logs/nbemm 和 /usr/openv/logs/nbrmms/。
• 查看 NetBackup 媒体服务器上或 DR Series 系统上是否生成有任何核心文件，其中可包括：

– Linux NetBackup 媒体服务器上的核心文件，位于 /usr/openv/netbackup/bin 目录下。与 OST 插件
关联的大多数 NetBackup 二进制数都在此目录下。

– 客户端上的核心文件，其位置并不固定。请验证这些核心文件是否位于以下目录：/、/root/ 或 /
proc/sys/kernel/core_pattern 中提及的目录。例如，如果下面是来自 DR Series 系统的 
core_pattern (/var/cores/core.%e.%p.%t)，则所有核心文件将位于 /var/cores 下。

Dell 建议，如果客户端上的 core_pattern 由 NAT 设置到特定目录时，则诊断脚本必须查看此目录以获取任何相

关的核心。

Windows 媒体服务器上的 NetBackup

对于运行在 Windows 媒体服务器上的 NetBackup，Dell 建议收集以下文件：

• 来自媒体服务器的 OST 插件配置文件和日志文件：

– 位置：%ALLUSERSPROFILE%\Dell\OST\log\libstspiDell.log*
• 来自媒体服务器的 NetBackup 作业日志和命令日志，以及以下目录中的日志文件：

– C:\Program Files\Veritas\NetBackup\logs\bptm（如果此目录存在）

– C:\Program Files\Veritas\NetBackup\logs\bpdm（如果此目录存在）

– C:\Program Files\Veritas\NetBackup\logs\bpbrm（如果此目录存在）

– C:\Program Files\Veritas\NetBackup\logs\bprd（如果此目录存在）

– C:\Program Files\Veritas\NetBackup\logs\bpcd（如果此目录存在）

– C:\Program Files\Veritas\NetBackup\logs\nbemm
– C:\Program Files\Veritas\NetBackup\logs\nbrmms

• NetBackup 媒体服务器上或 DR Series 系统上生成的任何核心文件。

• 如果出现服务器故障（故障可能不明显或无提示），可使用 Administrative Tools（管理工具）→ Event 
Viewer（事件查看器）收集 Windows 媒体服务器上应用程序的事件日志。然后，查看 Windows Logs
（Windows 日志）→ Application（应用程序）。一般 后一条标记有 Error（错误）的条目是您要搜索
的信息。

– 将此文本复制并粘贴到窗口中，如下例所示：

Faulting application bptm.exe, version 7.0.2010.104, time stamp 
0x4b42a78e, faulting module libstspiDellMT.dll, version 1.0.1.0, 
time stamp 0x4f0b5ee5, exception code 0xc0000005, fault offset 
0x000000000002655d, process id 0x12cc, application start time 
0x01cccf1845397a42.

– 如果系统无响应，请强制 bptm.exe 崩溃并完成以下操作：

1. 单击打开 Task Manager（任务管理器）。

2. 找到该进程。

3. 单击鼠标右键并选择 Create Dump File（创建转储文件）。

4. 从创建转储文件后显示的对话框中所指定的位置检索转储文件。

Windows 媒体服务器上的 Backup Exec

对于运行在 Windows 媒体服务器上的 Backup Exec，Dell 建议收集以下文件：
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• 来自媒体服务器的 OST 插件配置文件和日志文件：

– 位置：%ALLUSERSPROFILE%\Dell\OST\log\libstspiDell.log*

• 来自媒体服务器的 Backup Exec 作业日志和命令日志。

• Backup Exec 媒体服务器上或 DR Series 系统上生成的任何核心文件。

• 如果发生崩溃，请收集 %ProgramFiles%\Symantec\Backup Exec\BEDBG 下的任何小型转储文件。

• 如果系统无响应，请强制 pvlsvr.exe 和 bengine.exe 崩溃并完成以下操作：

a. 打开 Task Manager（任务管理器）。

b. 找到该进程。

c. 单击鼠标右键并选择 Create Dump File（创建转储文件）。 

d. 从创建转储文件后显示的对话框中所指定的位置检索转储文件。
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9
Configuring and Using Rapid Data Storage
RDS Overview
Rapid Data Storage (RDS) provides the logical disk interface that can be used with network storage devices. The Dell DR 
Series system requires the Dell Rapid OFS (ROFS) plug-in to integrate its data storage operations with the Dell Quest 
NetVault Backup (NVBU). The ROFS plug-in is installed by default on the NVBU server and the Dell DR Series system 
when the latest software updates are installed.

注: Apart from the latest NVBU and DR Series software updates, no other software is required to activate RDS on 
your NVBU and DR Series Systems in a Windows or Linux environment.

Using the ROFS plug-in, the DMAs can take full advantage of key DR Series system features like replication and data 
deduplication.

When RDS is used with the DR Series system, it offers the following benefits:

• RDS protocol provides faster and improved data transfers:

– Focus is on backups with minimal overhead

– Accommodates larger data transfer sizes

– Provides throughput that is better than CIFS or NFS

• RDS and DMA integration:

– ROFS API enables the DMA-to-media server software communication

– DR Series system storage capabilities can be used without extensive changes to DMAs

– Backup and replication operations are simplified by using built-in DMA policies

• DR Series system and RDS ports and write operations:

– Control channel uses TCP port 10011

– Data channel uses TCP port 11000

– Optimized write operations enable client-side deduplication

• Replication operations between DR Series systems:

– No configuration is required on the source or target DR Series system

– Replication is file-based, not container-based

– Replication is triggered by DMA optimized duplication operation

– DR Series system transfers the data file (not the media server)

– Once duplication completes, DR Series system notifies DMA to update its catalog (acknowledging the 
second backup). This makes the DMA aware of the replication location. Restores from either the source 
or replication target can be used directly from the DMA.

– Supports different retention policies between source and replica

– Replication is set up in the DMA itself, not the DR Series system
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RDS Guidelines
For best results, observe the following guidelines for optimal performance with your supported RDS operations with the 
DR Series system:

• Back up, restore, and optimized duplication operations performed using the Dell ROFS plug-in

注: The Dell ROFS plug-in is installed on client systems to support client-side deduplication.

• Optimal supported aggregated throughput rates:

– 3.8 Terabytes per hour (TB/hr) for passthrough write operations

– 7.3 TB/hr for dedupe write operations

注: Passthrough writes are when data is sent from a media server to the DR Series system without 
applying any optimization to the data. By contrast, dedupe writes are when data is sent from a media 
server to the DR Series system after optimization is applied to the data.

• Backup:

– Passthrough writes

– Dedupe writes

• Restore

• Replication

Best Practices: RDS and the DR Series System
This topic introduces some recommended best practices for using Rapid Data Storage (RDS) operations with the DR 
Series system.

RDS and non-
RDS containers 
can exist on the 
same DR Series 
system

The DR Series system supports having both RDS and non-RDS containers on the same 
appliance. However, this can cause incorrect capacity reporting as both container types share 
the same underlying storage.

RDS replication 
and non-RDS 
replication on the 
same DR Series 
system

Non-RDS replication must be configured, and it is replicated on a per-container basis. 
However, this type of replication will not replicate RDS containers. RDS replication is file-
based and is triggered by the DMA.

Do not change 
the container 
connection type 
from NFS/CIFS to 
RDS

A non-RDS container must be deleted before this container can then be created as an RDS 
container using the same name.

Setting Client-Side Optimization
Client-side optimization is a process that can contribute to saving time performing backup operations and reducing the 
data transfer overhead on the network.
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You can turn On or turn Off client-side optimization (also known as client-side deduplication) using the DR Series system 
CLI commands, rda --update_client --name --mode. For more information about DR Series system CLI commands, see 
the Dell DR Series System Command Line Reference Guide, available at support.dell.com/manuals.

Adding RDS Devices in NVBU
To add RDS devices in the NVBU:

1. Log on to your NVBU media server and launch NVBU console.

2. Click Device Management.
The NVBU Device Management window is displayed.

3. Select Add → Add Dell RDA Device.
The Add Dell RDA Device window is displayed.

4. In Host, enter the IP address or the system host name of the DR System.

5. In Username, enter backup_user.

注: The Username, backup_user is case-sensitive. You can configure RDS containers only while logged on 
the DR Series system with username backup_user.

6. In Password, enter the password used to access the DR Series system.

7. In LSU, enter the name of the RDS container.

注: The RDS container name in LSU is case-sensitive. Ensure that you enter the RDS container name exactly 
as it is on the DR Series system.

8. To save the entered details and add the device to the NVBU server:

– Select File → Save

– Click the Save icon.

Removing RDS Devices From NVBU
注: Removing an RDS device from NVBU does not delete the data stored in the RDS container on the DR Series 
system.

To remove existing RDS devices from NVBU:

1. Log on to your NVBU server and launch NVBU console.

2. Click Device Management.
The NVBU Device Management window is displayed.

3. Select the RDA device that you want to remove, right-click, and select Remove.

注: Ensure that you remove the RDA device from NVBU before you delete the container from the DR Series 
system. You must force remove the RDS device from NVBU, if you delete an RDS container from the DR Series 
system before removing it from the NVBU server.

4. Repeat step 3 to remove additional RDS devices.

The selected RDS device is removed from NVBU. The RDS container can now be removed from the DR Series system.
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Backing Up Data on the RDS Container Using NVBU
You must back up data on the RDS container (available on the DR Series systems) using NVBU. Before you can back up 
data using the RDS protocol, you must create an RDS container on the DR Series system and add that container as an 
RDA device on NVBU. For more information see, Adding RDA Device on NVBU.

To back up data on the RDS container:

1. In the NVBU Console, click Backup.
The NVBU Backup window is displayed.

2. From the Server Location list, select the relevant NVBU server.

3. In Job Title, enter a relevant job title.

4. In the Selections tab, select the appropriate built in Netvault Backup plugin.
For example, to backup the filesystem, select the filesystem plugin.

5. Navigate to the drive or folder that you want to back up and select that drive or folder.

6. Select the Backup Options tab, under Backup Method select the relevant backup options.
You can select one of the following:

– Standard

– Volume Shadow Copy Service (VSS)

7. In Backup Type, select the relevant backup type.
You can select one of the following:

– Full

– Incremental

– Differential

8. Under Backup Options, select the relevant options.
You can select:

– Ignore Active Bit

– Check for Files Being Modified During Backup

– Backup through Mount Points

– Enable Restartable Backup

9. Under Backup Options, if necessary, enter the Path to Backup Log.

10. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a pre-specified 
Trigger name.

11. Under Job Options select the relevant options.

12. Select The Target tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

13. Select the relevant RDS device from the list of displayed devices.
You can select more than one device.
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14. Select the Advanced Options tab, and select the relevant options.

15. To run the backup job, click the Submit icon.

The backup job may take a few minutes to complete depending on the amount of data that is backed up. You can view 
the progress of the backup job on NVBU, using the Job Management section of NVBU.

注: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Replicating Data to an RDS Container Using NVBU
Using NVBU with the DR Series system, you can run optimized replication jobs. You can replicate data in backup RDS 
containers on one DR Series system to a target RDS container that is on a different DR Series system. The two DR Series 
systems containing the source and target containers and the NVBU server must be on the same subnet. Both the source 
and target RDS containers must be added to the NVBU server as RDA devices. You can complete optimized replication 
(or optimized duplication) of backups that you complete using NVBU.

注: You cannot replicate RDS containers using the DR Series system native replication feature.

注: The source or backup container and the target container must use the RDS protocol.

To replicate the data available on the backup RDS container to a target RDS container:

1. In the NVBU Console, click Backup.
The NVBU Backup window is displayed.

2. From the Server Location list, select the relevant NVBU server.

3. In Job Title, enter a relevant job title.

4. In the Selections tab, select Data Copyand then Backups or Backup Sets and navigate to the backup job that you 
want to replicate.

5. Select the Backup Options tab, under Data Copy Options select the relevant options.

注: Under Copy Type, by default, options are set for Copy and Optimized replication for the DR Series systems.

6. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a prespecified 
Trigger name.

7. Under Job Options select the relevant options.

8. Select the Source tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

9. Select the relevant source RDS device from the list of displayed devices.
You can select more than one device.

10. Select the Target tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

11. Select the relevant target RDS device from the list of displayed devices.
You can select more than one device.

12. Under Media Options and General Options, select the relevant option.
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13. Select the Advanced Options tab and select the relevant options.

14. To run the optimized replication job, click the Submit icon.

注: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Restoring Data From a DR Series System Using NVBU
Use NVBU to restore data from a RDS container on a DR Series system.

To restore data from a DR Series system using NVBU:

1. In the NVBU Console, click Restore.
The NVBU Restore window is displayed.

2. From the Server Location list, select the relevant NVBU server.

3. In Job Title, enter a relevant job title.

4. In the Selections tab, navigate to the backup job that you want to restore.
By default, the data is restored into the folder that you have backed up.

5. To change the restore location, double click the backup saveset, navigate to the folder that you backed up, right 
click the folder and select Rename.
The Restore Rename window is displayed.

6. To rename the restore folder, select Rename to and enter the new name for the restore folder.

7. To relocate the restore data, select Relocate to and enter the new location for the restore folder.

8. From the Selection Method list, select Plugin, Backup Set, or Job.
By default Plugin is selected.

You can filter the backups using the Filter Options.

9. Select the Restore Options tab and select the relevant File System Plugin Restore Options.

10. Select the Source tab, under Device Options select, Specify Device.
The RDS devices added to NVBU are displayed.

11. Select the relevant source RDS device from the list of displayed devices.
You can select more than one device.

12. Select the Target Client tab.
A list of available clients is displayed.

13. From the list of available client, select the relevant target client.

14. Select the Schedule tab, under Schedule Options select one of the following:

– Immediate — This option starts the backup operation as soon as you save the current backup job.

– Once — This option allows you to run the backup only once at a scheduled time and date.

– Repeating — This option allows you to run the backup at a scheduled time and date on a daily, weekly, or 
monthly basis.

– Triggered — This option allows you to run the backup whenever the system encounters a prespecified 
Trigger name.

15. Under Job Options select the relevant options.

16. Select the Advanced Options tab and select the relevant options.

17. To run the restore job, click the Submit icon.
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注: For more information on Dell Quest NetVault Backup, see the Dell Quest NetVault Backup Administrator’s 
Guide.

Supported DR Series System CLI Commands for RDS
The following are the supported DR Series system CLI commands for RDS operations:

administrator@DocTeam-SW-01 > rda
Usage:
        rda --show [--config]
                 [--file_history] [--name <name>]
                 [--active_files] [--name <name>]
                 [--clients]
                 [--limits]

        rda --setpassword
        rda --delete_client --name <RDA Client Hostname>

        rda --update_client --name <RDA Client Hostname>
                 --mode <auto|passthrough|dedupe>

        rda --limit --speed <<num><kbps|mbps|gbps> | default>
                 --target <ip address | hostname>

        rda --help

   rda <command> <command-arguments>
   <command> can be one of:
                --show            Displays command specific information.
                --setpassword     Updates the Rapid Data Access (RDA) user 
password.
                --delete_client   Deletes the Rapid Data Access (RDA) client.
                --update_client   Updates attributes of a Rapid Data Access 
(RDA) client.
                --limit           Limits bandwidth consumed by Rapid Data 
Access(RDA) when replicating over a WAN link.

For command-specific help, please type rda --help <command>
        eg:
            rda --help show

注: The --files in the rda --show --file_history command represents replicated files that were processed via the 
DMA optimized duplication operation. This command displays only up to the last 10 such files. The --name in the 
rda --show --name command represents the RDA container name. For more information about RDA-related DR 
Series system CLI commands, see the Dell DR Series System Command Line Reference Guide.
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10
Troubleshooting and Maintenance
This topic provides an overview of the basic troubleshooting and maintenance information that is available to help you 
better understand the current state of your DR Series system. The following list of information sources can aid you in 
understanding the current state of and maintaining your system:

• System alert and system event messages, for more information, see DR Series System Alert and Event 
Messages, which provides a tables that list the system alerts and system events.

• Diagnostics service, for more information, see About the Diagnostics Service.

• Maintenance mode, for more information, see About the DR Series Maintenance Mode.

• Support mode, for more information, see About the DR Series Support Mode.

• Scheduling system operations, for more information, see Scheduling DR Series System Operations.

• Scheduling Replication operations, for more information, see Creating a Replication Schedule.

• Scheduling Cleaner operations, for more information, see Creating a Cleaner Schedule.

Troubleshooting Error Conditions
To troubleshoot error conditions that disrupt your normal DR Series system operations, complete the following:

1. Generate a DR Series system diagnostics log file bundle if one has not already been automatically created.
For more information, see Generating a Diagnostics Log File.

2. Check the system alert and system event messages to determine the current status of your DR Series system.
For more information, see DR Series System Alert and Event Messages, Monitoring System Alerts, and Monitoring 
System Events.

3. Verify if the DR Series system has recovered or whether it has entered into Maintenance mode or Support mode.
For more information, see About the DR Series System Maintenance Mode and About the DR Series System 
Support Mode.

4. If you cannot resolve the issue using the information in this DR Series system documentation, then read Before 
Contacting Dell Support, and seek assistance from Dell Support.

DR Series 系统警报和事件消息

DR Series 系统提供了多种系统警报和系统事件消息类型来描述系统的当前状态。您可以阅读这些消息，然后
确定是否可以采取任何措施来解决所报告的问题。

Dell 建议参阅本主题和其他相关主题中的材料：

• 尝试排除 DR Series 系统故障之前。

• 联系 Dell 支持部门寻求技术协助之前。

使用 DR Series 系统说明文件中提供的信息可能有助于解决某些基本问题。

某些警报和事件消息只是为了提供信息，并提供常规系统状态。其他警报和事件消息则显示特定状态或组件信

息，或者建议可通过执行特定任务来解决某一问题或确认是否存在某种情况。
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仍会有其他一些警报和事件信息将您引导至 Dell 支持寻求帮助，此时可能需要 Dell 支持干预。

• 表 1 按系统警报类型列出了 DR Series 系统警报消息：常规系统、系统机箱、NVRAM 以及在备份和重复
数据消除相关操作期间可能显示的 PERC 特定警报消息。

• 表 2 按系统事件类型（类型 1 到 7）列出了 DR Series 系统事件消息：备份、复制、重复数据消除、诊
断、清理器、DataCheck、维护和 OpenStorage Technology (OST) 操作期间可能显示的事件消息。

表. 7: DR Series 系统警报消息

警报消息 说明/含义或措施

常规系统警报

Filesystem scan requested.（已请求文件系统扫描。） 系统正切换至维护模式。文件系统具有只读访问权
限。

NVRAM not detected.（未检测到 NVRAM。） 请确保 NVRAM 卡正确就位。

NVRAM capacitor is disconnected.（NVRAM 电容器已

断开连接。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

NVRAM capacitor has degraded.（NVRAM 电容器已降

级。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

NVRAM solid-state drives (SSD) are disconnected.
（NVRAM 固态驱动器 (SSD) 已断开连接。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

NVRAM has failed to backup or restore data during the 
last boot.（NVRAM 在上次引导期间未能备份或还原数

据。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

NVRAM hardware failure.（NVRAM 硬件故障。） 请联系 Dell 支持部门，寻求可能的支持帮助或干预。

Data volume is not present. Check that all drives are 
installed and powered up.（数据卷不存在。请检查是

否已安装全部驱动器并通电。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

File server failed to start after multiple attempts.（文件服

务器在多次尝试后未能启动。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

File server failed multiple times. Entering Maintenance 
mode.（文件服务器多次失败。正在进入维护模

式。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

Insufficient disk space exists.（现有磁盘空间不足。） 文件系统现在为只读。

Unable to detect filesystem type on the Data volume.（无

法检测数据卷上的文件系统类型。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

Unable to detect filesystem type on the Namespace 
volume.（无法检测命名空间卷上的文件系统类型。）

请联系 Dell 支持部门，寻求可能的支持帮助或干预。

Filesystem scan discovered inconsistencies.（文件系统

扫描发现不一致问题。）

请检查文件系统报告，然后执行所建议的操作。请联

系 Dell 支持部门，寻求可能的协助或干预。

Replication peer network disconnected.（复制对等网络

已断开连接。）

请检查对远程站点的访问权限。

NVRAM does not match the data volume.（NVRAM 与数

据卷不匹配。）

如果这是新更换的 NVRAM，请使用 maintenance --
hardware --reinit_nvram 命令重新初始化此 NVRAM。
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警报消息 说明/含义或措施

有关更多信息，请参阅 Dell DR Series System Command 
Line Reference Guide（Dell DR Series 系统命令行参考指
南）。

Storage usage is approaching the system capacity.（存

储使用量接近系统容量。）

请清理文件系统。如果问题仍然存在，请联系 Dell 支
持部门寻求可能的帮助或干预。

Replication resync cannot proceed.（复制重新同步无

法继续。）

命名空间限制已达到其 大值。

Out of space on replication target.（复制目标上的空间

不足。）

请清理文件系统。如果问题仍然存在，请联系 Dell 支
持部门寻求可能的帮助或干预。

The filesystem has reached the maximum allowable limit 
for files and directories. Creating new files and 
directories will be denied.（文件系统已达到所允许的

大文件和目录数限制。创建新文件和目录将被拒
绝。）

请清理文件系统。如果问题仍然存在，请联系 Dell 支
持部门寻求可能的帮助或干预。

系统机箱警报

Power Supply <number> detected a failure.（检测到电

源设备 <number> 故障。）
• 如果电源线与指定的电源设备断开连接，请将

其重新连接起来。

• 请确保电源线上有输入交流电。

• 使用不同的电源线。

如果这样不能解决问题，请更换指定的电源设备。

Power Supply <number> is missing or has been removed.
（电源 <number> 缺失或已卸下。）

• 电源设备可能未正确连接。

• 请尝试在电源设备插槽中重新放置电源设备。

• 如果电源线与指定的电源设备断开连接，请将
其重新连接起来。

• 请确保电源线上有输入交流电。

• 使用不同的电源线。

如果这样不能解决问题，请更换指定的电源设备。

Power Supply <number> is unplugged.（电源设备 

<number> 已拔出。）
• 如果电源线与指定的电源设备断开连接，请将

其重新连接起来。

• 请确保电源线上有输入交流电。

• 使用不同的电源线。

Fan <number> failed.（风扇 <number> 故障。） • 请确认是否存在并正确安装指定散热风扇。

• 请确认指定散热风扇是否运转。

如果这不能解决问题，请更换指定散热风扇。

Fan <number> is missing.（风扇 <number> 缺失。） 请连接或更换缺失的指定散热风扇。

Abnormal network errors detected on Network Interface 
Controller <number>.（网络接口控制器 <number> 上检

测到异常网络错误。）

网络接口控制器错误可能是由网络拥塞或数据包错误
引起的。

• 请检查网络。如果这不能解决问题，请更换 
NIC。
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警报消息 说明/含义或措施

• 如果是嵌入式 NIC，则需要维修 DR Series 系统
设备。

Network Interface Controller is missing.（网络接口控制

器缺失。）
• 请卸下并重新插入 NIC。
• 如果这不能解决问题，请更换 NIC。

Network Interface Controller <name> is disconnected.
（网络接口控制器 <name> 已断开连接。）

请将其连接至网络并/或检查网络交换机或路由器是否

存在任何网络连接问题。

Network Interface Controller <name> is disabled.（网络

接口控制器 <name> 已禁用。）

请启用指定的 NIC 上的端口。

Network Interface Controller <name> driver is bad.（网

络接口控制器 <name> 驱动程序已损坏。）

请升级 DR Series 系统设备（在 Software Upgrade（软

件升级）页面中，单击 Start Upgrade（开始升

级））。

CPU <name> failed.（CPU <name> 故障。） 请更换指定的故障处理器。

CPU <name> is missing.（CPU <name> 缺失。） 请重新插入或更换缺失的指定处理器。

DIMM <name> failed.（DIMM <name> 故障。） 请更换指定的故障 DIMM（双列直插内存模块）设

备。

DIMM <name> is missing.（DIMM <name> 缺失。） • 请重新插入或更换指定的 DIMM 设备。

• 存储设备的内存容量低于正确运行所需的 小
值。

• 存储设备需要维修。

Temperature probe <name> failed.（温度探针 <name> 
故障。）

存储设备需要维修。

Voltage probe <name> failed.（电压探针 <name> 故
障。）

存储设备需要维修。

Temperature probes have recorded temperatures in the 
failed range.（温度探针录得处于故障范围内的温

度。）

• 请检查 DR Series 系统中的 Events （事件）页
面，了解具体的温度事件和温度探针的位置。

• 请检查数据中心的空调、通风和内部系统散热
风扇有无任何问题。

• 请确保有适当的气流穿过存储设备，并根据需
要清理散热孔。

Voltage probes have recorded readings in the failed 
range.（电压探针录得处于故障范围内的读数。）

• 请检查 DR Series 系统中的 Events（事件）页
面，了解具体的电压事件和电压探针的位置。

• 请检查电源设备。如果电源设备没有问题，则
请维修技术人员检查 DR Series 系统设备，确定
其是否需要维修。

Storage Controller <number> failed.（存储控制器 

<number> 故障。）

请更换 DR Series 系统中的 RAID 控制器。

Storage Controller <number> is missing.（存储控制器 

<number> 缺失。）

请重新插入或更换 DR Series 系统中的 RAID 控制器。
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警报消息 说明/含义或措施

Storage Controller <number> has an illegal configuration.
（存储控制器 <number> 具有非法配置。）

The expected number of virtual drives is <number>, and 
the actual number of virtual drives found was <number>.
（预期的虚拟驱动器数为 <number>，而实际找到的虚

拟驱动器数为 <number>。）

请运行 Dell Restore Manager (RM) 公用程序来修复驱动
器配置不匹配问题。

预期的机柜数为 <number>，而实际找到的机柜数为 
<number>。

• 请检查存储控制器与其所有机柜之间的 SAS 电
缆连接。

• 请检查机柜电源设备的电源线连接。

Physical disk <number> failed.（物理磁盘 <number> 故
障。）

请更换故障的物理磁盘。

Physical disk <number> is missing, removed, or it cannot 
be detected.（物理磁盘 <number> 缺失、已卸下或无

法检测到。）

请重新插入或更换此物理磁盘。

Physical disk <number> predictive failure reported.（物

理磁盘 <number> 报告预测故障。）

请更换此物理磁盘。

注: 即使此磁盘尚未发生故障，但建议的 佳做法

是更换此磁盘。

Physical disk <number> is an unsupported type.（物理磁

盘 <number> 属于不支持的类型。）

此磁盘类型不受支持，无法在此配置中使用。

请使用 Dell 支持的 SAS 物理磁盘更换不支持的物理磁
盘。

Physical disk <number> has been manually set to offline 
with a configuration command.（物理磁盘 <number> 已
通过配置命令手动设置为脱机。）

请卸下此物理磁盘并重新插入（驱动器在此状态下不

可操作）。

Physical disk <number> is foreign.（物理磁盘 <number> 
是外部磁盘。）

当已更换存储控制器或从另一个系统迁移所有驱动器
时，可能会发生此问题。这种情况下，应导入外部配

置。

如果在单一物理磁盘上看到此消息，则应清除外部配
置。

注: 当卸下并重新插入驱动器，同时重建仍在进行

时，也可能会发生此情况。

Virtual Disk <number> failed.（虚拟磁盘 <number> 故
障。）

请更换所有故障或缺失的物理磁盘，然后运行 Dell 
Restore Manager (RM) 公用程序。

Virtual Disk <number> has an invalid layout.（虚拟磁盘 

<number> 具有无效的布局。）

请运行 Dell Restore Manager (RM) 公用程序来修复此安

装。

<device> failed.（<device> 故障。） • 确认设备是否存在，然后检查电缆是否正确连
接。有关更多信息，请参阅 Dell DR Series 
System Owner’s Manual（Dell DR Series 所有
者手册）以确认系统布线是否正确。

• 检查与控制器电池的连接和电池健康状况。

• 如果这些步骤均无法解决问题，请更换存储控
制器电池。
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警报消息 说明/含义或措施

<device> is missing.（<device> 缺失。） • 确认设备是否存在，然后检查电缆是否正确连
接。有关更多信息，请参阅 Dell DR Series 
System Owner’s Manual（Dell DR Series 所有
者手册）以确认系统布线是否正确。

• 检查与控制器电池的连接和电池健康状况。

注: 当电池电量不足或耗尽时，可能会导致此警

告。

Storage <device> has failed.（存储 <device> 故障。） 请检查存储控制器与机柜或背板之间的电缆连接。

Storage <device> is missing.（存储 <device> 缺失。） 执行以下操作：

• 请检查存储控制器与机柜或背板之间的 SAS 和
电源线连接。

• 请检查外部机柜管理模块 (EMM) 和 PERC 状态 
LED。

NVRAM 警报

NVRAM PCI Controller failed.（NVRAM PCI 控制器故

障。）

请更换 NVRAM PCI 控制器。

NVRAM PCI Controller is missing.（NVRAM PCI 控制器

缺失。）

请重新插入或更换 NVRAM PCI 控制器。

Super Capacitor on the NVRAM PCI Controller failed.
（NVRAM PCI 控制器上的超级电容器故障。）

请更换 NVRAM PCI 控制器。

Super Capacitor on the NVRAM PCI Controller is missing.
（NVRAM PCI 控制器上的超级电容器缺失。）

请更换 NVRAM PCI 控制器。

Failed to check software compatibility.（未能检查软件

兼容性。）

升级 DR Series 系统设备（在 Software Upgrade（软件

升级）页面中，单击 Start Upgrade（开始升级））。

The system software package is incompatible with the 
current software stack.（系统软件包与当前软件堆栈

不兼容。）

升级 DR Series 系统设备（在 Software Upgrade（软件

升级）页面中，单击 Start Upgrade（开始升级））。

PERC 警报

The storage appliance failed to gather the system 
diagnostics.（存储设备未能收集系统诊断信息。）

• 请解决 DR Series 系统诊断日志捆绑包中的所有
问题。

• 请重新尝试收集诊断日志捆绑包。

• 请联系 Dell 支持部门寻求帮助。

Storage Appliance Critical Error: BIOS System ID is 
incorrect for correct operation of this storage appliance.
（存储设备严重错误：BIOS 系统 ID 不正确，导致此

存储设备无法正确运行。）

• DR Series 系统设备需要维修。

• 请联系 Dell 支持部门寻求帮助。
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表. 8: DR Series 系统事件消息

系统事件消息 说明/含义或措施

系统事件 = 类型 1

System memory usage has returned to an optimal 
level.（系统内存使用量已回到 佳水平。）

信息类消息。不需要用户干预。

A high level of system process usage has been 
detected, if it persists, please collect system 
diagnostics.（检测到系统进程使用量水平过高，如

果此问题持续存在，请收集系统诊断信息。）

信息类消息。不需要用户干预。

System process usage has returned to an optimal 
level.（系统进程使用量已回到 佳水平。）

信息类消息。不需要用户干预。

A high-temperature reading has been detected on the 
NVRAM PCI controller. System will operate only in a 
read-only mode. Please check system airflow.
（NVRAM PCI 控制器上检测到温度读数过高。系

统将仅在只读模式下运行。请检查系统气流。）

信息类消息。不需要用户干预。

A high-temperature reading has been detected on the 
NVRAM PCI controller. System will not become 
operational until the temperature reduces to an 
ambient value of 55 degrees Celsius (131 degrees 
Fahrenheit).（NVRAM PCI 控制器上检测到温度读数

过高。直到温度降至 55 摄氏度（131 华氏度）的环

境温度值之后，系统才会恢复运行。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预。

The next NVRAM capacitor health check is scheduled 
for <variable>.（下次 NVRAM 电容器运行状况检查

计划于 <variable> 执行。）

信息类消息。不需要用户干预。

Windows Active Directory client is unable to contact 
the Active Directory domain server.（Windows Active 
Directory 客户端无法连接 Active Directory 域服务

器。）

信息类消息。不需要用户干预。

Active Directory domain server connectivity is 
restored.（Active Directory 域服务器连接已恢

复。）

信息类消息。不需要用户干预。

The system IP address has changed from <variable> to 
<variable>.（系统 IP 地址已从 <variable> 更改为 

<variable>。）

信息类消息。不需要用户干预。

Filesystem scan has been requested. Switching to 
Maintenance mode. Filesystem has read-only access.
（已请求文件系统扫描。正切换至维护模式。文

件系统具有只读访问权限。）

信息类消息。不需要用户干预。

NVRAM not detected. Ensure card is seated properly.
（未检测到 NVRAM。请确保卡已正确就位。）

请确认 NVRAM 卡是否已在 DR Series 系统设备中正确就

位。请联系 Dell 支持部门寻求协助或干预。
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系统事件消息 说明/含义或措施

NVRAM capacitor is disconnected.（NVRAM 电容器

已断开连接。）

请联系 Dell 支持部门寻求协助或干预。

NVRAM capacitor has degraded.（NVRAM 电容器已

降级。）

请联系 Dell 支持部门寻求协助或干预。

NVRAM SSD is disconnected.（NVRAM SSD 已断开

连接。）

请联系 Dell 支持部门寻求协助或干预。

NVRAM has failed to backup or restore data during the 
last boot.（NVRAM 在上次引导期间未能备份或还

原数据。）

请联系 Dell 支持部门寻求协助或干预。

NVRAM hardware failure.（NVRAM 硬件故障。） 请联系 Dell 支持部门寻求协助或干预。

Data volume is not present. Check that all drives are 
inserted and powered up.（数据卷不存在。请检查

是否已插入全部驱动器并通电。）

请联系 Dell 支持部门寻求协助或干预。

Filesystem server failed to start after multiple attempts.
（文件系统服务器未能在多次尝试后启动。）

请联系 Dell 支持部门寻求协助或干预。

Filesystem server crashed multiple times. System is 
now entering Maintenance mode.（文件系统服务器

多次崩溃。系统现在正进入维护模式。）

请联系 Dell 支持部门寻求协助或干预。

Insufficient disk space. Filesystem switched to read-
only mode.（磁盘空间不足。文件系统已切换至只

读模式。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预。

Unable to detect filesystem type on the Data Volume.
（无法检测数据卷上的文件系统类型。）

请联系 Dell 支持部门寻求协助或干预。

Unable to detect filesystem type on the Namespace 
Volume.（无法检测命名空间卷上的文件系统类

型。）

请联系 Dell 支持部门寻求协助或干预。

Filesystem scan discovered inconsistencies.（文件系

统扫描发现不一致问题。）

Please check report and take the recommended action. 
Contact Dell Support for assistance or intervention.（请检查

报告并采取建议的措施。请联系 Dell 支持部门寻求协助

或干预。）

NVRAM does not match data volume.（NVRAM 与数

据卷不匹配。）

如果这是新更换的 NVRAM 设备，请使用 CLI maintenance 
--hardware --reinit_nvram 命令。有关更多信息，请参阅 

Dell DR Series System Command Line Reference Guide（Dell 
DR Series 系统命令行参考指南）。

Storage usage is approaching the DR Series system 
capacity.（存储使用量接近 DR Series 系统容

量。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预。

Replication resync cannot proceed because the 
Namespace depth has reached its maximum.（由于

命名空间深度已达 大值，因此复制重新同步无

法继续。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预。
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系统事件消息 说明/含义或措施

Filesystem has reached the maximum allowable file(s) 
and directories limit. New file and directory creation 
will be denied until sufficient space exists.（文件系统

已达到所允许的 大文件和目录数限制。在具有
充足空间之前，将拒绝创建新文件和目录。）

请清理文件系统。如果问题仍然存在，请联系 Dell 支持

部门寻求协助或干预。

Filesystem is reaching the maximum allowable file(s) 
and directories limit. New file and directory creation 
will be denied after the limit has been reached.（文件

系统即将达到所允许的 大文件和目录数限制。
在达到限制之后，将拒绝创建新文件和目录。）

请清理文件系统。如果问题仍然存在，请联系 Dell 支持

部门寻求协助或干预。

Replication has encountered an unexpected error.
（复制遇到意外错误。）

请联系 Dell 支持部门寻求协助或干预。

DataCheck has detected a potential corruption.
（DataCheck 检测到潜在损坏问题。）

Run data consistency checks at the first available opportunity. 
If this issue persists, contact Dell Support for assistance or 
intervention.（请及时执行数据一致性检查。如果此问题

仍然存在，请联系 Dell 支持部门寻求协助或干预。）

Temperature warning detected on NVRAM PCI 
controller.（NVRAM PCI 控制器上检测到温度警

告。）

请检查数据中心的空调、机架通风和内部散热风扇有无
任何问题。请确保有适当的气流穿过系统设备，并根据

需要清理系统散热孔。如果问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

Filesystem Name Space partition has reached its 
maximum allowable limit.（文件系统命名空间分区

已达到所允许的 大限制。）

请删除所有旧的、未使用的文件或禁用复制。如果问题
仍然存在，请联系 Dell 支持部门寻求协助或干预。

Filesystem Name Space partition is reaching its 
maximum allowable limit.（文件系统命名空间分区

即将达到所允许的 大限制。）

新的复制重新同步将被停止。如果问题仍然存在，请联

系 Dell 支持部门寻求协助或干预。

One or more software packages are incompatible.
（一个或多个软件包不兼容。）

请升级系统设备以纠正此问题。升级 DR Series 系统设备

（在 Software Upgrade（软件升级）页面中，单击 Start 
Upgrade（开始升级））。

系统事件 = 类型 2

Container <name> created successfully.（成功创建

容器 <name>。）

信息类消息。不需要用户干预。

Container <name> marked for deletion.（容器 

<name> 已标记为删除。）

有关更多信息，请参阅删除容器。请使用 DR Series 系统 

CLI maintenance --filesystem --reclaim_space 命令来恢复此

存储空间。

Successfully renamed container <name> as <name>.
（成功将容器 <name> 重命名为 <name>。）

信息类消息。不需要用户干预。

Successfully added connection entry for container 
<name>: type <variable> clients <variable>.（成功为

容器 <name> 添加连接条目：类型 <variable> 客户

端 <variable>。）

信息类消息。不需要用户干预。
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系统事件消息 说明/含义或措施

Successfully updated connection entry for container 
<name>: type <variable> clients <variable>.（成功更

新容器 <name> 的连接条目：类型 <variable> 客户

端 <variable>。）

信息类消息。不需要用户干预。

Successfully deleted connection entry for container 
<name>: type <variable> clients <variable>.（成功删

除容器 <name> 的连接条目：类型 <variable> 客户

端 <variable>。）

信息类消息。不需要用户干预。

Replication entry updated successfully for container 
<name>: role <variable> peer <variable> peer 
container <variable>.（成功更新容器 <name> 的复

制条目：角色 <variable> 对等 <variable> 对等容器 

<variable>。）

信息类消息。不需要用户干预。

Replication configuration updated successfully for 
container <name>: role <variable> peer <variable>.
（成功更新容器 <name> 的复制配置：角色 

<variable> 对等 <variable>。）

信息类消息。不需要用户干预。

Replication configuration deleted successfully for 
container <name>: peer <variable> peer container 
<name>.（成功删除容器 <name> 的复制配置：对

等 <variable> 对等容器 <name>。）

信息类消息。不需要用户干预。

Replication <variable> defaults successfully updated: 
role <variable> peer <variable>.（成功更新复制 

<variable> 的默认值：角色 <variable> 对等 

<variable>。）

信息类消息。不需要用户干预。

Successfully updated replication bandwidth limit for 
<variable> to <variable>.（成功将复制带宽限制 

<variable> 更新为 <variable>。）

信息类消息。不需要用户干预。

Successfully removed replication bandwidth limit for 
<variable>.（成功移除复制带宽限制 <variable>。）

信息类消息。不需要用户干预。

Successfully set <variable> replication bandwidth 
limit.（成功设置 <variable> 复制带宽限制。）

信息类消息。不需要用户干预。

Successfully initiated replication resync on container 
<name>.（在容器 <name> 上成功启动复制重新同

步。）

信息类消息。不需要用户干预。

Failure initiating replication resync on container 
<name>.（在容器 <name> 上启动复制重新同步失

败。）

有关更多信息，请参阅管理复制操作。

Snapshot <variable> → <variable> created 
successfully.（成功创建快照 <variable> → 

<variable>。）

信息类消息。不需要用户干预。
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系统事件消息 说明/含义或措施

Snapshot <variable> → <variable> successfully 
updated.（成功更新快照 <variable> → 

<variable>。）

信息类消息。不需要用户干预。

Snapshot <variable> → <variable> successfully 
deleted.（成功删除快照 <variable> → 

<variable>。）

信息类消息。不需要用户干预。

Online data verification <variable> successfully.（联

机数据验证 <variable> 成功。）

信息类消息。不需要用户干预。

Successfully <variable> system marker for <variable>.
（成功 <variable> <variable> 的系统标记。）

信息类消息。不需要用户干预。

Successfully updated <variable> schedule.（成功更

新 <variable> 计划。）

信息类消息。不需要用户干预。

系统事件 = 类型 3

System is entering Maintenance mode.（系统正进入

维护模式。）

信息类消息。不需要用户干预。请联系 Dell 支持部门寻

求协助或干预。

System is entering Support mode.（系统正进入支持

模式。）

信息类消息。不需要用户干预。请联系 Dell 支持部门寻

求协助或干预。

Failure-OFS client initialization failure.（失败 - OFS 客
户端初始化失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure-mtab initialization failure for container if 
<variable>.（失败 - 如果 <variable>，则容器 mtab 
初始化失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure-cannot initialize node mtab.（失败 - 无法初始

化节点 mtab。）

请联系 Dell 支持部门寻求协助或干预。

Failure retrieving configuration for container ID 
<variable>.（检索容器 ID <variable> 的配置失

败。）

请联系 Dell 支持部门寻求协助或干预。

Failure deleting container ID <variable>.（删除容器 

ID <variable> 失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure stopping container ID <variable>.（停止容器 

ID <variable> 失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure adding connection <variable> for container ID 
<variable>.（为容器 ID <variable> 添加连接 

<variable> 失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure deleting connection <variable> for container ID 
<variable>.（删除容器 ID <variable> 的连接 

<variable> 失败。）

请联系 Dell 支持部门寻求协助或干预。

Replication started as per schedule, will be active until 
<variable>.（复制已按计划开始，将一直持续到 

<variable>。）

信息类消息。不需要用户干预。
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系统事件消息 说明/含义或措施

Replication stopped as per schedule, will restart at 
<variable>.（复制已按计划停止，将于 <variable> 
重新开始。）

信息类消息。不需要用户干预。

Container replay failed for container <variable>.（容

器 <variable> 的容器回放失败。）

信息类消息。不需要用户干预。请联系 Dell 支持部门寻

求协助或干预。

Failure-Name Space subsystem initialization failed.
（失败 - 命名空间子系统初始化失败。）

信息类消息。不需要用户干预。请联系 Dell 支持部门寻

求协助或干预。

Inconsistencies were found in the Name Space.（命

名空间中发现不一致。）

请使用 DR Series 系统 CLI maintenance --filesystem --
start_scan 命令计划文件系统一致性检查。

System entering Maintenance mode-Name Space log 
replay failed.（系统正进入维护模式 - 命名空间日志

回放失败。）

请联系 Dell 支持部门寻求协助或干预。

System entering Maintenance Mode-Name Space 
transaction failure.（系统正进入维护模式 - 命名空

间事务失败。）

请联系 Dell 支持部门寻求协助或干预。

Failure-failed to commit Name Space transaction.（失

败 - 未能提交命名空间事务。）

请联系 Dell 支持部门寻求协助或干预。

Filesystem has reached the maximum supported 
number of Name Space entries.（文件系统已达到所

支持的 大命名空间条目数。）

请清理文件系统，以便允许创建新文件和目录。如果此

情况仍然存在，请联系 Dell 支持部门寻求协助或干预。

Filesystem has recovered from a lack of available 
Name Space entries.（文件系统已从可用命名空间

条目不足的情况中恢复。）

现在不允许执行文件系统创建操作。请联系 Dell 支持部

门寻求协助或干预。

Internal attributes of some files were found to be 
corrupt. The DR Series system will not allow the 
setting or removing of Attributes or ACLs on files that 
have corrupt attributes.（发现某些文件的内部属性

损坏。DR Series 系统将不允许对具有损坏属性的

文件设置或移除属性或 ACL。）

要查找具有损坏属性的所有文件并清除此状态，请使用 

DR Series 系统 CLI maintenance --filesystem --start_scan 命
令执行维护扫描。请联系 Dell 支持部门寻求协助或干

预。

Replication resync started for container <variable>.
（容器 <variable> 已开始复制重新同步。）

信息类消息。不需要用户干预。

Replication internal resync started for container 
<variable>.（容器 <variable> 已开始复制内部重新

同步。）

信息类消息。不需要用户干预。

Replication resync completed for container <variable>.
（容器 <variable> 已完成复制重新同步。）

信息类消息。不需要用户干预。

Replication internal resync completed for container 
<variable>.（容器 <variable> 已完成复制内部重新

同步。）

信息类消息。不需要用户干预。

Failure creating replication snapshot for container 
<variable>.（为容器 <variable> 创建复制快照失

败。）

如果情况仍然存在，请减少 inode 数量或联系 Dell 支持部

门寻求协助或干预。
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系统事件消息 说明/含义或措施

Failure deleting replication snapshot for container 
<variable>.（删除容器 <variable> 的复制快照失

败。）

如果情况仍然存在，请减少 inode 数量或联系 Dell 支持部

门寻求协助或干预。

Replication client connected for container <variable>.
（已连接容器 <variable> 的复制客户端。）

信息类消息。不需要用户干预。

Replication client disconnected for container 
<variable>.（容器 <variable> 的复制客户端已断开

连接。）

确认复制端口（9904、9911、9915 和 9916）和 OST（10011 
和 11000）操作已启用。如果问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

Replication server connected for container <variable>.
（已连接容器 <variable> 的复制服务器。）

确认复制端口（9904、9911、9915 和 9916）和 OST（10011 
和 11000）操作已启用。如果问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

Replication server disconnected for container 
<variable>.（容器 <variable> 的复制服务器已断开

连接。）

信息类消息。不需要用户干预。

Replication Name Service volume operations log 
(oplog) full for container <variable>.（容器 <variable> 
的复制名称服务卷操作日志 (oplog) 已满。）

确认复制端口（9904、9911、9915 和 9916）和 OST（10011 
和 11000）操作已启用。如果问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

DR Series entering Maintenance mode due to corrupt 
Name Service volume operations log (oplog) for 
container <variable>.（由于容器 <variable> 的名称

服务卷操作日志 (oplog) 损坏，因此 DR Series 正进

入维护模式。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

Replication data operations log (oplog) full for 
container <variable>.（容器 <variable> 的复制数据

操作日志 (oplog) 已满。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

DR Series entering Maintenance mode due to corrupt 
replication data operations log (oplog) for container 
<variable>.（由于容器 <variable> 的复制数据操作

日志 (oplog) 损坏，因此 DR Series 正进入维护模

式。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

System entering Maintenance mode due to corrupt 
blockmap for container <variable> scid <variable>.
（由于容器 <variable> scid <variable> 的块图损

坏，因此系统正进入维护模式。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

System entering Maintenance Mode due to corrupt 
datastore <variable> scid <variable>.（由于数据存储

区 <variable> scid <variable> 损坏，因此系统正进

入维护模式。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

Replication transmit log (txlog) full for container 
<variable>.（容器 <variable> 的复制传输日志 (txlog) 
已满。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

DR Series entering Maintenance mode due to corrupt 
replication txlog for container <variable>.（由于容器 

请收集诊断日志文件，并打开支持记录向 Dell 支持部门

寻求帮助。
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系统事件消息 说明/含义或措施

<variable> 的复制 txlog 损坏，因此 DR Series 正进

入维护模式。）

System entering Maintenance mode due to replication 
txlog commit error <variable> for container <variable>.
（由于容器 <variable> 的复制 txlog 提交错误 

<variable>，因此系统正进入维护模式。）

请收集诊断日志文件，并打开支持记录向 Dell 支持部门

寻求帮助。

DR Series entering Maintenance mode due to corrupt 
chunk data for container <variable>.（由于容器 

<variable> 的区块数据损坏，因此 DR Series 正进入

维护模式。）

请收集诊断日志文件，并打开支持记录向 Dell 支持部门

寻求帮助。

File replication unable to make progress on container 
<variable>.（文件复制无法在容器 <variable> 上进

行。）

请收集诊断日志文件，并打开支持记录向 Dell 支持部门

寻求帮助。

Replication syncmgr exited for container <variable> 
error <variable>.（因容器 <variable> 错误 <variable> 
导致退出复制 syncmgr。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication syncmgr event for container <variable> 
error <variable>.（因容器 <variable> 错误 <variable> 
导致复制 syncmgr 事件。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication Name Service exited for container 
<variable> error <variable>.（因容器 <variable> 错误 

<variable> 导致退出复制名称服务。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication data replicator exited for container 
<variable> error <variable>.（因容器 <variable> 错误 

<variable> 导致退出复制数据复制器。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication protocol version mismatch for container 
<variable> error <variable>.（因容器 <variable> 错误 

<variable> 导致复制协议版本不匹配。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication delete cleanup failed for container 
<variable> error <variable>.（因容器 <variable> 错误 

<variable> 导致复制删除清理失败。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication target system <variable> is running low on 
space. Replication cannot proceed further on 
container <variable>.（复制目标系统 <variable> 的
空间即将耗尽。无法在容器 <variable> 上继续进行

复制。）

信息类消息。请联系 Dell 支持部门寻求协助或干预。

Replication misconfiguration detected for container 
<variable>. Replication relationship might have been 
deleted forcibly on target system <variable>.（检测到

容器 <variable> 配置错误。可能已在目标系统 

<variable> 上强制删除复制关系。）

信息类消息。请联系 Dell 支持部门寻求协助或干预。
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Replication failed for container <variable> error 
<variable>.（因容器 <variable> 错误 <variable> 导致

复制失败。）

收集诊断日志文件捆绑包，并打开一条支持记录向 Dell 
支持部门寻求帮助。

Replication server failed to commit blockmap for 
container <variable>. System is entering Maintenance 
mode.（复制服务器未能提交容器 <variable> 的块

图。系统正进入维护模式。）

DR Series 系统会自行纠正。如果情况仍然存在，请减少 

inode 数量或联系 Dell 支持部门寻求协助或干预。

Replication container <variable> is paused due to files 
pending in the Cleaner process.（由于清理器进程中

的待处理文件，复制容器 <variable> 已暂停。）

请在复制副本容器上运行清理器。如果此情况仍然存
在，请联系 Dell 支持部门寻求干预或协助。

System is running a lower version of RPC. This will 
stall replication on all target containers.（系统运行的 

RPC 版本较低。这将停止所有目标容器上的复

制。）

请将 RPC 升级至正确的版本。如果此情况仍然存在，请

联系 Dell 支持部门寻求干预或协助。

NFS client successfully mounted <variable>.（NFS 客
户端成功装载 <variable>。）

信息类消息。不需要用户干预。

Maximum NFS connection limit <variable> reached, 
active NFS connections <variable>.（已达到 大 

NFS 连接限制 <variable>，活动 NFS 连接数为 

<variable>。）

已达到阈值限制。请减少连接数量。

NFS server started successfully.（NFS 服务器已成功

启动。）

信息类消息。不需要用户干预。

CIFS client successfully connected to container 
<variable>.（CIFS 客户端成功连接至容器 

<variable>。）

信息类消息。不需要用户干预。

Maximum CIFS connection limit <variable> reached.
（已达到 大 CIFS 连接限制 <variable>。）

已达到阈值限制。请减少连接数量。

CIFS server failed to start <variable>.（CIFS 服务器未

能启动 <variable>。）

请重新引导 DR Series 系统。如果问题仍然存在，请联系 

Dell 支持部门寻求协助或干预。

CIFS client connected <variable> times to container 
<variable>.（CIFS 客户端已 <variable> 次连接至容

器 <variable>。）

请重新引导 DR Series 系统。如果问题仍然存在，请联系 

Dell 支持部门寻求协助或干预。

CIFS server started successfully.（CIFS 服务器已成

功启动。）

信息类消息。不需要用户干预。

Online data verification (DataCheck) started.（联机数

据验证 (DataCheck) 已开始。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

Online data verification (DataCheck) suspended.（联

机数据验证 (DataCheck) 已暂挂。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

Online data verification (DataCheck) stopped.（联机

数据验证 (DataCheck) 已停止。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。
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Online data verification (DataCheck) resumed.（联机

数据验证 (DataCheck) 已恢复。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

Online data verification (DataCheck) detected 
<variable> corruption.（联机数据验证 (DataCheck) 
检测到 <variable> 个损坏。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

Online data verification (DataCheck) detected 
<variable> corruptions.（联机数据验证 (DataCheck) 
检测到 <variable> 个损坏。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

Online data verification (DataCheck) failed to start.
（联机数据验证 (DataCheck) 未能开始。）

信息类消息。如果问题仍然存在，请联系 Dell 支持部门

寻求协助或干预。

系统事件 = 类型 4

Unable to load deduplication dictionary <variable>.
（无法加载重复数据消除字典 <variable>。）

请使用 DR Series 系统 CLI maintenance --configuration --
reinit_dictionary 命令。如果此问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

Unable to locate deduplication dictionary <variable>.
（无法定位重复数据消除字典 <variable>。）

请使用 DR Series 系统 CLI maintenance --configuration --
reinit_dictionary 命令。如果此问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

Cleaner process run <variable> started.（清理器进程

运行 <variable> 已开始。）

信息类消息。不需要用户干预。

Cleaner process run <variable> completed in 
<variable> milliseconds (ms).（清理器进程运行 

<variable> 已在 <variable> 毫秒 (ms) 后完成。）

信息类消息。不需要用户干预。

Cleaner process encountered input/output (I/O) errors.
（清理器进程遇到输入/输出 (I/O) 错误。）

DR Series 系统中基于维护的问题。请使用维护模式或 DR 
Series 系统 CLI 命令检查状态。根据需要联系 Dell 支持部

门。

Failure to sync NVRAM <variable>.（未能同步 

NVRAM <variable>。）

DR Series 系统中的 NVRAM 硬件问题。请使用维护模式或 

DR Series 系统 CLI 命令检查状态。

Failure in reading from NVRAM <variable>.（读取 

NVRAM <variable> 时失败。）

DR Series 系统中的 NVRAM 硬件问题。请使用维护模式或 

DR Series 系统 CLI 命令检查状态。

Failure in writing to NVRAM <variable>.（写入 

NVRAM <variable> 时失败。）

DR Series 系统中的 NVRAM 硬件问题。请使用维护模式或 

DR Series 系统 CLI 命令检查状态。

Failure to write sync NVRAM <variable>.（未能写入

同步 NVRAM <variable>。）

DR Series 系统中的 NVRAM 硬件问题。请使用维护模式或 

DR Series 系统 CLI 命令检查状态。

Datastore <variable> length mismatch <variable>.（数

据存储区 <variable> 长度不匹配 <variable>。）

DR Series 系统中基于维护的问题。请使用维护模式或 DR 
Series 系统 CLI 命令检查状态。根据需要联系 Dell 支持部

门。

Data volume capacity threshold reached.（已达到数

据卷容量阈值。）

信息类消息。不需要用户干预。

Out of space. Rollback of updates on object <variable> 
failed. Restarting file server.（空间不足。对象 

DR Series 系统中基于维护的问题。请使用维护模式或 DR 
Series 系统 CLI 命令检查状态。根据需要联系 Dell 支持部

门。
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<variable> 更新回滚失败。正在重新启动文件服务

器。）

Failure reading from data volume.（读取数据卷时失

败。）

DR Series 系统中基于维护的问题。请使用维护模式或 DR 
Series 系统 CLI 命令检查状态。根据需要联系 Dell 支持部

门。

Failure writing to data volume.（写入数据卷时失

败。）

DR Series 系统中基于维护的问题。请使用维护模式或 DR 
Series 系统 CLI 命令检查状态。根据需要联系 Dell 支持部

门。

Checksum verification on metadata failed.（针对元数

据的校验和验证失败。）

请联系 Dell 支持部门寻求协助或修复文件系统。有关修

复信息，请参阅关于 DR Series 维护模式。

Optimization engine log replay failed.（优化引擎日志

重播失败。）

请联系 Dell 支持部门寻求协助或修复文件系统。有关修

复信息，请参阅关于 DR Series 维护模式。

Decompression of datastore failed <variable>.（数据

存储区解压缩失败 <variable>。）

请联系 Dell 支持部门寻求协助或干预。

Failed to clean active datastore <variable>.（未能清

理活动数据存储区 <variable>。）

请联系 Dell 支持部门寻求协助或干预。

Negative reference on datastore <variable>. Record 
type: <variable>. Count: <variable>.（数据存储区 

<variable> 引用数为负值。记录类型：<variable>。
计数：<variable>。）

请联系 Dell 支持部门寻求协助或修复文件系统。有关修

复信息，请参阅“关于 DR Series 维护模式”。

Datastore <variable> contains negative stream 
reference count. Record type: <variable>. Count: 
<variable>.（数据存储区 <variable> 包含负流引用

计数。记录类型：<variable>。计数：

<variable>。）

信息类消息。不需要用户干预。

Datastore <variable> total reference count reached 
threshold. Record type: <variable>. Count: <variable>.
（数据存储区 <variable> 总引用计数已达到阈值。

记录类型：<variable>。计数：<variable>。）

信息类消息。不需要用户干预。

Entering Maintenance mode due to failure in 
processing logs.（由于未能处理日志，正在进入维

护模式。）

请联系 Dell 支持部门寻求协助或干预。

Failed to acquire optimizer pipeline. Error: <variable>.
（未能获得优化器管道。错误：<variable>。）

请联系 Dell 支持部门寻求干预或帮助。

Failed to create optimizer event. Type: <variable>, 
Error: <variable>.（未能创建优化器事件。类型：

<variable>，错误：<variable>。）

请联系 Dell 支持部门寻求干预或帮助。

Task execution in fiber <variable> timed out after 
<variable> milliseconds (ms). Restarting file server.
（光纤 <variable> 中的任务执行已在 <variable> 毫
秒 (ms) 后超时。正在重新启动文件服务器。）

已重新启动文件系统。请收集诊断日志文件捆绑包，然

后将其上传给 Dell 支持部门。

Memory allocation failure.（内存分配失败。） 请收集诊断日志文件捆绑包。
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Background compression started.（后台压缩已开

始。）

信息类消息。不需要用户干预。

Background compression completed.（后台压缩已完

成。）

信息类消息。不需要用户干预。

Optimization initialized on container <variable>.（容器 

<variable> 上已开始优化。）

信息类消息。不需要用户干预。

Optimization terminated on container <variable>.（容

器 <variable> 上已终止优化。）

信息类消息。不需要用户干预。

Cleaner process started as per schedule, will be active 
until <variable>.（清理器进程已按计划开始，将一

直持续到 <variable>。）

信息类消息。不需要用户干预。

Cleaner process stopped as per schedule, will restart 
at <variable>.（清理器进程已按计划停止，将于 

<variable> 重新开始。）

信息类消息。不需要用户干预。

Cleaner aborted at <variable>.（清理器已于 

<variable> 中止。）

DR Series 系统应进入维护模式，并且清理器进程将重新

启动。

Moving data from NVRAM to disk failed. System is 
entering its Maintenance mode.（将数据从 NVRAM 
移至磁盘时失败。系统正进入其维护模式。）

信息类消息。不需要用户干预。

Last event/invalid event.（上个事件/无效的事件。） 信息类消息。请联系 Dell 支持部门寻求协助或干预。

Filesystem Cleaner process started as per schedule 
(will be active until <variable>).（文件系统清理器进

程已按计划开始（将一直持续到 <variable>）。）

信息类消息。不需要用户干预。

Filesystem Cleaner process stopped as per schedule 
(will restart at <variable>).（文件系统清理器进程已

按计划停止（将于 <variable> 重新开始）。）

信息类消息。不需要用户干预。

系统事件 = 类型 5

System shutdown initiated by administrator.（管理员

已启动系统关闭过程。）

信息类消息。不需要用户干预。

System reboot initiated by administrator.（管理员已

启动系统重新引导。）

信息类消息。不需要用户干预。

Start system upgrade to version <variable>.（系统开

始升级至版本 <variable>。）

信息类消息。不需要用户干预。

System name changed to <variable>.（系统名称已更

改为 <variable>。）

信息类消息。不需要用户干预。

System date changed to <variable>.（系统日期已更

改为 <variable>。）

信息类消息。不需要用户干预。

System time zone changed to <variable>.（系统时区

已更改为 <variable>。）

信息类消息。不需要用户干预。
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Password changed for user: administrator.（用户：

administrator 的密码已更改。）

信息类消息。不需要用户干预。

NTP server <variable> added.（已添加 NTP 服务器 

<variable>。）

信息类消息。不需要用户干预。

NTP server <variable> deleted.（已删除 NTP 服务器 

<variable>。）

信息类消息。不需要用户干预。

NTP service enabled.（已启用 NTP 服务。） 信息类消息。不需要用户干预。

NTP service disabled.（已禁用 NTP 服务。） 信息类消息。不需要用户干预。

User data destroyed using CLI command.（使用 CLI 
命令时破坏了用户数据。）

信息类消息。不需要用户干预。

User <variable> enabled.（已启用用户 

<variable>。）

信息类消息。不需要用户干预。

User <variable> disabled.（已禁用用户 

<variable>。）

信息类消息。不需要用户干预。

Networking interfaces restarted.（已重新启动网络

接口。）

信息类消息。不需要用户干预。

DHCP enabled: IP address assigned by DHCP.（已启

用 DHCP：由 DHCP 分配 IP 地址。）

信息类消息。不需要用户干预。

Static IP address <variable> assigned.（已分配静态 

IP 地址 <variable>。）

信息类消息。不需要用户干预。

Network interface bonding mode set to <variable>.
（网络接口绑定模式已设置为 <variable>。）

信息类消息。不需要用户干预。

Network MTU size set to <variable>.（网络 MTU 大小

已设置为 <variable>。）

信息类消息。不需要用户干预。

System name set to <variable>.（系统名称已设置为 

<variable>。）

信息类消息。不需要用户干预。

Email relay host set to <variable> for email alerts.（用

于电子邮件警报的电子邮件中继主机已设置为 
<variable>。）

信息类消息。不需要用户干预。

Recipients for email alerts set to <variable>.（电子邮

件警报的收件人已设置为 <variable>。）

信息类消息。不需要用户干预。

Recipient <variable> added to receive email alerts.
（已添加收件人 <variable> 来接收电子邮件警

报。）

信息类消息。不需要用户干预。

Recipient <variable> is no longer receiving email 
alerts.（收件人 <variable> 不再接收电子邮件警

报。）

请检查电子邮件收件人是否仍然存在，或邮箱是否已

满。

Administrator information set to <variable> for email 
alerts.（电子邮件警报的管理员信息已设置为 

<variable>。）

信息类消息。不需要用户干预。
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Test email sent.（测试电子邮件已发送。） 信息类消息。不需要用户干预。

Joined the Windows Active Directory domain 
<variable>.（已加入 Windows Active Directory 域 

<variable>。）

信息类消息。不需要用户干预。

Left the Windows Active Directory domain <variable>.
（已退出 Windows Active Directory 域 

<variable>。）

信息类消息。不需要用户干预。

System diagnostics package <variable> deleted.（已

删除系统诊断数据包 <variable>。）

信息类消息。不需要用户干预。

All diagnostic packages deleted.（已删除所有诊断

数据包。）

信息类消息。不需要用户干预。

System diagnostic package <variable> is copied off 
the system.（已从系统复制系统诊断数据包 

<variable>。）

信息类消息。不需要用户干预。

System statistics reset by administrator.（管理员已

重置系统统计信息。）

信息类消息。不需要用户干预。

System diagnostic package <variable> is collected.
（已收集系统诊断数据包 <variable>。）

信息类消息。不需要用户干预。

System diagnostics space usage exceeded threshold. 
Auto cleaning oldest package: <variable>.（系统诊断

空间使用量已超过阈值。正在自动清理 旧的数
据包：<variable>。）

信息类消息。不需要用户干预。

CIFS server cannot access file service.（CIFS 服务器

无法访问文件服务。）

请联系 Dell 支持部门寻求干预或协助。请收集诊断日志

文件捆绑包，然后将其上传给 Dell 支持部门。

Host <variable> added to SNMP alert recipient list.
（已将主机 <variable> 添加至 SNMP 警报收件人列

表。）

信息类消息。不需要用户干预。

Host <variable> deleted from SNMP alert recipient list.
（已将主机 <variable> 从 SNMP 警报收件人列表中

删除。）

信息类消息。不需要用户干预。

Host <variable> enabled for SNMP alerts.（已为 

SNMP 警报启用主机 <variable>。）

信息类消息。不需要用户干预。

Host <variable> disabled for SNMP alerts.（已为 

SNMP 警报禁用主机 <variable>。）

信息类消息。不需要用户干预。

User <variable> logged into the system.（用户 

<variable> 已登录到系统中。）

信息类消息。不需要用户干预。

CIFS user <variable> added.（已添加 CIFS 用户 

<variable>。）

信息类消息。不需要用户干预。

CIFS user <variable> deleted.（已删除 CIFS 用户 

<variable>。）

信息类消息。不需要用户干预。
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Password changed for CIFS user <variable>.（已更改 

CIFS 用户 <variable> 的密码。）

信息类消息。不需要用户干预。

System upgrade completed <variable>.（已完成系统

升级 <variable>。）

信息类消息。不需要用户干预。

Cleared foreign configuration on disk <variable>.（已

清除磁盘 <variable> 上的外部配置。）

信息类消息。不需要用户干预。

User <variable> logged into the system.（用户 

<variable> 已登录到系统中。）

信息类消息。不需要用户干预。

Disk <variable> configured as hot spare.（已将磁盘 

<variable> 配置为热备用磁盘。）

信息类消息。不需要用户干预。

Cleared foreign configuration on disk <variable>.（已

清除磁盘 <variable> 上的外部配置。）

信息类消息。不需要用户干预。

Telnet service enabled.（已启用 Telnet 服务。） 信息类消息。不需要用户干预。

Telnet service disabled.（已禁用 Telnet 服务。） 信息类消息。不需要用户干预。

DNS settings updated with primary <variable>, 
secondary <variable>, and suffix <variable>.（DNS 设
置已更新为主要 <variable>、次要 <variable> 和后

 <variable>。）

信息类消息。不需要用户干预。

System initialized successfully.（系统初始化成

功。）

信息类消息。不需要用户干预。

Security privilege(s) changed for <variable>.（已更改 

<variable> 的安全权限。）

信息类消息。不需要用户干预。

Miscellaneous Invalid/Last Event.（其他无效/上个事

件。）

信息类消息。不需要用户干预。

系统事件 = 类型 6

File system check restarted.（已重新启动文件系统

检查。）

信息类消息。不需要用户干预。

File system check completed successfully. No 
inconsistencies were found.（已成功完成文件系统

检查。未发现不一致问题。）

信息类消息。不需要用户干预。

File system check found some inconsistencies.（文件

系统检查发现一些不一致问题。）

DR Series 系统维护模式修复进程应该可以解决此问题。

如果问题仍然存在，请联系 Dell 支持部门寻求协助或干

预。

File system repair started.（已启动文件系统修

复。）

信息类消息。不需要用户干预。

File system repair completed.（已完成文件系统修

复。）

信息类消息。不需要用户干预。

File system check stop requested.（已请求停止文件

系统检查。）

信息类消息。不需要用户干预。
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系统事件消息 说明/含义或措施

One (or more) file(s) were deleted as part of the repair 
process.（修复过程中删除了一个或多个文件。）

信息类消息。不需要用户干预。要进行验证，请使用 DR 
Series 系统 CLI maintenance --filesystem --repair_history 
verbose 命令。

One or more file(s) were deleted as part of the repair 
process for container <variable>. Replication will be 
stopped for this container.（修复过程中删除了容器 

<variable> 的一个或多个文件。将停止此容器的复

制。）

信息类消息。不需要用户干预。

One or more file(s) were deleted as part of the repair 
process for container <variable>. Resync has been 
initiated for this container.（修复过程中删除了容器 

<variable> 的一个或多个文件。已启动此容器的重

新同步。）

信息类消息。不需要用户干预。

系统事件 = 类型 7

OST server started successfully.（OST 服务器成功启

动。）

信息类消息。不需要用户干预。

OST server failed to start.（OST 服务器未能启

动。）

请重新启动 OST 服务器。如果问题仍然存在，请联系 

Dell 支持部门寻求协助或干预。

OST server stopped successfully.（OST 服务器成功

停止。）

信息类消息。不需要用户干预。

OST client authentication failed.（OST 客户端身份验

证失败。）

请重试 OST 客户端身份验证。如果问题仍然存在，请联

系 Dell 支持部门寻求协助或干预。

OST Logical Storage Unit (LSU) quota exceeded 
<variable>.（OST 逻辑存储单元 (LSU) 配额已超过 

<variable>。）

信息类消息。请减少 LSU 的数量。如果问题仍然存在，

请联系 Dell 支持部门寻求协助或干预。

OST backup failed <variable>.（OST 备份失败 

<variable>。）

请重试 OST 备份操作。如果问题仍然存在，请联系 Dell 
支持部门寻求协助或干预。

OST Opdup failed <variable>.（OST 优化复制失败 

<variable>。）

OST 优化复制过程失败。如果问题持续存在，请联系 Dell 
支持部门寻求协助或干预。

OST Restore failed <variable>.（OST 还原失败 

<variable>。）

OST 还原过程失败。如果问题持续存在，请联系 Dell 支
持部门寻求协助或干预。

OST connections exceeded the maximum limit; count: 
<variable>, maximum limit: <variable>.（OST 连接数

已超过 大限制；计数：<variable>， 大限制：

<variable>。）

信息类消息。请减少 OST 连接的数量。如果问题仍然存

在，请联系 Dell 支持部门寻求协助或干预。

Connection from the OST client <variable> aborted.
（已中止来自 OST 客户端 <variable> 的连接。）

信息类消息。不需要用户干预。

OST client protocol version is not supported.（不支持 

OST 客户端协议版本。）

信息类消息。不需要用户干预。请在 Dell DR Series 
System Interoperability Guide（Dell DR Series 系统互操作性
指南）中查阅支持的 OST 客户端版本。

174



系统事件消息 说明/含义或措施

System is entering the Maintenance mode: OST LSU 
information file is corrupted.（系统正进入维护模

式：OST LSU 信息文件已损坏。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预。

System is entering the Maintenance mode: OST LSU 
image information is corrupted.（系统正进入维护模

式：OST LSU 映像信息已损坏。）

信息类消息。不需要用户干预。如果问题仍然存在，请

联系 Dell 支持部门寻求协助或干预

OST client connection was reset.（已重置 OST 客户

端连接。）

信息类消息。不需要用户干预。

System is entering the Maintenance mode: OST meta 
directory is corrupted.（系统正进入维护模式：OST 
元目录已损坏。）

信息类消息。不需要用户干预。

OST server initialization failed.（OST 服务器初始化

失败。）

信息类消息。不需要用户干预。

OST server initialization was successful.（OST 服务

器初始化成功。）

信息类消息。不需要用户干预。

关于诊断服务

通过 DR Series 系统中的 Diagnostics（诊断）服务可显示、收集和管理系统的诊断日志文件捆绑包。每个诊断

日志文件捆绑包提供：

• 系统操作的当前快照

• 可帮助理解系统操作的系统相关信息

• 系统操作的记录，可在 Dell 支持需要提供技术帮助时使用

要访问此功能，请使用以下 DR Series 系统导航面板 GUI 选项：

• Support（支持） → Diagnostics（诊断） 

Diagnostics（诊断）服务的工作方式是通过收集所有系统相关信息，帮助诊断系统中的问题或错误情况。

有关诊断日志文件捆绑包的更多信息，请参阅 Diagnostics（诊断）页面和选项。

诊断在系统启动期间作为一种服务运行，并且此进程侦听进入的请求。诊断收集进程在两种模式下启动：

• Admin-Generated mode（管理员生成模式）：当 DR Series 系统 CLI 或 DR Series 系统 GUI 请求由管理员
提出（并且列出的默认原因是管理员生成）时。

• Auto-Generated mode（自动生成模式）：报告进程或服务故障时，DR Series 系统开始收集系统相关信
息。完成自动生成的收集后，它将生成系统事件。

诊断日志目录超过 大存储容量时，任何生成一小时以上的日志都将自动删除。通过 DR Series 系统 GUI 可将

诊断日志文件下载并保存至网络上的其他系统。DR Series 系统还将维护一个单独的归档日志目录来收集其他

系统相关信息，这些归档日志超过 大容量时也将自动删除。

有关更多信息，请参阅 Diagnostics（诊断）页面和选项、生成诊断日志文件、下载诊断日志文件和删除诊断日

志文件。

注: 在生成一个诊断日志文件捆绑包时，它包含联系 Dell 支持寻求技术帮助时需要的所有 DR Series 系统信

息。生成诊断日志文件捆绑包后，此进程还收集以前所有自动生成的诊断并将其从系统中删除。

175



诊断日志文件捆绑包收集的硬件、存储和操作系统信息的类型与使用 Dell System E-Support Tool (DSET) 和 DR 
Series 系统 CLI 命令 (diagnostics --collect --dset) 收集的信息类型相同。有关 DR Series 系统命令行界面命令的更

多信息，请参阅 Dell DR Series Command Line Reference Guide（Dell DR Series 命令行参考指南）。

为系统收集的基于 DSET 的信息有助于 Dell 支持人员对 DR Series 系统进行故障排除或评估其状态。

了解诊断信息的收集

诊断服务收集工具进程遵循以下原则：

• DR Series 系统会针对任何系统过程或服务故障触发对 DR Series 系统状态的自动诊断日志收集。

• 所有自动诊断收集请求按照顺序被排队和执行。

• DR Series 系统 GUI 提供选项以显示现有诊断日志，生成新诊断日志，下载并保存现有诊断日志的副
本，或删除现有诊断日志。有关更多信息，请参阅 Diagnostics（诊断）页面和选项及关于诊断服务。

• DR Series 系统 CLI 还提供管理、生成或下载诊断日志文件的手段。有关更多信息，请参阅 Dell DR Series 
System Command Line Reference Guide（Dell DR Series 系统命令行参考指南）。

About the DR Series System Maintenance Mode
In general, the DR Series system enters the Maintenance mode whenever the file system has encountered an issue that 
prevents it from operating normally.

注: In this release of the DR Series systems, you can use the Reason code information available in the Mainenance 
mode to call Dell support. All maintenance must be conducted using the DR Series systems Command Line 
Interface.

When in its Maintenance mode, the filesystem is in a read-only state, and the system runs the following maintenance-
based operations:

注: Whenever the DR Series systems enters or exits from the Maintenance mode state, all communication via CIFS, 
NFS, RDA, or OST is lost.

• Runs an internal filesystem check.

• Generates a filesystem status report (if the filesystem check finds no issues, the DR Series system switches 
back to Operational mode without user intervention).

If the filesystem check finds issues, you can choose to make repairs (using Confirm Repair Filesystem) or ignore the 
detected issue (using Skip Repair Filesystem), at which point the system switches back to Operational mode.

The Maintenance mode process displays a number of stages, indicated on the Maintenance Mode progress bar, which 
include:

• Preparing for Filesystem Check

• Scan in Progress

• Completed Generating Report

注: If the Filesystem Check detects any repairable files, it generates a Repair Report that identifies these 
reported files. The Maintenance Mode progress bar halts at the Completed Generating Repair stage, and 
remains in Maintenance mode until you click Confirm Repair Filesystem. The DR Series system does not 
advance to the Switching to Operation Mode stage until the filesystem repair is completed.

• Switching to Operational Mode

• Operational Mode (Normal State)

The Maintenance Mode page provides the following information:

• Maintenance Mode Progress bar:
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– Displays the five stages of Maintenance mode

– Updates the progress bar as each stage completes

注: If an alert displays above the Maintenance Mode progress bar, this indicates that the 
filesystem check has completed, and it has generated a report on the repairable files (which are 
displayed in the Repair Report pane under the Maintenance Mode progress bar). To repair all of 
the reported files listed in the Repair Report, you must click Confirm Repair Filesystem.

• Repair Report:

– Displays a list of repairable filesystem files that were detected in the Filesystem Check.

– Identifies the repairable files by Container ID, File/Inode/Directory location, and a brief reason for 
failure.

– Provides a search capability that allows you to click prev or next to display the previous or next page in 
the Repair Report, or lets you display a specific page number of the Repair Report by entering this 
number in the Goto page and click go.

• System Information pane:

– System Name

– Software Version

– Current Date/Time

– iDRAC IP Address

• Support Information

– Service Tag

– Last Diagnostic Run

– BIOS Version

注: When in Maintenance mode, the DR Series system navigation panel displays the following options that are 
links to display the correspond page in the DR Series system GUI:

• Alerts

• Events

• Health

• Usage

• Diagnostics

• Software Upgrade

Once the DR Series system enters Maintenance mode, there can only be two possible outcome states:

• Operational mode (Normal State): where the filesystem check was successful, and no system files need to be 
repaired (Filesystem Check: successful).

• Maintenance mode has halted: where the filesystem check detected one or more repairable files (Filesystem 
Check: unsuccessful).

Filesystem Check — Successful: when the Maintenance mode successfully completes all of its stages, the DR Series 
system displays its status as having entered Operational mode (Normal State). Only after the Maintenance mode has 
successfully completed its internal check can it return to an Operational mode.

To return to the Operational mode, click Go to Dashboard on the Maintenance Mode page options bar. Go to Dashboard 
is only active when all of the internal system checks have completed and the progress bar indicates that all stages have 
been completed.

注: You may encounter issues when using data management agents (DMAs) such as NetBackup with expired 
backup images when the DR Series system is in its Maintenance mode.
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注: When in Maintenance mode, image expiration fails because the DR Series system is in a read-only state. If this 
occurs, the DMA assumes that the backup images have expired. However, the DR Series system administrator may 
be unaware that the backup data images still reside on the DR Series system.

Filesystem Check — Unsuccessful: when the Maintenance mode halts at the Completed Generating Report stage, this 
indicates that the filesystem check detected some repairable files, and listed them in the Repair Report pane on the 
Maintenance Mode page.

To return to the Operational mode, click Confirm Repair Filesystem on the Maintenance Mode page options bar to repair 
the files listed in the Repair Report. Confirm Repair Filesystem is the only active option you can select when the progress 
bar indicates that some filesystem files are in need of repair.

About the DR Series System Support Mode
Generally, the DR Series system enters its Support mode only because of one of the following reasons:

• The filesystem has encountered an issue that could not be resolved by running the internal Maintenance mode.

• Some system processes failed to start properly.

• The system detected an unsupported configuration.

The Support mode puts the DR Series system into a state in which only the following tasks can be performed:

• Generating a DR Series system diagnostics file. For more information, see Generating a Diagnostics Log File.

• Upgrading the DR Series system software. For more information, see Upgrading the DR Series System Software.

• Installing a license for the data storage expansion shelf enclosure. For more information, see Expansion Shelf 
Licenses and Installing an Expansion Shelf.

• Contacting Dell Support for technical assistance. For more information, see Contacting Dell.

注: Dell recommends that you generate a DR Series system diagnostics file whenever the DR Series system is in its 
Maintenance or Support modes if one was not automatically generated.

When in the Support mode, the DR Series system displays the following alert message:
The server is currently in Support mode. To continue, you must contact Dell 
Support at http://www.support.dell.com or contact your Dell support 
representative.

计划 DR Series 系统操作

请记住，在计划关键的 DR Series 系统操作时， 为重要的是确保在适当的时间执行每项操作，以免与其他重
要的系统操作发生重叠或对其造成妨碍。

通过更好地计划系统操作的运行时间，可以优化系统资源，以便实现 佳的 DR Series 系统性能。为此，请为

以下关键系统操作计划安排执行时间：

• 数据插入（它取决于 DMA）

• 复制进程

• 清理器进程（空间回收）

在计划和安排操作时，主要目标是在适当的时间运行清理器和复制操作，以免与其他重要的系统操作发生重叠

或对其造成妨碍。应该确保通过适当的安排和计划，系统可以相互独立地执行每项关键操作。

佳做法是在非标准工作时间运行这两项操作，以免与其他任何备份或插入操作发生冲突。简言之，通过高效

的计划可以 大限度地利用系统资源。
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Dell 建议将资源密集型操作安排在不执行任何其他系统操作的特定时间段内运行。这种方法称为窗口法，需要

计划特定的时间段（或“窗口”），每个时间段都设定开始时间和结束时间，以便执行数据插入、复制或空间

回收操作，而不干扰任何其他操作的运行。

Creating a Cleaner Schedule
Performing scheduled disk space reclamation operations are recommended as a method for recovering disk space from 
system containers in which files were deleted as a result of deduplication. The best method is to schedule a time when 
you can run the Cleaner on your DR Series system with no other planned processes running. Alternately, another 
method lets the Cleaner process on the DR Series system run whenever it determines that there are no active data 
ingests.

注: Even if no Cleaner schedule is set, but the system detects that there is disk space that can be reclaimed, the 
Cleaner process runs. However, the Cleaner will not start until the following conditions are met: it detects that 
there are no active data ingests, that two minutes of system idle time have elapsed since the last data file ingest 
was completed, and that the Replication process is not running (the Cleaner process runs as a lower system 
priority operation than the Replication process).

注: Running the Cleaner while ingesting data, reduces system performance. Ensure that you schedule the Cleaner 
to run when backup or replication is not in progress.

注: The Cleaner Schedule page displays the current DR Series system time zone and current timestamp (using this 
format: US/Pacific, Fri Nov 2 15:15:10 2012).

To schedule Cleaner operations on your system, complete the following:

1. Select Schedules → Cleaner Schedule.
The Cleaner Schedule page is displayed.

2. Click Schedule to create a new schedule (or click Edit Schedule to modify an existing schedule).
The Set Cleaner Schedule page is displayed.

3. Select (or modify) the Start Time and Stop Time setpoint values using the Hour and Minutes pull-down lists to 
create a Cleaner schedule.

注: You must set a corresponding Stop Time for every Start Time set in each Cleaner schedule you create. The 
DR Series system will not support any Cleaner schedule that does not contain a Start Time/Stop Time pair of 
setpoints (daily or weekly).

4. Click Set Schedule for the system to accept your Cleaner schedule (or click Cancel to display the Cleaner Schedule 
page).

注: To reset all of the values in the current Cleaner schedule, click Reset in the Set Cleaner Schedule dialog. 
To selectively modify values in the current schedule, make your changes to the corresponding hours and 
minutes pull-down lists to represent the Start Time and Stop Time you wish to set, and click Set Schedule.

The current Cleaner Status is represented in the Dashboard page in the System Information pane as one of the three 
following states:

• Pending—displayed when there is any scheduled window set and the current time is outside the scheduled 
window for the Cleaner operation.

• Running—displayed when the Cleaner operation is running during a scheduled window.

• Idle—displayed only if there is no Cleaner operation running during a scheduled window.

Dell recommends that you do not schedule the running of any Cleaner operations during the same time period when 
replication or ingest operations will be running. Failure to follow this practice will affect the time required to complete 
the system operations and/or impact your DR Series system performance.
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显示清理器统计信息

要显示附加的清理器统计信息，可使用 DR Series 系统 CLI stats --cleaner 命令显示以下类别的清理器统计信

息：

• Last Run Files Processed（清理器处理的文件数）

• Last Run Bytes Processed（清理器处理的字节数）

• Last Run Bytes Reclaimed（清理器回收的字节数）

• Last Run Start Time（指示上次清理器进程开始的日期和时间）

• Last Run End Time（指示上次清理器进程结束的日期和时间）

• Last Run Time To Completion(s)（指示清理器进程成功完成的次数）

• Current Run Start Time（指示当前清理器进程开始的日期和时间）

• Current Run Files Processed（当前清理器进程处理的文件数）

• Current Run Bytes Processed（当前清理器进程处理的字节数）

• Current Run Bytes Reclaimed（当前清理器进程回收的字节数）

• Current Run Phase 1 Start Time（指示当前清理器进程阶段 1 开始的日期和时间）

• Current Run Phase 1 Records Processed（列出当前清理器进程阶段 1 处理的数据记录数）

• Current Run Phase 1 End Time（指示当前清理器进程阶段 1 结束的日期和时间）

• Current Run Phase 2 Start Time（指示当前清理器进程阶段 2 开始的日期和时间）

• Current Run Phase 2 Records Processed（列出当前清理器进程阶段 2 处理的数据记录数）

• Current Run Phase 2 End Time（指示当前清理器进程阶段 2 结束的日期和时间）

• Current Run Phase 3 Start Time（指示当前清理器进程阶段 3 开始的日期和时间）

• Current Run Phase 3 Records Processed（列出当前清理器进程阶段 3 处理的数据记录数）

• Current Run Phase 3 End Time（当前运行阶段 3 结束时间）（指示当前清理器进程阶段 3 结束的日期和时
间）

• Current Run Phase 4 Start Time（指示当前清理器进程阶段 4 开始的日期和时间）

• Current Run Phase 4 Records Processed（列出当前清理器进程阶段 4 处理的数据记录数）

• Current Run Phase 4 End Time（指示当前清理器进程阶段 4 结束的日期和时间）

有关 DR Series 系统 CLI 命令的更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR 
Series 系统命令行参考指南）。
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11
Supported Ports in a DR Series System
The following table lists the application and service ports found on a normally operating DR Series system. There may be 
other ports that are not listed here, that an administrator may need to open and enable to support specific operations 
across the network. Be aware that the ports listed in the following table may not reflect your specific network 
environment, or any planned deployment. While some of these DR Series system ports may not need to be accessible 
through the firewall, this information is made available when deploying the DR Series system in your own network 
because it indicates supported ports that may need to be exposed.

表. 9: Supported DR Series System Ports

Port Type Number Port Usage or Description

DR Series System Application Ports

TCP 20 File Transfer Protocol (FTP)—for transferring files.

TCP 23 Telnet—remote terminal access protocol for unencrypted text 
communications.

TCP 80 Hypertext Transfer Protocol (HTTP)—unencrypted protocol communications.

TCP 443 HTTPS—combination of the HTTP with Secure Socket Layer (SSL)/Transport 
Layer Security (TLS).

TCP 1311 Hardware Health Monitor

TCP 9901 Watcher

TCP 9904 Configuration Server (needed for replication operations)

TCP 9911 Filesystem Server (needed for replication operations)

TCP 9915 MetaData Replication (needed for replication operations)

TCP 9916 Data Filesystem Server (needed for replication operations)

TCP 9918 Diagnostics Collector

TCP 9920 Data path used for OST replications

TCP 10011 Control channel (needed for OST operations)

TCP 11000 Data channel (needed for OST operations)

DR Series System Service Ports

TCP 22 Secure Shell (SSH)—used for secure logins, file transfers like SCP (Secure 
Copy) and SFTP (Secure File Transfer Protocol)

TCP 25 Simple Mail Transfer Protocol (SMTP)—used for routing and sending email

TCP 139 SMB daemon—used for SMB protocol-related processes
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Port Type Number Port Usage or Description

TCP 199 SNMP daemon—used by Simple Network Management Protocol (SNMP) 
requests

TCP 801 NFS status daemon
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12
获得帮助
有关可尝试哪些措施来自行解决问题或寻求 Dell 提供 DR Series 系统技术协助的更多信息，请参阅故障排除和
维护、错误情况故障排除、联系 Dell 支持部门之前和联系 Dell。

联系 Dell 支持部门之前

遇到错误情况或操作问题时，Dell 建议先确定是否可使用相关的 Dell DR Series 系统说明文件予以解决，然后再

尝试联系 Dell 支持部门寻求协助。

为帮助隔离或诊断使用 Dell DR Series 系统时可能遇到的任何基本问题，Dell 建议执行以下任务：

• 参阅 Dell DR Series System Administrator Guide（Dell DR Series 系统管理员指南），确认其中是否包含可
以解释或解决所遇问题的信息。请参阅第 9 章“故障排除和维护”。

• 参阅 Dell DR Series System Command Line Reference Guide（Dell DR Series 系统命令行参考指南），确认
其中是否包含可以解释或解决所遇问题的信息。

• 阅读 新的 Dell DR Series System Release Notes（Dell DR Series 系统发行说明）系列，确认其中是否包
含可以解释或解决所遇问题的信息。

• 找到 Dell 支持帐户编号和密码，找到 DR Series 系统的服务标签，了解支持帐户的类型，然后准备提供
与所执行的操作有关的具体详情。

• 记录您收到的任何状态或错误对话框信息的内容，以及它们显示的顺序。

• 生成当前版本的诊断文件（或者，如果这不可能，请找出 新的现有诊断文件）。

– 使用 DR Series 系统 GUI，单击 Diagnostics（诊断） → Generate（生成） 以生成诊断文件。

– 使用 DR Series 系统 CLI，在系统提示符处，输入命令 diagnostics --collect 以生成诊断文件。有关
更多信息，请参阅 Dell DR Series System Command Line Reference Guide（Dell DR Series 系统命令
行参考指南）。

注: 要在解决复制问题时取得 好的结果，应该尽可能同时在 DR Series 源和目标系统上生成诊断文件。

注: 每个生成的诊断文件捆绑包会包含帮助 Dell 支持了解到有关以下各项的 新数据的信息：

• 系统警报和事件

• 系统配置状态

• 系统日志文件

• 存储和复制容器的系统统计信息

• 系统硬件组件状态

联系 Dell
本主题介绍客户在需要联系 Dell 支持以寻求技术帮助时可遵循的流程。对于美国客户，请致电 800-WWW-DELL 
(800-999-3355)。

注: 如果没有活动的 Internet 连接，还可以在购买发票、装箱单、账单或 Dell 产品目录上找到所需的正确

联系信息。

Dell 提供了几种联机和电话支持与服务选项。可用的选项因国家/地区和产品而不同，某些服务在您所在的区域

可能并不提供。
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要联系 Dell 以解决销售支持、技术支持或客户服务问题，请执行以下操作：

1. 访问 support.dell.com。

2. 在 support.dell.com 页面底部单击选择所在国家/地区。有关国家和地区的完整列表，请单击 All（全部）。

此时将显示 Choose a Country/Region（选择国家/地区）页面。

3. 在 Americas（美洲）、Europe, Middle East, & Africa（欧洲、中东和非洲）或 Asia Pacific（亚太地区）选项
中单击国家/地区。

4. 根据您的需要，选择相应的服务或支持链接。

5. 选择对您而言 方便与 Dell 联络的方式。
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